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Safety Notices

The following safety 
precautions must be observed 
whenever the 156MTS is 
operated, serviced, or 
repaired. Failure to comply 
with these and other specific 
warnings and cautions within 
this manual is a violation of 
Agilent Technologie’s safety 
standards of design, 
manufacturing, and intended 
use of the test set.

Agilent assumes no liability 
for the operator’s failure to 
comply with these 
precautions.
Electric Shock Hazard

Warning! Do not remove the 
system covers. To avoid 
electric shock, use only the 
supplied power cords and 
connect only to properly 
grounded (three-pin) wall 
outlets.

Fire Hazard

Caution! For continued fire 
protection, use only fuses 
with the properly rated 
current, voltage, and type 
(see page 27–5). Disconnect 
power before replacing fuse.

Explosion Hazard

Warning! Do not operate the 
instrument in the presence of 
flammable gases.

Hazardous Material

Warning! If the LCD display 
is damaged, the liquid crystal 
material can leak. Avoid all 
contact with this material, 
especially swallowing. Use 
soap and water to thoroughly 
wash all skin and clothing 
contaminated with the liquid 
crystal material.
Cleaning

To clean the instrument use a 
damp cloth moistened with a 
mild solution of soap and 
water. Do not use harsh 
chemicals. Do not let water or 
other liquids get into the 
instrument.

Product Damage

Caution! Do not use this 
product if it shows visible 
damage, fails to perform, has 
been stored in unfavorable 
conditions, or has been 
subject to severe 
transportation stresses. Make 
the product inoperative and 
secure it against any 
unintended operation. 
Contact your Agilent 
Technology representative for 
assistance.

Lithium Battery

Caution! Danger of 
explosion if battery is 
incorrectly replaced. Replace 
only with same or equivalent 
type recommended by the 
manufacturer. Discard used 
batteries according to 
manufacturer’s instructions.
Symbols

The following are general 
definitions of safety symbols 
used on equipment and in 
manuals.

Instruction manual symbol. 
Indicates the user should 
refer to the instruction 
manual in order to protect 
against damage to the unit.

Indicates dangerous voltage.

Protective ground.

Frame or chassis ground.

Alternating current.

Direct current.

Alternating or direct current.





About This Book

Quick Start Chapter 1, About the 156MTS, includes brief topics that will help you 
get up and running quickly:

• The 156MTS at a glance

• Auto Test

• Trouble Scan

How To Test These chapters contain step-by-step procedures for using the test set:

• Chapter 2, Testing SONET Networks

• Chapter 6, DS3 Network Testing

• Chapter 10, DS1, DS0, and FT1 Network Testing

• Chapter 14, E1 and Timeslot Network Testing

• Chapter 18, ATM Network Testing

Reference These chapters contain reference information for the setup parameters:

• Chapter 3, SONET Configuration Reference

• Chapter 7, DS3 Configuration Reference

• Chapter 11, DS1, DS0, and FT1 Configuration Reference

• Chapter 15, E1 and Timeslot Configuration Reference

• Chapter 19, ATM Configuration Reference

Measurements These chapters describe the error and alarm results:

• Chapter 4, SONET Measurement Reference

• Chapter 8, DS3 Measurement Reference

• Chapter 12, DS1 Measurement Reference

• Chapter 16, E1 Measurement Reference

• Chapter 20, ATM Measurement Reference

General
Information

Chapters 22 through 27 contain general information about your 156MTS 
such as store and recall functions, global and auxiliary setups, printing, 
remote control, and downloading software.
v



Introduction
About this Version

Applicability This version of the HP CERJAC 156MTS User’s Manual applies to 
HP E4480A 156MTS SONET maintenance test sets running operating 
software version 6.40. Some functions of 156MTS test sets running 
earlier versions of the software may operate differently; some functions 
of test sets running later software versions may not be covered by this 
manual. Be sure to refer to any user-manual supplements or release 
notes that came with your set, or call CERJAC at 1-800-9-CERJAC.

Check the 
Software Version

You can check the version number of the operating software in your test 
set by observing the display during power-up. You can also view the 
software version at any time using the System Software Configuration 
screen (see System Software Revision, page 1–12).

Check the 
Installed Options

You can check the options installed in your test set using the System 
Software Configuration and System Hardware Configuration screens. 
See Hardware Configuration, page 1–12.

E4480A CERJAC 156MTS User’s Manual printing history

Version number Release date Notes

1.0 March, 1997 First release.

2.0 December, 1997 Updated to cover Release 6.40 
(new ATM and other features).

2.1 May, 1998 Minor typographical corrections.

2.2 May 2000 Update accumulated software 
driven updated throughout user’s 
manual.
vi
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About the 156MTS

At a GlanceQ
uick Start
At a Glance

The Front Panel 

Volume

Contrast

Contrast & 
Volume keys

Memory keys
(see pg 22–5)

LCD Display
(see pg 1–4)

Navigation 
keys
(see pg 1–5)

Error Inject & 
Action/Local 
keys

Auto Setup key
(see pg 1–6)

Optical Signal 
connectors

Trouble Scan
key
(see pg 1–7)

Start/Stop 
keys

Print & Display 
Hold keys

DS3 Alarm & 
Status LEDs
(see pg 8–2)

DS1/E1 Alarm 
& Status LEDs
(see pg 12–2, 
and pg 16–2)

STS-N Alarm & 
Status LEDs
(see pg 4–2) Power switch

ATM Alarm & 
Status LEDs
(see pg 20–2)

History Reset 
key

VT Alarm & 
Status LEDs
(see pg –29)
1–2
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The Rear Panel 

DS0 DS3
ERR OUT STS1 TX

CLK IN

BURST ERR INTX CLK IN

ERR OUTBITS OUT
DS1

DEMOD
JITTER OUT

VF IN

VF OUT

HAND SETDS1-INTERFACE

SIGNALING-TTL

DATA-LINK-RS422

DATA-LINK-RS232

TX CLK INBITS IN

PRINTER-RS232

REMOTE-IEEE-488

REMOTE-RS232

REF IN

Slo Blo

115 V

5A 250V

200W

Serial printer 
port

Serial remote 
control port

GPIB remote 
control port

Optional 
connector 
panel

AC input and 
fuse

Demodulated 
jitter output

Cooling fan

STS-1 Tx 
Clock input

Data Link 
drop and 
insert ports

DS1/E1 
signal 
input/output

DS0/TS 
Signaling TTL 
interface

SONET 
orderwire 
port

VF/DS0/TS 
input/output 
connectors

DS3 Error out 
and Tx Clock 
in connectors

DS1/E1 timing 
and error 
connectors

Error burst 
trigger input
1–3



About the 156MTS

At a GlanceQ
uick Start
LCD Display—Test Operation Screen

LCD Display—Main Menu

 1 STS1-STS1 (DS3/1) Final: 00:03:09.59
Trouble Scan  >>>>>>>

          No Errors or Alarms

DS1: TxClk>Int  Frm>SF     Data>QRSS
     Ins>1   Other DS1s>Same    Drop>1
DS3:   TxClk>Int   Frm>M13      XBit>1
STS1:  TxClk>Int       Scramble>On
          Tx>STSX1           Rx>STSX1
Err/Alm:Type>DS1 Data    Rate>Single

Final or Elapsed time

Test Mode label
(see About the Basic Testing 
Modes, page 1–12)

Memory buffer number

Measurement results screen
(scrolling controlled by RESULT)

Test configuration screen
(scrolling controlled by CONFIG)

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store and Recall Configurations

---------------------------------------
Press FIELD to highlight item, then
Press MENU to select item.

Automatic setup
(see pg 1–6)

Test modes
(see pg 1–12)

Automatic sequences

General system setup
(see pg 23–1)

Configuration storage
(see pg 22–2)
1–4
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Navigation Keys

The Control Screens Menu

Moves up and down through 
menu levels

Scrolls top half of display

Scrolls bottom half of display

Selects parameters or menu 
items

Changes values of selected 
parameters

VALUE

  Global Settings  |  Data Link Control
  Alarm Control    |  DS0/TS Settings
  APS Control      |  DS1/E1 Patterns
  DS3 FEAC Control |  DS1 Loop Codes
  DS3 C-Bit Control|
  SONET OH Control |

l: 00:03:09.59

arms

 Data>QRSS
ame    Drop>1
3      XBit>1
ramble>On
   Rx>STSX1

Rate>Single

    >Modify Glob
Modify Config Wh
Results Level:Su
Inhibit Errors o
Inv PRBS? No
Jitter Hits Thre

CONFIG CONFIG

FIELD FIELD

Test Operation
Screen

Control Screen
Menu

Selected
Control Screen

Use FIELD to select
a menu item

Use FIELD & VALUE
to make changes on
the control screen

Use CONFIG to
scroll the display
1–5
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To Perform an Auto Setup TestQ
uick Start
To Perform an Auto Setup Test

Note: Auto Setup Test does not set up ATM functionality. 

You can also run an auto test 
by selecting Auto from the 
Main Menu.

1. Press the AUTO SETUP key.

The Auto Setup Status screen is displayed.

When the 156MTS detects a signal, it checks for subrate traffic. If 
there is traffic, the set prompts you to select a channel.

2. Use the FIELD key to display the desired protocol (by highlighting a 
channel). Then press the MENU-down key to continue.

The 156MTS configures itself to the signals format and test pattern, 
and then enters to appropriate terminal test mode.

3. Select Channel and then data scan or frame scan, or keep going. 

4. Use the TROUBLE SCAN or RESULT keys to view test 
measurements.

 

 

 

  1  DS3-DS3  (DS1)       Final:           00:00:00.00 
DS3  Measurement  Summary
Bit:                          --       Sec Ago:           --
Frm:                        --                                 --
CRC:                       --                                 --
BPV:                       --                                  --
 DS3:        Tx>DSX3       TX>DSX3     TXClk>int
               Frm>M13          XBit>1        FEBE>111
 DS1:     TxClk>Int    Frm>ESF    Data>QRSS
           Ins>1                                 Other>Same
        Drop>1                                  Code>B8ZS
 Err/Aim:Type>DS1  Data             Rate>Single 

Use the result key to view measurements.

The set begins the appropriate Terminal
Test Mode.

          MODEL 156 MAIN MENU
  Auto Setup
  Terminal Testing
  Monitor Testing
  Drop & Insert Testing
  DS3/DS1/ATM Scans & Pointer Sequences
  Setup System Parameters
  Store and Recall Configurations

  ---------------------------------------------------------------------
  Press FIELD to highlight item, then
  Press MENU-Dn to select item.

The set begins to scan for input signals.

Select the subrate channel on the signal, if
necessary.

Apply an input signal.

Press the AUTO SETUP key.
1–6
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To Use Trouble Scan

A test must be running; if 
necessary, press START.

• Press the TROUBLE SCAN key.

The Trouble Scan function begins and the Trouble Scan screen 
automatically displays. 

An animated activity indicator 
shows that Trouble Scan is 
active.

The Trouble Scan display shows a summary of alarms and errors 
that have been detected.

Note: You can deactivate the Trouble Scan feature using the Global Settings control 
screen. See Trouble Scan Activation, page 23–2.

You can also scroll to the 
Trouble Scan display using the 
RESULT keys.

START

RUN

A test must be running; press START
if needed.

View results in the top of the display.

Activity bar indicates scan is active.
Use RESULT to view other screens.

DS3:     Frm>M13       Data>2^15-1
       TxClk>Int       FEBE>111  XBit>1
STS1:  TxClk>Int          Scramble>On
       Tx>STSX1           Rx>STSX1
Err:    Type>DS3 Data    Rate>Single

 1 STS1-STS1 (DS3)  Final:  00:01:07.66
Trouble Scan  >>>>>>>
SONET LOS:     HIS    DS3 LOS:       HIS
SONET LOF:     HIS    DS3 LOP:       ON
SONET LOPNTR:  ON     DS3 FFM:       ON
PATH CV:  18273645    More...

TROUBLE
SCAN

Press the TROUBLE SCAN key.

Trouble Scan is automatically activated
and displayed.
1–7
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Restore Default Settings (Cold Start) and Clears BuffersQ
uick Start
 Restore Default Settings (Cold Start) and 
Clears Buffers

The 156MTS powers on using the same configuration in which it was 
switched off. You can restore all 156MTS setup options to their factory 
defaults but clear the storage buffers at any time using this “cold 
start” procedure. This is useful for returning the instrument to a known 
configuration.

1. Press the POWER switch to O to switch off the 156MTS.

2. Press and hold the STOP key.

3. While holding the STOP key, press the POWER switch to I to switch 
the unit on.

The display shows the message “Performing Self Test.”

Then, the display shows the message “Performing Warm-Start 
Power-up. 

4. If you want to clear any stored configurations out of memory, 
quickly release the STOP key and press the START key.

For more information on 
configuration storage, 
See Configuration Storage and 
Retrieval, page 22–2.

The display shows the message “Clearing Config Storage Buffers.”

• When the unit completes its start-up routine, the factory default 
configuration will be in effect.

Press and hold the STOP key. While holding the STOP key,
switch on the test set

Observe the Warm-Start Powerup
message on the display.

Configuration Storage Buffer Unchanged

   Model 156 MTS Sonet Maintenance Test Set  
Software Version 7.0 Apr 11 2000 15:05:16
Performing Self Test.  Please wait...
Performing Warm-Start Powerup.
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Restore Default Setting While Holding Stor-
age Buffers

The 156MTS test set can restore all the setup options to the factory 
default setting without clearing the storage buffers.  If you want to 
clear the storage buffer, perform a cold start (see previous page).  If you 
want to retain the storage buffers and restore the factory setup options, 
then perform the following:

1. Stop test set.  Using the MENU-up key, go to the Model156 Main 
Menu. 

2. Using the FIELD-down key, step highlight down to Setup System 
parameters memu.  Press the MENU-down button.

3. At the Setup System Parameters menu, use the FIELD-down key, 
step highlight down to Restore Factory Default Settings.

4. Press the MENU-down button only once.  The display will ask the 
following question.

Caution: You are about to restore all Setup options to their factory default setting.  Are 
you sure you want to do this? 

5. NO!  To escape without restoring Factory Default Settings, press  
the MENU-down key.

6. YES!  Press  the MENU-up button to Restore Factory Default 
Settings and retain the storage buffer.

You are about to restore all setup
options to their factory default
settings.
Are you sure you want to do this?

Press  5 MENU for YES.
Press  MENU 6  for NO.

CAUTION
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To Perform a Terminal Mode Test

This is the basic procedure for performing a test with your 156MTS.

1. Switch on the 156MTS and connect the signal to be tested.
Connect the received signal to an RX jack; connect the transmit 
signal to a TX jack.

2. Use FIELD to select Terminal Testing from the Main Menu and 
press the MENU-down key.

3. Use FIELD and VALUE to configure the transmitter, receiver, and 
payload as appropriate for your application. Press MENU-down.

4. Use FIELD and VALUE to further configure the transmitter and 
receiver as necessary by setting the parameters in the lower half of 
the display. Use the CONFIG keys to scroll the lower half of the 
display.

5. Press START to begin the test.

• To pause a test in progress, press START. The timer is stopped, 
but not reset. To continue the test press START again.

• To freeze the display without pausing the test, press 
DISPLAY HOLD. Press the key again to resume.

6. Press the RESULT keys to view different measurement screens in 
the top half of the display.

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store & Recall Configurations

----------------------------------------
Press FIELD to highlight item, then
Press MENU select item.

         TERMINAL TESTING

Tx Rate: STS1          Rx Rate: STS1

Payload: DS3

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press ENTER to enter test mode.
Press MENU to return to Main Menu

DS3:     Frm>M13       Data>2^15-1
       TxClk>Int       FEBE>111  XBit>1
STS1:  TxClk>Int          Scramble>On
       Tx>STSX1           Rx>STSX1
Err:    Type>DS3 Data    Rate>Single

 1 STS1-STS1 (DS3)  Final:  00:00:00.00
STS-1 Measurement Summary
B1 (Sect CV):    --    Sec Ago:   --
B2 (Line CV):    --               --
BPV:             --               --
Rx Opt dBm:--

Select the test. Set up the transmitter, receiver,
and payload.

View results in the top half of the
display.

Set signal parameters in the bottom of
the display.
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To Display More Measurement Screens

The 156MTS has two results levels: summary and detail. You can select 
the level of results that are displayed by following this procedure.

1. From a test operation screen press CONFIG-right to display the 
Control Screens menu.

2. Select Global Settings and press CONFIG-right.

3. Use FIELD to highlight the Results Level field and use VALUE to 
set it to Summary or Detail.

In the measurement reference 
chapters of this manual, a 
screen’s results level is 
indicated by an “s” or a “d”.

Summary makes fewer, higher-level results screens available. 
Detail makes additional, more in-depth screens available.

4. Press CONFIG-right to return to the test operation screen.

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Bit:       --     Sec Ago:   --
    Frm:       --                --
  C-Bit:       --                --
  P-Bit:       --                --
    BPV:       --                --

Í   Global Settings  |
  DS3 FEAC Control  |
  DS3 C-Bit Control|
  Data Link Control|
  DS3 Prog Pattern |

Í

    >Modify Global Configurations<
Modify Config While Running?    No
Results Level: Summary  Trouble Scan:On
Inhibit Errors on Alarm?        Yes
Inv PRBS? No
Jitter Hits Thresh. (UI): WB>5.0  HB>0.2
1–11
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To View System Information

System Software 
Revision

1. Select Setup System Parameters from the Main Menu and press 
MENU-down. The Setup System Parameters menu is displayed.

2. To view the software versions select System Software 

Configuration from the Setup menu and press MENU-down. 

The revision of the software installed in your test set is displayed, as 
well as the date of installation (displayed cofig. code is typical).

3. Press MENU-up to return to the Setup menu.

Hardware 
Configuration

1. To view the hardware configuration select System Hardware 

Configuration from the Setup menu and press MENU-down. 

The options installed in your test set are displayed.

2. Press MENU-up to return to the Setup menu.

System Software Configuration

Boot:  X.XX  MON DT 199X HH:MM:SS
Host:  X.XX  MON DT 199X HH:MM:SS
ATM:   X.XX  MON DT 199X HH:MM:SS

IEEE-488 and RS-232 (SCPI): Installed
RS-232 Remote Front Panel:  Installed
Data/Event Logging:         Installed

Config. Code: 07 08 05 FF FF 58 FE F3

System Hardware Configuration

STS-1:   Installed   DS1:  Installed
STS-3:   Installed   DS1C: Installed
STS-3c:  Installed   DS0:  Installed
STS-12:  Installed   E1:   Installed

STS-12C: Installed   TS:   Installed
DS3:     Installed   FT1:  Installed
VT1.5:   Installed   ATM:  Installed
Dual DS3: Installed
DS3 Pulse Mask: Installed
Jitter: Installed for STS1 DS3 DS1 E1
1–12
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About the Basic Testing Modes

The 156MTS features different test modes to meet the needs of different 
test applications. You configure the test mode as you set up the test set, 
selecting the test mode category (terminal mode, drop & insert mode, 
and so forth) and then configuring the transmitter, receiver, and 
payload.

Terminal modes Terminal mode tests feature independant transmitter and receiver 
setup. Terminal modes are indicated on the display in the format:

TransmitRate–ReceiveRate (Payload)

where TransmitRate is the type of signal assigned to the transmitter, 
ReceiveRate is the type of signal assigned to the receiver, and Payload is 
the type of traffic the signals are carrying.

About Terminal Mode 
Applications

Terminal mode testing is used with a variety of transmission and 
multiplexing equipment, and is generally performed in out-of-service 
conditions.

Use Terminal mode when you need a test signal as an input to the 
system being tested. Often, such as for a multiplexer or demultiplexer 
test, the test set transmits a test signal at one rate and receives a 
different rate back. In other applications, you might perform a straight 
transmission test in which the same rate is both transmitted and 
received from the system under test.

Monitor modes Monitor mode tests feature identically configured transmitter and 
receiver signals, with a non-intrusive pass-through of the received 
signal. Monitor modes are indicated on the display in the format:

ReceiveRate–MON (Payload)

where ReceiveRate is the type of signal assigned to the receiver (the 
received signal is passed through to the transmitter), and Payload is the 
type of traffic the input signal is carrying.

About Monitor Mode 
Applications

Monitor mode testing is used to examine an incoming signal, gather 
error and performance statistics, and log alarm conditions. The test set 
regenerates the monitored signal to provide downstream keep-alive 
signals. Monitor mode is useful with a variety of in-service applications.
1–13
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You can drop channels from a monitored signal using the STS-1, DS3, or 
DS1/E1 electrical monitor connectors. In addition, SONET signals are 
sometimes accessed by interrupting the optical protection line, or 
through the use of optical splitters. The optical signal can be connected 
to the test set, and then the set’s output optical signal can be used to 
complete a SONET ring.

Note: Interrupting the optical line typically causes protection switching to occur on 
the SONET ring.

Drop & Insert 
modes

Drop and insert (D&I) mode tests feature identically configured 
transmitter and receiver signals, similar to monitor mode tests, but with 
the added capability to monitor and modify a subrate signal (channel). 
D&I modes are indicated on the display in the format:

Transmit&ReceiveRate–D&I (Payload)

where Transmit&ReceiveRate is the type of signal assigned to the 
transmitter and receiver, and Payload is the type of subrate channel on 
which measurements are performed.

About Drop&Insert 
Applications

D&I mode allows you test at the rate you need, even if the signal access 
is at a higher rate. As in Monitor mode, the test set passes the receive 
signal through to the transmit signal. D&I mode, however, allows you to 
select and examine a channel on the signal. In addition, you can modify 
the transmit channel (transmit a pattern, inject errors, and so forth).

D&I mode is also useful for performing out-of-service testing on a 
channel of a signal that is in-service. For example, if a SONET signal is 
carrying DS1 payloads, you can use D&I mode to test a single DS1 even 
though the network access may be at a SONET interface.
1–14
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To Set up for SONET Testing

For more information on 
SONET functions see 
Chapter 3, SONET 
Configuration Reference, and 
Chapter 4, SONET 
Measurement Reference.

1. On the Main Menu use FIELD to select a testing mode.

2. Press MENU-down. The testing setup screen for the mode you selected is 
displayed.

3. Use the FIELD and VALUE keys to select a SONET Tx Rate and Rx Rate 
as appropriate for your application. The rates do not have to be the same; 
optical and electrical rates can be configured simultaneously.

SONET rates include OC-12, OC-3, and STS-1/OC-1. The rates available 
depend on the options installed in your test set.

Note: For OC-1applications, select STS1/OC1 here, and set Rx> to Optical in step 6. 

For concatenated applications, 
select an STS-Nc payload.

4. Press FIELD to select Payload, and then use VALUE to select a payload 
appropriate for your application.

Example SONET Application

CERJAC
Test Set

Electrical or
Optical

Interface Port

SONET
Network

Far-end
Loop

Í

Í

         TERMINAL TESTING

Tx Rate: OC12           Rx Rate: OC12

Payload: VT1.5 Async

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press MENU-down to enter test mode.
Press MENU-up to return to Main Menu.

TX & RX Selections: OC12, E1, 
OC3, STS1/OC1, DS3, & DS1.

Payload Selections: DS3, DS3/ 
DS1, VT1.5 Async, VT1.5 Byte 
Sync, STS3c, STS12c, 12c/ATM 
& STS1/ATM. 
2–2
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5. Press MENU-down. The SONET test operation screen is displayed.    
Note that the screen below is typical and may appear different depending 
on your application.

6. Use the FIELD and VALUE keys to configure other signal parameters in 
the lower half of the display. These parameters vary depending on the test 
you are running. Some of the key parameters include:

STS1: or STSN: TxClk>: Sets the transmit timing source for the selected 
SONET transmit signal.

You can change the STS-12 
numbering scheme. 
See STS-12 Channel 
Numbering Scheme, 
page 3–4.

STS1 Ins>, Other>, and Drop>: Configures the STS-1s on higher-rate 
SONET signals.

Tx> and Rx>: Selects the connectors and levels for the transmit and receive 
signals.

Note: For OC-1, you selected STS1 for Tx Rate and Rx Rate in step 3. Next set Rx> to 
Optical for an OC-1 receive signal. Transmit OC-1 is available when the lasers 
are enabled (OC-N TX connector).

Note: If your 156MTS has rear-panel SONET electrical connectors installed, set Rx> 
to STS to select them (the rear-panel transmitters are always active).

7. Connect the signals to be tested.

If you are using the optical transmitter, press the TX ON/OFF key to 
enable it (TX ON LED lights).

 1 OC12-OC12(VT1.5A)Elapsed:  00:01:07.66 
OC12 Measurement Summary
B1 (Sect CV):       0  Sec Ago:    --
B2 (Line CV):       0              --
OC12 Rx Hz:   622080444
STS-1 Drop Hz: 51840037 Rx Opt dBm:-0.82

DS1: TxClk>Int  Frm>ESF     Data>QRSS
VT1.5: Ins>1 Oths>Same  Drop>1 Code>B8ZS
VTGrp: Ins>1   Other Grps>Same  Drop>1
STS1:  Ins>1,1 Other STSs>Same   Drop>1,1
STSN: TxClk>Int     Scramble>On   Rx>OC
Err/Alm:Type>DS1 Data   Rate>Single

VT Parameters

SONET Parameters
2–3
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To Configure the APS functions (K1/K2 bytes)

The 156MTS allows you to control the automatic protection switching (APS) 
channel of the SONET signal. The APS channel comprises the K1 and K2 
bytes of the SONET overhead.

1. From a SONET test operation screen, press CONFIG-right to scroll to the 
control screen menu.

2. Use FIELD to select APS Control and press CONFIG-right. The APS 
Control screen is displayed in the bottom half of the display:

The message being transmitted on the APS channel is shown on the right 
side of the APS Control screen. The new, user-editable message is 
displayed on the left side.

3. Use the FIELD and VALUE keys to set the APS channel values. As you 
make changes, the hexadecimal display of the K1 and K2 bytes also 
changes. The five fields of the APS control screen include:

For more information on the 
APS Control parameters, 
see SONET Automatic 
Protection Switching (APS) 
Parameters, page 3–12.
To activate the LFERF and LAIS 
alarms, see SONET Alarm 
Types, page 3–31.

• Message: Selects the text of the APS message.

• Rqst: Sets the request channel.

• Brdg: Sets the bridged channel indicator.

• Architecture: Sets the APS architecture used.

• Mode: Sets the APS mode, except for the LFERF and LAIS alarms

4. When you finish configuring the APS values, press the ACTION key to
activate them. The Current Values side of the APS Control screen chan
to reflect the new K1 and K2 bytes being transmitted.

5. Press CONFIG-right to return to the SONET test operation screen.

     >Press ACTION to update K1,K2<
    New Values     |   Current Values
 K1:00 K2:00 (Hex) |  K1:00 K2:00 (Hex)
 No Request        |  No Request
Rqst>Null Brdg>Null| Rqst:Null Brdg:Null
 1+1 Future (000)  |  1+1  Future (000)
2–4
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To Configure SONET Overhead Parameters

The overhead features provide control of SONET transport and path overhead, 
and SONET path trace configuration.

1. From a SONET test operation screen, press CONFIG-right to scroll the 
lower half of the display to the control screens menu.

2. Use FIELD to select SONET OH Control and press CONFIG-right. The 
SONET Transport Overhead Control screen is displayed:

See Transport Overhead 
Control, page 3–15, for more 
information on setting the 
transport overhead bytes.

3. Use the FIELD and VALUE keys to edit the displayed bytes. Bytes shown 
as “xx” cannot be edited.

4. Press CONFIG-right when you have finished setting the transport 
overhead. The SONET Path Overhead Control screen is displayed:

    SONET Transport Overhead Control
 Program in Hex:        | Use Data Link
                        | Control screen
 A1: xx  A2: xx  J0: xx | for inserting
 B1: xx  E1: 00  F1: 00 | external data.
 D1: 00  D2: 00  D3: 00 |

 H1: xx  H2: xx  H3: xx | H1SS:00(SONET)
 B2: xx  K1: xx  K2: xx | K1/K2: USE APS
 D4: 00  D5: 00  D6: 00 |        SCREEN.
 D7: 00  D8: 00  D9: 00 |
 D10:00  D11:00  D12:00 |
 Z1: 00  Z2: 00  E2: 00 |

      SONET Path Overhead Control

J1: xx ----To Modify, go to the J1 Path  
B3: xx     Trace Control Screen
C2: 14
G1: 00 (DS3 & 3c/12c payload modes only)

F2: 00
H4: 00 (DS3 & 3c/12c payload modes only)
Z3: 00
Z4: 00
Z5: 00
DS3 O-Bits: 000000000000000000
2–5
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For complete information 
on programming the path 
overhead bytes see Path 

Overhead Control, 
page 3–16.

5. Use FIELD and VALUE to edit the displayed path overhead bytes.

6. When you have finished setting the path overhead, press CONFIG-right. 
The J1 Path Trace Control screen is displayed:

For complete information on 
programming the J1 bytes 
see J1 Path Trace and J0 
Section Trace Control, 
page 3–18.

7. Use VALUE to select hexadecimal or ASCII programming.

8. Use FIELD and VALUE to edit each J1 byte in the 64-byte STS Path 
Trace string. As you edit the bytes in either ASCII (left side of the screen) 
or in hexadecimal (right side of the screen), the corresponding value is 
displayed on the other side of the screen.

9. When you have finished, press CONFIG-right.

• If you are testing OC-12, the J0 Section Trace Control screen is displayed. 
You can edit the values on this screen as you did the J1 Path Trace in 
step 8.

10. When you have finished, press CONFIG-right. The display returns to the 
SONET test operation screen.

         J1 Path Trace Control
  Reselt in:   ASCII     Format : 64-byte     
 Program in: Hex  Fill on Action: Hex 

 ARB-----    41 52 42 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00

 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
2–6
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To Configure SONET Datalinks

You can configure the routing of SONET datalinks to the rear-panel datalink 
ports.

1. From a SONET test operation screen, press CONFIG-right to scroll to the 
control screens menu.

2. Use FIELD to select Data Link Control and press CONFIG-right. The 
Data Link Control screen is displayed:

The items listed on the screen vary depending on the configuration of your 
test set and the operating mode.

3. Use the FIELD and VALUE keys to select and change the datalink 
options.

See SONET Datalink 

Control Parameters, 
page 3–20, for datalink 
information.

Note that selecting a datalink insert or pass-through mode overrides the 
programming on the SONET overhead controls screens (see To Configure 
SONET Overhead Parameters, page 2–5).

4. Press CONFIG-right when you have finished to scroll back to the test 
operation display.

            Data Link Control

RS232>None
RS422>None
Handset>None
DCC Pass-Thru>Off

OC-12 APS Pass-Thru>Off

----------------------------------------
Selection of data link insert or pass-
thru above overrides programmed byte
values.
2–7



Testing SONET Networks

To Inject SONET Alarms

SO
N

E
T the 

the 
To Inject SONET Alarms

You can inject SONET alarms when the transmit signal is set for a SONET 
rate.

Note: You can also insert errors on the SONET signal by selecting an appropriate 
error type and rate. See SONET Error Injection Types, page 3–30.

1. From a SONET test operation screen, press CONFIG-right to display 
control screens menu.

2. Use FIELD to select Alarm Control and press CONFIG-right. The Set 
SONET Alarm Conditions screen is displayed in the lower half of the 
display:

3. Use FIELD to select the SONET alarm you want. Press VALUE to set 
alarm Off or On. The alarm remains active until reset to Off.

See STS-N Alarm Screens, 
page –26, for information 
on SONET alarms.

4. Use the RESULT keys to scroll through the measurement screens and 
observe the effect of the SONET alarms you inject.

In loop tests, the red front panel alarm indicators on the instrument light to 
indicate the presence of the received alarm. When the alarm is cleared, the 
amber history indicators light.

5. To clear the history indicators, press RESET HIST.

6. Press CONFIG-right to return to the test operation display.

      >Set SONET Alarm Conditions<
          LOS>Off      AIS-P(PAIS)>Off
          LOF>Off      RDI-P(PYEL)>Off
  AIS-L(LAIS)>Off      AIS-V(PAIS)>Off
 RDI-L(LFERF)>Off      RDI-V(PYEL)>Off
LOP-P(LOPNTR)>Off    LOP-V(LOPNTR)>Off
2–8
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To Run Pointer Adjustment Sequences

You can run automated H1/H2 pointer justification sequences to increment 
and decrement the pointer value, or cause a new data flag (NDF) condition.

1. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans and 
Pointer Sequences.

2. Press MENU-down. The Test Sequences Menu menu is displayed, similar 
to the following:

3. Use FIELD to select the H1/H2 pointer sequence you want to run.

Í

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/    Scans & Pointer Sequences
Setup System Parameters
Store and Recall Configurations

----------------------------------------
Press FIELD to highlight item, then
Press MENU-down to select item.

Í
Í
Í

          TEST SEQUENCES

HPointer Increment
HPointer Decrement
HPointer New Data Flag (NDF)

DS1 Drop Scan
Signaling Scan
2–9
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4. Press MENU-down. The display shows the appropriate sequence 
operation screen.

5. Use VALUE to select an Increment/Decrement Rate.

6. Press FIELD and select a Configuration From setting (background test 
mode), if desired.

7. Next select a channel to be dropped from the SONET signal using the 
Drop Channel> field. This field is only valid for OC-12 and OC-3 tests.

8. Press START to begin the test.

• During the test press ACTION to control the pointer justification.

Í  1 H Pntr Increment Elapsed:  00:00:00.00 
STS Frame Measurements (A1/A2)
Severely Err Frm Sec:      81     
      Continuous EFS:      -0         
                %EFS:    0.00
Pointer Value:       0    %EFS:   --

Increment Rate> Single
Configurations From> OC12-OC12 (DS3)
STS-1/3c Drop Channel> 1
----------------------------------------
Press the ACTION button to
control pointer adjustments.
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To Run a VT1.5 Test

Set the VT 
Counting Mode

1. From the Main Menu press FIELD to select Setup and press 
MENU-down. The Setup menu is displayed.

VTs can either be identified 
individually (from 1 through 
28), or identified by their VT 
group and their position within 
that group (1 through 7 
VT groups, 1 through 4 VTs in 
each group). For example, 
VT 18 corresponds to VT 3 of 
VT group 4

2. Select Global Test Setups from the Setup menu and press MENU-down. 
The Global Test Setups screen is displayed.

3. Press FIELD to select VT Counting Mode and use VALUE to select 
either VT Group or 1 to 28.

Example VT1.5 Application

CERJAC
Test Set

STS-1

VT
Group

VT1.5
VT1.5
VT1.5
VT1.5

DS1
SONET

Network

VT
Group

VT
Group

VT
Group

VT
Group

VT
Group

VT
Group

Auxiliary Test Setups
Test Dur. Mode:   Continuous
Timer Duration:   00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Sub Menu Opt Pwr: Off   Auto Tst: Stop

Í

Pwr Up Optical Tx State:  Last State
STS12 # Scheme:   STS3#, STS1#
VT Counting: VT Group   DS2 Tx-XBit: 0
DS1 Block Size:   2Kbit
DS1 LOP & OOF Hold-off: 0.0 Seconds
Bits Clk Out Derived from: STS-N Rx Clk
2–11



Testing SONET Networks

To Run a VT1.5 Test

SO
N

E
T

 

is 

e 
Set Tx Rate, 
Rx Rate, and 
Payload

The VT1.5 testing features are available whenever Payload is set to 
VT1.5 Async or VT1.5 Byte Sync (the transmitter and receiver must each be 
set for a SONET rate—STS-1, OC-3, or OC-12).

1. From the Main Menu press FIELD to select either Terminal or Monitor
testing mode.

2. Press MENU-down. The test setup screen for the mode you selected 
displayed (this example shows Terminal testing mode).

3. Use VALUE to set the transmitter (Tx Rate) for a SONET rate. For 
Monitor mode the transmitter and receiver are set simultaneously 
(Tx/Rx Rate).

4. Press the right FIELD key and the use VALUE to set the receiver 
(Rx Rate) for a SONET rate. For OC-12, the rate must match the 
transmitter.

5. Next press the right FIELD key again to select the Payload parameter. 
Use VALUE to select VT1.5 Async or VT1.5 Byte Sync.

6. Press MENU-down. The VT1.5 test operation screen is displayed (se
next section).

Í

         TERMINAL TESTING

Tx Rate: OC3           Rx Rate: OC3

Payload: VT1.5 Async

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press ENTER to enter test mode.
Press MENU to return to Main Menu.
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Configure the DS1 
Signal

• When you press MENU-down from the testing mode setup screen, the 
VT1.5 test operation screen is displayed. Note that the screen may appear 
differently depending on the test mode you selected.

Note: For Monitor mode tests, the transmit functions are not available (transmit 
clock, insert channel, etc).

1. Use VALUE to set the DS1 test channel’s timing source.

2. Press the right FIELD key to select Frm and then use VALUE to set the 
DS1 test channel’s framing format.

3. Press FIELD again to select Data and then use VALUE to set the payload
pattern for the DS1 signal.

If you set Data> to DS0, you can insert and drop DS0 channels on the 
DS1. To configure the DS0 parameters, seeConfigure the DS0 Signal, 
page 10–8.

• Next configure the VT1.5 and VT group parameters (see next section).

 1 OC3-OC3 (VT1.5A) Final:  00:00:00.00 
OC3 Measurement Summary
B1 (Sect CV):    --    Sec Ago:    --
B2 (Line CV):    --                --
OC3 Rx Hz:       --
STS-1 Drop Hz:   --

Í DS1: TxClk>Int  Frm>SF     Data>QRSS
VT1.5: Ins>1  Other VT’s>Same     Drop>1
VTGrp: Ins>1  Other Grp’s>Same    Drop>1
STS1:  Ins>1  Other STS’s>Same    Drop>1
STSN:  TxClk>Int      Scramble>On  Rx>OC 
Err/Alm:Type>DS1 Data    Rate>Single
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Configure the 
VT1.5 Signal and 
VT Group

1. On the VT1.5 test operation screen, use FIELD and VALUE to set the 
VT1.5 signal and VT group mapping parameters.

Note: For Monitor mode tests, the transmit functions are not available (insert 
channel, other, etc).

2. Select the VT1.5: Ins> field and use VALUE to select the VT1.5s on 
which the DS1 test signal is to be inserted. See Insert VT Selection, 
page 3–25.

3. Select Other VT’s  to set the remaining VT1.5s. See Other Transmit VT 
Groups, page 3–28

4. Select Drop and use VALUE to set the VT1.5 to be dropped from the 
selected VT group on the receive signal.

5. Next use FIELD and VALUE to set the Ins, Other Grp’s , and Drop 
fields for the VT groups (if applicable). Ins and Other set the VT group 
on which the VT1.5 signal is inserted and dropped, as you selected in 
steps 2 through 4.

Configure the 
STS-1 and STS-N 
Signals

After you configure the VT1.5 and VT group parameters, you need to 
configure the SONET signal parameters.

Depending on your test configuration, you will need to set the STS-1 or 
STS-N timing source, scrambling, and input/output connectors. For STS-N 
applications, you must also set the STS-1 drop and insert mapping.

• To configure the SONET signals, see step 6, page 2–3.

 1 OC3-OC3 (VT1.5A) Final:  00:00:00.00 
OC3 Measurement Summary
B1 (Sect CV):    --    Sec Ago:    --
B2 (Line CV):    --                --
OC3 Rx Hz:       --
STS-1 Drop Hz:   --

Í
Í

DS1: TxClk>Int  Frm>SF     Data>QRSS
VT1.5: Ins>1  Other VT’s>Same     Drop>1
VTGrp: Ins>1  Other Grp’s>Same    Drop>1
STS1:  Ins>1  Other STS’s>Same    Drop>1
STSN:  TxClk>Int      Scramble>On  Rx>OC 
Err/Alm:Type>DS1 Data    Rate>Single
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lts 
Run the VT1.5 Test • After you have configured the VT1.5, STS-1, and STS-N parameters you 
are ready to begin the test.

1. Press START to begin testing. On the first line of the display the elapsed 
time begins to increment.

2. If you want to inject errors on the DS1 signal being inserted on the 
transmit VT1.5, use FIELD and VALUE to set the appropriate Err/Alm 
Type and Rate. Press ERROR INJECTION to activate and deactivate 
error injection.

For information on VT 
measurements, Chapter 4, 
SONET Measurement 
Reference pages –29 through 
–36.

3. Observe the Trouble Scan display for any detected errors. See To Use 

Trouble Scan, page 1–7

You can also use the RESULT keys to view different measurement 
screens in the top half of the display. You may need to adjust the resu
level to view more measurements (see To Display More Measurement 

Screens, page 1–11).

4. To end the test, press STOP.
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Optical Transmitter Power-up State
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Optical Transmitter Power-up State

You can set whether the optical transmitter (OC-N TX) is on or off when 
the unit is switched on.

Warning! The optical transmitter installed in the 156MTS contains a Class 1 Laser 
Product. Avoid visual contact with the transmitter.

Access the Auxiliary Test Setups screen from the Setup System 
Parameters screen.

The Pwr Up Optical Tx State parameter can be set as follows:

Last State: The test set repowers with the optical transmitter in the 
same state as when the unit was switched off.

On: The test set repowers with the optical transmitter active.

Off: The test set repowers with the optical transmitter off.

Note: Press the OC-N TX ON/OFF key to enable or disable the optical transmitter at 
any time.

Í

Auxiliary Test Setups
Test Dur. Mode:     Continuous
Timer Duration:     00:01:00 (hh:mm:ss)
Auto. Print Mode:   Off
Auto. Store Mode:   Off
Pwr Up Optical Tx State:  Last State
STS12 # Scheme:     STS3#, STS1#
VT Counting Mode:   VT Group
DS2 Tx-XBit:        0
DS1 Block Size:     2Kbit
DS1 LOP & OOF Hold0off: 0.0 Seconds
Bits Clk Out Derived from: STS-N Rx Clk
3–2
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STS-N Setup Parameters

STS-N parameters are applicable when the test configuration involves a 
signal with a rate higher than STS-1. A typical STS-N setup screen 
appears similar to the following:

STS-N Transmit 
Timing Source

TxClk> selects the STS-N transmit timing source. The timing source 
for the STS-N signal is independent from the asynchronous signals that 
are mapped into the payload. TxClk> can be set to one of the following:

Int: Timing is from the 156MTS’s internal Stratum-3 clock.

Loop: Timing is extracted from the receive SONET signal.

Ext BITS: Timing is based on the signal applied at the rear-panel BITS 
connector.

Ext 52M: Timing is based on the signal applied at the rear-panel 
STS1 TX CLK IN connector. This choice is not applicable for OC-12 
unless the payload is set to an STS-12c or STS-3c selection.

Receive Signal 
Source

Rx> selects the input source for the receive SONET signal. This field is 
only displayed if your set has a rear-panel SONET electrical connector 
option (US2 or 205). Rx> can be set to one of the following:

OC: Signal is received at the optical input port (OC-N RX).

STS: Signal is received at the electrical input port (rear-panel ECL RX).

Note that the rear-panel transmit connection is always active.

Í

DS3:     Frm>M13       Data>2^15-1
       TxClk>Int       FEBE>111  XBit>1
STS1:    Ins>1,1      Other>Same
        Drop>1,1
STSN:  TxClk>Int     Scramble>On  Rx>OC
Err:    Type>DS3 Data    Rate>Single
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STS-12 Channel 
Numbering 
Scheme

STS12 # Scheme selects how STS-1 channel numbers are displayed for 
STS-12. This parameter is on the Auxiliary Test Setups screen (accessed 
from the Setup System Parameters menu) and can be set as follows:

STS3#, STS1#: This is the default value. The STS-1s are identified by 
their position in one of the four STS-3s on the STS-12.

This feature is only applicable 
if you test set has 
OC-12/STS-12 testing 
capability installed.

Order of Transmission: STS-1s are identified by their place in the 
STS-12 transmission sequence.

Order at Mux Input: STS-1s are identified by their place in the 
sequence before multiplexing.

The setting you select is used in the STSN: Ins>, Drop>, or D&I> 
fields in OC-12/STS-12 testing modes. For “order of transmission” and 
“order at mux input” modes, these fields can be set from 1 through 12. 
For “STS3#, STS1#” mode these fields can be set from 1,1 through 4,3.

The following table and the figure below show the correspondence 
between the different schemes.

STS3#,STS1# Notation: 1,1 2,1 3,1 4,1 1,2 2,2 3,2 4,2 1,3 2,3 3,3 4,3

Order of Transmission: 1 2 3 4 5 6 7 8 9 10 11 12

Order at Mux Input: 1 4 7 10 2 5 8 11 3 6 9 12

1,1

1,2

1,3

1,11,21,3

STS-1s

STS-3 #1

2,1

2,2

2,3

2,12,22,3

3,1

3,2

3,3

3,13,23,3

4,1

4,2

4,3

4,14,24,3

2,33,34,3

STS-12

3,24,21,3 4,11,22,2 1,12,13,1

(12)

(11)

(10)

(9)

(8)

(7)

(6)

(5)

(4)

(3)

(2)

(1)

(12) (9) (6) (3) (11) (8) (5) (2) (10) (7) (4) (1)

123456789101112
Order of Transmission

Order at Mux Input

STS-3 #2

STS-3 #3

STS-3 #4

3:1

3:1

3:1

3:1

4:1

Order at Mux Input
STS-1

Number
Order of

Transmission
Order at

Mux Input
3,2 7 (8)= =
3–4
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STS-1/OC-1 Signal Setup Parameters

STS-1 signal parameters are applicable when the STS-1 involved in the 
test is not a subrate channel in a higher-rate (STS-N) signal. When STS-1 
is the highest-level signal involved in the test, the STS-1 setup 
parameters appear on the screen similar to the following:

Note: For OC-1 applications, select STS1/OC1 for the transmitter and receiver. The 
OC-N TX connector provides an OC-1 signal in parallel with the STS-1 TX 
signal. Set Rx> to Optical to use the OC-N RX connector for an input OC-1 
signal. The test mode label on the first line of the display indicates STS1 for 
both electrical and optical tests.

STS-1 Transmit 
Timing Source

TxClk> selects the STS-1 and OC-1 transmit timing source. The timing 
source is independent from the asynchronous signals that are mapped 
into the payload. TxClk> can be set to one of the following:

Int: Timing is from the 156MTS’s internal Stratum 3 clock.

Loop: Timing is extracted from the receive SONET signal.

Ext BITS: Timing is based on the signal applied at the rear-panel BITS 
connector.

Ext 52M: Timing is based on the signal applied at the rear-panel 
STS1 TX CLK IN connector.

STS-1 Scrambler Scramble> turns the STS-1 scrambler On or Off at the front-panel 
STS-1 RX and TX connectors and the OC-N RX and TX connectors. The 
scrambler is frame-synchronous with a length of 127. Scrambling 
provides for clock extraction during extended transmission of all-zeros 
or all-ones.

Í
Í

DS3:   Frm>M13       Data>2^15-1
       TxClk>Int     FEBE>111    XBit>1
STS1:  TxClk>Int        Scramble>On
       Tx>STSX1         Rx>STSX1
Err:   Type>DS3 Data    Rate>Single
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Transmit STS-1 
Level

Tx> selects the STS-1 transmit signal level. STS1:Tx> can be set to one 
of the following:

STSX1: STSX-1 level signal. LBO of 450 feet simulated cable.

High: High-level signal. No LBO. Nominal 1.01 Vpk input signal.

Low: Low-level signal. Flat loss from High level. Nominal 0.206 Vpk 
input signal.

900’: LBO added simulating 900 feet of cable.

Note: The level of the OC-1 signal present at the OC-N TX connector depends on the 
laser installed in your test set.

Receive STS-1 
Level

Rx> selects the input source and level for the receive STS-1 (or OC-N) 
signal. STS1:Rx> can be set to one of the following:

STSX1: STS-1 signal is received at the front-panel electrical input port 
(STS-1 RX). Automatic equalizer for 0 through 900 feet of cable.

High: STS-1 signal is received at STS-1 RX. Nominal 1.01 Vpk input 
signal.

Low: STS-1 signal is received at STS-1 RX. Nominal 0.206 Vpk input 
signal.

Monitor: STS-1 signal is received at STS-1 RX. Up to 26 dB flat loss 
from an STSX-1 signal.

Aux: STS-1 signal is received at the rear-panel STS-1 NRZ input.

Optical: OC-N signal is received at the optical input port (OC-N RX).

STS-1 Jitter 
Thresholds

For information on setting the jitter hits thresholds, see Jitter 

Threshold Configuration, page 23–3.
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STS-1 Payload Setup Parameters

STS-1 payload parameters are applicable when the tested STS-1 is a 
subrate channel mapped into a higher-rate (STS-N) signal. The STS-1 
payload setup parameters appears on the screen similar to the 
following:

Insert STS-1 
Channel

Ins> selects which STS-1 within an OC-3 or OC-12 signal is used for the 
transmit STS-1. For OC-3, Ins> can be set from 1 through 3. For OC-12, 
Ins> can be set from 1,1 through 4,3 or from 1 through 12 (you can 
change the STS-1 scheme numbering used for STS-12; see STS-12 

Channel Numbering Scheme, page 3–4).

Other STS-1 
Channels

Other> sets the payload for the remaining STS-1s (that are not selected 
by Ins>) within the OC-3 or OC-12 transmit signal. Other> can be set as 
follows:

Same: Fills the STS-1s with the same payload as the selected Ins> 
STS-1.

Unequ: Sets the remaining STS-1s to unequipped (all zeros in the path 
overhead and payload).

Ext: Fills the remaining STS-1s with the STS-1 signal applied at the 
front-panel STS-1 RX port (not applicable for OC-12).

Drop STS-1 
Channel

Drop> selects which STS-1 within an OC-3 or OC-12 signal is used for 
the receive STS-1. For OC-3, Drop> can be set from 1 through 3. For 
OC-12, Drop> can be set from 1,1 through 4,3 or from 1 through 12 
(you can change the STS-1 scheme numbering used for STS-12; 
see STS-12 Channel Numbering Scheme, page 3–4).

Í
Í

DS3:    Frm>M13       Data>2^15-1
        TxClk>Int     FEBE>111  XBit>1
STS1:   Ins>1,1       Other>Same
        Drop>1,1      Scramble>on
STSN:   TxClk>Int        Rx>OC
Err:    Type>DS3 Data    Rate>Single
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STS-1 Signal 
Scrambler

Scramble>: Turns the STS-1 scrambler On or Off at the front-panel 
STS-1 RX and TX connectors. The scrambler is frame-synchronous with 
a length of 127. Scrambling provides for clock extraction during 
extended transmission of all-zeros or all-ones.

STS-1 Drop & 
Insert Channel

This parameter is only available for drop and insert mode (D&I) tests. 
The D&I> field simultaneously sets the STS-1 insert and drop channels 
to the same number. For OC-3 D&I tests, D&I> can be set from 1 
through 3. For OC-12 tests, D&I> can be set from 1,1 through 4,3 or 
from 1 through 12 (you can change the STS-1 scheme numbering used 
for STS-12; see STS-12 Channel Numbering Scheme, page 3–4).

STS-1 Drop & 
Insert Payload

This parameter is only available for drop and insert tests in which the 
payload is set for STS-1. Data> selects the payload pattern of the 
transmit STS-1 channel, and can be set to one of the following:

Ext: Uses the payload of an STS-1 signal applied at the front-panel 
STS-1 RX jack.

Unequ: Sets the path overhead and payload to all-zeros.

Loop: Retransmits the recieved data on the transmit channel.
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STS-Nc Payload Setup Parameters

The 156MTS can supports SONET concatenated signals at STS-12c and 
STS-3c:

In an STS-12c signal, 12 
STS-1s are linked together to 
provide a higher-capacity SPE.

• STS-12c parameters are available when the transmitter and 
receiver are set for OC-12 and the payload is set for STS12c. The 
STS-12c setup screen appears similar to the following:

In an STS-3c signal, three 
STS-1s are linked together to 
provide a higher-capacity SPE.

• STS-3c setup parameters are applicable whenever the Payload is 
set to STS3C in an OC-3 or OC-12 testing mode (requires 
Option URY). The STS-3C setup screen appears similar to the 
following:

Payload The Data> field sets the payload data pattern for the concatenated 
signal. This field can be set as follows:

PRBSs: A pseudorandom bit sequence. Choices include 2^15–1, 
2^20–1, 2^23–1, and 2^31–1 (2^15–1 indicates a 215–1 PRBS; 2^31–1 
available for STS-12c only).

Prog32: A repeating, user-programmable, 32-bit pattern. The bit values 
are defined by the Prog32> field (see below).

All Ones: A repeating, all binary ones pattern.

Live: No pattern. The receiver does not try to synchronize to a pattern. 
The transmitter sends the last selected pattern.

Í STS12c: Data>2^15-1   Prog32>12345678

STSN:  TxClk>Int
Err:    Type>STS12c Data Rate>Single

Í
Í

STS3c:  Data>2^15-1
         Ins>1       Other>Same
STSN:  TxClk>Int        Rx>OC
Err:    Type>DS3 Data    Rate>Single
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Programmable 
Pattern

(STS-12c only) The Prog32> field defines the user-programmable 
STS-12c pattern. This pattern is transmitted when the Data> field is set 
to Prog32 (see above). Each digit in the Prog32 value can be set from 0 
through F (hexadecimal). The resulting value is converted to binary to 
form the 32-bit user pattern.

Insert STS-3c 
Channel

(STS-3c/OC-12 Tx only) Ins> selects which STS-3c channel within the 
OC-12 signal is used for the transmit STS-3c. Ins> can be set from 
1 through 4.

Other STS-3c 
Channels

(STS-3c/OC-12 Tx only) Other> sets the payload for the remaining 
STS-3c channels (that are not selected by Ins>) within the OC-12 
transmit signal. See map settings on page 3-11.  Other> can be set as 
follows:

Same: Fills the STS-3c channels with the same payload as the selected 
Ins> STS-3c.

Unequ: Sets the remaining STS-3c channels to unequipped (all zeros in 
the path overhead and payload).

Drop STS-3c 
Channel

(STS-3c/OC-12 Rx only) Drop> selects which STS-3c within the 
OC-12 signal is used for the receive STS-3c. Drop> can be set from 
1 through 4.

STS-3c Drop & 
Insert Channel

This parameter is available only for drop and insert mode tests (STS-3c 
D&I tests are available only on OC-12 signals). The D&I> field 
simultaneously sets the STS-3c insert and drop channels to the same 
number. D&I> can be set from 1 through 4.
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Map Settings

 Use Cursor Keys to make Selection. Press SET to accept settings.
STS-n SPE Layer
Selection

OC-1/STS-1 STS-1 SPE

VT1.5

VT2

VTgrp VT6

STS-3c SPE

STS-48c SPE BULK FILLEDOC-n/STS-n

STS-12C SPE BULK FILLED

BULK FILLED

140Mb/s NOT 
SUPPORTED

DS3

34Mb/s NOT 
SUPPORTED

BULK FILLED NOT 
SUPPORTED

BULK FILLED NOT 
SUPPORTED

2Mb/s ASYNC NOT 
SUPPORTED

2Mb/s Float NOT 
SUPPORTED

BULK FILLED NOT 
SUPPORTED

DS1 ASYNC

DS1 FLOAT

BULK FILLED NOT 
SUPPORTED

NOT 
SUPPORTED

NOT 
SUPPORTED
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SONET Automatic Protection Switching 
(APS) Parameters

The 156MTS can transmit messages on the automatic protection 
switching channel (APS—K1 and K2 bytes). The APS parameters are 
accessed by selecting APS Control from the Additional Test Controls 
menu.

APS Message The first field selects the APS message to be transmitted. The text of 
each message is displayed with its corresponding bit sequence (bits 1–4 
of K1). The available messages are listed in the following table.

     >Press ACTION to update K1,K2<
    New Values     |   Current Values
 K1:00 K2:00 (Hex) |  K1:00 K2:00 (Hex)
 No Request        |  No Request
Rqst>Null Brdg>Null| Rqst:Null Brdg:Null
 1+1 Future (000)  |  1+1  Future (000)

APS Messages

APS Message K1 Byte Display (hex) Bit Sequence

No Request 0x 0000

Do Not Revert 1x 0001

Reverse Request 2x 0010

Not Used 3x 0011

Exercise 4x 0110

Not Used 5x 0101

Wait-to-Restore 6x 0110

Not Used 7x 0111

Manual Switch 8x 1000

Not Used 9x 1001

SD-Low Priority Ax 1010
3–12



SONET Configuration Reference

SONET Automatic Protection Switching (APS) Parameters

SO
N

ET
Requested 
Channel

Rqst> determines the requested channel to which the message applies. 
The binary value of the channel number (0–15 = 0000–1111) is sent in 
bits 5–8 of K1. This is shown on the display in hex (the second digit 
of K1).

Bridge Channel Brdg> determines the bridge channel. The binary equivalent of the 
channel number (0–15 = 0000–1111) is transmitted in bits 1–4 of K2. 
This value is shown on the display in hexadecimal (the first digit of K2).

Architecture The fourth field indicates the APS architecture, and corresponds to bit 5 
of the K2 byte. For 1+1 bit 5 is set to 0; for 1:n bits 5 is set to 1.

APS mode The fifth field indicates the APS mode. This field can be set as follows:

Unidirection: Bit sequence = 100 (Bits 6–8 of K2).

Bidirection: Bit sequence = 101.

Future: Bit sequences = 000 through 011.

LFERF Alarm: Bit sequence = 110.

LAIS Alarm: Bit sequence = 111.

Note: LFERF and LAIS cannot be set from this screen, but will be displayed if 
received. To transmit SONET alarms, see SONET Alarm Types, page 3–31.

SD-High Priority Bx 1011

SF-Low Priority Cx 1100

SF-High Priority Dx 1101

Forced Switch Ex 1110

Lockout Protect Fx 1111

APS Messages, continued

APS Message K1 Byte Display (hex) Bit Sequence
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SONET Overhead Parameters

For more information on 
SONET overhead, see SONET 
Formats, page 5–8.

The 156MTS provides extensive control of SONET transport and path 
overhead configuration, and SONET path trace configuration.

SONET overhead control is accessed through the Control Screens 
menu. These parameters are available when the instrument is 
configured for SONET rates.

When you select SONET OH Control from the Control Screens menu 
and press CONFIG-right, a series of screens is presented. These screens 
give you access to the following SONET overhead parameters:

• Transport overhead bytes.

• Path overhead bytes.

• J1 Path trace string.

• J0 Section trace string (for OC-12 only).

Two additional screens provide access to VT overhead parameters 
(see VT Overhead Parameters, page 3–22).

Í

  Global Settings  |  DS1/E1 Patterns
  Alarm Control    |  DS1 Loop Codes
  APS Control      |  
  SONET OH Control    
  Data Link Control|     
  DS0/TS Settings  |
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Transport 
Overhead Control

The SONET Transport Overhead Control screen allows you to program 
the values for the transport overhead bytes. Bytes shown as xx cannot 
be edited on this screen. 

Note:  For STS-12c, the C1: xx byte is replaced by J0: xx. You can edit the J0 Section 
Trace string using the Section Trace Control screen (see page 3–18).

Transport Overhead Bytes: Each byte value can be set in 
hexadecimal from 00 through FF.

    SONET Transport Overhead Control
 Program in Hex:        | Use Data Link
                        | Control screen
 A1: xx  A2: xx  C1: xx | for inserting
 B1: xx  E1: 00  F1: 00 | external data.
 D1: 00  D2: 00  D3: 00 |

 H1: xx  H2: xx  H3: xx | H1SS:00(SONET)
 B2: xx  K1: xx  K2: xx | K1/K2: USE APS
 D4: 00  D5: 00  D6: 00 |        SCREEN.
 D7: 00  D8: 00  D9: 00 |
 D10:00  D11:00  D12:00 |
 Z1: 00  Z2: 00  E2: 00 |

User-programmable SONET Transport Overhead Bytes

Byte Description

E1 Section orderwire

F1 Section user channel

D1, D2, D3 Section data communication channel

H1 .Bit 5 - SDH Detect .  See H1SS, page 3.-16.

K1, K2 APS channel. See APS Message, page 3–12

D4–D12 Line data communication channel

Z1 S1 (STS-1 #1): Synchronization status.
Z1 (other STS-1s): Growth.

Z2 M0 (STS-1/OC-1 signals only): bits 5–8 = line FEBE
M1 (STS-1 #3 of STS-N≥3 signals): Line FEBE
Z2 (other STS-1s): Growth
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H1SS: This field sets bit 5 to 1 of the H1 byte when SDH is detected. 
Operator (option) can set to 0. (SDH) Synchronous Digital Hierarchy 
Signal (622 & 155 Mb/s rates) not supported by test set.

Path Overhead 
Control

The SONET Path Overhead Control screen allows you to program the 
path overhead bytes. Bytes shown as xx cannot be edited on this 
screen.

Path Overhead Bytes: Each byte value can be set in hexadecimal 
from 00 through FF.

E2 Line orderwire

User-programmable SONET Transport Overhead Bytes, continued

Byte Description

      SONET Path Overhead Control

J1: xx ----To modify, go to the J1 Path
B3: xx     Trace Control Screen
C2: 14
G1: 00 (DS3 & 3c/12c payload modes only)

F2: 00
H4: 00 (DS3 & 3c/12c payload modes only)
Z3: 00
Z4: 00
Z5: 00
DS3 O-Bits: 000000000000000000

User-programmable SONET Path Overhead Bytes

Byte Description

C2 STS path signal label

G1 Path status (programmable in DS3 and STS-3c payload modes 
only)

F2 Path user channel

H4 VT multiframe phase indicator (DS3 and STS-3c payloads only)

Z3, Z4 Growth
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DS3 O-Bits: This field allows you to edit the 18 DS3 overhead 
communication channel bits (O-Bits). The O-Bits comprise two bits 
from each of the nine subframes in an asynchronous mapping of a DS3 
into an STS-1. Each O-Bit can be set to 1 or 0.

Fill Action 
Reference

The table below lists the fill action selections which is 
reference for the J1 Path Trace,  J0 Section Trace Control, 
and J2 Path control screens. 

Z5 Tandem connection error count and datalink

User-programmable SONET Path Overhead Bytes

Byte Description

 
  
  Fill on
 Action

Format - for Fill on Action (inject button) Selections

1-Byte 16-Byte 64-Byte

NULL 0x00 in all bytes. 0x00 in all bytes. 0x00 in all bytes. 

HEX 0x01 in all bytes. 0x41 – 0x4F with CRC7, 
copied 4 times. 

0x41 to 0x7F (ASCII A to DEL), followed by a 
carriage return (0x0D) & line feed (0x0A). 

ASCII 0x41 in all bytes. “nnnnnn” serial number 
with CRC7, copied 4 
times. 

“Agilent Technologies 156MTS Test Set 
Serial No. nnnnnn” followed by carriage 
return (0x0D) and line feed (0x0A). 

USER First byte copied 
to all 64 bytes. 

Calculate and insert CRC7 
of first 16 bytes; copy first 
16 bytes 4 times. 

No action.
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J1 Path Trace and 
J0 Section Trace 
Control

The J1 Path Trace Control screen and the OC-12 J0 Section Trace 
Control screen allow you to program each byte of the 64-byte STS Path 
Trace string and STS Section Trace string, repectively. Each byte of the 
string is transmitted in the J1 or J0 byte of 64 consecutive frames.

The J0 screen is available for 
OC-12 only. Older units may 
not support this feature.

The Format field setting defines the byte size for 1-byte, 16-byte, or 
64-byte by steping through the selections using the Value switch. 

This screen shows the J1 Path Trace Control screen. The J0 control 
screen is similar. See page 3-17 for fill action selection table 
reference.

The J1/J0 bytes are transmitted left-to-right, top-to-bottom as shown on 
the display.

Each J1/J0 byte is shown twice on the display. On the right, the 
two-digit hexadecimal value of the byte is displayed. On the left, the 
ASCII equivalent of the byte’s value is shown in a corresponding 
character position.

Program in: Selects the mode in which you enter J1/J0 byte values:

• Hex: The cursor moves only in the hexadecimal display (right 
side of screen). Each of the 64 bytes can be set from 00h 
through FFh.

• ASCII: The cursor moves only in the ASCII display (left side of 
the screen). Each byte can be set from A through Z, to a blank, or 
to a dash.

Note: Note that additional ASCII characters are available by programming the 
corresponding value on the hexadecimal side of the display (see table on next 
page).

         J1 Path Trace Control
Results in: ASCII       Format:64-byte
Program in: Hex    Till on ACTION: Hex

 ARB-----    41 52 42 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00

 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
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Displayed ASCII characters and their Hexadecimal equivalents

Hex ASCII Hex ASCII Hex ASCII Hex ASCII Hex ASCII

20 blank 33 3 46 F 59 Y 6C l

21 ! 34 4 47 G 5A Z 6D m

22 “ 35 5 48 H 5B [ 6E n

23 # 36 6 49 I 5C \ 6F o

24 $ 37 7 4A J 5D ] 70 p

25 % 38 8 4B K 5E ^ 71 q

26 & 39 9 4C L 5F _ 72 r

27 ‘ 3A : 4D M 60 ‘ 73 s

28 ( 3B ; 4E N 61 a 74 t

29 ) 3C < 4F O 62 b 75 u

2A * 3D = 50 P 63 c 76 v

2B + 3E > 51 Q 64 d 77 w

2C , 3F ? 52 R 65 e 78 x

2D - 40 @ 53 S 66 f 79 y

2E . 41 A 54 T 67 g 7A z

2F / 42 B 55 U 68 h 7B {

30 0 43 C 56 V 69 i 7C |

31 1 44 D 57 W 6A j 7D }

32 2 45 E 58 X 6B k 7E ~
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SONET Datalink Control Parameters

Selecting Data Link Control 
from the Control Screens menu 
displays the Data Link Control 
screen.

The Data Link Control screen configures the functionality of the 
rear-panel data link ports.

Note: For information on other data link rate uses, see DS3 Datalink Parameters, 
page 7–15 or DS1 Data Link Parameters, page 11–16.

Rear-Panel RS-232 
Data Link Port

RS232> configures the rear-panel DATA-LINK RS-232 interface in both 
the transmit and receive directions. The choices are as follows:

None: The RS-232 data link interface is disabled.

Section User Channel (F1): The transmitted data on the Section 
user channel (F1 bytes) is derived from input at the rear-panel RS-232 
data link port. Received F1 data is transmitted on the port’s output.

Section Order Wire (E1): The transmit data on the Section order- 
wire channel (E1 bytes) is derived from input at the rear-panel RS-232 
data link port. Received E1 data is transmitted on the port’s output.

Line Order Wire (E2): The transmitted data on the Line orderwire 
channel (E2 bytes) is derived from input at the rear-panel RS-232 data 
link port. Received E2 data is transmitted on the port’s output.

Note: The Line and Section choices can be overwritten by the Handset> setting 
(see Rear-Panel Handset Interface, page 3–21).

            Data Link Control

RS232>None
RS422>None
Handset>None
DCC Pass-Thru>Off

OC-12 APS Pass-Thru>Off

----------------------------------------
Selection of data link insert or pass-
thru above overrides programmed byte
values.
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Rear-Panel RS-422 
Data Link Port

RS422> configures the operation of the rear-panel DATA-LINK RS-422 
interface port in both the transmit and receive directions. The available 
choices are as follows:

None: The RS-422 data link port is disabled.

Section DCC (D1-D3): Section data communication channel (D1, D2, 
and D3 bytes) transmit data is derived from input at the RS-422 data link 
port. Received data is transmitted on the port’s output.

Line DCC (D4-D12): The transmitted data on the Line data 
communication channel (D4–D12 bytes) is derived from input at the 
rear-panel RS-422 data link port. Received data is transmitted on the 
port’s output.

Note: The Line DCC and Section DCC choices can be overwritten by the 
DCC Pass Thru> setting (see SONET DCC Pass-Through Mode, page 3–21).

Rear-Panel 
Handset Interface

Handset> configures the operation of the rear-panel Handset interface 
in both the transmit and receive directions. The available choices are:

None: The Handset interface is disabled.

Section Order Wire (E1): The transmitted data on the Section 
orderwire channel (E1 bytes) is derived from the VF (voice frequency) 
input at the rear-panel Handset port. Received E1 data is converted to a 
VF signal and transmitted on the port’s output.

Line Order Wire (E2): The transmitted data on the Line orderwire 
channel (E2 bytes) is derived from the VF input at the handset port. 
Received E2 data is converted to a VF signal and transmitted on the 
port’s output.

SONET DCC 
Pass-Through 
Mode

DCC Pass-Thru> configures the test set so that the Section data 
communication channel (bytes D1, D2, and D3) and Line DCC (bytes 
D4–D12) received at the SONET input are transmitted at the SONET 
output. Set DCC Pass-Thru to On to retransmit the DCC. Set 
DCC Pass-Thru to Off to disable this function.

Note: When DCC Pass-Thru is On, the SONET transmit clock is forced to loop mode. 
When DCC Pass-Thru is set to Off, the clock configuration returns to the state 
selected in the SONET mode configuration screen.

This item is not available in Monitor mode.
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OC-12 APS 
Pass-Through 
Mode

APS Pass-Thru> configures the test set so that the Automatic 
Protection Switching channel (APS; bytes K1 and K2) received at the 
SONET input is transmitted at the SONET output. Set 
OC-12 APS Pass-Thru to On to retransmit the APS channel. Set 
OC-12 APS Pass-Thru to Off to disable this function.

Note: When APS Pass-Thru is On, the SONET transmit clock is forced to loop mode. 
When APS Pass-Thru is set to Off, the clock configuration returns to the state 
selected in the SONET mode configuration screen.

This item is not available in Monitor mode.

VT Overhead Parameters

For more information on VT 
overhead, see VT1.5 Format 
and Mapping, page 5–12.

The 156MTS provides control of VT overhead configuration and VT path 
trace configuration. Your test set must have Option UQA to take 
advantage of these features.

VT overhead control is accessed through the Additional Test Controls 
menu. These parameters are available when the instrument is 
configured for VT1.5 payloads.

When you select SONET OH Control from the Additional Test 
Controls menu and press CONFIG-right, a series of five screens is 
presented. The first three screens give you access to SONET overhead 
parameters (see SONET Overhead Parameters, page 3–14). The last 
two screens provide access to the following VT1.5 overhead 
parameters:

• VT path overhead bytes.

• J2 path trace string (byte-synchronous modes only).

Í

  Global Settings  |  DS1/E1 Patterns
  Alarm Control    |  DS1 Loop Codes
  APS Control      |
  SONET OH Control |
  Data Link Control|
  DS0/TS/Frac Setup|
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VT Path Overhead 
Control

The VT1.5 Path Overhead Control screen allows you to program the VT 
overhead byte values. Bytes shown as xx cannot be edited on this 
screen.

VT Path Overhead Bytes: Each byte can be set as described below.

Demux Framing Regen>: (Byte-synchronous mode only) This field 
affects the framing of the DS1 dropped from the VT1.5. When this field 
is set to Passthrough (default), the dropped DS1 data and framing are 
both derived from the VT1.5. When this field is set to Regenerate, the 
DS1 data and signaling is derived from the VT1.5, and the DS1 framing is 
internally generated by the test set.

      VT1.5 Path Overhead Control

V5: Signal Label: 100 (Byte Synchronous)
J2: xx ----Press ENTER to access the J2
           VT Path Trace Control Screen
Z6: 00

Z7: 00 ----(MSB is RFI-V Alarm)

Demux Framing Regen> Passthrough

User-programmable VT Path Overhead Bytes

Byte Description

V5: Signal 
Label

VT path signal label: Bits 5–7 of the V5 byte are the path 
signal label. The VALUE keys cycle through the settings:
000 Unequipped 100 Byte Synchronous
001 Equip Non-specif 101 Future
010 Asynchronous 110 PDI-V
011 Bit Synchronous 111 Future

J2 This byte is programmed using the J2 Path Trace Control 
screen. See J2 Path Trace Control, page 3–24. 
Byte-synchronous modes only.

Z6 Growth (undefined). VT byte-synchronous modes only.

Z7 Bit 8 is the VT path remote failure indication (RFI-V). Other Z7 
bits are undefined. VT byte-synchronous modes only.
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J2 Path Trace 
Control

The J2 Path Trace Control screen allows you to program each byte of 
the 64-byte VT Path Trace string. Each byte of the string is transmitted 
in the J2 byte of 64 consecutive VTs. 

The J2 bytes are transmitted left-to-right, top-to-bottom as shown on the 
display.  See page 3-17 for fill action selection table reference.

Each J2 byte is shown twice on the display. On the right, the two-digit 
hexadecimal value of the byte is displayed. On the left, the ASCII 
equivalent of the byte’s value is shown in a corresponding character 
position.

Program in: Selects the mode in which you enter J2 byte values:

• Hex: The cursor moves only in the hexadecimal display (right 
side of screen). Each of the 64 bytes can be set from 00h through 
FFh.

• ASCII: The cursor moves only in the ASCII display (left side of 
the screen). Each byte can be set from A through Z, to a blank, or 
to a dash.

Note: Note that additional ASCII characters are available by programming the 
corresponding value on the hexadecimal side of the display (see table on  
page 3–19).

         J1 Path Trace Control
Results in: ASCII       Format:64-byte
Program in: Hex    Till on ACTION: Hex

 ARB-----    41 52 42 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
 --------    00 00 00 00 00 00 00 00
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VT1.5 Setup Parameters

The VT1.5 option maps DS1 
test signals to virtual 
tributaries carried on an STS-1. 
Each STS-1 can carry as many 
as 28 VTs.

When equipped with Option UQA, the 156MTS can drop and insert 
VT1.5 mapped DS1 signals to and from an STS-1. VT1.5 setup 
parameters are available when Payload is set to VT1.5 Async or 
VT1.5 Byte Sync (the transmitter and receiver must be set for a 
SONET rate).

The VT1.5 parameters appear on the screen similar to the following:

Note: The DS1 setup parameters on the first line apply to the DS1 signal that is 
mapped into the VTs. For information on the DS1 parameters, see Chapter 11, 
DS1, DS0, and FT1 Configuration Reference.

Insert VT 
Selection

VT1.5: Ins> selects which VT1.5 channel within the STS-1 or VT group 
is used for the transmit VT.

See VT1.5 Channel Setup 
Mode, page 3–28.

• If VT Counting Mode is set to VT Group, Ins> determines 
which VT in the group (from 1 through 4) is selected.

• If VT Counting Mode is set to 1 to 28, Ins> determines which 
VT in the STS-1 (from 1 through 28) is selected.

Í
Í

DS1: TxClk>Int  Frm>SF     Data>QRSS
VT1.5: Ins>1  Oths>Same Drop>1 Code>B8ZS
VTGrp: Ins>1  Other Grp’s>Same    Drop>1
STS1:  Ins>1  Other STS’s>Same  Drop>1,1
STSN:  TxClk>Int      Scramble>On  Rx>OC 
Err/Alm:Type>DS1 Data    Rate>Single
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Other Transmit 
VTs

VT1.5: Other VTs> sets the payload for the remaining VT1.5 channels 
(that are not selected by Ins>). Other VTs> applies either to the 
remaining three VTs in a group, or to the remaining 27 VTs in an STS-1 
depending on the VT counting mode. Depending on the VT and counting 
modes, Other VTs> can be set as follows:

The Other VTs> payload selections are described on the next page.

Other VTs> Payload Selections by VT Mode

When the 
VT mode is…

and the 
Counting Mode is…

the available 
payloads are…

Asynchronous VT Group Same

Inv

All 0s

DS1 AIS

Ext

Byte-synchronous VT Group Same

Inv

All 0s

Asynchronous
or
Byte-synchronous

1 to 28 Same

AIS

Unequ
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Same: Fills the VTs with the same payload as the selected Ins> VT.

Inv: Fills the VTs with an inverted copy of the Ins> VT payload.

All 0s: Fills the VTs with an all binary zeros pattern.

DS1 AIS: Inserts a DS1 alarm indication signal on the VTs (unframed 
all-ones).

AIS: Inserts one of two AIS signals on the VTs. In asynchronous VT 
modes, the AIS is a DS1 AIS (unframed all-ones). In byte-synchronous 
VT modes, the AIS is a VT path AIS (all-ones in the V1 and V2 bytes).

Ext: Fills the VTs with the DS1 signal applied at the front-panel 
DS1/E1 RX jack.

Unequ: Sets the remaining VTs as unequipped (path overhead and 
payload set to all zeros).

Drop VT Selection VT1.5: Drop> selects which VT within the STS-1 or VT group is used 
for the receive VT.

See VT1.5 Channel Setup 
Mode, page 3–28.

• If VT Counting Mode is set to VT Group, Drop> determines 
which VT in the group (from 1 through 4) is selected.

• If VT Counting Mode is set to 1 to 28, Drop> determines 
which VT in the STS-1 (from 1 through 28) is selected.

• Setting Drop> to L automatically “locks” the drop VT to be the 
same channel number as VT1.5: Ins>.

Note: VTGrp: parameters are only displayed if VT Counting Mode is set to VT Group.
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Insert VT Group 
Selection

VTGrp: Ins> selects which of the seven VT groups is selected to 
transmit the four VTs defined by VT1.5: Ins> and Other VTs>. Ins> 
can be set from 1 through 7 (see VT1.5 Channel Setup Mode below).

Other Transmit VT 
Groups

VTGrp: Other Grps> sets the remaining VT groups (not selected by 
VTGrp: Ins>). Other Grps> can be set to one of the following:

Same: Sets the remaining six VT groups as identical to the Ins> group.

VT PAIS: Transmits VT path AIS on the remaining groups.

Unequ: Sets the remaining VT groups as unequipped (path overhead 
and payload set to all zeros).

Drop VT Group 
Selection

VTGrp: Drop> selects which VT group is dropped from the receive 
STS-1, and from which the VT1.5 Drop> channel is selected. Drop> 
can be set from 1 through 7, and to L (“locked” to the same channel 
number as VTGrp: Ins>).

VT1.5 Channel 
Setup Mode

There are two ways to specifying VT drop and insert channels on a 
SONET signal. The VT numbering scheme is set on the Auxiliary Test 
Setups screen. Select Setup System Parameters from the Main Menu 
and then select Auxiliary Test Setups.

VT Counting Mode sets the method for specifying VT channels. This 
parameter can be set as follows:

The table on the next page 
shows the two VT counting 
modes. Note that VTs are 
always mapped using the 
group scheme.

VT Group: VT channels are specified in groups of seven, each 
comprising four VTs. A channel is specified as VT 1 through 4 in 
VT group 1 through 7.

1 through 28: VT channels are specified by their position in the 
overall STS-1 signal, from 1 through 28.

Auxiliary Test Setups
Test Dur. Mode:   Continuous
Timer Duration:   00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Sub Menu Opt Pwr: Off   Auto Tst: Stop

Í

Pwr Up Optical Tx State:  Last State
STS12 # Scheme:   STS3#, STS1#
VT Counting: VT Group   DS2 Tx-XBit: 0
DS1 Block Size:   2Kbit
DS1 LOP & OOF Hold-off: 0.0 Seconds
Bits Clk Out Derived from: STS-N Rx Clk
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The following table lists the correlation between individual VT channels 
(1 through 28) and their positions when VT Group counting mode is 
used. The VT group number is listed across the top (1 through 7); the VT 
positions within each group are listed down the left (1 through 4).

VT1.5 Channels 1–28: Locations in VT Groups 1–7

VT Group Number 1 2 3 4 5 6 7

VT1.5 
Position in 
VT Group

(VTs = 1–28)

1 1 2 3 4 5 6 7

2 8 9 10 11 12 12 14

3 15 16 17 18 19 20 21

4 22 23 24 25 26 27 28
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SONET Error 
Injection Types

The following error types can be injected when the transmitter is set for 
a SONET rate.

Note: For information on injection rates, see About Error Injection Rates, page 27–8.

STS3c Data: Generates bit errors in the STS-3c payload data pattern. 
Rates: Single, 1.0E-2 through 1.0E-9, Burst, Off.

REI-P (path FEBE): Generates Path Remote Event Indications (path 
FEBEs) on the G1 byte. Rates: Single, 1.0E-4 through 1.0E-8.

Path BER: Generates errors in the payload and the path overhead 
bytes, except for the B3 parity byte. Rates: Single, 1.0E-2 through 
1.0E-9, Burst, Off.

Section BER: Generates errors at the selected rate in the entire 
SONET signal, except for the B1 parity byte and the A1 and A2 framing 
bytes (available in OC-3 transmitter modes and STS-12c payload modes 
only). Rates: Single, 1.0E-2 through 1.0E-9, Burst, Off.

Line BER: Generates errors at the selected rate in the entire SONET 
signal, except for the Section overhead and the B2 parity byte.
Rates: Single, 1.0E-2 through 1.0E-9, Burst, Off.

REI-L (line FEBE): Generates Line Remote Event Indications (line 
FEBEs) using bits 2 through 8 of the M0 byte for STS-1/OC-1, or the M1 
byte of STS-1 #3 for STS-N. Rates: Single, 1.0E-4 through 1.0E-8.

B1 Byte: Inverts the B1 byte in the transmit STS-N signal for one 
frame. This causes eight Section code violations (available in OC-3 
transmitter modes and STS-12c payload modes only). Affects the parity 
byte; BER injection affects data. Rates: Single, Off.

B2 Bytes: Inverts all B2 bytes in the transmit STS-N signal for one 
frame. This causes 24 line code violations in an OC-3 signal, and 96 line 
code violations in an OC-12 signal. For OC-12, Other> must be set to 
Same to fill the STS-1 channels. Rates: Single, Off.

B3 Byte: Inverts the B3 parity byte in the selected STS-1 for one frame. 
This causes eight Path code violations (available in OC-3 transmitter 
modes only). Rates: Single, Off

B1 Bit: Inverts the least-significant bit (Bit 1) in the B1 byte (available 
in OC-12 transmitter modes only). Rates: Continuous, Off.
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B2 Bit: Inverts the least-significant bit (Bit 1) in the B2 byte (available 
in OC-12 transmitter modes only). Rates: Continuous, Off.

A1 Bit: Inverts the least-significant bit (Bit 1) in the A1 framing byte 
(available in OC-12 transmitter modes only). Rates: Continuous, Off.

H Pointer: Transmits an illegal, out-of-range value in the STS-1 H1 and 
H2 (pointer) bytes. Rates: Single, 7–9 Consec (LOP threshold), 
Continuous, Burst, Off.

A1/A2 Frame: Inverts the 16-bit frame word formed by the A1 and A2 
bytes. Rates: Single, 3–5 Consec (OOF threshold), 23–30 Consec 
(LOF threshold), Continuous, Burst, Off.

SONET Alarm 
Types

SONET alarms can be transmitted by activating or deactivating 
transmission of a particular alarm using the Alarm Control screen. 
When you select Alarm Control from the Control Screens menu, the 
following screen is displayed:

Each alarm type can be set to On (continuously transmitted) or Off 
(not transmitted). Note that VT PYEL has additional selections. The 
following table describes the types of SONET alarms available.

      >Set SONET Alarm Conditions<
         LOS>Off         STS PAIS>Off
         LOF>Off         STS PYEL>Off
        LAIS>Off          VT PAIS>Off
       LFERF>Off          VT PYEL>Off
  STS LOPNTR>Off        VT LOPNTR>Off

SONET Alarm Injection Types

Alarm Description

LOS Loss of signal: Simulates a loss of signal by transmitting all 
zeros.

LOF Loss of frame synchronization: Simulates a loss of frame by 
transmitting errored framing patterns.

LAIS Line alarm indication signal: Sets the transmit K2 bytes to 
XXXXX111.

LFERF Line far-end receive failure: Sets the transmit K2 bytes to 
XXXXX110.
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VT1.5 Error 
Injection

The following error types can be injected when the payload is set for 
VT1.5.

VT BER: Generates bit errors at the selected rate on the selected 
VT1.5. Rates: Single, 1.0E-2 through 1.0E-9, Burst, Off.

REI-V (VT FEBE): Generates a VT path Remote Event Indication 
(path FEBE) error indication on the selected VT1.5 by setting bit 3 of 
the V5 byte to 1. Rates: Single, 1.0E-4 through 1.0E-8.

V Pointer: Generates an out-of-range illegal VT1.5 pointer value.
Rates: Single, 7–9 Consec (LOP threshold), Continuous, Burst, Off.

STS LOPNTR Loss of pointer: generates an illegal, out-of-range pointer 
value.

STS PAIS Path alarm indication signal: Transmits all-ones in H1, H2, 
H3, and the entire SPE.

STS PYEL Path Yellow alarm: Sets bit 5 of the transmit G1 bytes to 1.

VT PAIS VT path alarm indication signal: Transmits all-ones in the 
entire VT, including the V1 and V2 bytes.

VT PYEL On and Off: Activates a VT Path Yellow alarm (sets bits 4 
and 8 of the transmit V5 byte to 01).
PLM-V: VT Payload Label Mismatch. Sets bits 4 and 8 of 
the transmit V5 Byte to 10.
UNEQ-V: VT path unequipped. Sets bits 4 and 8 of the 
transmit V5 byte to 11.

VT LOPNTR Loss of pointer: generates an illegal, out-of-range pointer 
value.

SONET Alarm Injection Types, continued

Alarm Description
3–32
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STS-N Indicators

STS-N
ALARMS

LOS

LOF

LOCLK

ALARMS

AIS-L

RDI-L

LOP-P

AIS-P

RDI-P

LOPAT

STATUS

STS-N SIG

STS-N FRM

PATH PTR

CONCAT

PAT SYNC

ERRORS

ERRORS

B1 CV

B2 CV

B3 CV

REI-L

REI-P

HIST HIST

STS-N Alarm and Status Indicators

Indicator Description

HIST/ALARMS

LOS Loss of STS-N signal.

LOF Loss of frame.

LOCLK Loss of external clock signal.

AIS-L Line Alarm Indication Signal.

RDI-L Line Remote Defect Indication.

LOP-P Path Loss of Pointer.

AIS-P Path Alarm Indication Signal.

RDI-P Path Remote Defect Indication.

LOPAT Loss of payload pattern synchronization.

STATUS

STS-N SIG Valid STS-N signal detected.

STS-N FRM Frame synchronization achieved with STS-N signal.

PATH PTR Valid SONET pointer detected.

CONCAT Concatenated signal detected.

PAT SYNC Payload pattern synchronization achieved.

ERRORS STS-N errors detected.
4–2
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ERRORS

B1 CV B1 byte code violation detected.

B2 CV B2 byte code violation detected.

B3 CV B3 byte code violation detected.

REI-L Line Remote Error Indication detected.

REI-P Path Remote Error Indication detected.

STS-N Alarm and Status Indicators, continued

Indicator Description
4–3
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OC-N/STS-N Measurement Summary Screen
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OC-N/STS-N Measurement Summary Screen

For each screen, an “s” 
indicates Summary results 
level and a “d” indicates Detail 
level. See To Display More 
Measurement Screens, 
page 1–11.

This screen displays summaries for OC-12, OC-3, OC-3c, and STS-1 
tests. The specific OC-N or STS-N rate that is displayed depends on the 
receiver rate (and payload, for STS-12c and STS-3c).

Sec Ago shows time elapsed 
since last CV, in seconds.

B1 (Sect CV): B1 byte Section code violations count. Includes BIP-8 
errors in the B1 byte (as many as eight in each frame).

B2 (Line CV): B2 byte line code-violations count. Includes BIP-8 
errors in the B2 byte (as many as eight in each frame for STS-1, 24 for 
OC-3, and 96 for OC-12).

OC-N Rx Hz: Receive Frequency, in Hertz. The recovered clock 
frequency of the incoming OC-N data pattern.

STS-1 Drop Hz: Drop Frequency, in Hertz. The recovered clock 
frequency of the STS-1 data pattern dropped from the OC-N. Not 
applicable for STS-1 modes or for STS-12c and STS-3c payload modes.

BPV: Bipolar violation count (STS-1 screen only). The total number of 
BPVs detected on the STS-1 during the test.

STS-12c or STS-3c Patt Sync: Pattern Synchronization (STS-12c and 
STS-3c payload modes only). Indicates if the test set has synchronized 
to the receive STS-12c or STS-3c data pattern, based on the setting of 
Data> (see STS-Nc Payload Setup Parameters, page 3–9). ON 
indicates the pattern matches.

Rx Opt dBm: Received optical signal strength, in decibels. Indicates 
the strength (relative to 1.0 milliwatt) of the optical signal at the 
OC-N RX port.

s

 1 OC12-OC12 (VT1.5A)Final:  00:00:00.00 
OC12 Measurement Summary
B1 (Sect CV):    68272 Sec Ago:       12
B2 (Line CV):      288                 4
OC12 Rx Hz:   622080516
STS-1 Drop Hz: 51840043 Rx Opt dBm:-08.3
4–4
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Section Code Violations (B1) Screen

SO
N

ET
Section Code Violations (B1) Screen

This screen displays section code violation measurements (CVs in the 
B1 byte).

Sect CV Count: Section code violations count. Includes BIP-8 errors 
in the B1 byte (as many as eight in each frame).

CV BER (avg): Section CV average bit error ratio. The number of 
section CVs over the total number of section bits transmitted, including 
section and line overhead, since the beginning of the test.

CV BER (cur): Section CV current bit error ratio. The number of 
section CVs over the total number of section bits transmitted, including 
section and line overhead, during the previous 2.25 seconds.

ES: Section errored seconds. The number of seconds in which one or 
more section CVs or OOF events occurred.

SES: Section severely errored seconds. A count of seconds in which 
the number of section CVs met or exceeded the SES threshold, or in 
which an OOF event occurred. The threshold depends on the rate: 
STS-1 = 1 CV, OC-3 = 16 CVs, OC-12 = 63 CVs.

EFS: Section error-free seconds. The number of seconds in which no 
section CVs or OOF events occurred.

%EFS: Section percentage of error-free sends. Section EFS expressed 
as a percentage of the total number of seconds since the beginning of 
the test.

d

 1 STS1-STS1 (VT1.5A)Final:  00:00:00.00 
Section Code Violations (B1)
Sect CV Count:   68272  ES:          2
CV BER (avg): 2.61E-06  SES:         2
CV BER (cur): 0.00E+00  EFS:        40
                        %EFS:    95.24
4–5
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Line Code Violations (B2) Screen
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Line Code Violations (B2) Screen

This screen displays line CV measurements (code violations in the 
B2 byte).

Line CV Count: Line code violations count. Includes BIP-8 errors in 
the B2 byte (as many as eight in each frame for STS-1, 24 for OC-3, and 
96 for OC-12).

CV BER (avg): Line CV average bit error ratio. The number of line 
CVs over the total number of line bits transmitted (excludes section 
overhead) since the beginning of the test.

CV BER (cur): Line CV current bit error ratio. The number of line CVs 
over the total number of line bits transmitted (excludes section 
overhead) during the previous 2.25 seconds.

ES: Line errored seconds. The number of seconds in which one or 
more line CVs occurred.

SES: Line severely errored seconds. A count of seconds in which the 
number of line CVs met or exceeded the SES threshold. The threshold 
depends on the rate: STS-1 = 12 CVs, OC-3 = 32 CVs, OC-12 = 124 CVs.

EFS: Line error-free seconds. The number of seconds in which no line 
CVs occurred.

%EFS: Line percentage of error-free sends. Line EFS expressed as a 
percentage of the total number of seconds since the beginning of the 
test.

d

 1 STS1-STS1 (VT1.5A)Final:  00:00:00.00 
Line Code Violations (B2)
Line CV Count:     288  ES:          2
CV BER (avg): 1.11E-08  SES:         0
CV BER (cur): 0.00E+00  EFS:        40
                        %EFS:    95.24
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REI-L Measurements Screen
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REI-L Measurements Screen

REIs were formerly called 
“far-end block errors” (FEBE).

This screen displays line remote error indications (REI-L) 
measurements on SONET signals.

REI-L Count: REI-L count. REI-L reporting uses bits 2 through 8 of 
the M0 byte for STS-1/OC-1, or the M1 byte of STS-1 #3 for STS-N.

REI-L BER (avg): REI-L average bit error ratio. The number of BIP-8 
errors over the total number of line bits transmitted (excludes section 
overhead) since the beginning of the test.

REI-L BER (cur): REI-L current bit error ratio. The number of BIP-8 
errors over the total number of line bits transmitted (excludes section 
overhead) during the previous 2.25 seconds.

ES: REI-L errored seconds. The number of seconds in which at least 
one REI-L was reported.

SES: REI-L severely errored seconds. The number of seconds in which 
at least 27 REI-Ls were reported.

EFS: REI-L error-free seconds. The number of seconds in which no 
REI-Ls were reported.

%EFS: Percentage of REI-L error-free seconds. REI-L is EFS 
expressed as a percentage of the total number of seconds since the 
beginning of the test.

d

 1 OC12-OC3 (STS3c) Final:  00:00:00.00 
Line REI-L (FEBE) Measurements
REI-L Count:           7 ES:         4
REI-L BER (avg):1.90E-09 SES:        0
REI-L BER (cur):3.61E-09 EFS:        2
                         %EFS:    33.33
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Path Measurement Summary Screen

This screen displays path code violation measurements (CVs; BIP-8 
errors in the B3 byte). In concatenated payload modes, the title 
indicates “STS-12c” or “STS-3c.”

Sec Ago shows time elapsed 
since last FEBE, in seconds.

B3 (Path CV): Path code violations count. Includes BIP-8 errors in the 
B3 byte (as many as eight in each frame).

FEBE: Path far-end block errors. The number of path FEBEs reported 
(bits 1 through 4 of the G1 byte).

s

 1 OC12-OC12(VT/DS1)Final:  00:00:00.00 
Path Measurement Summary
B3 (Path CV):       7  Sec Ago:       1
REI-P (FEBE):       7                 1
4–8
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Path Code Violation (B3) Screen
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Path Code Violation (B3) Screen

This screen displays path CV results (code violations in the B3 byte). 
For concatenated payloads, the title indicates “STS-12c” or “STS-3c.”

Path CV Count: Path code violations count. Includes BIP-8 errors in 
the B3 byte (as many as eight in each frame).

CV BER (avg): Path CV average bit error ratio. The number of path 
CVs over the total number of path bits transmitted (excludes section 
and line overhead) since the beginning of the test.

CV BER (cur): Path CV current bit error ratio. The number of path 
CVs over the total number of path bits transmitted (excludes section 
and line overhead) during the previous 2.25 seconds.

Path UAS: Path unavailable seconds. The number of seconds the path 
was unavailable. The path is unavailable after ten consecutive path 
SESs. The path is declared available again after ten consecutive 
seconds with no path SESs. The Path UAS measurement includes the 
first ten seconds, but not the last ten seconds. The path is also 
unavailable during path AIS and path LOP conditions.

ES: Path errored seconds. The number of seconds in which one or 
more path CVs occurred.

SES: Path severely errored seconds. A count of seconds in which the 
number of path CVs was nine or more.

EFS: Path error-free seconds. The number of seconds in which no path 
CVs occurred.

%EFS: Path percentage of error-free sends. Path EFS expressed as a 
percentage of the total number of seconds since the beginning of the 
test.

d

 1 STS1-STS1(VT1.5A)Final:  00:00:00.00 
Path Code Violations (B3)
Path CV Count:       7  ES:           6
CV BER (avg): 1.40E-08  SES:          0
CV BER (cur): 2.66E-08  EFS:          4
Path UAS:            0  %EFS:      40.00
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REI-P Measurements
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REI-P Measurements

For STS-12c modes, this screen 
displays “STS-12c” in the title.

This screen displays path remote error indication (REI-P) 
measurements. REI-P measurements are block code violations reported 
from the far-end using bits 1 through 4 of the G1 byte.

REIs were formerly called 
“far-end block errors” (FEBE).

REI-P Count: REI-P count. The number of REI-Ps reported.

CV BER (avg): REI-P average bit error ratio. The number of BIP-8 
errors over the total number of path bits transmitted (excludes section 
and line overhead) since the beginning of the test.

CV BER (cur): REI-P current bit error ratio. The number of BIP-8 
errors over the total number of path bits transmitted (excludes section 
and line overhead) during the previous 2.25 seconds.

REI-P UAS: REI-P unavailable seconds. The number of seconds that 
the (reverse) path was unavailable. The path is declared unavailable 
after ten consecutive path SESs. The path is declared available again 
after ten consecutive seconds with no path SESs. The REI-P UAS 
measurement includes the first ten seconds, but not the last ten 
seconds.

ES: REI-P errored seconds. The number of seconds in which at least 
one REI-P was reported.

SES: REI-P severely errored seconds. The number of seconds in which 
at least nine REI-Ps were reported.

EFS: REI-P error-free seconds. The number of seconds in which no 
REI-Ps were reported.

%EFS: Percentage of REI-P error-free seconds. REI-P EFS expressed 
as a percentage of the total number of seconds since the beginning of 
the test.

d

 1 STS1-STS1(VT1.5A)Final:  00:00:00.00 
Path REI-P (FEBE) Measurements
REI-P Count:         7  ES:         6
CV BER (avg): 1.40E-08  SES:        0
CV BER (cur): 2.66E-08  EFS:        4
REI-P UAS:           0  %EFS:   40.00
4–10
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STS-12c and STS-3c Bit Error Measurements
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STS-12c and STS-3c Bit Error Measurements

This screen displays STS-12c or STS-3c bit error measurements 
depending on the test mode.

Error Count: The number of STS-12c/3c bit errors.

Average Ratio: STS-12c/3c average bit error ratio. The number of 
errored bits over the total number of bits since the beginning of the test.

Current Ratio: STS-12c/3c current bit error ratio. The number of 
errored bits over the total number of bits during the previous 2.25 
seconds.

Patt Sync: Indicates ON when a valid STS-12c/3c payload pattern is 
received.

ES: STS-12c/3c errored seconds. The number of seconds in which at 
least one STS-3c bit error occurred.

SES: STS-12c/3c severely errored seconds. The number of seconds in 
which at least 27 STS-3c bit errors occurred.

EFS: STS-12c/3c error-free seconds. The number of seconds in which 
no STS-3c bit errors occurred.

%EFS: Percentage of STS-12c/3c error-free seconds. STS-12c/3c EFS 
expressed as a percentage of the total number of seconds since the 
beginning of the test.

s

 1 OC12-OC12(STS12c)Final:  00:00:00.00 
STS-12c Bit Error Measurements
Error Count:        21   ES:         8
Average Ratio:1.85E-09   SES:        0
Current Ratio:7.42E-10   EFS:       11
Patt Sync:    ON         %EFS:   57.89
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STS Frame Measurements (A1/A2) Screen

SO
N

ET
STS Frame Measurements (A1/A2) Screen

This screen displays frame error measurements in the A1/A2 bytes of 
the STS frame.

An LOF was formerly called an 
“OOF” (out-of-frame) event.

LOF (OOF) Events: STS loss-of-frame events count. An LOF event is 
declared when four or more consecutive errored framing patterns are 
detected. (This measurement is not available in OC-12 receiver modes).

EFS: STS frame error-free seconds count. The number of seconds in 
which no OOF events occurred.

%EFS: Percentage of STS frame error-free seconds. STS frame EFS 
expressed as a percentage of the total number of seconds since the 
beginning of the test.

Severely Err Frm Sec: STS frame severely error seconds. The 
number of seconds in which at least one STS OOF occurred.

s

 1 STS1-STS1(VT1.5A)Final:  00:00:00.00 
STS Frame Measurements (A1/A2)
Severely Err Frm Sec:     --
      Continuous EFS:     --
                %EFS:   -.--
4–12
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STS-1 BPV Measurements Screen
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STS-1 BPV Measurements Screen

This screen displays bipolar violation measurements in the STS-1 
signal.

BPV Count: STS-1 bipolar violation count.

BPV BER (cur): STS-1 BPV average bit error ratio. The number of 
BPVs over the total number of transmitted bits since the beginning of 
the test.

BPV BER (avg): STS-1 BPV current bit error ratio. The number of 
BPVs over the total number of transmitted bits during the previous 2.25 
seconds.

LCVR Sec: STS-1 line-code violation rate seconds. The number of 
seconds in which the LCVR state occurred. The LCVR state is declared 
when the BPV rate exceeds 44 BPVs per second for one second. The 
LCVR state continues until the BPV rate is less than 4 BPVs per second 
for one second.

ES: STS-1 BPV errored seconds. The number of seconds in which at 
least one BPV occurred.

EFS: STS-1 BPV error-free seconds. The number of seconds in which 
no BPVs occurred.

%EFS: Percentage of STS-1 BPV error-free seconds. STS-1 BPV EFS 
expressed as the percentage of total seconds since the beginning of the 
test.

d

 1 STS1-STS1 (DS3)  Final:  00:00:00.00 
STS-1 BPV Measurements
BPV Count:       --     ES:     --
BPV BER (cur):   --     EFS:    --
BPV BER (avg):   --     %EFS:   --
LCVR Sec:        --
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STS-N Pointer Measurements Screen
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STS-N Pointer Measurements Screen

This screen displays pointer measurements for STS-1, STS-12c, or 
STS-3c signals. The screen appears differently depending on the test 
mode.

PJ + and –: STS-1, STS-12c, or STS-3c pointer justification count. The 
number of positive (+) and negative (–) pointer adjustments.

Last PJ Dir: Last pointer justification direction. The direction 
(positive or negative) of the previous pointer justification.

LOP-P (LOPNTR): Loss of pointer seconds. The number of seconds 
during which a loss of pointer condition was present.

Pointer Value: The decimal value of the STS-1, STS-12c, or STS-3c 
H1/H2 pointer. For STS-12c and STS-3c this is H1/H2 of STS-1 #1.

NDF Sec: New data flag seconds count. The number of seconds in 
which an NDF occurred. An NDF indicates an SPE alignment change. 
Bits 1–4 of the pointer carry the NDF which permits an arbitrary change 
in the pointer value because of a change in the payload.

PJ Sec: Pointer justification seconds count (STS-1 screen only). The 
number of seconds in which at least one pointer justification occurred.

EFS: STS-1 pointer error-free seconds (STS-1 screen only). The 
number of seconds in which no invalid H1/H2 pointers were detected.

In STS-3c, H1/H2 of STS-1 #1 
is set to a valid pointer. H1/H2 
for STS-1s #2 and #3 are set to 
93FFh to indicate 
concatenation.

%EFS: Percentage of STS-1 EFS (STS-1 screen only). STS-1 pointer 
EFS expressed as the percentage of total seconds since test start.

H1/H2 #1, #2, and #3: (STS-3c screen only) Hexadecimal value of the 
H1/H2 pointer bytes of STS-1 #1, #2, and #3. In STS-12c, the pointer 
bytes are displayed on a separate screen (see next page).

s

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
STS-1 Pointer Measurements
PJ: +   --    -   --     PJSec:   --
Last PJ Dir:      --   NDF Sec:   --
LOP-P(LOPNTR):    --       EFS:   --
Pointer Value:    --      %EFS:   --
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STS-12c Pointer Bytes Screen
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STS-12c Pointer Bytes Screen

This screen displays the values of the pointer bytes (H1 and H2 bytes) 
for each of the twelve STS-1s that make up the STS-12c frame. This 
screen is only available for STS-12c testing modes.

#1 through #12: The number indicates the STS-1 in the STS-12c frame 
(12 STS-1s are combined to form a concatenated STS-12).

H1/H2 byte values: The value for the H1 and H2 bytes of each STS-1 is 
displayed in hexadecimal format. For a valid STS-12c signal, the values 
of the H1/H2 bytes for STS-1s 2 through 12 must be 93/FF 
(hexadecimal).

APS Measurements Screen

This screen displays to automatic protection switching (APS) 
measurements (K1 and K2 bytes).

State Chng Sec: APS state change seconds. The number of seconds in 
which one or more change in the received APS message occurred.

Byte Fail Sec: APS byte failure seconds. The number of seconds in 
which one or more APS byte failure events occurred. An APS byte 
failure is declared when eight consecutive frames are received in which 
there are not at least three consecutive frames with identical APS bytes.

s

 1 OC12-OC12(STS12c)Final:  00:00:00.00 
STS-12c Pointer Bytes (H1/H2)
#1:  -- --  #5:  -- --  #9:  -- --
#2:  -- --  #6:  -- --  #10: -- --
#3:  -- --  #7:  -- --  #11: -- --
#4:  -- --  #8:  -- --  #12: -- --

d

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
APS Measurements
State Chng Sec:  --     Type:     --
Byte Fail Sec:   --     Mode:     --
Request Chan:    --  Bridge Chan: --
APS State:       --  No Request 
4–15
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APS Measurements Screen
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Channel 0 is the null channel; 
channel 15 is the extra traffic 
channel. Channels 1–14 are 
the working channels.

Request Chan: APS requested channel: The number of the channel 
(0–15) to which the received condition message applies. This code is 
received in bits 5 through 8 of the K1 byte.

Bridge Chan: APS bridged channel: The number of the channel (1–15) 
currently bridged onto the protection line at the far end. This code is 
bits 1 through 4 of the K2 byte.

APS State: APS signal state message: Indicates the received message 
based on bits 1 through 4 of the K1 byte. The table below lists the 
displayed messages and their corresponding 4-bit codes.

Type: APS architecture type at the far-end. The result indicates either 
1+1 (K2 bit 5 set to 0) or 1:n (K2 bit 5 set to 1).

Mode: APS switching mode at the far-end: Indicates one of the modes 
listed in the table on page 18. The mode is received on bits 6–8 of K2.
4–16
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APS Measurements Screen
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APS Signal State Code (K2 byte, bits 1 through 4)

K1 Bit 1 K1 Bit 2 K1 Bit 3 K1 Bit 4 APS State Message Displayed Result

0 0 0 0 No Request

0 0 0 1 Do Not Revert

0 0 1 0 Reverse Request

0 0 1 1 Not Used

0 1 0 0 Exercise

0 1 0 1 Not Used

0 1 1 0 Wait-to-Restore

0 1 1 1 Not Used

1 0 0 0 Manual Switch

1 0 0 1 Not Used

1 0 1 0 SD (signal degraded)—Low Priority

1 0 1 1 SD—High Priority

1 1 0 0 SF (signal failure)—Low Priority

1 1 0 1 SF—High Priority

1 1 1 0 Forced Switch

1 1 1 1 Lockout of Protection
4–17
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APS Measurements Screen
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APS Switching Mode Code (K2 byte, bits 6 through 8)

K2 Bit 6 K2 Bit 7 K2 Bit 8 APS Mode Displayed Result

0 0 0 Future

0 0 1 Future

0 1 0 Future

0 1 1 Future

1 0 0 Unidirectional switching

1 0 1 Bidirectional switching

1 1 0 Line FERF

1 1 1 Line AIS
4–18
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Transport Overhead Screen #1 and Screen #2
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Transport Overhead Screen #1 and Screen #2

These two screens display the transport overhead bytes of the SONET 
signal.

For each byte, the received value is displayed in hexadecimal notation. 
The table below describes the functions of the transport overhead 
bytes.

d

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
Transport Overhead Screen #1
                 E1:  --         F1:  --
D1:  --          D2:  --         D3:  --
H1:  --          H2:  --
                 K1:  --         K2:  --

d

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
Transport Overhead Screen #2
D4:  --          D5:  --         D6:  --
D7:  --          D8:  --         D9:  --
D10: --          D11: --         D12: --
Z1:  --          Z2:  --         E2:  --

Displayed SONET Transport Overhead Bytes

Byte Transport Overhead Function

D1–D3 Section DCC datalink

D4–D12 Line DCC datalink

E1 Section orderwire

E2 Line orderwire

F1 Section user channel

H1, H2 STS pointer

K1, K2 APS channel

Z1 S1/Z1, see SONET Overhead Parameters, page 3–14

Z2 M0/M1/Z2, see SONET Overhead Parameters, page 3–14
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Path Overhead Screen
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Path Overhead Screen

This screen displays the path overhead bytes of the SONET signal.

For each byte, the received value is displayed in hexadecimal notation. 
The table below describes the functions of the path overhead bytes.

d

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
Path Overhead
C2:  --          Z3:  --
G1:  --          Z4:  --
F2:  --          Z5:  --
H4:  --       O-Bit:  --

Displayed SONET Path Overhead Bytes

Byte Path Overhead Function

C2 STS path signal label: Identifies the STS payload mapping. Ten 
values identify the construction and content of the SPE, as 
listed below.

00 Unequipped.

01 Equipped; non-specific payload.

02 Floating VT mode.

03 Locked VT mode.

04 Asynchronous mapping for DS3.

05 Not used (mapping for byte-observable Syntran).

12 Asynchronous mapping for DS4NA.

13 Mapping for ATM.

14 Mapping for DQDB.

15 Asynchronous mapping for FDDI.

G1 STS path status (bits 1–4 provide FEBE monitoring).

F2 Path user channel.
4–20



SONET Measurement Reference

STS-N Path Trace Byte (J1) Values Screens and OC-12 Section Trace Byte (J0) 

SO
N

ET
STS-N Path Trace Byte (J1) Values Screens
and OC-12 Section Trace Byte (J0) ASCII 
Default Screens

The STS-N path trace (J1) byte message and the Section Trace (J0) 
message (both ASCII default setting) are displayed as follows: 

This ASCII default setting message is displayed on the path trace or 
section trace screen unless the operator changes the default to display 
the same data ASCII and hexadecimal values.  The operator can make 
this change  at the Sonet Path overhead control screen by changing the 
value between ASCII and HEX & ASCII selections.   With the ASCII and 
hexadecimal values displayed, the screen will display 64 bytes of data 
as typically represented on HOST code software release earlier than 
V6.60. 

H4 Payload indicator. Indicates the phase of the V1–V4 bytes in the 
VT1.5 overhead.

Z3, Z4, Z5 Growth bytes.

O-Bit The DS3 overhead communication channel bits.

Displayed SONET Path Overhead Bytes, continued

Byte Path Overhead Function

d

 1 OC12-OC12 (DS3) Elapsed:  00:00:00.00 
STS-N Path Trace Byte (J1) Message
     
     Agilent Technologies 156MTS Test          
      Set Serial No SERIAL_NO  
         

d

 1 OC12-OC12 (DS3) Elapsed:  00:00:00.00 
Section Path Trace Byte (J0) Message
     
     Agilent Technologies 156MTS Test          
      Set Serial No SERIAL_NO  
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STS-N Path Trace Byte (J1) Values Screens
and OC-12 Section Trace Byte (J0) ASCII & 
HEX Format Screens

These two screens display the 64-byte path trace message which is 
carried in the J1 byte. For OC-12, the Section Trace message is 
displayed on two similar screens with display values Hex and ASCII.

Eight bytes are displayed on each line. For example, the 1: line shows 
J1 or J0 bytes 1 through 8; The 9: line shows bytes 9 through 16; and so 
forth. For each byte, the hexadecimal value is shown on the left portion 
of the screen, and the ASCII equivalent value is shown on the right.

See Path and Section Trace settings on page 4-23.

d

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
STS-N Path Trace Byte (J1) Values 1-32
1:  41 67 69 6C 65 6E 74 00    Agilent-
9:  54 65 63 68 6E 6F 6C 6F    Technolo
17: 67 69 65 73 00 31 35 36    gies-156
25: 4D 54 53 00 53 45 53 54    MTS-Test

d

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
STS-N Path Trace Byte (J1) Values 33-64
33: 53 65 74 00 53 65 72 69    Set-Seri
41: 61 6C 00 4E 6F 00 53 45    al-No-SE
49: 52 49 41 4C 5F 4E 4F 00    RIAL_NO-
57: 00 00 00 00 00 00 00 00    --------
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Path- and Section-Trace Strings

Host version 6.60 lets you display and edit the J1 and J2 
path-trace strings, and the J0 section-trace string. (See Chapters 
3 and 4 of the 156MTS/31XE Programmer’s Manual, 
version 4.1 for information about the screens.) 

• New fields have been added to the J1 & J2 Path Trace Control 
and J0 Section Trace Control screens. 

• The Fill on ACTION (or Fill on INJECT) and Format fields 
define the transmit trace string to transmit when you press the 
ACTION (INJECT) button (see the table below). 

• Results Display in sets the display mode for the path-trace 
byte and section-trace byte values (below). This field has two 
options: 

• ASCII (the default)–displays values in ASCII.

• Hex & ASCII–displays values in hex and ASCII.  

 
  
  Fill on
 Action

Format - for Fill on Action (inject button) Selections

1-Byte 16-Byte 64-Byte

NULL 0x00 in all bytes. 0x00 in all bytes. 0x00 in all bytes. 

HEX 0x01 in all bytes. 0x41 – 0x4F with CRC7, 
copied 4 times. 

0x41 to 0x7F (ASCII A to DEL), followed by a 
carriage return (0x0D) & line feed (0x0A). 

ASCII 0x41 in all bytes. “nnnnnn” serial number 
with CRC7, copied 4 
times. 

“Agilent Technologies 156MTS Test Set 
Serial No. nnnnnn” followed by carriage 
return (0x0D) and line feed (0x0A). 

USER First byte copied 
to all 64 bytes. 

Calculate and insert CRC7 
of first 16 bytes; copy first 
16 bytes 4 times. 

No action.
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STS-1 Signal Measurements

This screen displays signal measurements for the STS-1 signal.

Rx Hz: STS-1 receive frequency in Hertz: The recovered clock 
frequency of the receive STS-1 data pattern.

Rx Pk V: STS-1 receive peak voltage: The receive signal level measured 
in volts peak (Vpk). Accuracy is ±5%.

Rx dBdsx: STS-1 receive dBdsx level: The receive signal level 
measured in decibels relative to an STSX-1 signal (0 dBdsx = 0.53 Vpk). 
Accuracy is ±1 dB.

s

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
STS-1 Signal Measurements
 Rx Hz:       --
 Rx Pk V:     --
 Rx dBdsx:    --
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STS-1 Jitter Measurements
Each measurement is 
calculated for both wide- band 
and high-band jitter. The jitter 
cut-off frequencies for STS-1 
at 100 Hz to 400 kHz 
(wide-band) and 20 kHz to 
400 kHz (high-band).

This screen displays jitter peak results for the selected receiver rate.

Current P-to-P: Current peak-to-peak jitter: The sum of the positive 
jitter peak and the negative jitter peak for the most recent one-second 
period. Displayed in unit intervals.

The STS-1 jitter mask is 1.5 UI 
for wide-band and 0.2 (0.15) 
for high-band.

MAX P-to-P: Maximum peak-to-peak jitter: The sum of the highest 
positive jitter peak and the highest negative jitter peak for the entire 
test duration. Displayed in unit intervals.

MAX Pos Peak: Maximum positive jitter peak: The greatest positive 
jitter peak since the beginning of the test. Displayed in unit intervals.

MAX Neg Peak: Maximum negative jitter peak: The greatest negative 
jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and 
Mask Results 
Screen

This screen displays jitter threshold and mask percentage results for 
the selected receiver rate.

The measurements on this display are described below. Each 
measurement is calculated for both wide-band and high-band jitter.

See Jitter Threshold 
Configuration, page 23–3.

Hits Count: Indicates the total number of jitter hits (jitter hit 
threshold exceeded) since the beginning of the test.

Total Hits Time: Indicates the cumulative total of time, in seconds, 
that the jitter hit threshold has been exceeded since the beginning of 
the test.

MAX Percent of Mask: Indicates the maximum peak-to-peak jitter 
for the entire test period expressed as a percentage of the jitter mask.

s

 1 STS1-STS1 (DS3)  Final:  00:00:00.00 
STS1 Jitter          Wide-Band High-Band
 Current P-to-P (UI):    --       --
 MAX P-to-P (UI):        --       --
 MAX Pos Peak (UI):      --       --
 MAX Neg Peak (UI):      --       --

d

 1 STS1-STS1 (DS3)  Final:  00:00:00.00 
STS1 Jitter          Wide-Band High-Band
 Hits Count:             --       --
 Total Hits Time(Sec):   --       --
 MAX Percent of Mask:    --       --
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STS-N Alarm Screens

The screens described in this section display alarm results for the 
SONET signal. The alarms that are displayed on the screens are 
described in the following table.

SONET Alarm Definitions

Alarm Description

AIS-L Line alarm indication signal (formerly “LAIS”): Declared when five 
consecutive K2 bytes are received containing XXXXX111. The 
alarm is cleared when five consecutive K2 bytes do not contain 
XXXXX111.

RDI-L Line remote defect indication (formerly “far-end receive failure” 
or “FERF”): Declared when five consecutive K2 bytes are 
received containing XXXXX110. The alarm is cleared when five 
consecutive K2 bytes do not contain XXXXX110.

LOS Loss of signal: Declared when between 10 and 100 µs of all-zeros 
pattern is detected. Nominal detect time is 55 µs. The alarm is 
cleared when a non-zero pulse is detected.

LOP-P Loss of pointer (formerly “LOPNTR”): Declared when eight 
consecutive frames are received that do not meet at least one of 
the following conditions:
• Normal flag (0110) and valid value (0–782).
• New data flag (1001) and valid value (0–782).
• Normal flag and valid value in STS-1 #1, and concatenation 
indicator (1001XX1111111111) in the other STS-1s.
LOP-P is not declared during AIS-P. The alarm is cleared when a 
consistent, valid pointer is received for three consecutive frames.

LOF Loss of frame synchronization: Declared when an OOF condition 
(out of frame: four consecutive errored framing patterns) is 
detected for 24 consecutive frames (3 ms). The alarm is cleared 
after 24 consecutive frames of correct framing patterns.

LOCLK Loss of clock synchronization: Declared when external clock 
source is no longer detected (when configured for external 
timing). This alarm is cleared when clock source is reapplied.
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STS-N Alarm 
Seconds Screens

These three screens display counts of SONET alarm seconds. An alarm 
second is a second during which a particular type of alarm is active. 

Note: For concatenated payloads the “LOPat” alarm (loss of pattern) is added, and 
the alarms are displayed on three screens instead of two.

LOPatt Loss of STS-12c or STS-3c pattern synchronization. Declared 
when the error ratio is 25% or higher (evenly distributed) on the 
SPE bytes, or when the error ratio exceeds 3.12–2 if the errors are 
not evenly distributed (STS-3c only). LOPatt is cleared when 64 
consecutive pattern matches (bits) are received.

AIS-P Path alarm indication signal (formerly “PAIS”): Declared when 
all-ones is received in H1/H2 for three consecutive frames. This 
alarm is cleared when all-ones is not received in H1/H2 for three 
consecutive frames.

RDI-P Path remote defect indications (formerly Path Yellow alarm): 
Declared when ten consecutive frames are received containing 
bit 5 of the G1 byte set to 1. The alarm is cleared when ten 
consecutive frames are received containing bit 5 of the G1 byte 
set to 0.

SONET Alarm Definitions, continued

Alarm Description

s

 1 OC12-OC12 (STS3c)Final:  00:00:00.00 
STS-N Alarm Seconds
AIS-L(LAIS):             --
RDI-L(LFERF):            --
LOS:                     --
LOP-P(LOPNTR):           --

s

 1 OC12-OC12 (STS3c)Final:  00:00:00.00 
STS-N Alarm Seconds
AIS-P(PAIS):             --
RDI-P(PYEL):             --
LOF:                     --
LOCLK:                   --
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STS-N Alarm and 
History Screens

These screens display current and previous SONET alarms. Like front 
panel LEDs, the screens provide current status of the alarm (Alarm) 
and also indicate if the alarm has occurred previously (Hist).

Note: For concatenated payloads the “LOPat” alarm (loss of pattern) is added, and 
the alarms are displayed on three screens instead of two.

STS-N Status Screen
This screen displays the status of certain SONET signal parameters, 
similar to the front-panel STS-N STATUS indicators.

d

 1 OC12-OC12 (STS3c)Final:  00:00:00.00 
STS-N          Alarm  Hist
 AIS-L(LAIS):   --    --
 RDI-L(LFERF):  --    --
 LOS:           --    --
 LOP-P(LOPNTR): --    --

d

 1 OC12-OC12 (STS3c)Final:  00:00:00.00 
STS-N          Alarm  Hist
 AIS-P(PAIS):   --    --
 RDI-P(PYEL):   --    --
 LOF:           --    --
 LOCLK:         --    --

d

 1 OC12-OC3 (STS3c) Final:  00:00:00.00 
STS-N          Status
STS-N Signal:      --
STS-N Frame:       --
Valid Pointer:     --
STS-3c Patt Sync:  --

SONET Status Conditions

Status Condition Description

STS-N Signal Valid STS-N signal present.

STS-N Frame Frame synch (no OOF for at least 24 frames).

Valid Pointer Consistent H1/H2 received for at least three frames.

STS-12c Patt Sync 
or STS-3c Patt Sync

Valid STS-12c or STS-3c payload pattern received.
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VT Indicators

VT Alarm and Status Indicators

Indicator Description

HIST/ALARMS

LOP-V Loss of VT pointer.

AIS-V VT1.5 Path Alarm Indication signal.

RDI-V VT1.5 path remote defect indication.

STATUS

VT PTR Valid VT1.5 pointer detected.

ERRORS

V5 CV Indicates V5 byte code violation.

REI-V VT remote error indication.

VT

LOP-V

ALARMS

AIS-V

RDI-V

VT PTR

STATUS

ERRORS

REI-V

HIST

V5 CV
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VT1.5 Measurement Summary Screen

This screen displays a summary of VT1.5 test results.

Sec Ago shows time elapsed 
since last error, in seconds.

V5 (VT VC): VT code violations count: Includes BIP-2 errors in the 
V5 byte (as many as two per frame).

VT FEBE: VT1.5 far-end block error count: Includes reported errors 
(VT FEBE reporting uses bit 3 of the V5 byte).

s

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 Measurement Summary
V5 (VT VC):        --     Sec Ago:   --
REI-V (FEBE):      --                --
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VT1.5 Code Violations Screen

This screen displays VT code violation measurements (CVs in the 
V5 byte).

VT CV Count: VT code violations count: Includes BIP-2 errors in the 
V5 byte (as many as two in each frame).

CV BER (avg): VT CV average bit error ratio: The number of VT CVs 
over the total number of VT bits transmitted since the beginning of the 
test.

CV BER (cur): VT CV current bit error ratio: The number of VT CVs 
over the total number of VT bits transmitted during the previous 2.25 
seconds.

VT UAS: VT unavailable seconds: The number of seconds that the VT 
was unavailable. The VT is declared unavailable after ten consecutive 
VT SESs. The VT is declared available again after ten consecutive 
seconds with no VT SESs. The VT UAS measurement includes the first 
ten seconds, but not the last ten seconds. The path is also unavailable 
during VT AIS and VT LOP conditions.

ES: VT errored seconds. The number of seconds in which one or more 
VT CVs occurred.

SES: VT severely errored seconds. A count of seconds in which the 
number of VT CVs was four or more.

EFS: VT error-free seconds. The number of seconds in which no VT 
CVs occurred.

%EFS: VT percentage of error-free seconds. VT EFS expressed as a 
percentage of the total number of seconds since the beginning of the 
test.

d

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 Code Violations (V5)
VT CV Count:     --     ES:     --
CV BER (avg):    --     SES:    --
CV BER (cur):    --     EFS:    --
VT UAS:          --     %EFS:   --
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VT1.5 REI-V (FEBE) Measurements Screen

This screen displays VT far-end block error (FEBE) measurements. 
FEBE measurements are block code violations reported from the 
far-end using bit 3 of the V5 byte.

REI-V (FEBE) Count: VT FEBE count. The number of VT CVs 
reported.

CV BER (avg): VT FEBE average bit error ratio. The number of BIP-2 
errors over the total number of VT bits transmitted since the beginning 
of the test.

CV BER (cur): VT FEBE current bit error ratio. The number of BIP-2 
errors over the total number of VT bits transmitted during the previous 
2.25 seconds.

REI-V (FEBE) UAS: VT FEBE unavailable seconds. The number of 
seconds that the (reverse) VT was unavailable. The VT is declared 
unavailable after ten consecutive VT SESs. The VT is declared available 
again after ten consecutive seconds with no VT SESs. The REI-V 
(FEBE) UAS measurement includes the first ten seconds, but not the 
last ten seconds.

ES: VT FEBE errored seconds. The number of seconds in which at 
least one VT FEBE was reported.

SES: VT FEBE severely errored seconds. The number of seconds in 
which at least four VT FEBEs were reported.

EFS: VT FEBE error-free seconds. The number of seconds in which no 
VT FEBEs were reported.

%EFS: Percentage of VT FEBE error-free seconds. VT FEBE EFS 
expressed as a percentage of the total number of seconds since the 
beginning of the test.

d

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 REI-V (FEBE) Measurements
REI-V Count:       --   ES:         --
CV BER (avg):      --   SES:        --
CV BER (cur):      --   EFS:        --
REI-V UAS:         --   %EFS:       --
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VT1.5 Pointer Measurements Screen

This screen displays pointer measurements for VT signals.

LOPNTR Sec: Loss of pointer seconds: The number of seconds during 
which a loss of pointer condition was present.

Pointer Value: The decimal value of the VT1.5 (V1/V2) pointer.

V1 and V2: Hexadecimal value of the V1 and V2 bytes.

PJ Sec: Pointer justification seconds count: The number of second in 
which at least one pointer justification occurred.

EFS: VT pointer error-free seconds. The number of seconds in which 
no invalid V1/V2 pointers were detected.

%EFS: Percentage of VT EFS. VT pointer EFS expressed as the 
percentage of total seconds since test start.

VT1.5 Path Overhead Screen

This screen displays the overhead bytes of the VT signal.

V4: Displays the value of the received V4 (undefined) byte.

V5: Sig Labl: Displays the bit values and signal label definition of 
bits 5–7 of the received V5 byte.

Z6, Z7: Displays the value of the receive Z6 and Z7 (growth) bytes. 
Bit 8 of the Z7 byte is used for RFI-V.

s

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 Pointer Measurements
PJ: ------   ------    PJSec:   ---
V1: FF  V2:   --         
LOP-V Sec:       --    EFS:     ---
Pointer Value:   --    %EFS:    ---.--

d

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 Path Overhead
V4: --
V5: Sign Lbl: --
Z6: --
Z7: --
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VT1.5 Path Trace Byte (J2) Values 

The following screen message indicates that there was no usable ASCII 
data input detected or an asynchronous payload selected.  

An synchronous payload would produce the following typical message. 
VT1.5 path trace (J2) byte message  is carried for OC-12, the Section 
Trace message (ASCII default setting) is displayed as follows:   

This ASCII default setting message is displayed on each path trace 
screen unless the operator changes the default to display the same data 
ASCII and hexadecimal values.  The operator can make this change  at 
the Sonet Path overhead control screen by changing the value between 
ASCII and HEX & ASCII selections.   With the ASCII and hexadecimal 
values displayed, the screen will display 64 bytes of data as represented 
typically on HOST code software releases earlier than V6.60. 

See Path and Section Trace settings on page 4-23.

d

 1 OC12-OC12 (DS3) Elapsed:  00:00:00.00 
VT1.5 Path Trace Byte (J2) Message
     
   ****  no displayable Message  ****          
        
         

d

 1 OC12-OC12 (DS3) Elapsed:  00:00:00.00 
VT1.5 Path Trace Byte (J2) Message
     
     Agilent Technologies 156MTS Test          
      Set Serial No SERIAL_NO  
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These two screens display the 64-byte path trace message which is 
carried in the J2 byte.

Eight bytes are displayed on each line. For example, the 1: line shows 
J2 bytes 1 through 8; The 9: line shows bytes 9 through 16; and so forth. 
For each byte, the hexadecimal value is shown on the left portion of the 
screen, and the ASCII equivalent value is shown on the right.

d

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 Path Trace Byte (J2) Values 1-32
1:  41 67 69 6C 65 6E 74 00    Agilent-
9:  54 65 63 68 6E 6F 6C 6F    Technolo
17: 67 69 65 73 00 31 35 36    gies-156
25: 4D 54 53 00 53 45 53 54    MTS-Test

d

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
VT1.5 Path Trace Byte (J2) Values 33-64
33: 53 65 74 00 53 65 72 69    Set-Seri
41: 61 6C 00 4E 6F 00 53 45    al-No-SE
49: 52 49 41 4C 5F 4E 4F 00    RIAL_NO-
57: 00 00 00 00 00 00 00 00    --------
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VT Alarm Screens

These two screens display counts of VT alarm seconds and current 
status. 

An alarm second is a second during which a particular type of alarm is 
active. An alarm’s current status is displayed as ON if that alarm 
condition is present.

PAIS: VT path alarm indication signal: Declared when all-ones is 
received in the V1 and V2 bytes for three consecutive frames. The alarm 
is cleared when all-ones is not received in the V1 and V2 bytes for three 
consecutive frames.

PYEL: VT path yellow: Declared when bits 4 and 8 of the V5 byte are 
set to 01 for ten consecutive VT supeframes. The alarm is cleared when 
the bits are not 01 for ten consecutive VT superframes.

LOPNTR: VT loss of pointer: Declared when a valid VT pointer is not 
received for eight consecutive frames. The alarm is cleared when a 
consistent, valid pointer value is received for three consecutive frames.

FEBE: VT far-end block errors: Declared when bit 3 of the V5 byte is 
received set to 1. This alarm is cleared when bit 3 is received set to 0.

s

 1 OC12-OC12(VT1.5A)Elapsed: 00:00:00.00 
VT1.5 Alarm Seconds
 AIS-V (PAIS):      --   RDI-V:   --
 RDI-V (PYEL):      --   RFI-V:   --
 LOP-V (LOPNTR):    --   RDI-V:   --
                         P0/P1:   --

d

 1 OC12-OC12(VT1.5A)Final:  00:00:00.00 
 VT1.5  Alarm             VT1.5  Alarm
  PAIS:   --               LOPNTR: --
  PYEL:   --               FEBE:   --
  RDI-V:  --               RFI-V:  --
  PDI-V:  --               P0/P1:  --
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RDI-V: VT remote defect indication: Displays the values of bits 4 and 8 
of the V5 byte, and indicates the corresponding alarm to which the 
remote device is responding:

RFI-V: VT remote failure indication: Declared when bit 8 of the Z7 byte 
is received as 1.

PDI-V: VT payload defect indication: Declared when the received V5 
signal label bits (Bits 5–7) are 110.

P0/P1: VT byte synchronization phase bit alignment alarm: Declared 
when VT byte-synchronous signaling framing is lost. Not valid for VT 
asynchronous modes.

Bits 4 and 8 RDI Description

0 1 AIS-V or LOP-V: VT alarm indication signal or loss of pattern 
(also indicated as PYEL).

1 0 PLM-V: VT payload label mismatch.

1 1 UNEQ-V: VT unequipped.

0 0 –– (no alarm).
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SONET Electrical Interfaces

STS-1 Transmitter
STS-1 TX

Signals:

Line Code: B3ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECo 440. Optional WECo 358 or BNC.

STS-1 Receiver
STS-1 RX

Signals:

Line Code: B3ZS.

Impedance: 75 ohm ±5%.

Connector: Accepts WECo 440. Optional WECo 358 or BNC.

STSX-1 Per TR-NWT-000253 Section 4.4.
0.53 Vpk ±1.2 dB.
LBO = 450 ft simulated 728A cable.

High 1.01 Vpk ±1.2 dB. LBO = none.

900 0.35 Vpk ±2.0 dB. LBO = 900 ft simulated 728A cable.

Low 0.206 Vpk ±2.0 dB. LBO = Flat loss from High level.

STSX-1 Automatic equalizer for 0 to 900 ft of 728A cable.

High 1.01 Vpk input signal, nominal.

Mon Up to 26 dB flat loss relative to nominal STSX-1 level.
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STS-1 Drop 
Output
STS-1 DROP

Signal:

Line Code: B3ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECo 440. Optional WECo 358 or BNC.

STS-12 and STS-3 
I/O

These are the specifications for the optional rear-panel SONET 
electrical connectors. Option 205 is required for STS-12; Option US2 is 
required for STS-3.

Signals provided:

• Rx Data (input)

• Tx Data (output)

• Tx Clock (output).

Level: ECL.

Impedance: 50 Ohms.

Connectors: SMA (STS-12), BNC (STS-3).

Output Termination The following figures show acceptable terminations for the STS-12 and 
STS-3 electrical connectors.

Note: For STS-12 the Tx Data and Tx Clock outputs are ac coupled, therefore the 
receiving equipment must set the dc bias level. For STS-3 the Tx Data and 
Tx Clock outputs are dc coupled.

STSX-1 Per TR-NWT-000253 Section 4.4.  0.53 Vpk ±1.2 dB.
LBO = 450 ft simulated 728A cable.
Provides STS-1 dropped from higher-rate signal.

Acceptable terminations for STS-12 and STS-3 electrical outputs 
(Tx Data and Tx Clock)

470 Ω

–5.2 V –1.3 V

56 Ω

0.01 µF

196 Ω

–5.2 V

61.9 Ω
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Input Termination The Rx Data input termination is as follows:

Termination for the STS-12 electrical input (Rx Data)

Termination for the STS-3 electrical input (Rx Data)

196 Ω

–5.2 V

61.9 Ω

130 Ω

–5.2 V

82 Ω
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OC-N Optical Interfaces

Transmitter: Transmitters are hermetic, InGasAsP lasers optically 
coupled to a 5D, 8 m core, single-mode fiber pigtail.

Receiver: Receivers are planar, InGaAs PIN photodetectors with a 62.5 
multi-mode fiber pigtail. When connecting to a single-mode source, you 
can use a single-mode or multi-mode fiber patch cable. When 
connecting to a multi-mode (LED) source, you must use a multi-mode 
fiber patch cable.

Note: When connecting a long reach (LR) laser transmitter to the receiver, either 
from the network or when looping the test set back on itself (LR laser installed), 
be sure to provide 8 dB of attenuation to avoid damaging the receiver.

OC-12/OC-3/OC-1 Optical Interfaces

OC-12/OC-3/OC-1
Intermediate Reach
1310 nm (622 Mbs)
Option UQK

OC-12/OC-3/OC-1
Long Reach
1310 nm (622 Mbs)
Option UQL

OC-12/OC-3/OC-1
Long Reach
1550 nm (622 Mbs)
Option UQM

Min. Max. Typ. Min. Max. Typ. Min. Max. Typ.

Transmitter

Avg. Optical Power (dBm) –12.0 –5.0 –8.0 –3.0 +2.0 0.0 –3.0 +2.5 0.0

Optical wavelength (nm) 1260 1360 1310 1280 1335 1310 1500 1580 1550

Receiver

Optical Sensitivity (dBm) –26.0 • –28.0 –26.0 • –28.0 –26.0 • –28.0

Peak input power (dBm) • –7.0 • • –7.0 • • –7.0 •

Optical Wavelength (nm) 1240 1380 • 1240 1380 • 1500 1570 •

Connectors PC/PC connectors are standard. Optional ST, D4-PC, or SC connectors 
are available.
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OC-3/OC-1 Optical Interfaces

STS-N Timing

Internal Source Stratum 3: 51.84 MHz, ±4.5 ppm.

External Source 
Inputs

STS1 TX CLK IN jack: TTL level, 50 ohm, BNC connector.

DS1 BITS IN jack: DSX-1 input signal per ANSI T1X1, CB119, and 
TR-TSY-000449.

• 1.544 MHz, SF-framed, all-ones pattern.

• 3.0 Vpk ±1.0 dB (0 dBdsx) typical expected.

• 100 ohm, WECo 310 connector.

• DS1 BITS OUT jack provides output signal as described above.

OC-3/OC-1
Intermediate Reach
1310 nm (155 Mbs)
Option UQG

OC-3/OC-1
Long Reach
1310 nm (155 Mbs)
Option UQH

OC-3/OC-1
Long Reach
1550 nm (155 Mbs)
Option UQJ

Min. Max. Typ. Min. Max. Typ. Min. Max. Typ.

Transmitter (OC-N TX)

Avg. Optical Power (dBm) –15.0 –8.0 –11.0 –3.0 +2.0 0.0 –3.0 +2.0 +2.0

Optical wavelength (nm) 1260 1360 1310 1280 1335 1310 1500 1580 1550

Receiver (OC-N RX)

Optical Sensitivity (dBm) –28.0 • –34.0 –28.0 • –34.0 –28.0 • –34.0

Peak input power (dBm) • –7.0 • • –7.0 • • –7.0 •

Optical Wavelength (nm) 1240 1380 • 1240 1380 • 1500 1570 •

Connectors PC/PC connectors are standard. Optional ST, D4-PC, or SC connectors 
are available.
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STS-1 Jitter Option Specifications

STS-1 jitter measurement requires STS-1 testing (standard base unit or 
Option UQC) and Option UQN.

Measurement 
Response

STS-1 Jitter Measurement per: TR-NWT-000253

Wideband cutoff frequency: 100 Hz to 400 kHz

Highband cutoff frequency: 20 kHz to 400 kHz

Roll-off (per decade) below lower 3 dB point: ≥20 dB

Roll-off (per decade) above higher 3 dB point: ≥60 dB

Jitter 
Measurements

Demodulated 
Jitter Output

DMOD JITTER OUT jack: 50 ohm, BNC connector. 
Scale = 100 mV/UI; range = 0 to 6 Vdc.

Measurement Range Resolution Accuracy

Maximum Peak Positive Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Maximum Peak Negative Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Current Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Max Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Wideband Mask Highband Mask

Percent of Mask 1.5 UI 0.2 UI
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SONET Formats

SONET Network 
Spans—Path, 
Line, and Section

STS-1 Frame

SONET
Terminal

Mux

SONET
Digital Cross-connect

System

SONET
Regenerator

SONET
Regenerator

SONET
Terminal

Mux

Path

Line Line

Section Section Section

A1 A2 J0 J1
B1 E1 F1 B3
D1 D2 D3 C2
H1 H2 H3 G1
B2 K1 K2 F2
D4 D5 D6 H4
D7 D8 D9 Z3

D10 D11 D12 Z4
S1 M0 E2 Z5

1 2 3 4 90Columns of Bytes

1

9

Rows

Path
Overhead

Section
OH

Line
OH

Synchronous Payload Envelope (SPE)

Transport
Overhead

125 µs
51.840 Mbs
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STS-N Frame

1

9

Rows

Path OH =
N × 1 Columns

A1
B1
D1
H1
B2
D4
D7

D10
Z1

A1
B1
D1
H1
B2
D4
D7

D10
Z1

A1
B1
D1
H1
B2
D4
D7

D10
S1

A2
E1
D2
H2
K1
D5
D8

D11
Z2

J0
F1
D3
H3
K2
D6
D9

D12
E2

J1
B3
C2
G1
F2
H4
Z3
Z4
Z5

A2
E1
D2
H2
K1
D5
D8

D11
Z2

A2
E1
D2
H2
K1
D5
D8

D11
Z2

Z0
F1
D3
H3
K2
D6
D9

D12
E2

Z0
F1
D3
H3
K2
D6
D9

D12
E2

J1
B3
C2
G1
F2
H4
Z3
Z4
Z5

J1
B3
C2
G1
F2
H4
Z3
Z4
Z5

#N#2#1STS-1: #N#2#1 #N#2#1 #N#2#1

SPE = N × 87 ColumnsTransport OH = N × 3 Columns

STS-1s are byte-interleaved to form STS-N.

#3 N × 125 µs
N = 3: 155.520 Mbs
N = 12: 622.080 Mbs
N = 48: 2.488 Gbs

A2
E1
D2
H2
K1
D5
D8

D11
M1
5–9



SONET Specifications

SONET Formats

SO
N

ET
SONET Overhead Bytes

Network Span Byte Description

Section Overhead

A1/A2 Framing. Pattern = 11110110 00101000 (F6 28 hex).

J0/Z0 J0 (STS-1 #1) = Section trace. Z0 = Growth. (Formerly C1)

B1 Section bit-interleaved parity (BIP-8) code.

E1 Local orderwire channel.

F1 Section user channel.

D1–D3 Section data communication channel (DCC).

Line Overhead

H1–H3 Payload pointers.

B2 Line bit-interleaved parity (BIP-8) code.

K1/K2 Automatic protection switching (APS) channel,
also Line AIS and Line ROI indication.

D4–D12 Line data communication channel (DCC).

S1/Z1 S1 (STS-1 #1) = Synchronization status. Z1 = Growth.

M0
M1
Z2

M0 (STS-1/OC-1 signals only): bits 5–8 = Line FEBE
M1 (STS-1 #3 of STS-N≥3 signals) = Line FEBE.
Z2 (other STS-1s) = Growth.

E2 Express orderwire channel.

Path Overhead

J1 Path trace.

B3 Path bit-interleaved parity (BIP-8) code.

C2 Path signal label.

G1 Path status. Bits 1–4 = path FEBE; bits 5–6 = path ROI.

F2 Path user channel.

H4 VT multiframe phase indicator.

Z3/Z4 Future growth.

Z5 Tandem connection error count and data link.
5–10



SONET Specifications

SONET Formats

SO
N

ET
STS-3c Frame (concatenated SONET signal)

STS-Nc Frame

A2 A2 J0 Z0
F1
D3

H2c H3
K2
D6
D9

D12
M1 E2

1

9

Rows

A2A1

H1c
B2

Z1

A1

H1c
B2

Z1

A1
B1
D1
H1
B2
D4
D7

D10
S1

Z0 J1
B3
C2
G1
F2
H4
Z3
Z4
Z5

H2c

Z2

E1
D2
H2
K1
D5
D8

D11
Z2

H3 H3

#2#1 #2#1 #2#1 #3#2#1STS-1:

uo uo
uo uo

uo uo
uo uo

uo uo
uo uo

uo uo
uo uouo uo

uo uo uo uo uo uo
uo uo
uo uo

uo uo uo uo uo uo
uo uo

#3#3#3

SPE = 261 ColumnsTransport OH = 9 Columns

Path OH = 1 ColumnH1c/H2c = Concatenation Indication
H1c = 10010011
H2c = 11111111

uo = Undefined overhead byte

1

9

Rows

(N × 3)–1
Columns

A1
uo
uo

H1c
B2
uo
uo
uo
Z1

A1
uo
uo

H1c
B2
uo
uo
uo
Z1

A1
B1
D1
H1
B2
D4
D7

D10
S1

A2
E1
D2
H2
K1
D5
D8

D11
Z2

J0
F1
D3
H3
K2
D6
D9

D12
E2

J1
B3
C2
G1
F2
H4
Z3
Z4
Z5

A2
uo
uo

H2c
uo
uo
uo
uo
Z2

A2
uo
uo

H2c
uo
uo
uo
uo
Z2

Z0
uo
uo
H3
uo
uo
uo
uo
uo

Z0
uo
uo
H3
uo
uo
uo
uo
uo

fs fs

#N#2#1STS-1: #N#2#1 #N#2#1 #N#2#1

SPE = N × 87 ColumnsTransport OH = N × 3 Columns

#3

A2
uo
uo

H2c
uo
uo
uo
uo
M1

fs fs
fs fs
fs fs
fs fs
fs fs
fs fs
fs fs
fs fs

Path OH = 1 Column
H1c/H2c = Concatenation Indication
uo = Undefined overhead byte
fs = Fixed stuff byte
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VT1.5 Format and Mapping

J1
B3
C2
G1
F2
H4
Z3
Z4
Z5

V 2 3
4

27

V V V2 3
4

27

5 6
7 8 9

10 11 12
13 14 15
16 17 18
19 20 21
22 23 24
25 26

V1
4
7

10
13
16
19
22
25 Gr

ou
p 

2 
/ V

T1
.5

 #
1 

/ C
ol

um
n 

1

Gr
ou

p 
1 

/ V
T1

.5
 #

4 
/ C

ol
um

n 
1

Gr
ou

p 
1 

/ V
T1

.5
 #

3 
/ C

ol
um

n 
1

Gr
ou

p 
1 

/ V
T1

.5
 #

2 
/ C

ol
um

n 
1

Gr
ou

p 
2 

/ V
T1

.5
 #

2 
/ C

ol
um

n 
1

Gr
ou

p 
7 

/ V
T1

.5
 #

4 
/ C

ol
um

n 
1

Gr
ou

p 
1 

/ V
T1

.5
 #

1 
/ C

ol
um

n 
2

Gr
ou

p 
1 

/ V
T1

.5
 #

2 
/ C

ol
um

n 
2fs

fs
fs
fs
fs
fs
fs
fs
fs Gr

ou
p 

7 
/ V

T1
.5

 #
4 

/ C
ol

um
n 

2 fs
fs
fs
fs
fs
fs
fs
fs
fs Gr

ou
p 

1 
/ V

T1
.5

 #
1 

/ C
ol

um
n 

3

Gr
ou

p 
7 

/ V
T1

.5
 #

4 
/ C

ol
um

n 
3

1 29 30 31 58 59 60 87Column #:

VT1.5 #1 VT1.5 #2 VT1.5 #3 VT1.5 #4

VT Group #1

STS-1 SPE

VT1.5 SPE
(26 bytes)

V5
1

25
J2
1

25
Z6
1

25
Z7
1

25

V1
1

26
V2
1

26
V3
1

26
V4
1

26

VT1.5
Superframe

VT1.5 SPE = 4 bytes POH
+ 100 bytes capacity

VT mapping uses seven groups
of four VTs each.
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VT Overhead Bytes

Overhead Byte Description

STS Path 
Overhead

H4 VT multiframe phase indicator.

VT Path 
Overhead

V1/V2 VT payload pointer.

V3 VT pointer action byte.

V4 Undefined.

V5 Bits 1–2: VT bit-interleaved parity (BIP-2) code.
Bit 3: VT path FEBE
Bits 4 and 8: path remote defect indication (RDI-V)
Bits 5–7: VT path signal label.

J2 VT path trace.

Z6 Growth.

Z7 Growth.
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Set up for DS3 Testing

DS3 testing features are available whenever the transmitter, receiver, or 
payload are configured for DS3.

1. From the Main Menu press FIELD to select a testing mode 
(Terminal, Monitor, or Drop & Insert).

2. Press MENU-down. The test setup screen for the mode you selected 
is displayed (this example shows Terminal testing mode).

Example DS3 Application

CERJAC
Test Set

DSX-3

         TERMINAL TESTING

Tx Rate: DS3           Rx Rate: Dual DS3

Payload: DS3

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press MENU-down to enter test mode.
Press MENU-up to return to Main Menu.
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Set up for DS3 Testing
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3. Use the FIELD and VALUE keys to set the transmitter (Tx Rate) 
and receiver (Rx Rate). For Monitor and D&I mode tests the 
transmitter and receiver are set together (Tx/Rx Rate).

For test sets with receiver-only 
dual DS3, only Rx Rate: can 
be set to Dual DS3.

• For a dual DS3 test, set one or both of TX Rate and RX Rate to 
Dual DS3. If different, the other rate must be set to DS3 or DS1.

• If you are testing a DS3 that is the payload of a higher-rate signal, 
set the transmitter and receiver as appropriate for that higher 
rate.

4. Next press the right FIELD key to select the Payload parameter. 
Use VALUE to set the payload as appropriate for your application.

• Remember that one of the transmitter, receiver, or payload must be 
set to a DS3 selection.

5. Press MENU-down. The DS3 operation screen is displayed (see next 
section).
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Configure the DS3 Signal

Note that the screen may appear differently depending on the test mode 
you selected.

Note: For dual DS3 testing the parameters on this screen configure the DS3-A signal.

1. Use the FIELD and VALUE keys to set the transmit signal level (Tx) 
and the receive signal level (Rx). If you are testing a DS3 signal 
dropped from a higher-rate signal, the Tx and Rx fields do not apply 
and are not displayed.

2. Use FIELD and VALUE to set the framing format (Frm), the payload 
data pattern (Data), and the transmit timing source (TxClk). If you 
select Progr (programmable pattern) for Data, you can set the 
pattern as desired (see Configure the DS3 User Test Pattern, page 6–9).

3. Next set the FEBE bits (FEBE) and the transmitted X-bit (XBit).

• If you are performing a dual DS3 test, access the Dual DS3 Control 
configuration screen to configure the DS3-B signal (see Configure the 
DS3-B Signal (Dual DS3 only), page 6–5).

• If you are testing a DS3 signal dropped from a higher-rate signal, 
configure the higher-rate signal parameters for your application.

• If you selected C-Bit parity framing, you can set the C-bits and FEAC 
channel next. See Configure DS3 Overhead Parameters, page 6–7.

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Summary      DS3-A         DS3-B
 Bit:            --               --
 Frame:          --               --
 P-Bit:          --               --
 BPV:            --               --

DS3:   Tx>DSX3       Rx>DSX3
      Frm>M13      Data>2^15-1
    TxClk>Int      FEBE>111   XBit>1

Err: Type>DS3 Data      Rate>Single
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Configure the DS3-B Signal (Dual DS3 only)

Note: At least one of the Tx Rate and Rx Rate parameters must be set to Dual DS3. 
See Set up for DS3 Testing, page 6–2.

1. From the DS3 test operation screen, press MENU-down. The control 
screens menu is displayed.

2. Use FIELD to select Dual DS3 Control and then press 
CONFIG-right. The Dual DS3 Control screen is displayed.

3. Use VALUE to select from which DS3 signal the test set drops and 
inserts DS1 channels (DS1 From DS3).

4. Press FIELD and then use VALUE to set the operation of the 
front-panel DS3 LED indicators.

5. Next use FIELD and VALUE to set the signal parameters for DS3-B 
as you did for DS3-A (see Configure the DS3 Signal, page 6–4).

Note: For test sets with receiver-only dual DS3, the DS3-B parameters apply only to 
the receiver. The DS3-B transmit signal is a passthrough of the receive signal.

• After you finish configuring both DS3 signals, you are ready to begin 
the test. See Run the DS3 Test, page 6–10.

Í

  Global Settings  |  DS3 Prog Pattern
  DS3 FEAC Control |
  DS3 C-Bit Control|
  Dual DS3 Control |
  Data Link Control|
  DS3 Pulse Mask   |

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Summary      DS3-A         DS3-B
 Bit:            --               --
 Frame:          --               --
 P-Bit:          --               --
 BPV:            --               --

Dual: DS1 from DS3>A  Shared LED>None
DS3B:  Tx>DSX3        Rx>DSX3
      Frm>M13       Data>2^15-1
    TxClk>Int       FEBE>111   XBit>1
DS1: Drop>1  Insert>1  Other>Same
Err: Type>DS3 Data      Rate>Single
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Configure Other Signal Parameters

If you are testing a DS3 signal that is dropped and inserted from a 
SONET signal, the DS3 signal is mapped to an STS-1 signal. If necessary, 
the STS-1 is mapped into a higher-rate SONET signal. You must 
configure the SONET signal parameters to match your application.

1. On the test operation screen, use FIELD and VALUE to set the signal 
and STS-1 parameters. This example shows the DS3 carried in an 
STS-1 which is mapped to an OC-12 signal.

Note: For Monitor mode tests, the transmit functions are not available (insert 
channel, other, etc).

You can change the STS-12 
numbering scheme. 
See STS-12 Channel 
Numbering Scheme, page 3–4.

2. Set STS1: INS> to select the STS-1 signal onto which the DS3 
signal is mapped.

3. Set Other to configure the remaining STS-1s.

4. Next select Drop and choose which STS-1 is dropped from the 
receive signal.

5. Set Scramble to activate or deactivate STS-1 scrambling.

6. Set the transmit timing source (STSN: TxClk>) and receive port 
(Rx>) for the higher-rate SONET signal.

• After you finish configuring the DS3 and SONET signal parameters 
you already to run the test. See Run the DS3 Test, page 6–10.

 1 OC12-OC12 (DS3)  Final:  00:00:00.00 
OC12 Measurement Summary
B1 (Sect CV):    --    Sec Ago:    --
B2 (Line CV):    --                --
OC12 Rx Hz:      --
STS-1 Drop Hz:   --    Rx Opt dBm: --

Í
Í
Í

DS3:     Frm>M13       Data>2^15-1
       TxClk>Int       FEBE>111  XBit>1
STS1:    Ins>1,1      Other>Same
        Drop>1,1   Scramble>On
STSN:  TxClk>Int         Rx>OC
Err:    Type>DS3 Data    Rate>Single
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Configure DS3 Overhead Parameters

The DS3 FEAC control and C-bit control features allow you to configure 
the DS3 signal overhead bits. To access the FEAC and C-bit control 
functions, select the appropriate item from the control screens menu.

Configure FEAC 
Transmission

To access the FEAC control functions, select DS3 FEAC Control from 
the control screens menu and press CONFIG-right. The DS3 FEAC 
Control screen is displayed on the bottom of the screen.

1. Press VALUE to set continuous code transmission on or off.

2. Press the right FIELD key and use VALUE to select what is 
transmitted when a FEAC burst is activated.

3. Next set the number of codes sent in a burst (Burst of).

4. Select the Alarm/Status parameter and use VALUE to select the 
FEAC code to be transmitted.

5. Select Loopback line to select the signal to be affected when a 
FEAC loop-up or loop-down code is transmitted.

6. Press ACTION to activate the FEAC burst.

Í
Í

  Global Settings  |  DS3 Prog Pattern
  DS3 FEAC Control |
  DS3 C-Bit Control|
  Dual DS3 Control |
  Data Link Control|
  DS3 Pulse Mask   |

            DS3 FEAC Control
Continuous Alarm/Status>Off
FEAC burst>None              Burst of>10
Alarm/Status>DS3 Eqpt Fail (SA)...011001
Loopback line>DS3 Line............011011
>>>>Press ACTION to send FEAC burst<<<<
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Configure C-Bit 
Transmission

To access the C-bit control functions, select DS3 C-Bit Control from 
the Control Screens menu and press CONFIG-right. The DS3 C-Bit 
Control screen is displayed.

1. Use FIELD to select the individual C-bits and then use VALUE to set 
them to either 1 or 0.

• C-bits displayed with an x are not user editable.

• C-bits displayed with an * are not editable from the DS3 C-Bit 
Control screen, but can be controlled using the FEBE parameter 
on the DS3 test operation screen.

2. When you have finished editing the C-bits, press CONFIG-right to 
return to the test operation display.

           DS3 C-Bit Control

 Program Bits:   |Use Data Link Control 
                 |screen for inserting
 Row  C1  C2  C3 |external Data.
  1   x   1   1  |
  2   1   1   1  |
  3   x   x   x  |
  4   *   *   *  |
  5   1   1   1  |
  6   1   1   1  |
  7   1   1   1  | * Use FEBE Settings
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Configure the DS3 User Test Pattern

The 156MTS has a 
programmable DS3 test 
pattern. You can edit the 
pattern bit sequence to meet 
your needs.

To use the DS3 user pattern set the Data> field to Progr on the test 
operation screen.

Follow this procedure to configure the DS3 user test patterns.

1. From the test operation screen press CONFIG-right. The control 
screens menu is displayed.

2. Select DS3 Prog Pattern and press CONFIG-right. The DS3 Prog 
Pattern  screen is displayed.

3. Use FIELD and VALUE to select the bits in the DS3 loop code and 
set them to binary 1 or 0.

4. When you have finished programming the pattern press 
CONFIG-right to return to the test operation screen.

DS3:   Tx>DSX3       Rx>DSX3
      Frm>M13      Data>Progr
    TxClk>Int      FEBE>111   XBit>1

Err: Type>DS3 Data      Rate>Single

Í

Global Settings  |
DS3 FEAC Control |
DS3 C-Bit Control|
Data Link Control|
DS3 Pulse Mask   |
DS3 Prog Pattern |

DS3 Prog Pattern

DS3 Prog Pat:   11110000

Ì
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Run the DS3 Test

After you have configured the DS3 signal, DS3 overhead, and SONET 
signal parameters you are ready to begin the test.

1. Connect the signals to be tested. If you are performing a dual DS3 
test, connect the DS3-B transmit and receive signals to the 
appropriate jacks on the rear optional connector panel.

2. Press START to begin testing. On the first line of the display the 
elapsed time begins to increment.

3. If you want to inject errors on the DS3 signal, use FIELD and VALUE 
to set the appropriate Err Type and Rate. Press ERROR 
INJECTION to activate and deactivate error injection.

Note: For dual DS3 tests, you must be on the DS3-A or DS3-B configuration screen 
(in the lower half of the display) to inject errors on that signal.

4. Use the RESULT keys to view different measurement screens in the 
top half of the display. You may need to adjust the results level to 
view more measurements (see To Display More Measurement Screens, 
page 1–11).

5. To end the test, press STOP.
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Perform a DS3 Pulse Mask Test

To perform DS3 Pulse Mask 
testing your test set must have 
option 202.

The DS3 Pulse Mask testing feature allows you to evaluate the shape of 
a received DS3 pulse (a positive or negative pulse represents a binary 1) 
and compare it to one of a set of standardized “masks” (ranges that set 
ideal wave shape boundaries).

Set up for a Pulse 
Mask Test

The 156MTS can perform pulse mask testing any time the receiver is set 
for DS3 (Rx Rate: DS3). Configure the other DS3 signal parameters as 
you would for any DS3 test. See Set up for DS3 Testing, page 6–2.

Set up the Pulse 
Mask Parameters

• To access the DS3 Pulse Mask setup parameters, select 
DS3 Pulse Mask on the Control Screens  menu.

1. Press CONFIG-right. The DS3 Pulse Mask Control screen is shown 
in the lower half of the display.

2. Use the VALUE keys to select a pulse mask (Mask>).

3. Next press use FIELD and VALUE to select a mask Tolerance. You 
can use the X% choices to loosen the mask specifications.

4. Select Polarity> and use the VALUE keys to select whether you 
want to measure positive pulses, negative pulses, or both.

Í

Global Settings  |
DS3 FEAC Control |
DS3 C-Bit Control|
Data Link Control|
DS3 Pulse Mask   |
DS3 Prog Pattern |

         >DS3 Pulse Mask Control<
Mask>None               Tolerance>Spec
Polarity>Positive
----------------------------------------
With test running, press ACTION to
start/stop Pulse Mask acquisition.
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Run the Pulse 
Mask Test

Pulse mask testing can only be performed while the DS3 Pulse Mask 
Control screen is displayed.

1. Check the results level to make sure that you will be able to view 
the measurement screens you want. See To Display More 

Measurement Screens, page 1–11.

2. Make sure the DS3 Pulse Mask Control screen is displayed.

3. Press START to begin a DS3 test.

4. Use the RESULT keys to scroll the top half of the display to show 
the Positive or Negative Pulse Mask results screen.

5. Press ACTION to begin the pulse mask test.

The bottom line of the results screen changes to show the status of 
the pulse mask test, for example “Acquiring Positive One Data,” 
Calculating Results,” and so forth.

You can obtain a graphical 
display of DS3 pulses using the 
CERJAC Pulse Mask Graphic 
software for Windows and a 
PC. Refer to the Pulse Mask 
Graphic User’s Manual, 
contact your HP 
representative, or call 
1-800-9-CERJAC.

6. When the test is complete, observe the data on the results screen. 
Pulse mask parameters are displayed as “Pass” (meets mask 
specifications) or “Fail” (does not meet specifications), or as their 
numerical values.

For more information on pulse mask measurements, see DS3 Pulse 

Mask Screens, page 8–18.

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
Positive Pulse Mask:     -- Tol:    --
Pulse Fit:       --  Imbal:         --
Rise Time:       --    Amp:         --
Fall Time:       --  Width:         --
 Pulse Mask test has not been started

         >DS3 Pulse Mask Control<
Mask>None               Tolerance>Spec
Polarity>Positive
----------------------------------------
With test running, press ACTION to
start/stop Pulse Mask acquisition.
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DS3 Setup Parameters

DS3 parameters are applicable when the transmitter, receiver, or 
payload is set for DS3. Not all DS3 parameters apply for every test 
mode, but DS3 setup parameters typically appear on the screen similar 
to the following:

Transmit DS3 
Level

DS3: Tx> sets the DS3 transmit signal level at the DS3 TX jack. This 
parameter is not available when the DS3 signal is the payload of a 
higher-rate signal. Tx> can be set as follows:

DSX3: DS3 cross-connect level. LBO of 450 feet simulated cable.

High: High-level signal. No LBO.

Low: Low-level signal. Flat loss from High level.

900’: LBO added simulating 900 feet of cable.

Receive DS3 Level DS3: Rx> selects the input level for the receive DS3 signal. This 
parameter is not available when the DS3 signal is the payload of a 
higher-rate signal. Rx> can be set as follows:

DSX3: Automatic equalizer for 0 through 900 feet of cable.

High: Nominal 0.91 Vpk input signal.

Low: Nominal 0.186 Vpk input signal.

Monitor: Up to 26 dBdsx flat loss.

DS3 Framing 
Format

DS3: Frm> selects the transmit and receive DS3 signal framing format. 
DS3: Frm> can be set to either M13, CBit (C-bit Parity format), or 
Unfrm (unframed).

DS3:   Tx>DSX3       Rx>DSX3
      Frm>M13      Data>2^15-1
    TxClk>Int      FEBE>111   XBit>1

Err: Type>DS3 Data      Rate>Single
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DS3 Payload DS3: Data> selects the payload for the DS3 signal. The choices for 
DS3: Data> are described in the following table.

DS3 Payload Selections

DS3: Data> 
Selection

Payload 
Description

2^15-1 A 215–1 pseudorandom bit sequence (PRBS). This is a 
15-stage PRBS generator with feedback taps at 14 and 15.

2^20-1 A 220–1 PRBS. 20-stage with feedback taps at 17 and 20.

2^23-1 A 223–1 PRBS. 23-stage with feedback taps at 18 and 23.

Progr User-defined pattern. See User-Programmable DS3 Pattern, 
page 7–14.

AIS DS3 alarm indication signal. Valid framing and parity bits, all 
C-bits set to 0, and data bits set to a repeating 1010... pattern.

All Ones All binary ones pattern. Framing depends on DS3: Frm>.

Passthru The received DS3 signal is passed through to the transmit 
DS3 port as-is. Errors can be injected on the pass-through 
signal, except in monitor mode.

Idle Repeating 1100... pattern in the informations bits. Also: valid 
framing bits, C-bits set to 0 in M-subframe 3, and X1 and X2 
set to 1. Overrides DS3: Frm> selection.

Live No pattern. The receiver does not try to synchronize to a 
pattern.

Ext A signal applied at the front-panel DS3 RX port is used as the 
transmit DS3. This selection is available only when the DS3 
signal is the payload in a higher-rate signal.

Loop The DS3 signal dropped from a higher-rate signal is used as 
the transmit DS3 signal. This selection is available only when 
the DS3 signal is the payload in a higher-rate signal.
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Transmit Timing 
Source

DS3: TxClk> selects the DS3 transmit timing source. This parameter 
can be set as follows:

Int: Timing is from the 156MTS’s internal clock.

Ext: Timing is derived from the rear-panel DS3 TX CLK IN port.

Loop: Timing is derived from the receive or drop DS3 signal.

Note: If DS3: Data> is set to Ext, the transmit timing is derived from the input signal.

FEBE Bit Status FEBE> sets the value of the three transmit Far-end Block Error 
(FEBE) bits. These bits are C41, C42, and C43, and each can be set to 
either 1 or 0.

X-Bit Status DS3: XBit> sets the value of the transmit X1 and X2 bits 
simultaneously. XBit> can be set to 1 (X1 and X2 both set to 1) or 0 
(both set to 0).

DS3 Drop & Insert For DS3 testing on a SONET signal, one DS3 signal is mapped to and 
from an STS-1 signal. For STS-1, there is no drop and insert channel to 
select. For STS-N, the drop and insert is defined by the STS-1 Drop and 
Ins fields. See STS-1 Payload Setup Parameters, page 3–7.

Note that the DS3 DROP jack provides the DS3 signal dropped from the 
selected drop STS-1 or from the STS-1 RX jack.

DS3 Jitter 
Thresholds

For information on setting the jitter hits thresholds, see Jitter 

Threshold Configuration, page 23–3.
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Dual DS3 Setup Parameters

Overview There are two dual DS3 options available for the 156MTS. Each 
provides a second, independent DS3 interface, referred to as “DS3-B.”

• Full dual DS3 provides both a DS3 transmitter and receiver that 
allows full DS3 testing on two separate DS3 facilities 
simultaneously (requires Option UQZ).

• Receiver-only dual DS3 provides a DS3 receiver with a pass 
through to the DS3-B transmit port (requires Option 0YJ).

RX
“A”

TX
“A”

RX
“B”

TX
“B”

RX
“A”

TX
“A”

RX
“B”

RX TX

Pass Through

Single DS3

Full Dual DS3
(Option UQZ)

Dual-receiver DS3
(Option 0YJ)
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Transmit and 
Receive Rates

Dual DS3 setup parameters are available when the transmitter 
(TxRate>) or receiver (RxRate>) is set for Dual DS3. For 
receiver-only dual DS3, only the receiver can be set to Dual DS3.

Configuration of the second DS3 interface is accessed by selecting 
Dual DS3 Control from the Control Screens menu. The DS3-B setup 
parameters are displayed on the screen similar to the following:

For receiver-only dual DS3, the DS3-B setup screen is shown as 
follows:

DS1/E1 Drop 
Selection

The Dual: DS1 from DS3> (or DS1 Drop From>) field selects which 
DS3 interface is used to drop the DS1/E1 signal and display DS1/E1 
results. This parameter can be set to either A or B (DS3A or DS3B).

DS3 LED Setup Shared LED> determines how the front-panel DS3 ALARMS and 
STATUS indicators are implemented in dual DS3 mode:

None: LEDs are not shared; the front-panel LEDs show only DS3-A 
information.

Alarm: ALARMS indicators only are shared, indicating when there is a 
current error or history state on either the receive DS3-A or DS3-B.

Alm/Stat: ALARMS and STATUS indicators are shared; indicating 
when there is alarm, history, and signal status conditions on either the 
receive DS3-A or DS3-B.

Dual: DS1 from DS3>A  Shared LED>None
DS3B:  Tx>DSX3        Rx>DSX3
      Frm>M13       Data>2^15-1
    TxClk>Int       FEBE>111   XBit>1
DS1: Drop>1  Insert>1  Others>Same
Err: Type>DS3 Data       Rate>Single

          >>Dual DS3 Control<<
DS3B:   RxFrm>M13       RxData>2^15-1
      RxLevel>DSX3   Drop Chan>1
      Passthrough Error Rate>Single
DS1 Drop From>DS3A
Shared LEDs>None
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DS3-B Error Rate Passthrough Error Rate> sets the error injection rate (receiver-only 
dual DS3 modes only). Test sets with receive-only dual DS3 can inject 
logic errors on DS3-B as configured by this field. This field can be set to 
Single, 1.0E-2 through 1.0E-9, and Off.

Note: Test sets with full dual DS3 test sets can inject errors on DS3-B in the same 
manner as for DS3-A.

DS3-B 
Configuration

The setup parameters for the second DS3 interface (DS3-B) are the 
same as for the first DS3 interface (DS3-A, see DS3 Setup Parameters, 
page 7–2). However the configuration of DS3-B is completely 
independent of DS3-A. Note that DS3-B can drop and insert DS1/E1 
channels (using DS3B: Data>DS1 Data) even if DS3-A is not 
configured for DS1/E1 traffic.

The DS3-B signal is input and output through the rear-panel DS3-B RX 
and DS3-B TX connectors installed on the optional connector panel.

Note: For receive-only dual DS3, only the receiver parameters apply.

Note: For DS3 monitor modes with an E1/TS payload, error injection is not available.
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DS3 FEAC Channel Parameters

The 156MTS allows you to program what messages are transmitted on 
the far-end alarm and control (FEAC) channel. FEAC parameters are 
applicable when the DS3 framing format is set for C-bit parity.

FEAC setup parameters are accessed by selecting DS3 FEAC Control 
from the Control Screens menu.

Continuous FEAC 
Transmission

Continuous Alarm/Status> sets continuous transmission of the 
selected FEAC code (see Alarm/Status) On or Off. When this 
parameter is set to Off, FEAC Burst transmission is still available.

FEAC Code Type FEAC Burst> selects the type of code transmitted when a FEAC burst 
is activated by the ACTION key. FEAC Burst> can be set as follows:

None: No codes are transmitted.

Loopback Activate: The loop up code for the selected 
Loopback Line is transmitted when the ACTION key is pressed.

Loopback Deactiv: The loop down code for the selected 
Loopback Line is transmitted when the ACTION key is pressed.

Alarm/Status: The FEAC alarm or status code as determined by the 
selected Alarm/Status is transmitted when the ACTION key is pressed.

FEAC Burst 
Length

Burst of> sets the number of times the selected FEAC code is 
transmitted when the ACTION key is pressed. Burst of> can be set 
from 03 through 15.

FEAC Alarm and 
Status Codes

Alarm/Status> selects the FEAC code to be transmitted when 
Continuous Alarm/Status> is set to On or when FEAC Burst> is set 
to Alarm/Status (see page 7–8).  The FEAC code is 16 bits (2 bytes) 
long. All eight bits in the first byte are set to a logic 1 and serve as a flag 
indicating the start of the code. 

            DS3 FEAC Control
Continuous Alarm/Status>Off
FEAC Burst>None              Burst of>10
Alarm/Status>DS3 Eqpt Fail (SA)...011001
Loopback line>DS3 Line............011011
>>>>Press ACTION to send FEAC burst<<<<
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The second byte of the FEAC code  has a leader bit zero, then  6-bit 
FEAC code (selections listed below), and followed a trailer zero. The 
code selection is sequenced between leading and trailing 0’s. The 
meanings of the various FEAC codes are defined in the table below. 

Alarm/Status> Field FEAC Code Selections

FEAC Code Bit Sequence
Decimal 
Equivalent Description

DS3 Eqpt Fail (SA) 011001 25 DS3 service-affecting equipment failure

DS3 LOS/HBER 001110 14 Loss of signal/High bit error ratio

DS3 Out-of-Frame 000000 0

DS3 AIS Received 010110 22 Alarm indication signal

DS3 IDLE Received 011010 26

DS3 Eqpt Fail (NSA) 001111 15 DS3 non-service-affecting equipment failure

Com Eqpt Fail (NSA) 011101 29 Non-service-affecting common equip. failure

Multi DS1 LOS/HBER 010101 21 Multiple DS1 loss of signal/high bit error ratio

DS1 Eqpt Fail (SA) 000101 5 Service-affecting DS1 equipment failure

Single DS1 LOS/HBER 011110 30 Single DS1 loss of signal/high bit error ratio

DS1 Eqpt Fail (NSA) 000011 3 Non-service-affecting DS1 equipment failure

DS3 NIU Loop Up 001001 9 Network interface unit loop activation

DS3 NIU Loop Down 010010 18 Network interface unit loop deactivation

— — — All other bit sequences are unassigned.
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FEAC Loopback 
Line Selection

Loopback Line> selects which line is affected when FEAC Burst> is 
set to Loopback Activate or Loopback Deactiv (see page 7–8). The 
following table lists the choices for Loopback Line> and their 
corresponding FEAC bit sequences.

Loopback Line> Field FEAC Code Selections

Line Line Identifier Code Line Line Identifier Code

DS3 Line 011011 DS1 Line—#15 101111

DS1 Line—#1 100001 DS1 Line—#16 110000

DS1 Line—#2 100010 DS1 Line—#17 110001

DS1 Line—#3 100011 DS1 Line—#18 110010

DS1 Line—#4 100100 DS1 Line—#19 110011

DS1 Line—#5 100101 DS1 Line—#20 110100

DS1 Line—#6 100110 DS1 Line—#21 110101

DS1 Line—#7 100111 DS1 Line—#22 110110

DS1 Line—#8 101000 DS1 Line—#23 110111

DS1 Line—#9 101001 DS1 Line—#24 111000

DS1 Line—#10 101010 DS1 Line—#25 111001

DS1 Line—#11 101011 DS1 Line—#26 111010

DS1 Line—#12 101100 DS1 Line—#27 111011

DS1 Line—#13 101101 DS1 Line—#28 111100

DS1 Line—#14 101110 DS1 Line—All 010011
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DS3 C-Bit Configuration

You can set the status of many of the DS3 C-bits. C-bit control is 
available when the DS3 framing format is set to CBit and is accessed by 
selecting DS3 C-Bit Control from the Control Screens menu.

Restricted C-Bits C-Bits displayed with an x cannot be edited on this screen.

FEBE C-Bits The three C-bits in row 4 (FEBE bits, displayed as *) cannot be edited 
on this screen, but are set using FEBE> (see FEBE Bit Status, 
page 7–4).

Programmable 
C-Bits

The C-bits displayed as either 1s or 0s can be edited. Some bits may 
have specific functions in the DS3 signal as described below:

• C3 in row 1 (FEAC bit) may be overwritten by the setup on the 
FEAC control screen (see DS3 FEAC Channel Parameters, 
page 7–8).

See DS3 Datalink Parameters, 
page 7–15

• Rows 2, 6, and 7 can be used to form an 84.6 kbs data link that can 
be dropped and inserted using the rear-panel DATA LINK RS-232 
port.

• Row 5 can be used as the 28.2 kbs path maintenance data link 
(PMDL) and can be dropped and inserted using the rear-panel 
DATA LINK RS-232 port.

• Rows 6 and 7 can be used to form an 56.4 kbs data link that can be 
dropped and inserted using the rear-panel DATA LINK RS-232 port.

           DS3 C-Bit Control

 Program Bits:   |Use Data Link Control 
                 |screen for inserting  
 Row  C1  C2  C3 |external Data.
  1   x   1   1  |
  2   1   1   1  |
  3   x   x   x  |
  4   *   *   *  |
  5   1   1   1  |
  6   1   1   1  |
  7   1   1   1  | * Use FEBE Settings
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DS3 Pulse Mask Configuration

To perform DS3 Pulse Mask 
testing your test set must have 
Option 202.

DS3 Pulse Mask testing is available when the receiver is set for DS3 
(Rx Rate: DS3 or Dual DS3). Pulse mask parameters are accessed by 
selecting DS3 Pulse Mask from the control screens menu.

Note: For dual DS3 test set configurations, pulse mask testing is only available on the 
DS3 A signal.

Pulse Mask Type Mask> selects the pulse mask to be used for the pulse mask test. The 
available choices are:

A pulse mask is a standardized 
range defining the boundaries 
of an ideal waveform shape.

None: No mask is used. Mask fit and imbalance results are not 
applicable, but other results are still valid.

G.703: Pulse mask as defined by the proposed update to CCITT 
recommendation G.703 (DS3 Electrical Interface Spec. T1X1.4/95-013).

T1.102: Pulse mask as defined by ANSI specification T1.102.

T1.404: Pulse mask as defined by ANSI specification T1.404.

TR499: Pulse mask as defined by Bellcore specification 
TR-NWT-000499.

         >DS3 Pulse Mask Control<
Mask>None               Tolerance>Spec
Polarity>Positive
----------------------------------------
With test running, press ACTION to
start/stop Pulse Mask acquisition.
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Mask Tolerance 
Adjustment

Tolerance> specifies an adjustment to the pulse mask specification 
selected by Mask>. Tolerance> can be set as follows:

Spec: The selected mask specification is not adjusted.

3%: The selected mask specification is offset ±3 percent of the peak 
amplitude (see figure).

6%: The selected mask specification is offset ±6 percent of the peak 
amplitude (see figure).

Pulse Mask Tolerance Adjustment

Capture Pulse 
Polarity

Polarity> determines whether the test set evaluates a received positive 
voltage pulse (Positive), negative voltage pulse (Negative), or both 
(Pos + Neg). For mask imbalance measurements, both positive and 
negative pulses must be evaluated.
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User-Programmable DS3 Pattern

The user-programmable data pattern is accessed by selecting 
DS3 Prog Pattern from the Control Screens menu.

The DS3 programmable pattern configuration screen appears as 
follows:

The DS3 Prog Pat fields represent the bits the DS3 user pattern. Each 
bit can be set to 1, 0, or to a dot. A dot represents an unused bit position 
and is not transmitted. The pattern length can be from two through 
eight bits, and is defined by the number of bits set to 1 or 0.

The pattern is transmitted with the most significant bit following the 
frame bit (for pattern lengths that divide evenly into 84).

DS3 Prog Pattern

Í DS3 Prog Pat:   11110000
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DS3 Datalink Parameters

Selecting Data Link Control 
from the Control Screens menu 
displays the Data Link Control 
screen.

The Data Link Control screen configures the functionality of the 
rear-panel data link ports.

Note: For information on other data link rate uses, see SONET Datalink Control 
Parameters, page 3–20 or DS1 Data Link Parameters, page 11–16.

Rear-Panel RS-232 
Data Link Port

RS232> configures the rear-panel DATA-LINK RS-232 interface in both 
the transmit and receive directions. The choices for DS3 are as follows:

None: The RS-232 data link interface is disabled.

DS3 C-Bit PMDL (Row 5): The transmitted data on the Path 
Maintenance Data Link (PMDL; the three C-Bits in Row 5) is derived 
from input at the RS-232 data link port. Received data is transmitted on 
the port’s output (DS3 C-Bit format only).

DS3 C-Bit Rows 6 & 7: The transmitted data on the six C-Bits in 
Rows 6 and 7 (three bits in each row) is derived from the RS-232 
Data-Link port. Received data is transmitted on the port’s output (DS3 
C-Bit format only).

DS3 C-Bit Rows 2, 6, 7: The transmitted data on the nine C-Bits in 
Rows 2, 6, and 7 (three bits in each row) is derived from the RS-232 data 
link port. Received data is transmitted on the port’s output (DS3 C-Bit 
format only).

Note: The remaining data link parameters on this screen apply only for SONET rate 
testing. See SONET Datalink Control Parameters, page 3–20.

Í

            Data Link Control

RS232>None
RS422>None
Handset>None
DCC Pass-Thru>Off

OC-12 APS Pass-Thru>Off

----------------------------------------
Selection of data link insert or pass-
thru above overrides programmed byte
values.
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DS2 X-Bit Control

You can set the state of the transmit DS2 X-bit. Access the Auxiliary 
Test Setups screen from the Setup System Parameters screen.

VALUE toggles the X-bit state between binary 1 and 0.

Auxiliary Test Setups
Test Dur. Mode:   Continuous
Timer Duration:   00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Sub Menu Opt Pwr: Off   Auto Tst: Stop

Í

Pwr Up Optical Tx State:  Last State
STS12 # Scheme:   STS3#, STS1#
VT Counting: VT Group   DS2 Tx-XBit: 0
DS1 Block Size:   2Kbit
DS1 LOP & OOF Hold-off: 0.0 Seconds
Bits Clk Out Derived from: STS-N Rx Clk
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DS3 and DS2 Error Injection

The following type of error can be injected when the transmitter or 
payload is set for DS3. The rates for each selection (except DS3 LOS) 
are Single, 1.0E-2 through 1.0E-9, Burst, and Off.

Note: For information on injection rates, see About Error Injection Rates, page 27–8.

DS3 Data: Generates DS3 data bit errors before the parity is 
calculated, so parity errors are not generated.

DS3 Data, Par: Generates DS3 data bit errors after the parity is 
calculated, resulting in both data and parity errors.

DS3 BPV: Generates bipolar violations.

DS3 Frame: Generates errors in the F1 and F0 frame bits.

DS3 C1: Generates errors in the C1 bits of the DS3 subframes.

DS3 C2: Generates errors in the C2 bits of the DS3 subframes.

DS3 C3: Generates errors in the C3 bits of the DS3 subframes.

DS3 C ALL: Generates errors among all the C bits of the DS3 
subframes.

DS3 LOS: Generates DS3 loss of signal. Rates: Continuous, Burst, Off.

DS2 C1: Generates errors in the C1 bits of the DS2 signal.

DS2 C2: Generates errors in the C2 bits of the DS2 signal.

DS2 C3: Generates errors in the C3 bits of the DS2 signal.

DS2 C ALL: Generates errors among all the C bits of the DS2 signal.
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DS3 Indicators

DS3 Alarm and Status Indicators

Indicator Description

HIST/ALARMS

LOS Loss of DS3 signal.

OOF Out of frame.

AIS DS3 alarm indication signal.

LOPAT Loss of pattern.

FFM Frame format mismatch.

STATUS

DS3 SIG Valid DS3 signal detected.

M13 SYNC Detected signal is M13 format.

C-BIT SYNC Detected signal is C-bit parity format.

PAT SYNC Receiver synchronized with test pattern.

X-BIT X-bit status indication.

IDLE CHNL DS3 idle channel detected.

ERRORS DS3 error detected.
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About Dual-DS3 Measurements
The DS3-A column shows 
results for the DS3 A signal. 
The DS3-B column shows 
results for the DS3 B signal. If 
a DS3 results screen does not 
indicate two sets of results, 
that screen applies only to 
DS3 A.

For dual DS3 testing some results screens change to display results for 
both DS3 A and DS3 B on the screen. For example:

DS3 Summary Screen
For each screen, an “s” 
indicates Summary results 
level and a “d” indicates Detail 
level. See To Display More 
Measurement Screens, 
page 1–11.

This screen displays a summary of DS3 test results. The screen appears 
differently, depending on the payload setting (DS3 or DS1).

Sec Ago shows the time 
elapsed since last error, in 
seconds.

Bit: DS3 bit error count: The number of errored bits (transmitted at 
one level, but received at another).

Frm: DS3 frame error count: The number of errored F1 and F10 bits.

C-Bit: DS3 C-bit parity error count: The number of CP-bit errors (not 
applicable in M13 format).

P-Bit: DS3 P-bit parity error count: The number of P-bit errors.

BPV: DS3 bipolar violation count: The number of DS3 BPVs detected.

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Summary      DS3-A         DS3-B
 Bit:            --               --
 Frame:          --               --
 P-Bit:          --               --
 BPV:            --               --

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Bit:       --     Sec Ago:   --
    Frm:       --                --
  C-Bit:       --                --
  P-Bit:       --                --
    BPV:       --                --

s

 1 DS3-DS3 (DS1)    Final:  00:00:00.00 
DS3 Measurement Summary
Frame:         --     Sec Ago:   --
P-Bit:         --                --
CP-Bit:        --                --
BPV:           --                --
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Bit Error Measurements Screens 1, 2, and 3
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Bit Error Measurements Screens 1, 2, and 3
These three screens display DS3 bit error measurement results (in DS1 
payload modes, only a variation of screen #3 is shown).

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Bit Error Measurements #1
Error Count:     --
Average ratio:   --
Current Ratio:   --

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Bit Error Measurements #2
ES:     --     Sync ES:       --
EFS:    --     Sev ES:        --
%EFS:   --     Avail Sec:     --
               Unavail Sec:   --

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Bit Error Measurements #3 (Seconds)
Thrsh E-3:   --     Dribble:    --
Thrsh E-4:   --     CSES3:      --
Thrsh E-5:   --     Burst ES:   --
Thrsh E-6    --

DS3 Bit Error Measurements

Measurement Description

Error Count The total number of DS3 bit errors detected.

Average Ratio Average DS3 BER: The number of DS3 bit errors over the 
total DS3 bits transmitted since the start of the test.

Current Ratio Current DS3 BER: The number of DS3 bit errors over the 
number of DS3 bits transmitted in the previous 2.25 sec.

ES DS3 errored seconds: The number of seconds during 
which at least one DS3 bit error occurred (seconds are 
counted beginning at test start).

EFS DS3 error-free seconds: The number of seconds during 
which no DS3 bit errors occurred.
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Bit Error Measurements Screens 1, 2, and 3
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S3
%EFS Percentage of DS3 error-free seconds: DS3 EFS 
expressed as the percentage of the total number of 
seconds in the test.

Sync ES DS3 synchronous errored seconds: The number of 
seconds in which at least one DS3 bit error occurred 
(seconds are counted beginning at the error occurrence).

Sev ES DS3 severely errored seconds (SES): The number of 
seconds during which the error rate was 10–3 or greater 
(approximately 44,100 errors per second or more for 
framed modes, 44,700 for unframed).

Avail Sec DS3 available seconds: The number of seconds during 
the test that were not unavailable (see below).

Unavail Sec DS3 unavailable seconds: The DS3 is declared 
unavailable after ten consecutive seconds of SES or LOP. 
The DS3 is declared available again after ten consecutive 
seconds with no SESs or LOPs.

Thrsh E-N DS3 threshold seconds: The number of available seconds 
during which the bit error rate or P-bit error rate (which 
ever is larger) exceeded the indicated threshold. The 
thresholds correspond to the following values 
(Framed/unframed): E-3 = 44,100/44,700; E-4 = 4,410/4,470; 
E-5 = 441/447; E-6 = 44/44.

Dribble DS3 dribbling error seconds: The number of seconds in 
which the error rate does not exceed 10–6 (approximately 
1 through 43 errors).

CSES3 DS3 Consecutively severely-errored seconds count: The 
number of SESs for which the previous two seconds were 
also SESs. This count is reset during LOS, LOF, and LOP.

Burst ES DS3 burst error seconds: The number of seconds in 
which 100 or more bit errors occurred.

DS3 Bit Error Measurements, continued

Measurement Description
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DS3 P-Bit Parity Measurements Screen
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DS3 P-Bit Parity Measurements Screen

This screen displays a summary of DS3 section parity (P-bit) 
measurements.

Count: DS3 P-bit parity error count: The number of P-bit parity errors 
that occurred since the beginning of the test.

Cur Ratio: DS3 P-bit parity current bit error ratio: The number of P-bit 
errors over the number of bits transmitted during the previous 2.25 sec.

Avg Ratio: DS3 P-bit parity average bit error ratio: The number of P-bit 
errors over the number of bits transmitted since the beginning of the 
test.

ES: DS3 P-bit parity errored seconds: The number of seconds during 
which at least one P-bit parity error occurred.

EFS: DS3 P-bit parity error-free seconds: The number of seconds 
during which no P-bit errors occurred.

%EFS: Percentage of DS3 P-bit parity error-free seconds: DS3 P-bit 
EFS expressed as the percentage of seconds since the beginning of the 
test.

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 P-Bit Parity Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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DS3 CP-Bit Parity Measurements Screen
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DS3 CP-Bit Parity Measurements Screen

This screen displays a summary of DS3 path parity (CP-bit) results. This 
screen is applicable in C-bit parity framing modes only.

Count: DS3 CP-bit parity error count: The number of CP-bit parity 
errors that occurred since the beginning of the test.

Cur Ratio: DS3 CP-bit parity current bit error ratio: The number of 
CP-bit errors over the number of bits transmitted during the previous 
2.25 sec.

Avg Ratio: DS3 CP-bit parity average bit error ratio: The number of 
CP-bit errors over the number of bits transmitted since the beginning of 
the test.

ES: DS3 CP-bit parity errored seconds: The number of seconds during 
which at least one CP-bit parity error occurred.

EFS: DS3 CP-bit parity error-free seconds: The number of seconds 
during which no CP-bit errors occurred.

%EFS: Percentage of DS3 CP-bit parity error-free seconds: CP-bit EFS 
expressed as the percentage of seconds since the beginning of the test.

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 CP-Bit Parity Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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DS3 Frame Measurements Screen

This screen displays a summary of DS3 framing error measurements.

Count: DS3 framing error count: The number of F1 and F10 bit errors 
that occurred since the beginning of the test.

Cur Ratio: DS3 framing current bit error ratio: The number of F-bit 
errors over the number of F-bits transmitted during the previous 2.25 
sec.

Avg Ratio: DS3 framing average bit error ratio: The number of F-bit 
errors over the number of F-bits transmitted since the beginning of the 
test.

ES: DS3 framing errored seconds: The number of seconds during 
which at least one F-bit error occurred.

EFS: DS3 framing error-free seconds: The number of seconds during 
which no F-bit errors occurred.

%EFS: Percentage of DS3 framing error-free seconds: DS3 framing 
EFS expressed as the percentage of seconds since the beginning of the 
test.

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Frame Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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DS3 FFCV Measurements Screen

This screen displays DS3 frame-format coding violation (FFCV) 
results.

NE Cnt: Near-end FFCV count: For M13 this is the number of F- or 
M-bit errors within an M-frame. For C-bit this is the number of F- or 
M-bit errors within an M-frame, or CP-bit errors in the following 
M-frame.

FE Cnt: Far-end FFCV count: For M13 this measurement is not 
applicable. For C-bit this is the number of FEBE-bit errors (any of the 
three FEBE bits not set to 1).

NE ES A: Near-end errored seconds, type A: The number of 
one-second intervals with exactly one near-end FFCV and no near-end 
OOF or AIS events.

FE ES A: Far-end errored seconds, type A: The number of one-second 
intervals with exactly one far-end FFCV and no far-end OOF or AIS 
events.

NE ES B: Near-end errored seconds, type B: The number of 
one-second intervals during which 2 through 44 near-end FFCVs 
occurred, and no near-end OOF or AIS events occurred.

FE ES B: Far-end errored seconds, type B: The number of one-second 
intervals during which 2 through 44 far-end FFCVs occurred, and no 
far-end OOF or AIS events occurred.

NE ES C: Near-end errored seconds, type C: The number of 
one-second intervals during which more than 44 near-end FFCVs 
occurred, or at least one near-end OOF or AIS events occurred.

FE ES C: Far-end errored seconds, type C: The number of one-second 
intervals during which more than 44 far-end FFCVs occurred, or at least 
one far-end OOF or AIS events occurred.

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 FFCV Measurements
NE Cnt:    --     FE Cnt:    --
NE ES A:   --     FE ES A:   --
NE ES B:   --     FE ES B:   --
NE ES C:   --     FE ES C:   --
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DS3 BPV Measurements Screen

This screen displays DS3 bipolar violation (BPV) measurements.

Count: DS3 BPV count: The number of bipolar violations that occurred 
since the beginning of the test.

Cur Ratio: DS3 BPV current bit error ratio: The number of BPVs over 
the number of bits transmitted during the previous 2.25 sec.

Avg Ratio: DS3 BPV average bit error ratio: The number of BPVs over 
the number of bits transmitted since the beginning of the test.

ES: DS3 BPV errored seconds: The number of seconds during which at 
least one BPV occurred.

EFS: DS3 BPV error-free seconds: The number of seconds during 
which no BPVs occurred.

%EFS: Percentage of DS3 BPV error-free seconds: DS3 BPV EFS 
expressed as the percentage of seconds since the beginning of the test.

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 BPV Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
 LCVR Sec:      --
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DS3 FEAC Monitor Screen

This screen displays the received DS3 far-end alarm and control 
(FEAC) codes.

Last Rx Code: Last received FEAC alarm/status code: Displays the 
text and six-bit sequence for the most recently received FEAC alarm or 
status code. Does not display loopback control sequences. 
Seconds Ago displays the elapsed time since the code was received, in 
seconds.

Rx Sequence: Last received FEAC loopback control sequence: 
Displays the type of FEAC loopback code (Activate or Deactivate) most 
recently received. Seconds Ago displays the elapsed time since the 
sequence was received, in seconds.

Line: Last line affected by loopback control sequence: Indicates which 
line was affected by the most recently received FEAC loopback 
sequence, for example DS1 #7, and so forth.

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
            DS3 FEAC Monitor
Last Rx Code:  --
 Seconds Ago:  --
 Rx Sequence:  --        Line:  --
 Seconds Ago:  --
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DS3 C-Bit Monitor Screen

This screen displays the binary state of the received DS3 C-Bits.

A 1 or a 0 is displayed for each C-bit on the receive signal.

• The third C-bit in row 1 (C3) is the FEAC bit.

• Rows 2, 5, 6, and 7 are used in various combinations to form 
different data links. For more information see Programmable 

C-Bits, page 7–11.

DS3 P-Bit and X-Bit Monitor Screen

This screen displays the binary state of the received DS3 P- and X-bits.

A 1 or a 0 is displayed for each X-bit (message bits) and P-bit (parity 
bits) on the receive signal.

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
           DS3 C-Bit Monitor
Row 1:  X   1   1  | Row 5:  1   1   1
Row 2:  1   1   1  | Row 6:  1   1   1
                   | Row 7:  1   1   1
                   |

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
        DS3 P and X Bit Monitor
   X1:1      X2:1
   P1:0      P2:0
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DS3 Alarm Screens
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DS3 Alarm Screens

The screens described in this section display alarm results for the DS3 
signal. The alarms that are displayed on the screens are described in the 
following table.

DS3 Alarm Definitions

Alarm Description

AIS Alarm indication signal: Declared when the received signal 
is a repeating 1010… pattern (1 following the framing bit) 
with valid framing and all C-bits set to 0. Signal must be 
present for three consecutive one-second intervals.

Idle Idle signal: Declared when the received signal is a repeating 
1100… pattern (11 following the framing bit) with valid 
M-frame and M-subframe alignment and P-bit parity. Also, 
the C-bits are set to 0 in M-subframe #3 and X-bits are both 
set to 1.

LOP Loss of pattern synchronization: Declared when 240 bit 
errors out of 1024 consecutive data bits. This alarm is 
cleared when there are no pattern errors for 64 consecutive 
data bits.

LOS Loss of signal: Declared after 128 or more pulse positions are 
received with neither a positive or negative pulse. The alarm 
is cleared when a pulse is received.

OOF Out of frame: Declared when the receiver cannot achieve 
either F-sync or M-sync frame synchronization. F-bit 
synchronization is declared lost when the number of 100% 
errored bit bursts exceeds 1020. M-bit synchronization is 
declared lost when two out of three consecutive M-groups 
are errored (an M-group is an M0, M1, M0 sequence; an 
errored M-group is an M-group that is not set to 010).

FFM Frame format mismatch: Declared when the received frame 
format does not match the set’s selected format, and no AIS 
or OOF exists for three consecutive seconds. The alarm is 
cleared when these conditions are not met for three 
consecutive seconds.
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DS3 Alarm Screens
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DS3 Alarm & 
Status Seconds 
Screen

This screen displays counts of DS3 alarm seconds. An alarm second is a 
one-second interval during which at least one DS3 alarm of the 
specified type occurred.

DS3 Alarm and 
History Screen

This screen displays the current and previous occurrence of DS3 
alarms. Like the front-panel indicator LEDs, the screen provides a 
current status of the alarm (Alarm) and also indicates if the alarm has 
occurred previously (Hist).

LCVA Line code violation alarm: Declared when three consecutive 
one-second intervals contain a LOS or a BPV error rate 
greater than 44 errors per second (1–7). The alarm is cleared 
when there is no LOS and the error rate is less than 
44 errors/sec for three consecutive seconds.

Blue Blue alarm: Declared when the received signal is a 
repeating 1010… pattern (1 following the framing bit) with 
valid framing. Signal must be present for three consecutive 
one-second intervals.

DS3 Alarm Definitions, continued

Alarm Description

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Alarm & Status Seconds
AIS Sec:    --     LOS Sec:   --
Idle Sec:   --     OOF Sec:   --
LOP Sec:    --

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3  Alarm  Hist       DS3  Alarm  Hist
 LOS:  --    --         AIS:  --    --
 FFM:  --    --         LCVA: --    --
 OOF:  --    --         Blue: --    --
 LOP:  --    --
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DS3 Signal Measurements Screen

This screen displays signal measurements for the DS3 signal.

Rx Hz: DS3 receive frequency in Hertz: The recovered clock frequency 
of the receive DS3 data pattern.

Rx Pk V: DS3 receive peak voltage: The receive signal level measured 
in volts peak (Vpk). Accuracy is ±5%.

Rx dBdsx: DS3 receive dBdsx level: The receive signal level measured 
in decibels relative to a DS3 signal (0 dBdsx = 0.48 Vpk). Accuracy is 
±1 dB.

EXZ: DS3 excess zeros: Shows ON when three or more consecutive 
zeros are received.

Mask: Displays the name of the selected pulse mask (see DS3 Pulse 

Mask Configuration, page 7–12) and indicates whether the received 
pulse meets the mask specifications. This field displays one of the 
following messages:

• Pass: indicates the pulse meets the specified shape.

• Fail: indicates the pulse did not meet the specified shape.

• Unavail: indicates the pulse mask data is not available.

See DS3 Pulse Mask Screens, page 8–18, for additional pulse mask 
measurement information.

s

 1 DS3-DS3 (DS3)     Final:  00:00:00.00 
DS3 Signal Measurements
 Rx Hz:       --    Mask:       --    --
 Rx Pk V:     --
 Rx dBdsx:    --
 EXZ:         --
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Jitter Measurements Screen
Each measurement is 
calculated for both wide- band 
and high-band jitter. The jitter 
cut-off frequencies for DS3 is 
10 Hz to 400 kHz (wide-band) 
and 30 kHz to 400 kHz 
(high-band).

This screen displays jitter peak results for the selected receiver rate.

Current P-to-P: Current peak-to-peak jitter: The sum of the positive 
jitter peak and the negative jitter peak for the most recent one-second 
period. Displayed in unit intervals.

The DS3 jitter mask is 5.0 UI 
for wide-band and 0.1 for 
high-band.

MAX P-to-P: Maximum peak-to-peak jitter: The sum of the highest 
positive jitter peak and the highest negative jitter peak for the entire 
test duration. Displayed in unit intervals.

MAX Pos Peak: Maximum positive jitter peak: The greatest positive 
jitter peak since the beginning of the test. Displayed in unit intervals.

MAX Neg Peak: Maximum negative jitter peak: The greatest negative 
jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and 
Mask Results 
Screen

This screen displays jitter threshold and mask percentage results for 
the selected receiver rate.

The measurements on this display are described below. Each 
measurement is calculated for both wide-band and high-band jitter.

See Jitter Threshold 
Configuration, page 23–3.

Hits Count: Indicates the total number of jitter hits (jitter hit 
threshold exceeded) since the beginning of the test.

Total Hits Time: Indicates the cumulative total of time, in seconds, 
that the jitter hit threshold has been exceeded since the beginning of 
the test.

MAX Percent of Mask: Indicates the maximum peak-to-peak jitter 
for the entire test period expressed as a percentage of the jitter mask.

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3 Jitter           Wide-Band High-Band
 Current P-to-P (UI):    --       --
 MAX P-to-P (UI):        --       --
 MAX Pos Peak (UI):      --       --
 MAX Neg Peak (UI):      --       --

d

 1 STS1-STS1 (DS3)  Final:  00:00:00.00 
STS1 Jitter          Wide-Band High-Band
 Hits Count:             --       --
 Total Hits Time(Sec):   --       --
 MAX Percent of Mask:    --       --
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DS3 Status Screen
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DS3 Status Screen

This screen displays the status of certain DS3 signal parameters, similar 
to the front-panel DS3 STATUS indicators.

The displayed status parameters are described in the following table.

d

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
DS3        Status         DS3     Status
 Signal:    --           Pat Sync: --
 M13 Frm:   --           X-Bit:    --
 C-Bit Frm: --           Idle:     --

SONET Status Conditions

Status Condition Description

Signal Signal present: Indicates ON when an 128 contiguous 
pulse are received.

M13 Frm M13 frame synchronization: Indicates ON when F-sync 
and M-sync have been found and at least 16 C11 (FID) 
bits set to 0 were received during the previous 0.25 
second.

C-Bit Frm C-bit frame synchronization: Indicates ON when F-sync 
and M-sync have been found and fewer than 16 C11 
(FID) bits set to 0 were received during the previous 
0.25 second.

Pat Sync Pattern synchronization: Indicates ON when a valid 
payload pattern match is detected for at least 64 
consecutive bits.

X-Bit X-bit status: Indicates ON when both received X-bits 
are set to 0.

Idle Idle channel: Indicates ON when the received signal is 
a repeating 1100… pattern (11 following the framing bit) 
with valid M-frame and M-subframe alignment and 
P-bit parity. Also, the C-bits are set to 0 in 
M-subframe #3 and X-bits are both set to 1.
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DS3 Pulse Mask Screens

These screens display DS3 pulse mask measurements, based on the 
shape of a received DS3 pulse (binary 1). Both positive and negative 
pulses can be measured (see Capture Pulse Polarity, page 7–13).

Positive/Negative Pulse Mask: Indicates whether this screen applies 
to the positive or negative pulse being evaluated. Mask indicates the 
selected pulse mask specification (see Pulse Mask Type, page 7–12).

Tol: Displays the selected mask tolerance adjustment (see Mask 

Tolerance Adjustment, page 7–13).

Pulse Fit: Indicates Pass if the received pulse fits the selected pulse 
mask and tolerance.

Rise Time: Indicates the calculated rise time of the received pulse, in 
nanoseconds.

Fall Time: Indicates the calculated fall time of the received pulse, in 
nanoseconds.

Imbal: Indicates Pass when the ratio of the amplitude of the positive 
received pulse and the amplitude of the negative received pulse meets 
the specifications of the selected pulse mask. Polarity> must be set to 
Pos + Neg, see Capture Pulse Polarity, page 7–13.

Amp: Indicates Pass when the amplitude of the receive pulse is in the 
range 360 to 850 millivolts.

Width: Indicates the width of the received pulse, in nanoseconds.

s

 1 DS3-DS3 (DS3)    Final:  00:00:00.00 
Positive Pulse Mask:     -- Tol:    --
Pulse Fit:       --  Imbal:         --
Rise Time:       --    Amp:         --
Fall Time:       --  Width:         --
 Pulse Mask test has not been started
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DS3 Pulse Mask Screens
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Pulse Mask
Status Line

The bottom line of the pulse mask results display indicates the status of 
the pulse mask test. The status line indicates one of the messages 
described in the following table.

Pulse Mask test has not been started: Indicates a pulse mask test 
has not yet begun.

Acquiring Positive One Data or Acquiring Negative One Data:

Indicates the test set is acquiring a positive or negative pulse to 
evaluate.

Done—Not Enough Isolated Ones: Indicates the pulse mask test 
was canceled because a pulse could not be acquired, or a LOS was 
detected. Pulse acquisition requires a sufficient number of isolated 
ones. An isolated one is a one (pulse) preceded by at least two zeros 
(non- pulses) and followed by at least one zero.

Calculating Results: X% Complete: Indicates that all pulse 
acquisitions are complete and that pulse mask calculations are being 
performed.

Positive Test Complete or Negative Test Complete: Indicates 
pulse acquisition and calculations are done.
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DS2 Status Screen

This screen displays the status of certain DS2 signal parameters, similar 
to the front-panel STATUS indicators. This screen is only shown when 
the payload is set to DS1 (the DS2 signal is part of the DS1 to DS3 
multiplex process). Each status indicator shows ON if its condition is 
present.

The transmit X-bit can be set 
on the Global test Setups 
screen (see page 7–16).

X/A Bit: DS2 X-bit or A-bit status: Declared when the receive X-bit 
(DS1-mapped DS3 signals) or A-bit (E1-mapped DS3 signals) is set to 1.

DS1 Payl and E1 Payl: DS3 mapping type: Indicates the mapping 
present on the receive DS3 signal (DS1 or E1). Only only status 
indicates ON at a time.

M12 Loopback: DS1 loopback request: Indicates a loopback request 
for the selected DS1 channel (uses the DS2 C-bits).

d

 1 DS3-DS3 (DS1)    Final:  00:00:00.00 
DS2           Status
 X/A Bit:      --
 DS1 Payl:     --
 E1 Payl:      --
 M12 Loopback: --
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DS2 Alarm and History Screen

This screen displays DS2 alarms. This screen is only shown when the 
payload is set to DS1.

LOS: DS2 loss of signal: Declared when 192 DS2 bits are received set to 
0. This alarm is cleared when a single DS2 bit is received.

OOF: DS2 out of frame: Declared when DS2 F-sync or M-sync is 
detected. Loss of DS2 F-sync is declared when three F-bits out of 15 are 
errored. Loss of DS2 M-sync is declared when 2 M-bit sequences out of 
three are errored.

This condition is cleared when DS2 F-sync or DS2 M-sync is 
reestablished. DS2 F-sync is established when 15 consecutive, 
error-free F-bits are received. DS2 M-sync is established when two 
consecutive, error-free M-bit sequences are received.

AIS: DS2 Alarm Indication Signal: Declared when an all-ones, 
unframed DS2 signal is detected (the all-ones requires a 99.9% ones 
density).

d

 1 DS3-DS3 (DS1)    Final:  00:00:00.00 
DS2       Alarm   Hist
 LOS:      --     --
 OOF:      --     --
 AIS:      --     --
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DS3 Interfaces

Note: For dual DS3 options installed in the instrument, additional DS3 TX and DS3 RX 
are installed on the rear-panel optional connector plate. The signal 
specifications for these connectors are the same as for the front-panel.

DS3 Transmitter 
DS3 TX

Signals:

Line Code: B3ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECo 440. Optional WECo 358 or BNC.

DS3 Receiver 
DS3 RX

Signals:

Line Code: B3ZS.

Impedance: 75 ohm ±5%.

Connector: Accepts WECo 440. Optional WECo 358 or BNC.

DSX-3 Per CB119, ANSI T1X1 and TR-TSY-000499.
0.48 Vpk ±1.2 dB. LBO = 450 ft simulated 728A cable.

High 0.91 Vpk ±1.2 dB. LBO = none.

900 0.33 Vpk ±2.0 dB. LBO = 900 ft simulated 728A cable.

Low 0.186 Vpk ±2.0 dB. LBO = Flat loss from High level.

DSX-3 Automatic equalizer for 0 to 900 ft of 728A cable.
44.736 MHz ±300 ppm.
Jitter tolerance per Bellcore TR-TSY-000009.

High 0.91 Vpk input signal, nominal.

Mon Up to 26 dB flat loss relative to nominal DSX-3 level.

Low 0.186 Vpk input signal, nominal.
9–2
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DS3 Drop Output 
DS3 DROP

Signal = DSX-3: DS3 dropped from higher-rate signal.

• Per TR-TSY-000499.

• 0.48 Vpk ±1.2 dB.

• LBO = 450 ft simulated 728A cable.

Line Code: B3ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECo 440. Optional WECo 358 or BNC.

DS3 Timing Internal: 44.736 MHz ±20 ppm.

DS3 TX CLK IN jack: Input DS3 signal. TTL levels, 50 ohm, BNC 
connector.

Bit Error Output DS3 ERR OUT: Provides a single pulse output for each DS3 error 
detected. TTL level, 50 ohm, BNC connector.

Data Link Interfaces

For data link port pinout information, see Data Link Interfaces, 
page 27–4. For DS3 data link control information, see DS3 Datalink 

Parameters, page 7–15.
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Jitter Option Specifications

DS3 jitter measurement requires DS3 testing (E4480A-001 base unit or 
Option URR), Option UQP, and either Option UQN or 201.

Measurement 
Response

DS3 Jitter Measurement per: TR-TSY-000499

Wide-band cut-off frequency: 10 Hz to 400 kHz

High-band cut-off frequency: 30 kHz to 400 kHz

Roll-off (per decade) below lower 3 dB point: ≥20 dB

Roll-off (per decade) above higher 3 dB point: ≥60 dB

Jitter 
Measurements

Demodulated 
Jitter Output

DMOD JITTER OUT jack: 50 ohm, BNC connector. 
Scale = 100 mV/UI; range = 0 to 6 Vdc.

Measurement Range Resolution Accuracy

Maximum Peak Positive Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Maximum Peak Negative Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Current Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Max Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Wideband Mask Highband Mask

Percent of Mask 5.0 UI 0.1 UI
9–4
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DS3 (44.736 Mbs) and DS2 Signal Formats

M0 C11 F0 C12 C13 F1

M1 C21 F0 C22 C23 F1

M0 C31 F0 C32 C33 F1

M0 C41 F0 C42 C43 F1

M1 Subframe

M2 Subframe

M3 Subframe

M4 Subframe

49-bit
Block

48 bits

M-subframe

DS2
M-frame

X1 F1 C11 F0 C12 F0 C13 F1

X2 F1 C21 F0 C22 F0 C23 F1

P1 F1 C31 F0 C32 F0 C33 F1

P2 F1 C41 F0 C42 F0 C43 F1

M0 F1 C51 F0 C52 F0 C53 F1

M1 F1 C61 F0 C62 F0 C63 F1

M0 F1 C71 F0 C72 F0 C73 F1

85-bit
Block

84 bits

M-subframe

DS3
M-frame

AIC N FEAC

DL DL DL

CP CP CP

DL DL DL

DL DL DL

DL DL DL

FEBEFEBEFEBE
9–5
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Bit M13 Format Function C-Bit Parity Format Function

X1/X2 Message bits. Remote alarm indication.

F1/F0 Frame bits (F1=1; F0=0). Frame bits (F1=1; F0=0).

P1/P2 Parity bits Parity bits.

M0/M1 Multiframe bits (M0=0; M1=1). Multiframe bits (M0=0; M1=1).

C11 Bit-stuffing control/indication. AIC: Application identification channel.

C12 N: Reserved network application bit.

C13 FEAC: far-end alarm/control channel.

C41/C42/C43 FEBE: far-end block error indication.

Other C-bits DL: datalinks.
9–6
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Set up for DS1 Testing

DS1 testing features are available whenever the transmitter, receiver, or 
payload are configured for DS1.

1. From the Main Menu press FIELD to select a testing mode.

2. Press MENU-down. The testing setup screen for the mode you 
selected is displayed (this example shows Terminal testing 
mode).

Example DS1 Application

CERJAC
Test Set DS1

Far-end
Loop

DS0 FT1DS1

         TERMINAL TESTING

Tx Rate: DS1           Rx Rate: DS1

Payload: DS1

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press ENTER to enter test mode.
Press MENU to return to Main Menu.
10–2
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3. Use the FIELD and VALUE keys to set the transmitter (Tx Rate) 
and receiver (Rx Rate) for your application. For Monitor and D&I 
tests the transmitter and receiver are set simultaneously 
(Tx/Rx Rate).

• If you are testing a DS1 that is the payload of a higher-rate signal, 
set the transmitter and receiver as appropriate for that higher 
rate.

4. Next press the right FIELD key to select the Payload parameter. 
Use VALUE to set the payload as appropriate for your application.

• To test DS0 signals set Payload to DS0 (this step is optional).

• Remember that one of the transmitter, receiver, or payload must 
be set to a DS1 selection.

5. Press MENU-down. The DS1 operation screen is displayed (see next 
section).
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Configure the DS1 Signal

• When you press MENU-down from the testing mode setup screen, 
the test operation screen is displayed. Note that the screen may 
appear differently depending on the test mode you selected.

1. Use the FIELD and VALUE keys to set the transmit timing source 
(TxClk), the framing format (Frm) and the line coding (Code). 

2. Next use FIELD and VALUE to set the transmit signal level (Tx), the 
receive signal level (Rx), and the termination mode (Term).

3. Use FIELD and VALUE to select a pattern (Data). For FT1 testing 
set Data to the FT1. Select a Progr pattern to use a custom bit 
sequence. See Configure DS1/E1 User Test Patterns, page 10–6.

• If you are testing a DS1 signal dropped from a higher-rate signal, the 
Tx, Rx, and Term fields do not apply and are not displayed.

• If you are testing a DS1 dropped from a higher-rate signal, configure 
the higher-rate signal. See Configure Other Signal Parameters, 
page 10–11.

• If you selected DS0 for the payload (Data), configure the DS0 
parameters. See Configure the DS0 Signal, page 10–8.

• If you are testing DS0 signals, configure the data parameters. 
See steps for Configuring the DS0 Signal, page 10–10.

 1 DS1-DS1 (FT1)    Final:  00:00:00.00 
FT1 Measurement Summary
Bit:           --     Sec Ago:   --
Frame:         --                --
CRC:           --                --
BPV:           --                --

DS1: TxClk>Int   Frm>SF      Code>AMI
        Tx>DSX1              Term>Term
        Rx>DSX1
      Data>QRSS
Err/Alm:Type>DS1 Data    Rate>Single
10–4
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Configure the ESF Datalink Message

If you set the DS1 framing format to Extended Superframe (ESF), you 
can set the message to be transmitted on the ESF datalink.

1. From the test operation screen press CONFIG-right to display the 
control screen menu.

2. Use FIELD to select DS1/E1 Patterns and press CONFIG-right. 
The Programmable Patterns screen is displayed.

3. Use VALUE to select the datalink message.

4. If you selected User 1 or User 2 for the datalink message, use 
FIELD and VALUE to define the user pattern. Each bit can be set to 
1 or 0.

5. When you finish editing, press CONFIG-right to return to the test 
operation screen.

Í DS1: TxClk>Int   Frm>ESF     Code>AMI
     Tx>DSX1                 Term>Term
     Rx>DSX1
   Data>Progr #1
Err/Alm:Type>DS1 Data    Rate>Single

Í

  Global Settings  |
  Data Link Control|
  DS0/TS/Frac Setup|
  DS1/E1 Patterns  |
  DS1 Loop Codes   |
                   |

Í

DS1/E1 Prog Pattern
ESF datalink message
  Data link idle     (01111110 01111110)
ESF Programmable datalink patterns
 User 1: v100010v xxxxxxxx  <v=0) (x=1)
 User 2: v011000v xxxxxxxx  (v=0) (x=1)

Prog Pat 1:     01000000................
Prog Pat 2:     010000..................
Prog Pat 3:     01000100000.............
Prog Pat 4:     010001000000000.........
Prog Pat 5:     010001000000000100......
Prog Pat 6:     010001000000000000100...
10–5
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Configure DS1/E1 User Test Patterns
The 156MTS has six programmable test patterns for use in DS1 and E1 
testing. To use the patterns, set Data> to a Progr selection. Follow this 
procedure to configure the six DS1 user test patterns.

1. From the test operation screen press CONFIG-right to display the 
control screen menu.

2. Use FIELD to select DS1/E1 Patterns and press CONFIG-right. 
The Programmable Patterns screen is displayed.

Each pattern can be 2 through 
24 bits long. Lengthen the 
pattern by changing the first 
dot to either a 1 or a 0; shorten 
the pattern by setting the last 
bit in the pattern to a dot.

3. Use FIELD and VALUE to select the individual bits in each pattern 
and set them to binary 1, 0, or to a dot.

4. When you finish editing, press CONFIG-right to return to the test 
operation screen.

Í

DS1: TxClk>Int   Frm>SF      Code>AMI
     Tx>DSX1                 Term>Term
     Rx>DSX1
   Data>Progr #1
Err/Alm:Type>DS1 Data    Rate>Single

Í

  Global Settings  |
  Data Link Control|
  DS0/TS/Frac Setup|
  DS1/E1 Patterns  |
  DS1 Loop Codes   |
                   |

DS1/E1 Prog Pattern
ESF datalink message
  Data link idle     (01111110 01111110)
ESF Programmable datalink patterns
 User 1: v100010v xxxxxxxx  <v=0) (x=1)
 User 2: v011000v xxxxxxxx  (v=0) (x=1)

Í Prog Pat 1:     01000000................
Prog Pat 2:     010000..................
Prog Pat 3:     01000100000.............
Prog Pat 4:     010001000000000.........
Prog Pat 5:     010001000000000100......
Prog Pat 6:     010001000000000000100...
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Configure the FT1 Signal

Note: The Data> field must be set for FT1. See Configure the DS1 Signal, page 10–4.

1. The FT1 parameters are controlled from the Fractional T1 Setup 
screen. Press CONFIG-right to call the control screens menu.

2. Use FIELD to highlight DS0/TS/Frac Setup and press 
CONFIG-right twice to display the Fractional T1 Setup screen.

3. Use VALUE to select the base rate for the fractional T1 signal. Set 
Nx to either 64k or 56k (kilobytes).

4. Next use FIELD and VALUE to select the DS0 channels of the DS1 
signal that make up the N×64 or N×56 signal (Select). Each active 
DS0 is represented by an asterisk; inactive DS0s are represented by 
a dot.

5. Use FIELD and VALUE to select the payload for the FT1 signal 
(Data).

6. Press CONFIG-right to return to the test operation screen.

Í

  Global Settings
  Data Link Control|
  DS0/TS/Frac Setup|
  DS1/E1 Patterns  |
  DS1 Loop Codes   |
                   |

Í

          >Fraction T1 Setup<
Nx>64k 
       1  |   |   |   |   |   24
Select>************************
Data>QRSS
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Configure the DS0 Signal

This section describes how to configure the DS0 payload of a DS1 
signal. There are two ways to configure the DS0 parameters, depending 
on whether you are testing from a directly-connected DS1 or from a 
subrate DS1 carried on a higher-rate signal (See Set up for DS1 Testing, 
page 10–2).

DS0 from Direct 
DS1 Connection

This procedure describes how to configure the DS0 payload of a DS1 
signal that is connected directly to the test set (input and output at the 
DS1 RX and TX jacks).

1. The DS0 parameters are displayed on the test operation screen. Use 
FIELD to highlight Ins>.

2. Use VALUE to select the channel into which the transmit DS0 is 
inserted.

3. Next use FIELD and VALUE to set status of the other transmit DS0 
channels of the DS1 signal.

4. Use FIELD and VALUE to select the channel number from which 
the DS0 is dropped.

5. Finally, use FIELD and VALUE to set the transmit tone (Tone). This 
parameter also allows you to transmit the VF signal applied at the 
rear-panel VF IN jack.

• After you finish configuring the DS0 parameters, you are ready to 
begin the test.

Í
Í

DS1:    Rx>DSX1           Tx>DSX1
       Frm>SF           Code>AMI
     TxClk>Int          Term>Term
DS0:   Ins>1   Other>Same      Drop>1
      Tone>DRS 1004 Hz
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DS0 from Subrate 
DS1

This procedure describes how to configure the DS0 payload of a 
subrate DS1 signal that is carried on a higher-rate signal.

1. To enable DS0 transmission on the subrate DS1 signal, you must set 
the DS1 Data> field to DS0. This example shows the test operation 
screen of a DS3-to-DS3 terminal mode test with a DS1 payload (DS0 
is available when the payload is set to DS1):

2. From the test operation screen, press CONFIG-right. The control 
screens menu is displayed in the bottom half of the screen:

3. Press FIELD to highlight DS0/TS/Frac Setup and then press 
CONFIG-right. The DS0 Setup screen is displayed in the lower half 
of the screen:

 1 DS3-DS3 (DS1)    Final:  00:00:02.00
DS0 VF Meas      -60....-40...-20.....0.
  Level:  0.5     ********************
 >+3dBm:       0 Thres. Sec
  Freq:1004  Hz
  Data:10111010 A=0   B=0   C=0   D-0

DS3:   Rx>DSX3     Tx>DSX3   TxClk>Int
      Frm>M13      XBit>1     FEBE>111
DS1: TxClk>Int  Frm>ESF    Data DS0
       Ins>1              Other>Same
      Drop>1               Code>AMI
Err/Alm:Type>DS1 Data    Rate>Single

Í

Í

  Global Settings  |  DS1/E1 Patterns
  DS3 FEAC Control |  DS1 Loop Codes
  DS3 C-Bit Control|
  Data Link Control|
  DS0/TS/Frac Setup|
  DS3 Pulse Mask   |

              >DS0 Setup<
Data>1004Hz           Nx>64k
Ins>1            Drop>1
Other>Same (VF Tone Only)
Tx Signaling:  A>1 B>1 C>1 D>1
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4. Press VALUE to adjust the setting of Data>. You can select a VF 
tone, external VF signal, or a bit pattern.

5. Press FIELD to select Nx> and use VALUE to set the DS0 base rate.

6. Next press FIELD to select the Ins> field and then use VALUE to set 
the insert VF channel number on the DS1 signal.

7. Press FIELD to select Drop> and use VALUE to set the drop 
channel number. You can also select L to lock the drop channel to 
match the insert channel.

8. Select Other> and use VALUE to set the remaining channels in the 
DS1 signal.

9. Use FIELD and VALUE again to configure each ABCD Tx Signaling 
bit to either binary 1 or 0.

10. When you have finished setting the DS0 parameters, press 
CONFIG-right to return to the test operation screen. You can also 
remain in the DS0 Setup screen and observe the effect of your 
changes on the upper half of the display as you make them.

 1 DS3-DS3 (DS1)    Final:  00:00:02.00
DS0 VF Meas      -60....-40...-20.....0.
  Level:  0.5     ********************
 >+3dBm:       0 Thres. Sec
  Freq:1004  Hz
  Data:10111010 A=0   B=0   C=0   D-0

              >DS0 Setup<
Data>1004Hz           Nx>64k
Ins>7            Drop>L
Other>Same (VF Tone Only)
Tx Signaling:  A>1 B>1 C>1 D>1
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Configure Other Signal Parameters

If you are testing a DS1 signal that is dropped and inserted from a DS3 
or SONET signal you must configure the mapping of the lower-rate 
signals to the higher-rate signals.

After you have set the DS1 signal parameters (See Configure the DS1 

Signal, page 10–4), use FIELD and VALUE to set the higher-rate signal 
parameters. This example shows a DS1 carried in an DS3 which is 
mapped to an STS-1 signal, which is in turn mapped to an OC-12 signal.

Note: For monitor tests, the transmit functions are not available (insert channel, etc).

1. Set Ins to select the transmit DS1 channel on the DS3. Set Oths to 
configure the remaining DS1 channels. Next set Drop to select the 
receive DS1 channel on the DS3.

2. Configure the DS3 signal by setting the transmit timing source 
(TxClk), framing format (Frm), and X-bit status (XBit).

For STS-12 tests, you can 
change the STS-1 numbering 
scheme. See STS-12 Channel 
Numbering Scheme, page 3–4.

3. Set STS1: INS> to select the STS-1 signal onto which the DS3 
signal is mapped.

4. Set Other to configure the remaining STS-1s.

5. Next select Drop and choose which STS-1 is dropped from the 
receive signal.

6. Set the transmit timing source for the higher-rate SONET signal 
(STSN: TxClk>).

7. Set Scramble to activate or deactivate STS-N scrambling.

After you finish configuring the DS1 and higher-rate signal parameters 
you already to run the test. See Run the DS1 Test, page 10–14.

Í
Í
Í
Í

DS1: TxClk>Int  Frm>SF     Data>QRSS
     Ins>1  Oths>Same Drop>1  Code>B8ZS
DS3:  TxClk>Int    Frm>M13       XBit>1
STS1: Ins>1,1 Other STSs>Same   Drop>1,1
STSN: TxClk>Int      Scramble>On
Err/Alm:Type>DS1 Data    Rate>Single
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Loopback the Far End

This section describes how to set up and transmit codes to activate and 
deactivate loopback at the far-end equipment.

1. Select the loop code to be transmitted. Use FIELD to highlight the 
Err/Alm:Type> field and then use VALUE to select DS1 LoopUp 
or LoopDn.

2. Next use FIELD and VALUE to set Rate> to the appropriate length 
of time the code is to be transmitted.

3. Press CONFIG-right to display the Control Screens menu.

4. Select DS1 Loop Codes and press CONFIG-right again. The DS1 
Loop Code Setup screen is displayed.

Í

DS1: TxClk>Int   Frm>SF     Code>AMI
        Tx>DSX1             Term>Term
        Rx>DSX1
      Data>QRSS
Err/Alm:Type>DS1 LoopUp  Rate>8 Seconds

Í

  Global Settings  |
  Data Link Control|
  DS0/TS/Frac Setup|
  DS1/E1 Patterns  |
  DS1 Loop Codes   |
                   |

         DS1 Loop Code Setup

 LoopUp Code: Inband Line [CSU] (10000)
 LoopDn Code: Inband Line [CSU] (100)
 Framing Overwrite: On

User Codes     Inband      Outband(ESF)
 LpUp:Tx>10000...........  000111
      Rx>10000...........
 LpDn:Tx>100.............  011100
      Rx>100.............
10–12
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5. Use FIELD and VALUE to configure the loop up and down code 
parameters.

Select predefined loop codes or select a “Usr” code to use the 
programmable codes.

6. Set Framing Overwrite to On or Off as appropriate for your test.

7. If you selected a “Usr” code in step 5, use FIELD and VALUE to 
program the LpUp (loop up) and LpDn (loop down) user codes.

Each pattern can be 2 through 
16 bits long. Lengthen the 
pattern by changing the first 
dot to either a 1 or a 0; shorten 
the pattern by setting the last 
bit in the pattern to a dot.

 Tx> sets the code that the test set transmits. Rx> sets the code that 
the test set monitors for on the input signal. Inband loop coes are 
defined on the left side of the screen and out-of-band (for ESF) loop 
codes are defined on the right.

8. When you have finished, use CONFIG-right to return to the test 
operation screen.

9. To transmit the loop code, press the ERROR INJECT key.

The 156MTS transmits the currently selected loop code.

10. Verify that the far-end has looped back by observing the DS1 
PAT SYNC and LOPAT indicators.

When loopback is successfully activated, PAT SYNC lights and the 
LOPAT alarm LED goes off (the LOPAT history LED lights).

11. When the far-end is looped, perform any other testing you require.

12. To deactivate the loopback, set Err/Alm:Type> to DS1 LoopDn 
and press ERROR INJECT. 

When the loopback is deactivated, the DS1 PAT SYNC indicator 
goes off and the red LOPAT alarm indicator lights.
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Run the DS1 Test

After you have configured the DS1 signal, FT1 signal, and higher-rate 
signal parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the 
elapsed time begins to increment.

2. If you want to inject errors on the DS1 or FT1 signal, use FIELD and 
VALUE to set the appropriate Err/Alm Type and Rate. Press 
ERROR INJECT to activate and deactivate error injection.

3. Press TROUBLE SCAN to view the Trouble Scan results screen. Any 
detected errors or alarms will be shown here.

4. Use the RESULT keys to view different measurement screens in the 
top half of the display. You may need to adjust the results level to 
view more measurements (see To Display More Measurement 

Screens, page 1–11).

5. To end the test, press STOP.
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Run an Automatic DS1 Drop Scan

The 156MTS features an automatic test sequence that scans a DS3 
signal and analyzes each of the 28 DS1 channels for framing and 
pattern. The DS3 signal can be dropped from a higher-rate signal. This 
section describes how to set up and run the DS1 Drop Scan sequence.

For more information, See DS1 
Drop Scan Sequence, 
page 11–17.

1. Connect the signal to be tested. The signal must be a DS3 signal or a 
higher-rate signal carrying DS3 signals.

2. Setup the background mode by configuring the test set as if you 
were going to run a manual test. For example, set up an STS-1 
monitor mode test with a channelized DS3 payload.

3. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans & 

Pointer Sequences.

4. Press MENU-down. The Test Sequences menu is displayed.

Í

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store and Recall configurations

----------------------------------------
Press < FIELD > to highlight item, then
Press MENU-down select item.

          TEST SEQUENCES

HPointer Increment
HPointer Decrement
HPointer New Data Flag (NDF)

Í DS1 Drop Scan
Signaling Scan
ATM Path.Circuit Scan
10–15
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5. Use FIELD to select DS1 Drop Scan and press MENU-down. The 
DS1 Drop Scan operation screen is displayed.

6. Set Configurations From to match your application. For example, 
if you are testing an STS-1 signal carrying channelized DS3 traffic, 
you could select STS1-MON (DS3/1).

7. Next set Channel Scan Mode to either Single (one scan) or 
Continuous (repetitive scanning).

8. Press START to begin the scan. The test set begins checking each 
DS1 on the DS3 signal for framing format and pattern, and displays 
the results on the appropriate display line.

9. The scan ends automatically in Single mode; press STOP to end the 
scan in Continuous mode.

 1 DS1 Drop Scan    Final:  00:00:00.00 
   1: --                 6: --
   2: --                 7: --
   3: --                 8: --
   4: --                 9: --
   5: --                10: --

Configurations From> DS3-MON (DS1)
Channel Scan Mode  > Single
----------------------------------------
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Run an Automatic DS0 Signaling Scan

The 156MTS features an automatic test sequence that scans a DS1 
signal, analyzes each of the DS0 channels, and displays the status of the 
signaling bits for each channel. The DS1 signal can be dropped from a 
DS3 signal.

1. Connect the signal to be tested. The signal must be a DS1 signal or a 
DS3 signal carrying DS1 traffic.

2. Setup the background mode by configuring the test set as if you 
were going to run a manual test. For example, set up an DS1 
terminal mode test with a DS0 payload (see Set up for DS1 Testing, 
page 10–2).

3. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans & 

Pointer Sequences.

4. Press MENU-down. The Test Sequences menu is displayed.

Í

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/  Scans & Pointer Sequences
Setup System Parameters
Store and Recall configurations

----------------------------------------
Press < FIELD > to highlight item, then
Press MENU-down select item.

          TEST SEQUENCES

HPointer Increment
HPointer Decrement
HPointer New Data Flag (NDF)

Í
DS1 Drop Scan
Signaling Scan
ATM Path.Circuit Scan
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5. Use FIELD to select Signaling Scan and press CONFIG-right. The 
Signaling Scan operation screen is displayed.

6. Set Configurations From to match your application. For example, 
if you are testing A DS1 signal carrying DS0 traffic, you could select 
DS1-DS1 (DS0).

7. Next set Channel Scan Mode to either Single (one scan) or 
Continuous (repetitive scanning).

8. Press START to begin the scan. The test set begins checking each 
DS0 on the DS1 signal for the signaling bit status, and displays the 
results on the appropriate display line.

9. Use the RESULTS keys to scroll through the displays of DS0 
channels and their signaling bit status.

10. The scan ends automatically in Single mode; press STOP to end the 
scan in Continuous mode.

 1 Signaling Scan   Final:  00:00:00.00 
     ABCD  ABCD  ABCD  ABCD  ABCD  ABCD
  1: 00--  00--  00--  00--  00--  00--
  7: 00--  00--  00--  00--  00--  00--
 13: 00--  00--  00--  00--  00--  00--
 19: 00--  00--  00--  00--  00--  00--

Configurations From> DS1-DS1 (DS0)
Channel Scan Mode  > Single
----------------------------------------
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DS1 Setup Parameters

DS1 parameters are applicable when the transmitter, receiver, or 
payload is set for DS1 (or VT1.5). Not all DS1 parameters apply for 
every test mode, but DS1 setup parameters typically appear on the 
screen similar to the following:

Transmit Timing 
Source

DS1: TxClk> selects the DS1 transmit timing source. This parameter 
can be set as follows:

Int: Timing is from the 156MTS’s internal clock.

Ext: Timing is derived from the rear-panel DS1 TX CLK IN port.

Loop: Timing is derived from the receive or drop DS1 signal.

Ref: Timing is derived at the rear-panel DS1 REF IN.

Note: If DS1: Data> is set to Ext, the transmit timing is derived from the input signal.

DS1: TxClk>Int   Frm>Sf     Code>AMI
        Tx>DSX1             Term>Term
        Rx>DSX1
      Data>QRSS
Err/Alm:Type>DS1 Data    Rate>Single
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DS1 Framing 
Format

DS1: Frm> selects the transmit and receive DS1 signal framing format. 
DS1: Frm> can be set to as follows:

SF: Superframe format (also called D4).

ESF: Extended superframe format.

SLC-96: SLC-96 format (also called TR8). Not available for VT1.5 
byte-synchronous modes.

Unfrm: Unframed format. Not available for VT1.5 byte-synchronous 
modes.

MBLT: Mobile Both-Line Terminal format. This is a modified SF format 
used by certain Ericsson switching equipment). Not available for VT1.5 
modes.

UnfT1c: Unframed T1C format.

SF/ESF: Auto-match mode. The test set analyzes the receive DS1 for 
SF or ESF format, and sets the transmitter to match. Not available for 
VT1.5 modes.

Note: If DS1: Data> is set to Ext, the framing format is determined by the input signal.

Note: If DS1: Data> is set to AIS, the transmitted signal is unframed regardless of the 
DS1: Frm> setting. On VT1.5 signals, the AIS is transmitted as a VT path AIS.

Line Coding DS1: Code> selects the line coding scheme as either AMI (alternate 
mark inversion) or B8ZS (bipolar with eight-zero substitution).

Transmit DS1 
Level

DS1: Tx> sets the DS1 transmit signal level at the DS1 TX port. This 
parameter is not available when the DS1 signal is the payload of a 
higher-rate signal. Tx> can be set as follows:

DSX1: DS1 cross-connect level, per TR-TSY-000499.

LBO –7.5 dB: Adds a line build out (LBO) 7.5 decibels attenuation 
from the DSX-1 level.

LBO –15 dB: Adds an LBO of 15 dB from DSX-1 level.

LBO –22 dB: Adds an LBO of 22 dB from DSX-1 level.
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Receive DS1 Level DS1: Rx> selects the input level for the receive DS1 signal. This 
parameter is not available when the DS1 signal is the payload of a 
higher-rate signal. Rx> can be set as follows:

DSX1: DS1 cross-connect level. Equalized for 0 to 655 feet of cable.

Mon: Monitor level. 10 to 25 dB flat loss relative to DSX-1 signal.

ALBO: Automatic equalizer for 400 to 4000 feet of cable.

Termination Mode DS1: Term> sets the DS1 RX port to either terminate (Term) or bridge 
(Bridge) the received signal. This parameter is not available when the 
DS1 signal is the payload of a higher-rate signal.

DS1 Payload DS1: Data> selects the payload for the DS1 signal. The choices for 
DS1: Data> are described in the following table.

DS1 Payload Selections (DS1: Data>)

Selection Description

QRSS A quasirandom signal source comprising a 220–1 pattern 
with a 14-zero constraint.

2^6-1 A 26–1 pseudorandom bit sequence (PRBS). 
This is a six- stage PRBS generator with feedback taps at 
stages 5 and 6.

2^9-1 A 29–1 PRBS. Nine-stage with feedback taps at 5 and 9.

2^11-1 A 211–1 PRBS. 11-stage with feedback taps at 9 and 11.

2^15-1 A 215–1 PRBS. 15-stage with feedback taps at 14 and 15.

2^20-1 A 220–1 PRBS. 20-stage with feedback taps at 17 and 20.

2^23-1 A 223–1 PRBS. 23-stage with feedback taps at 18 and 23.

All 0s All binary zeros (not available in VT1.5 byte sync modes).

All Ones All binary ones pattern.

Alt 1/0 Alternating binary 1s and 0s pattern.
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1 in 8 A 12.5% ones density pattern, synchronized to the F-bit as 
follows: F 0100 0000.

2 in 8 A 25% ones density pattern synchronized to the F-bit as 
follows: F 0110 0000

3 in 24 A 12.5% ones density pattern, synchronized to the F-bit as 
follows: F 0100 0100 0000 0000 0000 0100.

Progr #1 —
Progr #6

User-defined pattern. See User-Programmable DS1/E1 
Patterns, page 11–13.

AIS DS1 alarm indication signal: an unframed all-ones signal that 
overrides the DS1: Frm> setting. In VT1.5 this is transmitted 
as a VT path AIS (all-ones in the V1 and V2 bytes).

Ext A signal applied at the front-panel DS1 RX port is used as the 
transmit DS1. The received timing and framing override 
DS1: TxClk> and Frm>. This selection is available only when 
the DS1 signal is the payload in a higher-rate signal.

Passthru The receive DS1 signal is passed through to the transmit DS1 
port as-is (line code violations are corrected). Errors can be 
injected on the pass-through signal, except in monitor mode.

55 Octet This is also known as the Daly pattern. Framing does not 
overwrite the pattern. The pattern bit sequence is as follows:

10000000 10000000 10000000 10000000 10000000
10000000 00000001 10000000 10000000 10000000
10000000 10000000 10000000 11000000 10000000
10000000 10000000 10000000 11100000 10000000
10000000 10000000 10000000 10101010 10101010
10101010 10101010 01010101 01010101 01010101
01010101 10000000 10000000 10000000 10000000
10000000 10000000 11111111 11111111 11111111
11111111 11111111 11111111 00000001 10000000
00000001 10000000 00000001 10000000 00000001
10000000 00000001 10000000 00000001 10000000

Live No pattern. The receiver does not try to synchronize to a 
pattern. The transmitter sends the last-selected pattern.

DS1 Payload Selections (DS1: Data>), continued

Selection Description
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Insert DS1 
Channel

DS1: Ins> selects which DS1 within a DS3 signal is used for the 
transmit DS1. DS1: Ins> can be set from 1 through 28. This parameter 
is only applicable when the DS1 is the payload in a higher-rate signal.

Other DS1 
Channels

DS1: Other> sets the payload for the other DS1s (that are not selected 
by Ins>) on the DS3 transmit signal. Other> is only applicable when 
the DS1 is the payload in a higher-rate signal, and can be set as follows:

Same: Fills the DS1s with the same payload as the selected Ins> DS1.

Inv: Sets the DS1s to an inverted version of the Ins> DS1 payload.

AIS: Fills the remaining DS1s with a DS1 alarm indication signal (AIS).

This field is labeled “Oths” in SONET tests with DS3/DS1 payloads.

Drop DS1 Channel DS1: Drop> selects which DS1 within a DS3 signal is used for the 
receive DS1. DS1: Drop> can be set from 1 through 28 or to L (locked 
to match the Ins> channel). This parameter is only applicable when the 
DS1 is the payload in a higher-rate signal.

Note that the front-panel DS1 DROP jack provides the selected DS1 
signal dropped from the DS3.

DS1 Drop & Insert 
Channel

This parameter is only available for drop and insert mode (D&I) tests. 
The D&I> field simultaneously sets the DS1 insert and drop channels to 
the same number. D&I> can be set from 1 through 28. This parameter 
is only applicable when the DS1 is the payload in a higher-rate signal.

Note that the front-panel DS1 DROP jack provides the selected DS1 
signal dropped from the DS3.

DS0 DS0 traffic. The DS1 carries DS0 channels. See DS0 Setup 
Parameters, page 11–10.

FT1 Fractional T1 traffic. The DS1 signal carries subrate traffic 
made up of N number of DS0 channels. See FT1 Setup 
Parameters, page 11–9.

DS1 Payload Selections (DS1: Data>), continued

Selection Description
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Additional DS1 Setup Parameters

DS1 Block Size DS1 Block Size sets the DS1 information block size for applications 
involving block transfer protocols (such as video telephony).

Note: The DS1 Block Size value is used for E1 block measurements too.

This parameter is located on the Auxiliary Test Setups screen:

• Select Setup System Parameters from the Main Menu and 
press MENU-down.

• Next select Auxiliary Test Setups and press MENU-down.

DS1 Block Size can be set from 2Kbit through 8Kbit (kilobits). The 
block size is used to compute block error measurements (see DS1 

Block Error Measurements Screen, page 12–6).

DS1 Alarm Delay You can set a DS1 alarm hold-off period to delay the declaration of DS1 
LOP (loss of pattern) and OOF (out of frame) alarms.

DS1 LOP & OOF Hold-off: Sets the length of time alarms are 
delayed. This can be set from 0.0 (no delay) to 9.9.

DS1 Jitter Hits 
Threshold

For information on setting the jitter hits thresholds, see Jitter 

Threshold Configuration, page 23–3.

Auxiliary Test Setups
Test Dur. Mode:   Continuous
Timer Duration:   00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Pwr Up Optical Tx State:  Last State

Í
Í

STS12 # Scheme:   STS3#, STS1#
VT Counting Mode: VT Group
DS2 Tx-Xbit:      0
DS1 Block size:   2Kbit
DS1 LOP & OOF Hold-off: 0.0 seconds
Bits Clk Out Derived from: STS-N Rx Clk
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DS1 and DS0 Error and Alarm Injection

The following type of error can be injected when the transmitter or 
payload is set for DS1 or VT1.5. The rates for each selection are Single, 
1.0E-2 through 1.0E-9, Burst, Continuous, and Off.

Note: For information on injection rates, see About Error Injection Rates, page 27–8.

DS1 Data: Generates data bit errors before the CRC is calculated, so 
no CRC errors are generated.

DS1 Data, CRC: Generates combined data bit errors and CRC errors 
by erroring the data bits after the CRC is calculated.

DS1 Frame: Generates DS1 frame bit errors. For SF and SLC-96 
formats, the Ft bits are errored. For ESF format, the FPS bits are 
errored.

DS1 BPV: Generates bipolar violations in the DS1 data. For B8ZS 
coding, BPVs cause data bit errors as well.

DS1 Yellow: Generates a Yellow alarm condition on the transmit DS1 
using DS0 bit 2 in SF format, or an alternating 00 FF (hex) pattern in the 
facility data link for ESF format.

DS1 LoopUp: Generates the currently defined DS1 loopback activate 
code. See DS1 Loop Codes, page 11–14.

DS1 LoopDn: Generates the currently defined DS1 loopback 
deactivate code. See DS1 Loop Codes, page 11–14.

DS1 Idle: Generates a DS1 Idle/CDI (customer defect indication) 
signal. This is the pattern 0001 0111 on all 24 timeslots on the DS1. For 
ESF, a Yellow alarm is also sent on the datalink.

DS0 Data: Generates data bit errors on the selected DS0 when 
DS1: Data> is set to DS0 and DS0 Data> is set to a pattern.
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FT1 Setup Parameters

FT1 parameters are applicable when the DS1 payload (Data>) is set for 
FT1. FT1 parameters are accessed by selecting DS0/TS/Frac Setup 
from the Control Screens menu and pressing CONFIG-right twice. The 
Fractional T1 Setup screen appears as follows:

FT1 Base Rate Nx> selects the base rate for the FT1 signal. The base rate is the rate of 
a single DS0 channel. Nx> can be set to 64k (64 kbs) or 56k (56 kbs).

Note: This selection also sets the Nx> setting on the DS0 Setup screen.

Selected DS0 
Channels

Select> determines which DS0s are used to generate the FT1 signal. A 
channel set to “*” is included in the FT1 signal. A channel set to “.” is 
not included in the FT1 signal.

Channels that are not selected are transmitted as all-ones.

FT1 Payload Data> selects the payload for the FT1 signal. The data is distributed 
across the entire FT1 signal, even if the DS0s that make up the FT1 are 
not contiguous. The payload choices for Data> include the following 
(see DS1 Payload, page 11–4, for a description of each payload):

• QRSS

• PRBSs (2^6-1, and so on)

• All 0s or All 1s

• Alt 1/0

• 1 in 8, 2 in 8, or 3 in 24

• Progr #1 through Progr #6

• 55 Octet

          >Fraction T1 Setup<
Nx>64k 
       1  |   |   |   |   |   24
Select>************************
Data>QRSS
11–9



DS1, DS0, and FT1 Configuration Reference

DS0 Setup Parameters

D
S1/D

S0/FT1
DS0 Setup Parameters

DS0 setup parameters are applicable when the Payload is DS1 or DS0.

DS0 Mode 
Implementation

There are two ways that DS0 parameters are displayed. When the DS0 
traffic is carried in a DS1 signal connected directly to the test set, the 
DS0 parameters appear similar to the following:

When the DS0 traffic is carried in a DS1 that is the payload of a 
higher-rate signal, the DS0 parameters are accessed by selecting 
DS0 Control from the Control Screens menu. The DS0 Setup screen 
appears as follows:

Insert DS0 
Channel

DS0: Ins> selects which DS0 within a DS1 signal is used for the 
transmit DS0. DS0: Ins> can be set from 1 through 24.

Other DS0 
Channels

DS0: Other> sets the payload for the other DS0s (that are not selected 
by Ins>) on the DS1 transmit signal. Other> can be set as follows:

Same: Fills the DS0s with the same payload as the selected Ins> DS0.

All Ones: Sets the DS0s to an all-ones pattern.

Passthru: The DS0 payloads are retransmitted as received.

Í
Í

DS1:    Rx>DSX1           Tx>DSX1
       Frm>SF           Code>AMI
     TxClk>Int          Term>Term
DS0:   Ins>1   Other>Same      Drop>1
      Tone>DRS 1004 Hz

              >DS0 Setup<
Data>1004Hz           Nx>64k
Ins>1            Drop>1
Other>Same (VF Tone Only)
Tx Signaling:  A>1 B>1 C>1 D>1
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Drop DS0 Channel DS0: Drop> selects which DS0 within a DS1 signal is used for the 
receive DS0. DS0: Drop> can be set from 1 through 24. On the DS0 
Setup screen, Drop> can also be set to L, which locks the drop DS0 to 
match the insert DS0 (L is not available for monitor mode tests).

DS0 Drop & Insert 
Channel

This parameter is only available for drop and insert mode (D&I) tests. 
The D&I> field simultaneously sets the DS0 insert and drop channels to 
the same number. D&I> can be set from 1 through 24.

DS0 Base Rate Nx> selects the base rate for the DS0 signal. Nx> can be set to 64k 
(64 kbs) or 56k (56 kbs).

Note: This selection also sets the Nx> setting on the Fractional T1 Setup screen.

DS0 Payload The DS0 payload is set by one of two parameters, depending on the DS0 
test mode (see DS0 Mode Implementation, page 11–10).

DS0 Setup Screen 
Data>

On the DS0 Setup screen, Data> sets the DS0 payload as described in 
the following table.

DS0 Payload Selection (Data>)

Selection Payload Description

1004Hz
1012Hz
1020Hz
2010Hz

These four selections apply a test tone at the indicated 
frequency (in Hertz). Not available for monitor test modes.
The 2010 Hz tone is transmitted at –12 dB.

Tone Monitor modes only. Sets the receiver to expect an input tone 
on the drop signal.

Ext VF Transmits a VF signal applied at the rear panel VF IN jack. Not 
available for monitor test modes.

QRSS Quasirandom Sequence Signal. Transmits a quasirandom 
signal.

2^E-1 PRBS. A pseudorandom bit sequence of length 2^E-1 where E 
is the exponent. For example 2^9-1 is a 29–1 PRBS.

All 0s All binary zeros pattern (not available in VT1.5 byte sync 
modes).

All 1s All binary ones pattern.
11–11



DS1, DS0, and FT1 Configuration Reference

DS0 Setup Parameters

D
S1/D

S0/FT1
 Test Configuration 
Screen DS0: Tone>

On the test configuration screen (for direct DS1 signals) DS0: Tone> 
sets the DS0 payload as follows:

DRS 1004 Hz: Transmits a Digital Reference Signal of 1004 Hertz.

DRS 1012 Hz: Transmits a Digital Reference Signal of 1012 Hertz.

DRS 1020 Hz: Transmits a Digital Reference Signal of 1020 Hertz.

External VF: Transmits the signal applied at the rear-panel VF IN port.

Transmit DS0 
Signaling

The Tx Signaling: fields on the DS0 Setup screen set the binary status 
of the transmitted ABCD signaling bits of the selected insert DS0. Each 
bit (A>, B>, C>, and D>) can be set to either 1 or 0. C> and D> are 
applicable only in ESF format.

Alt 1/0 Alternating binary 1s and 0s pattern.

1 in 8 A 12.5% ones density pattern, synchronized to the F-bit as 
follows: F 0100 0000.

2 in 8 A 25% ones density pattern synchronized to the F-bit as 
follows: F 0110 0000

3 in 24 A 12.5% ones density pattern, synchronized to the F-bit as 
follows: F 0100 0100 0000 0000 0000 0100.

Prog#1 — 
Prog#6

User-programmable patterns. Transmits the corresponding 
user pattern (see User-Programmable DS1/E1 Patterns, 
page 11–13).

55 Oct Transmits a specific repeating 55-byte pattern, also known as 
the Daly Pattern.

DATA-LINK- 
RS232

Transmits the data applied at the rear-panel 
DATALINK RS-232 port.

DS0 Payload Selection (Data>), continued

Selection Payload Description
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User-Programmable DS1/E1 Patterns

The user-programmable DS1/E1 data patterns are accessed by selecting 
DS1/E1 Patterns on the Control Screens menu and then pressing 
CONFIG-right. These patterns are used when the DS1, E1, or DS0 
Data> field is set to a Prog #.

The DS1/E1 programmable pattern configuration screen appears as 
follows:

The Prog Pat # fields represent the bits in each of the DS1/E1 user 
patterns. Each bit can be set to 1, 0, or to a dot. A dot represents an 
unused bit position and is not transmitted. Pattern length can be from 2 
through 24 bits, and is defined by the number of bits set to 1 or 0.

The pattern is transmitted with the most significant bit following the 
frame bit (for pattern lengths that divide evenly into 192).

DS1/E1 Prog Pattern
ESF datalink message
  Data link idle     (01111110 01111110)
ESF Programmable datalink patterns
 User 1: v100010v xxxxxxxx  <v=0) (x=1)
 User 2: v011000v xxxxxxxx  (v=0) (x=1)

Prog Pat 1:     01000000................
Prog Pat 2:     010000..................
Prog Pat 3:     01000100000.............
Prog Pat 4:     010001000000000.........
Prog Pat 5:     010001000000000100......
Prog Pat 6:     010001000000000000100...
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DS1 Loop Codes

Loop codes are transmitted by setting Err/Alm:Type> to DS1 LoopUp 
or DS1 LoopDn. The transmitted loop up or loop down code is 
configured on the DS1 Loop Code Setup screen. To access this screen, 
select DS1 Loop Codes from the Control Screens menu and press 
CONFIG-right.

Loop Up and Loop 
Down Codes

LoopUp Code selects the code transmitted when Err/Alm:Type> is 
set to DS1 LoopUp. LoopDn Code selects the code transmitted when 
Err/Alm:Type> is set to DS1 LoopDn. These fields can be set as 
follows:

Inband Line [CSU] (10000): In-band line loop code: repeating 5-bit 
sequence (10000) typically used by CSUs.

Inband Ntwk [NIU] (11000): In-band network loop code: repeating 
5-bit sequence (11000), typically used by NIUs.

Inband 4bit (1100): In-band 4-bit loop code (repeating 1100 
sequence).

Inband Usr: In-band user-defined loop code. The code defined for 
Inband LpUp:Tx> (loop up) or Inband LpDn:Tx> (loop down) is 
transmitted when this is selected.

Outband Line [CSU] (000111): Out-of-band line loop code: six bit 
code transmitted in the ESF facility datalink; typically used by CSUs.

Outband Ntwk [NIU] (001001): Out-of-band network loop code: six 
bit code transmitted in the ESF FDL; typically used by NIUs.

         DS1 Loop Code Setup

 LoopUp Code: Inband Line [CSU] (10000)
 LoopDn Code: Inband Line [CSU] (100)
 Framing Overwrite: On

User Codes     Inband      Outband(ESF)
 LpUp:Tx>10000...........  000111
      Rx>10000...........
 LpDn:Tx>100.............  011100
      Rx>100.............
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Outband Pyld (001010): Out-of-band payload loop code: six bit code 
transmitted in the ESF FDL. This type loops only the payload of the 
signal.

Outband Usr: Out-of-band user-defined loop code. The code defined 
for Outband LpUp:Tx> (loop up) or Outband LpDn:Tx> (loop down) 
is transmitted when this is selected.

Frame Format 
Overwrite

Framing Overwrite sets whether the transmitted loop code writes 
over the DS1 framing. On means framing is overwritten; Off means 
framing is not overwritten.

User-defined Loop 
Codes

There are two sets of use-defined loop codes:

LpUp: The codes used for loop activation.

LpDn: The codes used for loop deactivation.

In-band Codes For in-band loop codes (codes transmitted in the payload portion of the 
DS1 signal) each user-defined loop code has a Tx and an Rx bit 
sequence:

Tx: This is the bit sequence that is transmitted when ERROR INECT is 
pressed.

Rx: This is the bit sequence for which the 156MTS monitors on the 
received signal.

Each code can be set from 2 through 16 bits long. Each bit can be set to 
either 1 or 0. Unused bits are set to a dot.

Out-of-band Codes Out-of-band codes are transmitted and received in the facility datalink 
(FDL) of Extended Superframe (ESF) formatted signals. Each code is 
six bits long, and is transmitted as part of a 16-bit sequence, as follows:

0bbbbbb0 11111111

where bbbbbb is the six-bit code.
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DS1 Data Link Parameters

Selecting Data Link Control 
from the Control Screens menu 
displays the Data Link Control 
screen.

The Data Link Control screen configures the functionality of the 
rear-panel data link ports.

Note: For information on other data link rate uses, see SONET Datalink Control 
Parameters, page 3–20 or DS3 Datalink Parameters, page 7–15.

Rear-Panel RS-232 
Data Link Port

RS232> configures the rear-panel DATA-LINK RS-232 interface in both 
the transmit and receive directions. The choices for DS1 are as follows:

None: The RS-232 data link interface is disabled.

DS1 ESF or SLC-96 Data Link: The transmitted data on the DS1 
data link channel (ESF or SLC-96 formats) is derived from the RS-232 
data link port. Received data from this data link is transmitted on the 
port’s output.

DS0 Data: The transmitted DS0 data on the DS1 signal is derived from 
the RS-232 data link port. Received DS0 data is output on this port.

Note: The remaining data link parameters on this screen apply only for SONET rate 
testing. See SONET Datalink Control Parameters, page 3–20.

Í

            Data Link Control

RS232>None
RS422>None
Handset>None
DCC Pass-Thru>Off

OC-12 APS Pass-Thru>Off

----------------------------------------
Selection of data link insert or pass-
thru above overrides programmed byte
values.
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DS1 Drop Scan Sequence

The DS1 drop sequence scans the 28 DS1 channels of a DS3 signal one 
at a time. The DS3 signal can be an electrical signal at the DS3 RX port, 
or it can be dropped from an STS-1, OC3, or OC-12 signal. The DS1 drop 
scan setup and results screen appears as follows:

Drop Scan 
Configuration

The Configurations From> field selects the test mode that is used for 
the DS1 drop scan sequence. The configuration that was last set-up for 
the selected mode (the background mode) is used for the test sequence. 
The modes are listed in the following table. The modes available depend 
on the configuration of your test set.

Scan Mode Channel Scan Mode> selects the method used to control the DS1 
scan.

Single: The 28 DS1s are scanned and then the sequence ends.

Continuous: After each scan of the 28 DS1s is performed, the scan is 
repeated.

 1 DS1 Drop Scan    Final:  00:00:00.00 
   1: --                 6: --
   2: --                 7: --
   3: --                 8: --
   4: --                 9: --
   5: --                10: --

Configurations From> DS3-MON (DS1)
Channel Scan Mode  > Single
----------------------------------------

DS1 Drop Scan Sequences Configurations From Selections

DS3–MON (DS1) DS3–DS3 (DS1) STS1–MON (DS3/1)

OC3–OC3 (DS3/1) OC3–MON (DS3/1)

OC12–OC12 (DS3/1) OC12–MON (DS3/1)
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Drop Scan Results The results of the DS1 drop scan are displayed on the top half of the 
display. Each channel is listed, along with its detected status. The 
RESULT keys scroll through the channel list screens.

After each DS1 is analyzed, one of the following is displayed for that 
channel:

No Signal: No detectable signal. Either no DS3, or no DS1 traffic 
present on the DS3.

AIS: Alarm indication signal detected on the DS1.

No Frame: The framing format as set in the background mode was not 
detected on the DS1.

Frame: The DS1 framing format as set in the background mode was 
detected, but without pattern synchronization.

Frm & Pat: Both DS1 frame format and pattern were detected, as 
selected in the background mode.
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DS0/Timeslot Signaling Scan

The DS0/TS signaling sequence scans the 24 DS0 channels of a DS1, or 
the 31 TS (timeslot) channels of an E1, and reports the signaling bit 
status. The DS1 or E1 can be directly connected at the DS1/E1 RX port, 
or it can be dropped from a DS3. The signaling scan screen appears as 
follows:

Signaling Scan 
Configuration

The Configurations From> field selects the test mode for the 
signaling scan sequence, using the configuration that was last set-up for 
the selected mode (the background mode). The modes are listed in the 
following table. 

Scan Mode Channel Scan Mode> selects whether the DS0/TS scan repeats:

Single: The 24 DS0s are scanned and then the sequence ends.

Continuous: After all channels are scanned, the scan is repeated.

Signaling Scan 
Results

The results of the signaling  scan are shown on the top half of the 
display. Each channel is listed, along with the  status of its signaling bits 
(either 1 or 0). The C and D signaling bits are only applicable to DS1 
ESF format and E1 CAS (30-channel) format signals.

 1 Signaling Scan   Final:  00:00:00.00 
     ABCD  ABCD  ABCD  ABCD  ABCD  ABCD
  1: 00--  00--  00--  00--  00--  00--
  7: 00--  00--  00--  00--  00--  00--
 13: 00--  00--  00--  00--  00--  00--
 19: 00--  00--  00--  00--  00--  00--

Configurations From> DS1-DS1 (DS0)
Channel Scan Mode  > Single
----------------------------------------

Signaling Scan Sequences Configurations From Selections

DS1–MON (DS0) E1–MON (TS) DS3–MON (DS0)

DS1–DS1 (DS0) E1–E1 (TS) DS3–MON (E1/TS)
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DS1 Indicators

DS1 Alarm and Status Indicators

Indicator Description

HIST/ALARMS

LOS Loss of DS1 (or E1) signal.

OOF Out of frame.

AIS DS1 (E1) alarm indication signal.

YEL DS1 Yellow alarm; (E1 Remote alarm).

LOPAT Loss of pattern.

COFA DS1 Change of frame alignment.

DS1 STATUS

DS1 SIG Valid DS1 signal detected.

DS1C SIG Valid DS1C signal detected.

SF SYNC Valid Superframe (SF) format detected.

ESF SYNC Valid Extended Superframe (ESF) format detected.

PAT SYNC Receiver synchronized with test pattern.

B8ZS DS1 B8ZS zero substitution codes detected.

ERRORS DS1 error detected.
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DS1 Measurement Summary Screen

For each screen, an “s” 
indicates Summary results 
level and a “d” indicates Detail 
level. See To Display More 
Measurement Screens, 
page 1–11.

This screen displays an overview of DS1 error measurements.

Sec Ago shows the time 
elapsed since the last error, in 
seconds.

Bit: DS1 bit error count: The number of errored bits (transmitted at 
one level, but received at another).

Frm: DS1 frame error count: The number of framing bits received in 
error. The framing bits are Ft or Fs (for SF format), FPS bits (ESF), and 
Ft (SLC-96).

CRC: DS1 CRC-6 error count: The number of ESF CRC-6 fields that are 
received in error.

BPV: DS1 bipolar violation count: The number of DS1 BPVs. A BPV is 
the occurrence of two consecutive pulses of the same polarity (unless 
the pulses are part of a B8ZS zero-substitution code).

DS1 Drop Hz: Drop DS1 frequency: The frequency, in Hertz, of the 
DS1 signal dropped from a higher-rate signal. This measurement is only 
displayed when testing higher-rate signals carrying DS1 subrate traffic.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Measurement Summary
Bit:           --     Sec Ago    --
Frm:           --                --
CRC:           --                --
BPV:           --                --
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DS1 Bit Error Measurement Screens 

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Bit Error Measurements #1
 Error Count:       --
 Current Ratio:     --
 Average Ratio:     --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Bit Error Measurements #2
 ES:       --      Sync ES:       --
 EFS:      --      Avail Sec:     --
 %EFS:     --      Unavail Sec:   --
 Sev ES:    --     Degrad Min:    --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Bit Error Measurements #3  (Seconds)
 Thrsh E-3:    --      Dribble:    --
 Thrsh E-4:    --      CSES:       --
 Thrsh E-5:    --      Burst ES:   --
 Thrsh E-6:    --

DS1 Bit Error Measurements

Measurement Description

Error Count The total number of DS1 bit errors detected.

Current ratio Current DS1 BER: The number of DS1 bit errors over the 
number of DS1 bits received in the previous 2.25 seconds.

Average Ratio Average DS1 BER: The number of DS1 bit errors over the 
total DS1 bits received since the beginning of the test.

ES DS1 errored seconds: Number of seconds with at least 
one DS1 bit error, LOP, or LOS (seconds are counted from 
test start). Seconds during which a LOS are not counted.

EFS DS1 error-free seconds: The number of seconds during 
which no DS1 bit errors occurred.

%EFS Percentage of DS1 error-free seconds: EFS expressed as 
the percentage of the total number of seconds in the test.
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Sev ES DS1 severely errored seconds (SES): The number of 
seconds during which the error ratio was 10–3 or greater.

Sync ES DS1 synchronous errored seconds: The number of 
seconds in which at least one DS1 bit error occurred 
(seconds are counted beginning at the error occurrence).

Avail Sec DS1 available seconds: The number of seconds during 
the test that were not unavailable (see below).

Unavail Sec DS1 unavailable seconds: The DS1 is declared 
unavailable after ten consecutive seconds of SES or LOP. 
The DS1 is declared available again after ten consecutive 
seconds with no SESs or LOPs.

Degrad Min DS1 degraded minutes: The number of 60-second 
intervals during which the available seconds and bit error 
counts are both greater than zero, but do not exceed the 
SES threshold; or, the number of 60-second intervals 
during which the available seconds and CRC error counts 
are both greater than zero but less than 320. The 
60-second intervals do not need to be contiguous.

Thrsh E-n DS1 threshold seconds: Number of available seconds 
during which the bit or CRC error rate (whichever is 
larger) exceeded the threshold. Thresholds correspond to 
the following values (framed/unframed): E-3 = 1,536/1,544; 
E-4 = 154/154; E-5 = 15/15; E-6 = 2/2.

Dribble DS1 dribbling error seconds: The number of seconds 
during which the error rate is greater than 1, but does not 
exceed 10–6 (between 1 and 14 errors).

CSES DS1 Consecutively severely-errored seconds count: The 
number of SESs for which the previous two seconds were 
also SESs. This count is reset during LOS, LOF, and LOP.

Burst ES DS1 burst error seconds: The number of seconds in 
which three or more bit errors occurred.

DS1 Bit Error Measurements, continued

Measurement Description
12–5



DS1 Measurement Reference

DS1 Block Error Measurements Screen

D
S1/D

S0/FT1
DS1 Block Error Measurements Screen
To determine block errors, the 
received DS1 bits are counted 
into blocks of 2 through 8 
kilobits (block size is 
user-programmable, see DS1 
Block Size, page 11–7).

This screen displays measurements based on DS1 block errors.

Est. Total Blocks: Estimated count of DS1 blocks: The estimated 
number of blocks received, as determined by the selected block size.

Block Err Count: DS1 block error count: The number of DS1 blocks 
that contained one or more errors.

Burst Err Seconds: DS1 block burst errored seconds: The number of 
seconds in which the number of block errors was three or greater.

SEE: Severe error event count. A SEE is four consecutive quarter- 
seconds each containing 93 or more bit errors, or more than N block 
errors. The value of N depends on the DS1 block size (see following 
table). A SEE ends when there are two consecutive error-free seconds.

CATV UAS: Cable TV unavailable seconds count: The number of 
CATV UASs. A CATV UAS interval is declared when there are 60 
consecutive BESs, ten consecutive SESs, or ten consecutive LOP 
seconds. These seconds are included in the unavailable time.

A CATV UAS interval ends when there are 60 consecutive error-free 
seconds. These seconds are not included in the unavailable time.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Block Error Measurements
Est. Total Blocks:      --
Block Err Count:        --
Burst Err Seconds:      --
SEE:     --        CATV UAS:     --

Severe Error Event (SEE) Block Error Threshold Values

Bloc
 Size

N (number of 
block errors)

Block
Size

N (number of 
block errors)

2 Kbit 46 6 Kbit 15

3 Kbit 30 7 Kbit 13

4 Kbit 23 8 Kbit 11

5 Kbit 18
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DS1 CRC-6 Error Measurements Screen

This screen displays measurements based on CRC-6 errors in ESF 
formatted DS1 signals.

Count: CRC error count: The number of ESF CRC-6 values that are 
errored.

Cur Ratio: Current CRC error ratio: The average CRC error ratio 
during the previous 2.25 seconds.

Avg Ratio: Average CRC error ratio: The number of CRC-6 errors over 
the number of bits received since the beginning of the test.

ES: CRC errored seconds: The number of seconds during which at 
least one CRC error occurred.

EFS: CRC error-free seconds: The number of seconds during which no 
CRC errors occurred.

%EFS: CRC error-free seconds percentage: DS1 CRC-6 EFS expressed 
as a percentage of the total time since the beginning of the test.

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 CRC-6 Error Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
12–7
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DS1 Frame Error Measurements Screen

This screen displays measurements based on framing errors in framed 
DS1 signals.

Count: Frame bit error count: The number of errored frame bits, 
including Ft or Fs bits (for SF format), FPS bits (for ESF), or Ft bits (for 
SLC-96).

Cur Ratio: Current frame bit error ratio: The average frame bit error 
ratio during the previous 2.25 seconds.

Avg Ratio: Average frame bit error ratio: The number of frame bit 
errors over the number of frame bits received since the beginning of the 
test.

ES: Frame bit errored seconds: The number of seconds during which 
at least one frame bit error occurred.

EFS: Frame bit error-free seconds: The number of seconds during 
which no frame bit errors occurred.

%EFS: Frame bit error-free seconds percentage: DS1 frame bit EFS 
expressed as a percentage of the total time since the beginning of the 
test.

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Frame Error Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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DS1 Combined Frame and CRC Errors Screen

This screen can be useful 
when monitoring live traffic. 
CRC results provide a 
reasonable assessment of 
payload performance, and 
framing results help complete 
the picture of the DS1 signal.

This screen displays errored seconds measurements based on 
combined DS1 framing and CRC errors.

ES: Frame/CRC errored second count: The number of seconds during 
which at least one frame bit or CRC-6 error occurred, but no OOF 
events occurred.

ES A: CRC type A errored seconds count: The number of seconds 
during which a single CRC-6 error occurred, and no OOF events 
occurred.

ES B: CRC type B errored seconds count: The number of seconds 
during which at least one but fewer than 320 CRC-6 errors occurred, but 
no OOF events occurred.

SES: Frame/CRC severely errored seconds count: The number of 
seconds during which an OOF event or 320 CRC-6 errors occurred.

Cons SES: Frame/CRC consecutive severely errored seconds count: 
The number of seconds counted as CSESs. This value increments by ten 
for every ten successive frame/CRC SESs that occur.

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Combined Frame & CRC Errors
 ES:      --          SES:         --
 ES A:    --          Cons SES:    --
 ES B:    --
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DS1 BPV Measurements Screen

This screen displays measurements based on bipolar violations 
(BPVs).

Count: BPV error count: The number of bipolar violations. A BPV is 
the occurrence of two consecutive pulses of the same polarity (unless 
the pulses are part of a B8ZS zero-substitution code).

Cur Ratio: Current BPV error ratio: The average BPV error ratio 
during the previous 2.25 seconds.

Avg Ratio: Average BPV error ratio: The number of BPVs over the 
number of bits received since the beginning of the test.

LCVR Sec: Line code violation rate seconds count: The number of 
seconds in which the LCVR state was declared. The LCVR state is 
declared when the BPV error rate exceeds 15 for one second 
(approximately 10–6). The LCVR state is cleared when the BPV rate 
drops to less than one per second (approximately 10–7). 

ES: BPV errored seconds: The number of seconds during which at least 
one BPV occurred.

EFS: BPV error-free seconds: The number of seconds during which no 
BPV errors occurred.

%EFS: BPV error-free seconds percentage: Bipolar violation EFS 
expressed as a percentage of the total time since the beginning of the 
test.

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 BPV Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
 LCVR Sec:      --
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DS1 Slips Screen

This screen displays DS1 slips measurements based on comparing the 
timing relationship between the receive DS1 signal to an external 
reference signal. The reference signal is a bipolar DSX-1 source applied 
at the rear-panel DS1 REF IN connector.

A frame slip is also called a 
controlled slip.

Frm Slips: Frame slip count: The number of frame slip occurrences. A 
frame slip is declared when a difference of 193 time slots (bits) is 
detected between the receive and reference signals. Multiple frame 
slips within 0.25 seconds are counted as a single frame slip.

Bit Slips: Bit slip count: The number of individual time slot differences 
between the receive and reference signals, in either direction. A 
positive value indicates that the receive frequency is greater than the 
reference frequency. A negative value indicates the receive frequency is 
less than the reference. If the reference is lost, the bit slip count is 
restarted from zero when the reference is restored.

Bit Slips (graphic): This arrow provides a repeating graphic showing 
the number of bit slips. When the arrow reaches the right side of the 
display, 193 bits slips have been counted and a frame slip is declared.

Slip Sec: Slip seconds count: The number of second during which one 
or more frame slips occurred.

Rx Hz: Receive DS1 frequency: The received signal frequency 
displayed in Hertz.

Delta Hz: Frequency difference in Hertz: The difference between the 
receive DS1 frequency and the reference frequency. A positive value 
indicates the receive frequency is faster than the reference; a negative 
value indicates the receive frequency is slower.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Slips
 Frm Slips:   --      Slip Sec:    --
 Bit Slips:   --
 Bit Slips:--------->
 Rx Hz:        --     Delta Hz:    --
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DS1 Idle/CDI Detection Screen

This screen displays measurements based on the detected of the DS1 
Idle/CDI code. The Idle/CDI (customer defect indicator) is often 
transmitted by DS1 NIUs upon detection of a customer-side loss of 
signal.

The Idle/CDI code is defined as the repeating pattern 0001 0111 in all 24 
timeslot son the DS1. In ESF format, a Yellow alarm is also transmitted 
in the facility datalink.

Current State: Indicates whether the Idle/CDI code is currently being 
detected on the selected receive DS1 signal. ON indicates the code is 
present.

History: Indicates whether the Idle/CDI code was previously detected 
since the beginning of the test.

Received Sec: The number of seconds during which the Idle/CDI code 
was detected since the beginning of the test.

Seconds Ago: The number of second since the last Idle/CDI code was 
detected.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Idle Detection

 Current State: --  History: --
 Received Sec:     --
 Seconds Ago:      --
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DS1 ESF Datalink Display Screen

This screen displays the received DS1 Extended Superframe (ESF) 
facility datalink (FDL). The received signal must be ESF  framed.

Binary: Shows the current 16-bit FDL sequence.

Message: Shows the corresponding text message of the received FDL 
code (if applicable).

Received Sec: Displays how long the current code has been received.

DS1 Loop Code Display Screen

This screen displays the status of loop codes received by the test set.

The screen reports the status of in-band and out-of-band loop-up and 
loop-down codes. For each type of loop code, the Cur (current) field 
will display ON when that code is being detected. The His (history) 
field shows ON when that loop code has been detected since the start 
of the test.

The Seconds field indicates how long the loop code was detected. 
Sec Ago shows how long it has been since the code was last detected.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
         DS1 ESF Data Link

Binary:   0111111001111110
Message:  Data link idle
Received Sec:        176

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Loopcode - Cur His  Seconds  Sec Ago
Inband LpUp:   --  ON         8       56
Inband LpDn:   --  ON         8       40
Outband LpUp:  --  ON         8        5
Outband LpDn:  ON  --         6     --
12–13
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DS1 Signal Measurements Screen

This screen displays signal measurements for the DS1 receive signal.

Rx Hz: Receive DS1 signal frequency: The frequency of the receive 
DS1 signal, in Hertz.

Rx Pk V: Receive DS1 level, Vpk: The level of the receive DS1 signal in 
volts peak (accuracy is ±5%).

Rx dBdsx: Receive DS1 level, dB: The level of the receive DS1 signal in 
decibels, referenced to a DSX-1 level (accuracy is ±1 dB). The range is 
–30 to +6 dBdsx.

Rx ma: Simplex current, mA: The level of DC current between the 
transmit and receive pairs in milliamperes (mA). A positive (+) value 
indicates current flow from the receive pair to the transmit pair.

Ref Hz: Reference DS1 signal frequency: The frequency of the 
reference DS1 signal applied at the rear-panel DS1 REF IN connector, in 
Hertz.

EXZ: Excessive zeros count: The number of consecutive-zero strings 
greater than 15 (for AMI) or greater than 7 (for B8ZS). Each string is 
considered a single event.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Signal Measurements
 Rx Hz:       --        Ref Hz:    --
 Rx Pk V:     --        EXZ:       --
 Rx dBdsx:    --
 Rx ma:       --
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Jitter Measurements

Jitter Peak 
Results

Each result is calculated for both wide-band and high-band jitter.

For DS1, the wide-band jitter 
cutoff frequency is 10 Hz to 
40 kHz and the high-band 
cutoff frequency is 8 kHz to 
40 kHz.

Current P-to-P: Current peak-to-peak jitter: The sum of the positive 
jitter peak and the negative jitter peak for the most recent one-second 
period. Displayed in unit intervals.

MAX P-to-P: Maximum peak-to-peak jitter: The sum of the highest 
positive jitter peak and the highest negative jitter peak for the entire 
test duration. Displayed in unit intervals.

MAX Pos Peak: Maximum positive jitter peak: The greatest positive 
jitter peak since the beginning of the test. Displayed in unit intervals.

MAX Neg Peak: Maximum negative jitter peak: The greatest negative 
jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and 
Mask Results

See DS1 Jitter Hits Threshold, 
page 11–7.

Each result is calculated for both wide-band and high-band jitter.

Hits Count: Indicates the total number of jitter hits (jitter hit 
threshold exceeded) since the beginning of the test.

For DS1, the wide-band mask 
is 5.0 UI and the high-band 
mask is 0.1 UI.

Total Hits Time: Indicates the cumulative total of time, in seconds, 
that the jitter hit threshold has been exceeded since the beginning of 
the test.

MAX Percent of Mask: Indicates the maximum peak-to-peak jitter 
for the entire test period expressed as a percentage of the jitter mask. 

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Jitter           Wide-Band High-Band
 Current P-to-P (UI):    --       --
 MAX P-to-P (UI):        --       --
 MAX Pos Peak (UI):      --       --
 MAX Neg Peak (UI):      --       --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Jitter           Wide-Band High-Band
 Hits Count:             --       --
 Total Hits Time(Sec):   --       --
 MAX Percent of Mask:    --       --
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DS1 Alarm Screens
These screens display alarm results for the DS1 receive signal. The 
alarms displayed on the screens are described in the following table.

DS1 Alarms

Alarm Description

LOS DS1 loss of signal: Declared when there are 175 or more 
contiguous pulse positions with no pulses. LOS is cleared when 
there is a 12.5% or higher ones-density on the receive signal.

LOP DS1 loss of pattern: Declared when pattern synchronization is not 
achieved or when the receive pattern does not correspond to the 
internal reference pattern.
Pattern synchronization is declared when 64 consecutive pattern 
matches (bits) are received.
Loss of pattern synchronization is declared when 224 out of 1,024 
consecutive pattern bits are errored. (User patterns with less 
than 25% transition density use 85 errors out of 1,024 bits.) The 
1,024-bit blocks are counted from the beginning of pattern 
synchronization.

AIS DS1 alarm indication signal: Declared when an unframed all-ones 
pattern is received (“all-ones” is considered to be fewer than 
three zeros in two consecutive frames).

Yellow DS1 Yellow alarm: Declared when Bit 2 of at least 256 
consecutive DS0 timeslots is set to 0 (SF format) or 16 pattern sets 
of 00h and FFh are received on the FDL (ESF format).

OOF DS1 out of frame: Declared when two out of four framing bits are 
errored (Ft and Fs bits for SF format, FPS bits for ESF, or Ft for 
SLC-96 and MBLT).

COFA Change of frame alignment: Declared when the test set 
resynchronizes to a new frame or multiframe alignment after an 
OOF condition.

1s Den DS1 ones density alarm: Declared when more than 15 
consecutive zeros are received (AMI) or more than 7 consecutive 
zeros are received (B8ZS).
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DS1 Alarm 
Seconds Screen

This screen displays counts of DS1 alarm seconds. An alarm second is 
one during which at least one occurrence of that alarm occurred. 

DS1 Alarm and 
History Screen

This screen displays the current and previous occurrence of DS1 alarms 
on the receive signal. Like the front-panel indicator LEDs, the screen 
provides a current status of the alarm (Alarm) and also indicates if the 
alarm has occurred previously (Hist).

DS1 Monitor 
Alarm & Status 
Seconds

This screen is only available in DS1 monitor test modes, and displays 
counts of DS1 alarm seconds on the monitored DS1 signal.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Alarm Seconds
 LOS:       --            OOF:     --
 LOP:       --
 AIS:       --
 Yellow:    --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1  Alarm  Hist       DS1  Alarm  Hist
 LOS:  --    --       COFA:   --    --
 OOF:  --    --       LOP:    --    --
 YEL:  --    --       1s Den: --    --
 AIS:  --    --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1 Monitor Alarm & Status Seconds
 LOS:       --            OOF:     --
 AIS:       --
 Yellow:    --
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DS1 Status Screen
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DS1 Status Screen

This screen displays The status of certain DS1 signal parameters, 
similar to the front-panel DS1/E1 STATUS indicators. 

For each parameter, the display shows ON if that condition is present.

DS1 Signal: DS1 signal present: Declared when a DS1 signal is 
received with at least a 12.5% ones-density.

Pattern: DS1 pattern synchronization: Declared when 64 consecutive 
pattern matches (bits) are received.

SF Sync: Valid SF signal frame synchronization: Declared when 24 
consecutive error-free F-bits are received.

ESF Sync: Valid ESF signal frame synchronization: Declared when 24 
consecutive error-free FPS-bits are received.

DS1C Signal: DS1C signal present: Declared when at least 175 
contiguous pulses are received at the DS1C rate (3.152 Mbs).

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
DS1         Status  DS1          Status
 DS1 Signal:  --     DS1C Signal:  --
 Pattern:     --
 SF Sync:     --
 ESF Sync:    --
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DS0 VF Measurements Screen

This screen displays VF level, frequency, data, and signaling results for 
the selected DS0 drop channel on the DS1 signal (this screen is only 
active when the DS0 Data> is set for a tone).

Level: DS0 level: The DS0 signal tone level in decibels (dBm). The bar 
graph to the right gives a graphical display of the signal.

>+3dBm Thresh Sec: DS0 3 dBm threshold seconds: The number of 
seconds in which the signal level exceeded +3 dBm.

Freq: DS0 frequency: The frequency of the received tone in Hertz.

Data: DS0 payload: The current eight bits in binary format (1s or 0s).

ABCD: DS0 channel signaling bits: The binary status of the four 
signaling bits. Bits C and D are only active if the DS1 signal is set for 
ESF framing.

s

 1 DS1-DS1 (DS1)    Final:  00:00:02.00
DS0 VF Meas      -60....-40...-20.....0.
  Level:  0.5     ********************
 >+3dBm:       0 Thres. Sec
  Freq:1004  Hz
  Data:10111010 A=0   B=0   C=0   D-0
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DS0/TS Bit Error Measurements Screen
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DS0/TS Bit Error Measurements Screen

This screen displays BER results on the selected DS0. This screen is 
only active when the DS0 Data> is set for a pattern.

Error Count: DS0 pattern bit errors: The number of bit errors 
detected on the selected DS0 since the beginning of the test.

Average Ratio: DS0 average pattern bit error ratio: The average ratio 
of errored bits over the total number of bits for the selected DS0 since 
the beginning of the test.

Current Ratio: DS0 current pattern bit error ratio: The average ratio 
of errored bits over the total number of bits for the selected DS0 during 
the most recent 2.25 seconds.

s

 1 DS1-DS1 (DS1)    Final:  00:00:02.00
DS0/TS Bit Error Measurements
  Error Count:          0
  Average Ratio: 0.00E+00
  Current Ratio: 0.00E+00
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FT1 Measurement Summary Screens

This screen displays an overview of fractional T1 (FT1) error 
measurements.

Sec Ago shows the time 
elapsed since the last error, in 
seconds.

Bit: FT1 bit error count: The number of errored bits (transmitted at 
one level, but received at another).

Frm: FT1 frame error count: The number of framing bits received in 
error.

CRC: FT1 CRC error count: The number of FT1 CRC fields that are 
received in error.

BPV: FT1 bipolar violation count: The number of FT1 BPVs. A BPV is 
the occurrence of two consecutive pulses of the same polarity.

s

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
FT1 Measurement Summary
Bit:           --     Sec Ago    --
Frm:           --                --
CRC:           --                --
BPV:           --                --
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FT1 Bit Error Measurement Screens
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FT1 Bit Error Measurement Screens

These three screens display results based on FT1 bit error 
measurements. 

The results displayed on the screens are similar to the DS1 bit error 
measurements, except that they apply to FT1 signal. See DS1 Bit Error 

Measurements, page 12–4.

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
FT1 Bit Error Measurements #1
 Error Count:       --
 Current Ratio:     --
 Average Ratio:     --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
FT1 Bit Error Measurements #2
 ES:       --      Sync ES:       --
 EFS:      --      Avail Sec:     --
 %EFS:     --      Unavail Sec:   --
 Sev ES:    --     Degrad Min:    --

d

 1 DS1-DS1 (DS1)    Final:  00:00:00.00 
FT1 Bit Error Measurements #3  (Seconds)
 Thrsh E-3:    --      Dribble:    --
 Thrsh E-4:    --      CSES:       --
 Thrsh E-5:    --
 Thrsh E-6:    --
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DS1/DS0/FT1 Specifications

DS1/DS0 Interfaces
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DS1/DS0 Interfaces

DS1 Transmitter 
DS1 TX

Signal = DSX-1: DSX-1 signal with selectable LBOs:

• Per CB119, ANSI T1X1 and TR-TSY-000499.

• 3.0 Vpk ±1.0 dB (0 dBdsx).

• Supports Simplex power.

• LBO = –7.5, –15.0, or –22.0 dBdsx.

Line Code: AMI or B8ZS.

Impedance: 100 ohm ±5% balanced; return loss >20 dB.

Connector: Accepts WECo 310. Optional Bantam.

DS1 Receiver 
DS1 RX

Signals:

Line Code: AMI or B8ZS.

Impedance:

• Term = 100 ohms ±5%, return loss >20 dB.

• Bridge = >1000 ohms.

Connector: Accepts WECo 310 plug. Optional Bantam.

DSX-1 Per CB119, ANSI T1X1 and TR-TSY-000499.
3.0 Vpk ±1.0 dB (0 dBdsx).
1.544 MHz ±1000 ppm.
Sensitivity = 26 dB below 0 dBdsx.
Jitter tolerance per Bellcore TR-TSY-000009

ALBO Automatic LBO equalized for 400 to 4000 ft of 22 AWG 
pulp insulated cable.

Mon 10 to 25 dB flat loss relative 0 dBdsx.
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DS1 Drop Output 
DS1 DROP

Signal = DSX-1: DS1 dropped from higher-rate signal.

• Per ANSI T1X1 and TR-TSY-000499.

• 3.0 Vpk ±1.0 dB (0 dBdsx).

Line Code: AMI or B8ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECo 310 plug. Optional Bantam.

DS1 Timing Internal: 1.544 MHz ±20 ppm.

DS1 TX CLK IN jack: Input DS1 signal. TTL levels, 50 ohm, BNC 
connector. Requires a 2.5 Vdc offset.

Bit Error Output DS1 ERR OUT: Provides a single pulse output for each DS3 error 
detected. TTL level, 50 ohm, BNC connector.

DS1 Slips 
Reference

Input: DS1 REF IN jack: DSX-1, per TR-TSY-000499.

• 3.0 Vpk input level, typical.

• WECo 310 connector.

DS1 Network 
Interface

DS1 INTERFACE port: DB-15 socket connector. Provides parallel 
connections to the front-panel DS1 TX and DS1 RX connectors.

Pin Function

1 DS1 Tx tip

9 DS1 Tx ring

3 DS1 Rx tip

11 DS1 Rx ring

All others No connection
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Data Link Interfaces
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DS1 Errors Output DS1 ERR OUT jack: TTL, 50 ohm, BNC connector.

DS0 Interfaces VF Drop Port: VF OUT jack: 600 ohm, internal codec.

VF Insert Port: VF IN 600 ohm, internal codec.

ABCD Signaling 
Bits Drop

SIGNALING TTL port: TTL, DB-9 socket connector, 50 ohms.

Note: The rear-panel DS1 REF IN, DS1 INTERFACE, DS1 ERR OUT, and 
SIGNALING TTL connectors serve the corresponding E1 functions when the 
test set is in an E1 mode.

Data Link Interfaces

For data link port pinout information, see Data Link Interfaces, 
page 27–4. For DS1 data link control information, see DS1 Data Link 

Parameters, page 11–16.

Pin Function

3 Signaling bit A

8 Signaling bit B

4 Signaling bit C

9 Signaling bit D

All others Ground
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Jitter Option Specifications

DS3 jitter measurement requires DS3 testing (E4480A-001 base unit or 
Option URR), Option UQP, and either Option UQN or 201.

Measurement 
Response

DS1 Jitter Measurement per: TR-TSY-000499

Wide-band cutoff frequency: 10 Hz to 400 kHz

High-band cutoff frequency: 8 kHz to 400 kHz

Roll-off (per decade) below lower 3 dB point: ≥20 dB

Roll-off (per decade) above higher 3 dB point: ≥60 dB

Jitter 
Measurements

Demodulated 
Jitter Output

DMOD JITTER OUT jack: 50 ohm, BNC connector. 
Scale = 100 mV/UI; range = 0 to 6 Vdc.

Measurement Range Resolution Accuracy

Maximum Peak Positive Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Maximum Peak Negative Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Current Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Max Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Wideband Mask Highband Mask

Percent of Mask 5.0 UI 0.1 UI
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DS1 Signal Formats—1.544 Mbs
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DS1 Signal Formats—1.544 Mbs

1 2 3 4 5 6 7 8

1 24 F

1 2 Fs 3 4 5 6 7 8 9 10 11 12

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

1 DS1 Frame = 24 eight-bit timeslots + 1 framing bit = 193 bits

1 Superframe = 12 Frames

1 Extended Superframe = 2 Superframes = 24 Frames

1 Timeslot (DS0) = 8 bits

SF Format Framing Word:
F-bit sequence = 100011011100
(Ft = 101010; Fs = 001110)
Signaling bits:
A = bit 8 of frame 6
B = bit 8 of frame 12

ESF Format Framing Word (F-bits of frames 4, 8, 12, 16, 20, 24) = 001011
CRC-6 Bits = F-bits of frames 2, 6, 10, 14, 18, 22.
Facility Data Link (FDL: 4 kbs) = F-bits of odd-numbered frames.
Signaling bits:
A = bit 8 of frame 6, B = bit 8 of frame 12, C = bit 8 of frame 18, D = bit 8 of frame 24.

Ft FsFt FsFt FsFt FsFt FsFt
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E1 and Timeslot Network Testing

Set up for E1 Testing

E1/TS
Set up for E1 Testing

E1 testing is available when the payload is set for DS3/E1, E1, or TS.

1. From the Main Menu use FIELD to pick a test mode and press 
MENU-down. The testing setup screen for the mode you selected is 
displayed (terminal mode is shown here):

2. Use FIELD and VALUE to set the transmitter (Tx Rate) and 
receiver (Rx Rate) as appropriate for your application. For Monitor 
mode tests the transmitter and receiver are set simultaneously 
(Tx/Rx Rate).

3. Next press the right FIELD key to select the Payload parameter.

Example E1 Application

CERJAC
Test Set

STS-1

E1
E1
E1

SONET
Network

DS2
DS2
DS2
DS2
DS2
DS2
DS2

DS3

         TERMINAL TESTING

Tx Rate: STS1/OC1      Rx Rate: STS1/OC1

Payload: DS3/E1

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press ENTER to enter test mode.
Press MENU to return to Main Menu.
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Set up for E1 Testing

E1
/T

S

4.  Use VALUE to set the payload to DS3/E1, E1, or TS.

• DS3/E1: To test E1 signals mapped to and from a DS3 on a 
higher-rate signal.

• E1: To test clear channel E1, timeslot traffic, or fractional E1.

• TS: To test timeslot traffic on an E1 (Tx and Rx must be set to 
E1).

5. Press MENU-down. The E1 test operation screen is displayed (see 
next section).
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Configure the E1 Signal

E1/TS
Configure the E1 Signal

• When you press MENU-down from the test mode setup screen, the 
test operation screen is displayed. The screen may appear 
differently based on the test mode you selected (this example 
shows DS3/E1 testing).

1. Use FIELD and VALUE to set the E1 transmit timing source 
(TxClk), payload (Data), line coding (Code), and framing format 
(Frm).

If you select a user pattern for Data>, define that pattern as desired. 
See Configure the Programmable Patterns, page 14–5.

For timeslot or fractional E1 testing set Data> to TS or FE1, 
respectively.

2. Next configure the E1 mapping to and from the DS3 (if applicable). 
Set the insert channel (Ins), other transmit channels (Oths), and 
the drop channel (Drop).

• If you are testing E1 signals mapped to and from a DS3, configure 
the DS3 and any higher-rate signals next. See Configure the DS3 

and Higher-rate Signals, page 14–6.

• If you are testing timeslot traffic on the E1 signal, you can configure 
the TS parameters now. See Configure the Timeslot Parameters, 
page 14–7.

• If you are testing fractional E1 signals, you can configure the FE1 
parameters now. See Configure the FE1 Signal, page 14–9.

 1 STS1-STS1(DS3/E1) Final:  00:00:00.00
E1 Measurement Summary
Bit:           --     Sec Ago:   --
TS0 Frm:       --                --
CRC-4:         --                --

Í
Í

E1: TxClk>Int   Data>QRSS      Code>HDB3
 Frm>TS0        Ins>1  Oths>Same Drop>1
DS3: TxClk>Int    Frm>M13    XBit>1
STS1:TxClk>Int       Scramble>On
        Tx>STSX1           Rx>STSX1
Err: Type>E1 Data      Rate>Single
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Configure the Programmable Patterns
The 156MTS has six programmable test patterns for use in DS1 and E1 
testing. To use the patterns, set Data> to a Progr selection. Follow this 
procedure to configure the six E1 user test patterns.

1. From the test operation screen press CONFIG-right to display the 
control screen menu.

2. Use FIELD to select DS1/E1 Patterns and press CONFIG-right. 
The Programmable Patterns screen is displayed.

Each pattern can be 2 through 
24 bits long. Lengthen the 
pattern by changing the first 
dot to either a 1 or a 0; shorten 
the pattern by setting the last 
bit in the pattern to a dot.

3. Use FIELD and VALUE to select the individual bits in each pattern 
and set them to binary 1, 0, or to a dot.

4. When you finish editing, press CONFIG-right to return to the test 
operation screen.

Í E1: TxClk>Int   Data>Progr #1  Code>HDB3
 Frm>TS0        Ins>1  Oths>Same Drop>1
DS3: TxClk>Int    Frm>M13    XBit>1
STS1:TxClk>Int       Scramble>On
        Tx>STSX1           Rx>STSX1
Err: Type>E1 Data      Rate>Single

Í

  Global Settings  |
  Data Link Control|
  DS0/TS/Frac Setup|
  DS1/E1 Patterns  |
  DS1 Loop Codes   |
                   |

DS1/E1 Prog Pattern
ESF datalink message
  Data link idle     (01111110 01111110)
ESF Programmable datalink patterns
 User 1: v100010v xxxxxxxx  <v=0) (x=1)
 User 2: v011000v xxxxxxxx  (v=0) (x=1)

Í Prog Pat 1:     01000000................
Prog Pat 2:     010000..................
Prog Pat 3:     01000100000.............
Prog Pat 4:     010001000000000.........
Prog Pat 5:     010001000000000100......
Prog Pat 6:     010001000000000000100...
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Configure the DS3 and Higher-rate Signals
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Configure the DS3 and Higher-rate Signals

If you are testing E1 signals mapped to and from a DS3 signal, you need 
to set the DS3 signal parameters after you have configured the E1 
parameters. You also must configure any higher-rate signals on which 
the DS3s are carried.

1. Use FIELD and VALUE to configure the DS3 transmit and receive 
levels (Rx and Tx). These fields are not displayed when the DS3 is 
carried on a higher-rate signal.

For information on DS3 setup, 
see DS3 Setup Parameters, 
page 7–2.

2. Next set the DS3 timing source (TxClk), framing format (Frm), 
transmit X-bit status (XBit), and transmit FEBE bits (FEBE).

3. Configure the SONET parameters as appropriate for your 
application. Set the transmit timing source (TxClk), scrambling, 
and transmit and receive levels (Tx and Rx).

• If you are testing timeslot traffic on the E1 signal, you can configure 
the TS parameters now. See Configure the Timeslot Parameters, 
page 14–7.

• If you are not testing the TS signals, you can begin the test right 
now. See Run the E1 Test, page 14–10.

 1 STS1-STS1(DS3/E1) Final:  00:00:00.00
E1 Measurement Summary
Bit:           --     Sec Ago:   --
TS0 Frm:       --                --
CRC-4:         --                --

Í
Í
Í

E1: TxClk>Int   Data>QRSS      Code>HDB3
 Frm>TS0        Ins>1  Oths>Same Drop>1
DS3: TxClk>Loop Frm>CBit XBit>1 FEBE>111
STS1:TxClk>Int       Scramble>On
        Tx>STSX1           Rx>STSX1
Err: Type>E1 Data      Rate>Single
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Configure the Timeslot Parameters
This section describes how to configure the timeslot (TS) payload of an 
E1 signal. There are two ways to configure the TS parameters 
depending on whether you are using the E1–E1 (TS) mode, or testing an 
E1 carried on a DS3 signal (see Set up for E1 Testing, page 14–2).

TS in the 
E1–E1 (TS) Mode

This procedure describes how to configure the TS payload in the 
E1–E1 (TS) test mode. Note that the E1 signal is connected directly to 
the E1 jacks. Both Tx Rate and Rx Rate must be set to E1, and 
Payload must be set to TS.

1. The TS parameters are displayed on the E1 test operation screen. 
Use FIELD to highlight TS:Ins>.

2. Use VALUE to select the timeslot on which you want to insert the 
transmit TS signal.

3. Select Other and set the format for the remaining transmit 
timeslots.

4. Next select Drop and choose the timeslot you want to drop from 
the E1 for the receive TS signal.

5. Set the state of each of the transmit signaling bits (ABCD) as 
desired.

6. Select a transmit tone for the inserted timeslot (Tone). This 
parameter also allows you to insert the VF signal applied at the 
rear-panel VF IN jack.

• After you finish configuring the E1 and TS parameters, you are 
ready to begin the test.

Í

E1: TxClk>Int           Frm>TS0
     Code>HDB3   Rx>DSX      Term>Term
TS:   Ins>1   Other>Same     Drop>1
        A>1    B>1    C>1     D>1
     Tone>DRS 1004 Hz
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Configure the Timeslot Parameters
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TS from a 
Subrate E1

This procedure describes how to configure the TS payload when either 
the transmit or receive E1 is mapped to a DS3.

1. To enable the TS on the transmit E1, set the E1 Data field to TS:

2. From the test operation screen press CONFIG-right. The Control 
Screens menu is displayed in the bottom half of the screen:

3. Select DS0/TS Settings and then press CONFIG-right. The TS 
Setup screen is displayed:

4. Set the TS payload (Data>). You can select a VF tone, an external 
VF signal, or a bit pattern.

5. Set Ins> and Drop> to configure the insert and drop TSs. You can 
select L to lock the drop channel to match the insert channel.

6. Set Other> to configure the remaining channels in the E1 signal.

7. Next set each ABCD Tx Signaling bit to either binary 1 or 0.

8. When you have finished setting the TS parameters, press 
CONFIG-right to return to the test operation screen.

Í E1: TxClk>Int   Data>TS        Code>HDB3
 Frm>TS0        Ins>1  Oths>Same Drop>1
DS3: TxClk>Loop Frm>CBit XBit>1 FEBE>111
STS1:TxClk>Int       Scramble>On
        Tx>STSX1           Rx>STSX1
Err: Type>E1 Data      Rate>Single

  Global Settings  |  Data Link Control
  Alarm Control    |  DS0/TS/Frac Setup
  APS Control      |  DS1/E1 Patterns
  DS3 FEAC Control |  DS1 Loop Codes
  DS3 C-Bit Control|
  SONET OH Control |

Í

              >TS Setup<
Data>1004Hz
Ins>1            Drop>1
Other>Same (VF Tone and Ext RS232 Only)
Tx Signaling:  A>1 B>1 C>1 D>1
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Configure the FE1 Signal

Note: The Data> field must be set for FE1. See Configure the E1 Signal, page 14–4.

1. The FE1 parameters are controlled from the Fractional E1 Setup 
screen. Press CONFIG-right to call the control screens menu.

2. Use FIELD to highlight DS0/TS/Frac Setup and press 
CONFIG-right twice to display the Fractional T1 Setup screen.

3. Next use FIELD and VALUE to select the TS channels of the E1 
signal that make up the fractional E1 signal (Select). Each active 
timeslot is represented by an asterisk; inactive DS0s are represented 
by a dot.

4. Use FIELD and VALUE to select the payload for the FT1 signal 
(Data).

5. Press CONFIG-right to return to the test operation screen.

Í

  Global Settings
  Data Link Control|
  DS0/TS/Frac Setup|
  DS1/E1 Patterns  |
  DS1 Loop Codes   |
                   |

          >Fraction E1 Setup<

       1  |   |   |   |   |   |   | 31
Select>*******************************
TS16 not used Frm>TS0/16 or TS0/16+CRC
Data>QRSS
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Run the E1 Test

E1/TS
Run the E1 Test

• After you have configured the E1 signal, TS signal, and DS3 and any 
higher-rate signal parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the 
elapsed time begins to increment.

2. If you want to inject an alarm on the E1 signal, use FIELD and 
VALUE to set the Err: Type> and Rate> as desired (Modify 

Config While Running must be set to Yes, see Configuration Lock 

During Test, page 23–2).

3. Watch the Trouble Scan display for any errors, or use the RESULT 
keys to view different measurement screens in the top half of the 
display. You may need to adjust the results level to view more 
measurements (see To Display More Measurement Screens, 
page 1–11).

4. To end the test, press STOP.
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Run an Automatic E1 Timeslot Signaling Scan

The 156MTS features an automatic test sequence that scans an E1 
signal, analyzes each timeslot, and displays the status of the signaling 
bits for each timeslot. The E1 signal can be dropped from a DS3 signal. 
This section describes how to set up and run the Signaling Scan 
sequence.

1. Connect the signal to be tested. The signal must be an E1 signal or a 
DS3 signal carrying E1 traffic.

2. Setup the background mode by configuring the test set as if you 
were going to run a manual test. For example, set up an E1 terminal 
mode test with a TS (timeslot) payload. See Set up for E1 Testing, 
page 14–2.

3. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans & 

Pointer Sequences.

4. Press MENU-down. The Test Sequences menu is displayed.

Í

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store and Recall configurations

----------------------------------------
Press < FIELD > to highlight item, then
Press MENU-down select item.

          TEST SEQUENCES

HPointer Increment
HPointer Decrement
HPointer New Data Flag (NDF)

Í
DS1 Drop Scan
Signaling Scan
ATM Path.Circuit Scan
ATM Cell Capture
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5. Use FIELD to select Signaling Scan and press MENU-down. The 
Signaling Scan operation screen is displayed.

6. Set Configurations From to match your application. For example, 
if you are testing an E1 signal carrying TS traffic, you could select 
E1-E1 (TS).

7. Next set Channel Scan Mode to either Single (one scan) or 
Continuous (repetitive scanning).

8. Press START to begin the scan. The test set begins checking each 
timeslot on the E1 signal for the signaling bit status, and displays the 
results on the appropriate display line.

9. Use the RESULTS keys to scroll through the displays of timeslots 
and their signaling bit status.

10. The scan ends automatically in Single mode; press STOP to end the 
scan in Continuous mode.

 1 Signaling Scan   Final:  00:00:00.00 
     ABCD  ABCD  ABCD  ABCD  ABCD  ABCD
  1: 00--  00--  00--  00--  00--  00--
  7: 00--  00--  00--  00--  00--  00--
 13: 00--  00--  00--  00--  00--  00--
 19: 00--  00--  00--  00--  00--  00--

Configurations From> E1-E1 (TS)
Channel Scan Mode  > Single
----------------------------------------
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E1 Setup Parameters

E1/TS
E1 Setup Parameters

E1 setup parameters appear on the screen similar to the following (the 
E1–E1 (E1) mode is shown):

Transmit Timing 
Source

E1: TxClk> selects the E1 transmit timing source. This parameter can 
be set as follows:

Int: Timing is from the 156MTS’s internal clock.

Ext: Timing is derived from the rear-panel DS1 TX CLK IN port 
(E1 signal expected).

Loop: Timing is derived from the receive E1 signal.

E1 Framing 
Format

E1: Frm> selects the transmit and receive E1 signal framing format. 
E1: Frm> can be set to as follows:

TS0: E1 Timeslot 0 format (31-channel, non-CAS). No CRC.

TS0+CRC: E1 Timeslot 0 format with CRC-4.

TS0+TS16: E1 Channel Associated Signaling format (CAS, 
30-channel). Uses timeslot 0 and 16 framing.

TS0+TS16+CRC: E1 CAS format with CRC-4

Unfrm: Unframed E1 signal.

Note: If E1: Data> is set to AIS, the framing format is forced to unframed regardless 
of the Frm> setting.

E1: TxClk>Int           Frm>TS0
     Data>QRSS         Code>HDB3
       Rx>DSX          Term>Term

Err: Type>E1 BPV       Rate>Single
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E1 Payload E1: Data> selects the payload for the E1 signal. The choices for 
E1: Data> are described in the following table. This parameter is not 
applicable for E1/TS mode. TRBS is Pseudo Random and from E1 is 
inverted from DS0.

E1 Payload Selections

E1: Data> 
Selection

Payload 
Description

QRSS A quasirandom signal source comprising a 220–1 pattern 
with a 14-zero constraint.

2^6-1 A 26–1 pseudorandom bit sequence (PRBS). A six-stage 
PRBS generator with feedback taps at stages 5 and 6.

2^9-1 A 29–1 PRBS. Nine-stage with feedback taps at 5 and 9.

2^11-1 A 211–1 PRBS. 11-stage with feedback taps at 9 and 11.

2^15-1 A 215–1 PRBS. 15-stage with feedback taps at 14 and 15.

2^20-1 A 220–1 PRBS. 20-stage with feedback taps at 17 and 20.

2^23-1 A 223–1 PRBS. 23-stage with feedback taps at 18 and 23.

All 0s All binary zeros pattern.

All Ones All binary ones pattern.

Alt 1/0 Alternating binary 1s and 0s pattern.

1 in 8 A 12.5% ones density pattern, synchronized to the F-bit as 
follows: F 0100 0000.

2 in 8 A 25% ones density pattern synchronized to the F-bit as 
follows: F 0110 0000

3 in 24 A 12.5% ones density pattern, synchronized to the F-bit as 
follows: F010001000000000000000100.

Progr #1 —
Progr #6

User-defined pattern. The most significant bit follows the 
frame bit for lengths that divide evenly into 192. 
See User-Programmable DS1/E1 Patterns, page 11–13.

AIS E1 alarm indication signal. This is an unframed all-ones 
signal that overrides the E1: Frm> setting.
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Line Coding E1: Code> selects the line coding scheme as either AMI (alternate 
mark inversion) or HDB3 (high-density bipolar three-zero substitution).

Transmit E1 Level The transmit signal level for E1 applications is fixed at the 
cross-connect level (approximately 3.0 Vpk, ±1 dB).

Receive E1 Level E1: Rx> sets the input level for the input E1 signal. Rx> is not available 
when the E1 is mapped to a DS3 signal. Rx> can be set as follows:

DSX: Cross-connect level.

Monitor: Monitor level.

Termination Mode E1: Term> sets the E1 RX port to either terminate (Term) or bridge 
(Bridge) the received signal.

E1 Insert Channel E1: Ins> selects which E1 within a DS3 signal is used for the transmit 
E1. E1: Ins> can be set from 1 through 21. This parameter is only 
applicable when the E1 is mapped to a DS3 signal. See E1 to DS3 

Mapping, page 15–5.

55 Octet This is also known as the Daly pattern. Framing does not 
overwrite the pattern. The pattern bit sequence is shown in 
the DS1 payload table (see page 11–5).

Live No pattern. The receiver does not try to synchronize to a 
pattern. The transmitter sends the last-selected pattern.

TS Timeslot traffic. The E1 carries TS channels generated by 
the test set or from an external source. Seexx.

FE1 Fractional E1 traffic. The E1 signal carries subrate traffic 
made up of N number of TS channels. See Fractional E1 
Setup Parameters, page 15–9.

Ext A signal applied at the front-panel E1 RX port is used as the 
transmit E1. The input timing and framing override the 
E1: TxClk> and Frm> settings. This selection is only available 
when the E1 signal is the payload of a higher-rate signal.

E1 Payload Selections, continued

E1: Data> 
Selection

Payload 
Description
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Other E1 Channels E1: Oths> sets the payload for the E1s that are not selected by Ins> on 
the transmit DS3. Oths> can be set as follows:

Oths> is only applicable when 
the E1 is mapped to a DS3.

Same: Fills the E1s with the same payload as the selected Ins> E1.

Inv: Sets the E1s to an inverted version of the Ins> E1 payload.

AIS: Fills the remaining E1s with an E1 alarm indication signal (AIS).

E1 Drop Channel E1: Drop> selects which E1 within a DS3 is used for the receive E1, 
from 1 through 21. This parameter is only applicable when the E1 is 
mapped to a DS3 signal. See E1 to DS3 Mapping, page 15–5.

E1 to DS3 Mapping

When the E1 is mapped to and from a DS3, the mapping scheme is as 
follows: three E1s are mapped into each DS2; seven DS2s are mapped 
into each DS3. The following table lists the location of each E1 mapped 
on the DS3. E1s are selected using the E1: Drop> or Ins> fields.

E1 to DS3 Mapping

Drop/Ins E1 DS2 No. E1 No. Drop/Ins E1 DS2 No. E1 No.

1 1 1 12 4 3

2 1 2 13 5 1

3 1 3 14 5 2

4 2 1 15 5 3

5 2 2 16 6 1

6 2 3 17 6 2

7 3 1 18 6 3

8 3 2 19 7 1

9 3 3 20 7 2

10 4 1 21 7 3

11 4 2
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E1 Timeslot (TS) Setup Parameters

TS Mode 
Implementation

There are two ways that TS parameters are displayed. In E1–E1 (TS) 
test modes, the TS parameters appear similar to the following:

For other E1 modes (Payload set to DS3/E1 or E1) the TS parameters 
are accessed by selecting DS0/TS Settings from the Additional Test 
Controls menu. The TS Setup screen appears as follows:

Insert Timeslot Ins> selects which TS within an E1 signal is used for the transmit TS. 
Ins> can be set from 1 through 31.

Note: You can select TS 16 and overwrite it with the selected Tone> even in TS 16 
(CAS) framing modes.

Other Timeslots Other> sets the payload for the other TSs (that are not selected by 
Ins>) on the E1 transmit signal. Other> can be set as follows:

Same: Fills the TSs with the same payload as the selected Ins> TS.

All Ones: Sets the TSs to an all-ones pattern.

Note: When TS 16 framing is selected, the Other> setting does not overwrite TS 16.

Drop Timeslot Drop> selects which TS within an E1 signal is used for the receive TS. 
Drop> can be set from 1 through 31. On the TS Setup screen Drop> 
can also be set to L, which locks the drop TS to automatically match the 
insert TS.

Í
Í
Í

E1: TxClk>Int           Frm>TS0
     Code>HDB3   Rx>DSX      Term>Term
TS:   Ins>1   Other>Same     Drop>1
        A>1    B>1    C>1     D>1
     Tone>DRS 1004 Hz

              >TS Setup<
Data>1004Hz
Ins>1            Drop>1
Other>Same (VF Tone and Ext RS232 Only)
Tx Signaling:  A>1 B>1 C>1 D>1
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Timeslot Drop & 
Insert Channel

This parameter is only available for drop and insert mode (D&I) tests. 
The D&I> field simultaneously sets the TS insert and drop channels to 
the same number. D&I> can be set from 1 through 31.

Transmit TS 
Signaling

The A>, B>, C>, and D> fields set the binary status of the transmitted 
ABCD signaling bits of the selected insert TS. Each bit can be set to 
either 1 or 0. C> and D> are applicable only in TS 16 framing.

TS Payload (Tone) TS: Tone> sets the payload for the selected Ins> timeslot as follows 
(this parameter is only available in E1–E1 (TS) test mode):

DRS 1004 Hz: Transmits a Digital Reference Signal of 1004 Hertz.

DRS 1012 Hz: Transmits a Digital Reference Signal of 1012 Hertz.

DRS 1020 Hz: Transmits a Digital Reference Signal of 1020 Hertz.

External VF: Transmits the signal applied at the rear-panel VF IN port.

TS Payload
(Data)

The Data> field on the TS Setup screen sets the TS payload as 
described in the following table. TRBS is Pseudo Random and from 
E1 is inverted from DS0.

E1 Timeslot Payload Selection

Data> 
Selection

Payload 
Description

1004Hz
1012Hz
1020Hz
2010Hz

These three selections apply a test tone at the indicated 
frequency (in Hertz). Not available for monitor test modes.
The 2010 Hz tone is transmitted at –12 dB.

Tone Monitor modes only. Sets the receiver to expect an input 
tone on the drop signal.

Ext VF Transmits a VF signal applied at the rear panel VF IN jack. 
Not available for monitor test modes.

QRSS Quasirandom Sequence Signal. Transmits a quasirandom 
signal.
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2^E-1 PRBS. Transmits a pseudorandom bit sequence of length 
2^E-1 where E is the exponent. For example 2^9-1 is a 29–1 
PRBS.

All 0s Transmits a binary zeros pattern.

All 1s Transmits a binary ones pattern.

Alt 1/0 Transmits an alternating binary 1s and 0s pattern.

1 in 8 Transmits a repeating pattern of one binary 1 in every eight 
bits.

2 in 8 Transmits a repeating pattern of two binary 1s in every eight 
bits.

3 in 24 Transmits a repeating pattern of three binary 1s in every 24 
bits.

Prog#1 
through 
Prog#6

User-programmable patterns. Transmits the corresponding 
user pattern (See User-Programmable DS1/E1 Patterns, 
page 11–13).

55 Oct Transmits a specific repeating 55-byte pattern, also known 
as the Daly Pattern.

External 
RS232

Transmits the data applied at the rear-panel 
DATALINK RS-232 interface.

E1 Timeslot Payload Selection, continued

Data> 
Selection

Payload 
Description
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Fractional E1 Setup Parameters

FE1 parameters are applicable when the E1 payload (Data>) is set for 
FE1. FE1 parameters are accessed by selecting DS0/TS/Frac Setup 
from the Control Screens menu and pressing CONFIG-right twice. The 
Fractional E1 Setup screen appears as follows:

Selected Timeslots Select> determines which timeslots are used to generate the FE1 
signal. A channel set to “*” is included in the FE1 signal. A channel set 
to “.” is not included in the FE1 signal.

Channels that are not selected are transmitted as all-ones.

Note: Timeslot 16 is not used when the E1 frame format (Frm>) is set to either TS0/16 
or TS0/16+CRC.

FE1 Payload Data> selects the payload for the FE1 signal. The data is distributed 
across the entire FE1 signal, even if the TSs that make up the FE1 are 
not contiguous. The payload choices for Data> include the following 
(see E1 Payload Selections, page 15–3, for a description of each 
payload):

• QRSS

• PRBSs (2^6-1, and so on)

• All 0s or All 1s

• Alt 1/0

• 1 in 8, 2 in 8, or 3 in 24

• Progr #1 through Progr #6

• 55 Octet

          >Fraction E1 Setup<

       1  |   |   |   |   |   |   | 31
Select>*******************************
TS16 not used Frm>TS0/16 or TS0/16+CRC
Data>QRSS
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E1 and TS Error and Alarm Injection

The following types of error can be injected in E1 testing modes. The 
rates for the selections include Single, 1.0E-2 through 1.0E-9, Burst, 
Continuous, and Off.

Note: For information on injection rates, see About Error Injection Rates, page 27–8.

E1 BPV: Generates bipolar violations in the E1 data. This type is not 
available for DS3-mapped E1 modes.

E1 Data: Generates data bit errors before the CRC is calculated, so no 
CRC errors are generated.

E1 Data, CRC: Generates combined data bit errors and CRC errors by 
erroring the data bits after the CRC is calculated.

E1 Frm, CRC: Generates combined E1 frame bit errors and CRC 
errors by erroring the frame alignment pattern in timeslot 0 after the 
CRC is calculated.

E1 MFrm, CRC: Generates combined E1 multiframe frame bit errors 
and CRC errors by erroring timeslot 16 after the CRC is calculated.

E1 MFrm, Alm: Generates an E1 distant multiframe alarm condition 
by setting bit 6 of timeslot 16 (in frame 0) to 1.

E1 Rmt Alm: Generates an E1 remote alarm condition by setting bit 3 
of timeslot 0 to 1.

TS Data: Generates data bit errors in the selected timeslot when 
E1 Data> is set for TS and TS Data> is set to a pattern.
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E1 Indicators

E1 Alarm and Status Indicators

Indicator Description

HIST/ALARMS

LOS Loss of E1 signal.

OOF Out of frame.

AIS E1 alarm indication signal.

YEL E1 Remote (“Yellow”) alarm.

LOPAT Loss of pattern.

COFA E1 “change of frame alignment.”

STATUS

E1 SIG Valid E1 signal detected.

TS0 SYNC Valid Timeslot 0 (TS0) framing detected.

TS16 SYNC Valid TS16 framing detected.

CRC SYNC Valid CRC framing detected.

PAT SYNC (DS1 and E1) Receiver synchronized with test pattern.

HDB3 E1 HDB3 zero substitution codes detected.

ERRORS E1 error detected.
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E1 Measurement Summary Screen

For each screen, an “s” 
indicates Summary results 
level and a “d” indicates Detail 
level. See To Display More 
Measurement Screens, 
page 1–11.

This screen displays an overview of E1 error measurements.

Sec Ago shows the time 
elapsed since the last error, in 
seconds.

Bit: E1 bit error count: The number of errored bits (transmitted at one 
level, but received at another).

TS0 Frm: E1 frame error count: The number of TS0 frame word 
errors.

CRC-4: E1 CRC-4 error count: The number of CRC-4 fields that are 
received in error.

BPV: E1 bipolar violation count: The number of E1 BPVs. A BPV is the 
occurrence of two consecutive pulses of the same polarity (unless the 
pulses are part of an HDB3 zero-substitution code). This measurement 
is not displayed for DS3-mapped E1 signals.

E1 Drop Hz: Drop E1 frequency: The frequency, in Hertz, of the E1 
signal dropped from the DS3 signal. This measurement is only displayed 
for DS3-mapped E1 signals.

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Measurement Summary
Bit:           --     Sec Ago    --
TS0 Frm:       --                --
CRC-4:         --                --
BPV:           --                --
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E1 Bit Error Measurement Screens

These three screens display results based on E1 bit error 
measurements. 

The results displayed on the screens are described in table beginning on 
the next page.

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Bit Error Measurements #1
 Error Count:       --
 Current Ratio:     --
 Average Ratio:     --

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Bit Error Measurements #2
 ES:       --      Sync ES:       --
 EFS:      --      Avail Sec:     --
 %EFS:     --      Unavail Sec:   --
 Sev ES:    --     Degrad Min:    --

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Bit Error Measurements #3  (Seconds)
 Thrsh E-3:    --      Dribble:    --
 Thrsh E-4:    --      CSES3:      --
 Thrsh E-5:    --
 Thrsh E-6:    --
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E1 Bit Error Measurements

Measurement Description

Error Count The total number of E1 bit errors detected.

Current ratio Current E1 BER: The number of E1 bit errors over the 
number of E1 bits received in the previous 2.25 seconds.

Average Ratio Average E1 BER: The number of E1 bit errors over the total 
number of E1 bits received since the beginning of the test.

ES E1 errored seconds: The number of seconds during which 
at least one E1 bit error occurred (seconds are counted 
from test start).

EFS E1 error-free seconds: The number of seconds during 
which no E1 bit errors occurred.

%EFS E1 error-free seconds percentage: E1 EFS expressed as 
the percentage of the total number of seconds in the test.

Sev ES E1 severely errored seconds (SES): The number of 
seconds during which the error rate was 10–3 or greater 
and during which no loss of pattern occurred.

Sync ES E1 synchronous errored seconds: The number of seconds 
in which at least one E1 bit error occurred (seconds are 
counted beginning at the error occurrence).

Avail Sec E1 available seconds: The number of seconds during the 
test that were not unavailable (see below).

Unavail Sec E1 unavailable seconds: The E1 is declared unavailable 
after ten consecutive seconds of SES or LOP. The E1 is 
declared available again after ten consecutive seconds 
with no SESs or LOPs.

Degrad Min E1 degraded minutes: The number of 60-second intervals 
during which available seconds and bit error counts are 
both greater than zero, but do not exceed the SES 
threshold; or, the number of 60-second intervals during 
which the available seconds and CRC error counts are 
both greater than zero but less than 320. The 60-second 
intervals do not need to be contiguous.
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Thrsh E-n E1 threshold seconds: The number of available seconds 
during which the bit error rate or CRC error rate (which- 
ever is larger) exceeded the indicated E-n threshold. The 
thresholds correspond to the following values:

Bits (Unfrm) Bits (TS0) Bits (TS16) CRC Errors

E-3 2,048 1984 1920 —

E-4 205 198 192 205

E-5 21 20 19 21

E-6 2 2 2 2

Dribble E1 dribbling error seconds: The number of seconds during 
which the error rate is greater than 1, but does not exceed 
10–6 (between 1 and 14 errors).

CSES3 E1 Consecutively severely-errored seconds count: The 
number of SESs for which the previous two seconds were 
also SESs. This count is reset during LOS, LOF, and LOP.

E1 Bit Error Measurements, continued

Measurement Description
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E1 Block Error Measurements Screen

To determine block errors, the 
received E1 bits are counted 
into blocks of 2 through 8 
kilobits (block size is 
user-programmable, see DS1 
Block Size, page 11–7).

Est. Total Blocks: Estimated count of E1 blocks: The estimated 
number of blocks received, as determined by the selected block size.

Block Err Count: E1 block error count: The number of E1 blocks that 
contained one or more errors.

Burst Err Seconds: E1 block burst errored seconds: The number of 
seconds in which the number of block errors was three or greater.

SEE: Severe error event count: The number of SEEs; a SEE is declared 
when there are four consecutive quarter-seconds each containing 93 or 
more bit errors, or more than N number of block errors. The value of N 
depends on the E1 block size (see following table). A SEE ends when 
there are two consecutive error-free seconds.

CATV UAS: Cable TV unavailable seconds count: The number of 
CATV UASs. A CATV UAS interval is declared when there are 60 
consecutive BESs, ten consecutive SESs, or ten consecutive LOP 
seconds. These seconds are included in the unavailable time.

A CATV UAS interval ends when there are 60 consecutive error-free 
seconds. These seconds are not included in the unavailable time.

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Block Error Measurements
Est. Total Blocks:      --
Block Err Count:        --
Burst Err Seconds:      --
SEE:     --        CATV UAS:     --

Severe Error Event (SEE) Block Error Threshold Values

E1 Block 
Size

N (number of 
block errors)

E1 Block 
Size

N (number of 
block errors)

2 Kbit 46 6 Kbit 15

3 Kbit 30 7 Kbit 13

4 Kbit 23 8 Kbit 11

5 Kbit 18
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E1 TS0 Frame Error Measurements Screen

This screen displays measurements based on TS0 frame word errors in 
framed E1 signals.

Count: E1 TS0 frame word error count: The number of errored TS0 
frame words.

Cur Ratio: Current TS0 frame word error ratio: The average frame 
word error ratio during the previous 2.25 seconds.

Avg Ratio: Average TS0 frame word error ratio: The number of frame 
word errors over the number of frame words received since the 
beginning of the test.

ES: Frame word errored seconds: The number of seconds during 
which at least one frame word error occurred.

EFS: Frame word error-free seconds: The number of seconds during 
which no frame word errors occurred.

%EFS: Frame word error-free seconds percentage: E1 TS0 frame word 
EFS expressed as a percentage of the total time since the beginning of 
the test.

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 TS0 Frame Error Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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E1 CAS Frame Error Measurements Screen

This screen displays measurements based on TS16 channel associated 
signaling (CAS) frame word errors in TS16 framed E1 signals.

Count: E1 TS16 frame word error count: The number of errored TS16 
frame words.

Cur Ratio: Current TS16 frame word error ratio: The average frame 
word error ratio during the previous 2.25 seconds.

Avg Ratio: Average TS16 frame word error ratio: The number of frame 
word errors over the number of frame words received since the 
beginning of the test.

ES: Frame word errored seconds: The number of seconds during 
which at least one TS16 frame word error occurred.

EFS: Frame word error-free seconds: The number of seconds during 
which no TS16 frame word errors occurred.

%EFS: Frame word error-free seconds percentage: E1 TS16 frame 
word EFS expressed as a percentage of the total time since the 
beginning of the test.

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 CAS Frame Error Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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E1 CRC-4 Error Measurements Screen

This screen displays measurements based on CRC errors in CRC-4 
formatted E1 signals.

Count: CRC error count: The number of E1 CRC-4 values that are 
errored.

Cur Ratio: Current CRC error ratio: The average CRC error ratio 
during the previous 2.25 seconds.

Avg Ratio: Average CRC error ratio: The number of CRC-4 errors over 
the number of bits received since the beginning of the test.

ES: CRC errored seconds: The number of seconds during which at 
least one CRC error occurred.

EFS: CRC error-free seconds: The number of seconds during which no 
CRC errors occurred.

%EFS: CRC error-free seconds percentage: E1 CRC-4 EFS expressed 
as a percentage of the total time since the beginning of the test.

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 CRC-4 Error Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
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E1 BPV Measurements Screen

E1
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E1 BPV Measurements Screen

This screen displays measurements based on bipolar violations (BPVs). 
This screen is not displayed for E1 signals mapped to and from a DS3 
signal.

Count: BPV error count: The number of bipolar violations. A BPV is 
the occurrence of two consecutive pulses of the same polarity (unless 
the pulses are part of a HDB3 zero-substitution code).

Cur Ratio: Current BPV error ratio: The average BPV error ratio 
during the previous 2.25 seconds.

Avg Ratio: Average BPV error ratio: The number of BPVs over the 
number of bits received since the beginning of the test.

ES: BPV errored seconds: The number of seconds during which at least 
one BPV occurred.

EFS: BPV error-free seconds: The number of seconds during which no 
BPV errors occurred.

%EFS: BPV error-free seconds percentage: Bipolar violation EFS 
expressed as a percentage of the total time since the beginning of the 
test.

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 BPV Measurements
 Count:         --       ES:       --
 Cur Ratio:     --       EFS:      --
 Avg Ratio:     --       %EFS:     --
16–11



E1 Measurement Reference

E1 Slips Screen

E1/TS
E1 Slips Screen

This screen displays E1 slips measurements based on comparing the 
timing relationship between the receive E1 signal to an external 
reference signal. The reference signal is a bipolar DSX source applied at 
the rear-panel DS1 REF IN connector.

A frame slip is also called a 
controlled slip.

Frm Slips: Frame slip count: The number of frame slip occurrences. A 
frame slip is declared when a difference of 256 time slots (bits) is 
detected between the receive and reference signals. Multiple frame 
slips within 0.25 seconds are counted as a single frame slip.

Bit Slips: Bit slip count: The number of individual time slot differences 
between the receive and reference signals, in either direction. A 
positive value indicates that the receive frequency is greater than the 
reference frequency. A negative value indicates the receive frequency is 
less than the reference. If the reference is lost, the bit slip count is 
restarted from zero when the reference is restored.

Bit Slips (graphic): This arrow provides a repeating graphic showing 
the number of bit slips. When the arrow reaches the right side of the 
display, 256 bits slips have been counted and a frame slip is declared.

Slip Sec: Slip seconds count: The number of second during which one 
or more frame slips occurred.

Rx Hz: Receive E1 frequency: The received signal frequency displayed 
in Hertz.

Delta Hz: Frequency difference in Hertz: The difference between the 
receive E1 frequency and the reference frequency. A positive value 
indicates the receive frequency is faster than the reference; a negative 
value indicates the receive frequency is slower.

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Slips
 Frm Slips:   --      Slip Sec:    --
 Bit Slips:   --
 Bit Slips:--------->
 Rx Hz:        --     Delta Hz:    --
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E1 Signal Measurements Screen
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E1 Signal Measurements Screen

This screen displays signal measurements for the E1 receive signal. This 
screen is not displayed for E1 signals mapped to and from a DS3 
signal.

Rx Hz: Receive E1 signal frequency: The frequency of the receive E1 
signal, in Hertz.

Rx Pk V: Receive E1 signal level, Vpk: The level of the receive DS1 
signal in volts peak (accuracy is ±5%).

Rx dBdsx: Receive E1 signal level, dB: The level of the receive E1 
signal in decibels, referenced to a DSX level (accuracy is ±1 dB). The 
range is –30 to +6 dBdsx.

Rx ma: Receive E1 level, mA: The level of the receive E1 signal in 
milliamperes (mA).

Ref Hz: Reference E1 signal frequency: The frequency of the reference 
E1 signal applied at the rear-panel DS1 REF IN connector, in Hertz.

EXZ: Excessive zeros count: The number of consecutive-zero strings 
greater than 15 (for AMI) or greater than 4 (for HDB3). Each string is 
considered a single event.

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Signal Measurements
 Rx Hz:       --        Ref Hz:    --
 Rx Pk V:     --        EXZ:       --
 Rx dBdsx:    --
 Rx ma:       --
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Jitter Measurements

E1/TS
Jitter Measurements

Jitter Peak 
Results

Each result is calculated for both wide-band and high-band jitter.

For E1, the wide-band jitter 
cut-off frequency is 20 Hz to 
100 kHz and the high-band 
cut-off frequency is 20 kHz to 
100 kHz.

Current P-to-P: Current peak-to-peak jitter: The sum of the positive 
jitter peak and the negative jitter peak for the most recent one-second 
period. Displayed in unit intervals.

MAX P-to-P: Maximum peak-to-peak jitter: The sum of the highest 
positive jitter peak and the highest negative jitter peak for the entire 
test duration. Displayed in unit intervals.

MAX Pos Peak: Maximum positive jitter peak: The greatest positive 
jitter peak since the beginning of the test. Displayed in unit intervals.

MAX Neg Peak: Maximum negative jitter peak: The greatest negative 
jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and 
Mask Results

See DS1 Jitter Hits Threshold, 
page 11–7.

Each result is calculated for both wide-band and high-band jitter.

Hits Count: Indicates the total number of jitter hits (jitter hit 
threshold exceeded) since the beginning of the test.

For E1, the wide-band mask is 
1.5 UI and the high-band mask 
is 0.2 UI.

Total Hits Time: Indicates the cumulative total of time, in seconds, 
that the jitter hit threshold has been exceeded since the beginning of 
the test.

MAX Percent of Mask: Indicates the maximum peak-to-peak jitter 
for the entire test period expressed as a percentage of the jitter mask. 

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Jitter            Wide-Band High-Band
 Current P-to-P (UI):    --       --
 MAX P-to-P (UI):        --       --
 MAX Pos Peak (UI):      --       --
 MAX Neg Peak (UI):      --       --

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Jitter            Wide-Band High-Band
 Hits Count:             --       --
 Total Hits Time(Sec):   --       --
 MAX Percent of Mask:    --       --
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E1 Alarm Screens
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E1 Alarm Screens

These two screens display alarm results for the E1 receive signal. The 
alarms displayed on the screens are described in the following table.

E1 Alarm Descriptions

Alarm Description

LOS E1 loss of signal: Declared when there are 175 or more 
contiguous pulse positions with no positive or negative 
pulses. LOS is cleared when there is a 12.5% or higher 
ones-density on the receive signal.

OOF E1 out of frame: Declared when the frame alignment word is 
received errored for three consecutive frames.

AIS E1 alarm indication signal: Declared when an unframed 
all-ones pattern is received (“all-ones” is considered to be 
fewer than three zeros in two consecutive frames).

LOP E1 loss of pattern: Declared when pattern synchronization is 
not achieved or when the receive pattern does not 
correspond to the internal reference pattern.
Pattern synchronization is declared when 64 consecutive 
pattern matches (bits) are received.
Loss of pattern synchronization is declared when 250 out of 
1,024 consecutive pattern bits are errored. (User patterns 
with less than 25% transition density use 85 errors out of 
1,024 bits.)

RAI Remote alarm indication: Declared when bit 3 of the 
received timeslot 0 is set to 1 for three consecutive non-FAS 
frames.

Dist Distant multiframe alarm: Declared when bit 6 of timeslot 16 
in frame 0 is set to 1 for three consecutive multiframes.
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E1 Measurement Reference

E1 Alarm Screens

E1/TS
E1 Alarm Seconds 
Screen

This screen displays counts of E1 alarm seconds. An alarm second is 
one during which at least one occurrence of that alarm occurred. 

E1 Alarm and 
History Screen

This screen displays the current and previous occurrence of E1 alarms 
on the receive signal. Like front-panel indicator LEDs, the screen 
provides a current status of the alarm (Alarm) and also indicates if the 
alarm has occurred previously (Hist).

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Alarm Seconds
 LOS:       --            AIS:     --
 OOF:       --            LOP:     --
                          RAI:     --
                         Dist:     --

d

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1   Alarm  Hist       E1   Alarm  Hist
 LOS:  --    --         RAI:  --    --
 OOF:  --    --         Dist: --    --
 AIS:  --    --
 LOP:  --    --
16–16
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E1 Status Screen
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E1 Status Screen

This screen displays The status of certain E1 signal parameters, similar 
to the front-panel DS1/E1 STATUS indicators. 

For each parameter, the display shows ON if that condition is present.

E1 Signal: E1 signal present: Declared when an E1 signal is received 
with at least a 12.5% ones-density.

The TS0, TS16, and CRC4 sync 
indications work cumulatively 
together. For example, if your 
E1 signal is CAS and CRC-4 
formatted 
(Frm>TS0+TS16+CRC) all 
three indicators will show ON 
when a valid signal is received.

TS0 Sync: Valid TS0 frame synchronization: Declared when valid FAS 
words are received in two consecutive FAS frames, and bit 2 in 
timeslot 0 of the intervening non-FAS frame is set to 0.

TS16 Sync: Valid CAS multiframe synchronization: Declared when a 
valid MFA signal is detected in timeslot 16, and timeslot 16 of the 
previous frame does not contain all-zeros.

CRC4 Sync: Valid CRC-4 format frame synchronization: Declared 
when two consecutive valid CRC-4 signals are detected within 12–14 ms 
after frame synchronization.

Pattern: E1 pattern synchronization: Declared when 64 consecutive 
pattern matches (bits) are received.

HDB3: E1 high-density bipolar signal present: Declared when valid 
HDB3 (three-zero substitution) codes are detected on the receive E1 
signal.

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Status           E1 Status
 E1 Signal:   --     Pattern:     --
 TS0 Sync:    --     HDB3:        --
 TS16 Sync:   --
 CRC4 Sync:   --
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E1 Measurement Reference

E1 Timeslot Measurements Screen

E1/TS
E1 Timeslot Measurements Screen

This screen displays timeslot level, frequency, data, and signaling 
results for the selected TS drop channel on the E1 signal (this screen is 
only active when the DS0 Data> is set for a tone).

Level: TS level: The TS signal RMS power in decibels (dBm). The bar 
graph to the right gives a graphical display of the signal.

>+3dBm Thresh Sec: TS 3 dBm threshold seconds: The number of 
seconds in which the dropped TS signal level exceeded +3 dBm.

Freq: TS frequency: The frequency of the dropped tone in Hertz.

Data: TS payload: The current eight bits in binary format (1s or 0s).

ABCD: TS channel signaling bits: The binary status of the four 
signaling bits for the dropped TS.

s

 1 E1-E1 (E1)       Final:  00:00:00.00 
E1 Time Slot     -60....-40...-20.....0.
  Level:  0.5     ********************
 >+3dBm:       0 Thres. Sec
  Freq:1004  Hz
  Data:10111010 A=0   B=0   C=0   D=0
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DS0/TS Bit Error Measurements Screen
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DS0/TS Bit Error Measurements Screen

This screen displays BER results on the selected TS. This screen is only 
active when the TS Data> is set for a pattern.

Error Count: TS pattern bit errors: The number of bit errors detected 
on the selected TS since the beginning of the test.

Average Ratio: TS average pattern bit error ratio: The average ratio of 
errored bits over the total number of bits for the selected TS since the 
beginning of the test.

Current Ratio: TS current pattern bit error ratio: The average ratio of 
errored bits over the total number of bits for the selected TS during the 
most recent 2.25 seconds.

s

 1 DS1-DS1 (DS1)    Final:  00:00:02.00
DS0/TS Bit Error Measurements
  Error Count:          0
  Average Ratio: 0.00E+00
  Current Ratio: 0.00E+00
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E1 Specifications

E1/TS Interfaces

E1/TS
E1/TS Interfaces

E1 Transmitter
E1 TX

Signal: DSX

• Per CCITT G.703.

• 3.0 Vpk ±1.0 dB (0 dBdsx).

Line Code: AMI or HDB3.

Impedance: 120 ohm ±5% balanced; return loss >20 dB.

Connector: Accepts WECo 310 plug. Optional Bantam.

E1 Receiver
E1 RX

Signals:

Line Code: AMI or HDB3.

Impedance:

• Term = 120 ohms ±5%, return loss >20 dB.

• Bridge = >1000 ohms.

Connector: Accepts WECo 310 plug. Optional Bantam.

E1 Drop Ouput
E1 DROP

Signal = DSX: E1 dropped from higher-rate signal.

• Per CCITT G.703.

• 3.0 Vpk ±1.0 dB (0 dBdsx).

Line Code: AMI or B8ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECo 310 plug. Optional Bantam.

DSX Per CCITT G.703.
3.0 Vpk ±1.0 dB (0 dBdsx). 2.048 MHz ±1000 ppm.
Equalized for 0 to 655 ft of 22 AWG pulp insulated cable.
Sensitivity = 26 dB below 0 dBdsx.
Jitter tolerance per CCITT G.823.

Mon Per CCITT G.703. 0.3 Vpk input level typical (–20 dBdsx).
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E1/TS Interfaces
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E1 Timing Internal: 2.048 MHz ±20 ppm.

DS1 TX CLK IN jack: Input E1 signal. TTL levels, 50 ohm, BNC 
connector.

E1 Timeslot 
Interfaces

TS VF Drop Port: VF OUT jack: 600 ohm, internal codec.

TS VF Insert Port: VF IN jack: 600 ohm, internal codec.

ABCD Signaling 
Bits Drop

SIGNALING TTL port: TTL, DB-9S connector, 50 ohms. For pinout 
information, see ABCD Signaling Bits Drop, page 13–4.

Note: The rear-panel DS1 REF IN, DS1 INTERFACE, DS1 ERR OUT, and 
SIGNALING-TTL connectors serve the corresponding E1 functions when the 
test set is in an E1 mode.

E1 Slips Reference Input: DS1 REF IN jack: accepts E1 signal.

• 3.0 Vpk input level, typical.

• WECo 310 connector.

E1 Network 
Interface

DS1 INTERFACE port: DB-15 socket connector. Provides parallel 
connections to the front-panel DS1 TX and DS1 RX connectors.

E1 Errors Output DS1 ERR OUT jack: TTL, 50 ohm, BNC connector.

Pin Function

1 E1 Tx tip

9 E1 Tx ring

3 E1 Rx tip

11 E1 Rx ring

All others No connection
17–3
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Jitter Option Specifications

E1/TS
Jitter Option Specifications

E1 jitter measurement requires E1 testing (Option URQ), Option UQR, 
and either Option UQN or 201.

Measurement 
Response

E1 Jitter Measurement per: CCITT G.823

Wide-band cut-off frequency: 20 Hz to 100 kHz

High-band cut-off frequency: 20 kHz to 100 kHz

Roll-off (per decade) below lower 3 dB point: ≥20 dB

Roll-off (per decade) above higher 3 dB point: ≥60 dB

Jitter 
Measurements

Demodulated 
Jitter Output

DMOD JITTER OUT jack: 50 ohm, BNC connector. 
Scale = 100 mV/UI; range = 0 to 6 Vdc.

Measurement Range Resolution Accuracy

Maximum Peak Positive Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Maximum Peak Negative Jitter 0.1 to 6.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Current Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Max Peak-to-Peak Jitter 0.1 to 12.0 UI 0.1 UI ±5% of reading, ±0.05 UI.

Wideband Mask Highband Mask

Percent of Mask 1.5 UI 0.2 UI
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E1 Signal Format—2.048 Mbs

0 31

1 E1 Frame = 32 eight-bit timeslots = 256 bits

1 Timeslot (TS) = 8 bits

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 302928

Cn 0 1 11 100

0 SaA1 Sa Sa Sa Sa

1 6 7 84 532

0 Y X X0 X00

A DCB A B C D

MF alignment (frame 0 only)

Signaling (frames 1–15)

TS16 (CAS format)

FAS frames (0 and even frames)

Non-FAS frames (odd frames)
E bits = bit 1 of frames 13 & 15

TS0 (CRC-4 format)

Si 0 1 11 100

SaA1 Sa Sa Sa Sa

FAS frames (0 and even frames)

Non-FAS frames (odd frames)

TS0 (non-CRC-4 format)

Si
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E1 Specifications

E1 Signal Format—2.048 Mbs

E1/TS
C1–C4: CRC-4 bits.

A: Remote alarm indication bits.

S: Spare bits.

E: CRC error indication bits.

An–Dn: ABCD signaling bits for channel n.

E1 Multiframe Structure (showing TS0 and TS16 bits)

Frame

TS0 bits

TS1–TS15

TS16 bits

TS17–TS311 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

E1
 M

ul
tif

ra
m

e

Su
b-

M
ul

tif
ra

m
e 

1

0 C1 0 0 1 1 0 1 1 0 0 0 0 X Y X X

1 0 1 A S S S S S A1 B1 C1 D1 A16 B16 C16 D16

2 C2 0 0 1 1 0 1 1 A2 B2 C2 D2 A17 B17 C17 D17

3 0 1 A S S S S S A3 B3 C3 D3 A18 B18 C18 D18

4 C3 0 0 1 1 0 1 1 A4 B4 C4 D4 A19 B19 C19 D19

5 1 1 A S S S S S A5 B5 C5 D5 A20 B20 C20 D20

6 C4 0 0 1 1 0 1 1 A6 B6 C6 D6 A21 B21 C21 D21

7 0 1 A S S S S S A7 B7 C7 D7 A22 B22 C22 D22

Su
b-

M
ul

tif
ra

m
e 

2

8 C1 0 0 1 1 0 1 1 A8 B8 C8 D8 A23 B23 C23 D23

9 1 1 A S S S S S A9 B9 C9 D9 A24 B24 C24 D24

10 C2 0 0 1 1 0 1 1 A10 B10 C10 D10 A25 B25 C25 D25

11 1 1 A S S S S S A11 B11 C11 D11 A26 B26 C26 D26

12 C3 0 0 1 1 0 1 1 A12 B12 C12 D12 A27 B27 C27 D27

13 E 1 A S S S S S A13 B13 C13 D13 A28 B28 C28 D28

14 C4 0 0 1 1 0 1 1 A14 B14 C14 D14 A29 B29 C29 D29

15 E 1 A S S S S S A15 B15 C15 D15 A30 B30 C30 D30
17–6



18
AT
M

Run an Automatic VP/VC Scan 18–2

Run a Cell Capture Test 18–4

Set up for ATM Testing 18–7

Choose an ATM Test Mode 18–8

Configure Global ATM Parameters 18–10

Configure the ATM Foreground Channel (no traffic shaping) 18–11

Configure the ATM Forground Channel (with traffic Shaping)   18–12

Set ATM Cell Payloads 18–13

Set the Foreground, Idle and Receive VP/VC 18–14

Configure the ATM Background Channels (no traffic shaping) 18–15

Configure the ATM Background Channels (with traffic shaping)   18–16

Configure Misinserted Cell Errors 18–18

Setup for STS-12c ATM Testing 18–19

Run the ATM Test 18–21
ATM Network
Testing
18–1



ATM Network Testing

Run an Automatic VP/VC Scan

ATM
Run an Automatic VP/VC Scan

The VP/VC scan is not 
available for STS-12c ATM 
applications.

The 156MTS features an automatic ATM scan that analyzes the receive 
signal for ATM traffic and identifies the active channels and bandwidth. 
This procedure describes how to setup and run the test.

1. Connect the signal to be tested to the appropriate 156MTS input 
connector.

2. From the Main Menu, select Terminal, Monitor, or Drop & Insert 
test mode and press MENU-down.

3. On the test setup screen, configure the transmitter, receiver, and 
payload as necessary for your test. For ATM on SONET signals, be 
sure the Payload is set for ATM. Press MENU-down.

4. On the test operation screen, configure the signal parameters as 
needed. For ATM on T-carrier, set the Data> field to ATM.

For loop tests, configure the 
ATM transmit stream before 
you begin the VPI/VCI scan. 
See Configure Global ATM 
Parameters, page 18–10.

5. Press CONFIG-right to display the Control Screen menu. Use FIELD 
to select ATM Setup and press CONFIG-right again.

6. On the ATM Setup menu, select VPI/VCI Scan and press 
CONFIG-right.

 1 STS1-STS1 (DS3) Final:  00:00:00.00 
Trouble Scan

          No Errors or Alarms

Í DS3:    Frm>M13       Data>ATM
        TxClk>Int     FEBE>111    XBit>1
STS1:   TxClk>Int        Scramble>On
        Tx>STSX1         Rx>STSX1
Err:    Type>DS3 Data    Rate>Single

Í

          ATM Standard Active
Standard           |
VPI/VCI Scan       |
Transfer Delay     |
Inter Arrival Time |
Cell Capture       |
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ATM Network Testing

Run an Automatic VP/VC Scan

AT
M

 The ATM VPI/VCI Scan operation screen is displayed.

7. Use FIELD and VALUE to set Function> to Channel Search and 
then press the START key.

The instrument scans the input signal for ATM traffic. Active VP/VC 
addresses are displayed in the list on the top half of the display.

8. Press STOP to end the scan (the scan ends automatically when 40 
VP/VCs are detected).

9. Use VALUE to set Function> to BW Measurement and press 
START.

The instrument checks each active VP/VC to determine the 
percentage of bandwidth used by that channel.

10. Press STOP to end the bandwidth measurement (the measurement 
ends when all active channels have been measured).

11. Use RESULT to scroll the results screens in the top half of the 
display. There are five screens; each screen lists as many as eight 
channels.

12. To select a channel for further testing, use FIELD to highlight the 
Further measurement on item> field. Use VALUE to choose a 
detected channel to test and then press CONFIG-right.

To perform additional testing on the channel you selected, see Run 

the ATM Test, page 18–21.

 1 ATM VPI/VCI Scan Final:  00:12:25.97 
 >--
 1 >02/0001   012%   5 >04/0003   012% 
 2 >03/0001   000%   6 >05/0003   000% 
 3 >04/0001   012%   7 >--/----   ---% 
 5 >05/0001   012%   8 >--/----   ---% 

 Function>Channel Search
 Notation>Hex
 Further measurement on item>1
----------------------------------------
Select the Channel Search function,
then press START to execute.
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ATM Network Testing

Run a Cell Capture Test

ATM
Run a Cell Capture Test

The cell capture sequence is 
not available for STS-12c ATM 
applications.

Use the cell capture test to filter and view a specific cell stream, or a 
range of streams. This procedure shows how to set up and run the test.

1. From the Main Menu, select Terminal, Monitor, or Drop & Insert 
test mode and press MENU-down.

2. On the test setup screen, configure the transmitter, receiver, and 
payload as necessary for your test. For ATM on SONET signals, be 
sure the Payload is set for ATM. Press MENU-down.

3. On the test operation screen, configure the signal parameters as 
needed. For ATM on T-carrier, set the Data> field to ATM.

For loop tests, configure the 
ATM transmit stream before 
you begin the VPI/VCI scan. 
See Configure Global ATM 
Parameters, page 18–10.

4. Press CONFIG-right to display the Control Screen menu. Use FIELD 
to select ATM Setup and press CONFIG-right again.

5. On the ATM Setup menu, select Cell Capture and press 
CONFIG-right.

 1 STS1-STS1 (DS3) Final:  00:00:00.00 
Trouble Scan

          No Errors or Alarms

Í DS3:    Frm>M13       Data>ATM
        TxClk>Int     FEBE>111    XBit>1
STS1:   TxClk>Int        Scramble>On
        Tx>STSX1         Rx>STSX1
Err:    Type>DS3 Data    Rate>Single

Í

          ATM Standard Active
Standard           |
VPI/VCI Scan       |
Transfer Delay     |
Inter Arrival Time |
Cell Capture       |
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Run a Cell Capture Test

AT
M

6. Next select Cell Capture Mode and choose a mode. The capture 
mode determines what other setup screens will be presented (this 
example uses Cell Capture Mode>Range of VPIs).

7. Press CONFIG-right. The next Cell Capture screen is displayed.

The appearance of this screen depends on the capture mode 
selected in step 6. The selected mode is indicated in the title of the 
screen.

8. Use the FIELD and VALUE keys to set a VPI address range to 
capture. The test set will only capture cells that fall within the range 
you set.

9. Press CONFIG-right to display the VPI Masking setup screen.

You can refine the capture range by masking parts of the range 
entered in step 8. Use FIELD and VALUE to enter as many as four 
masks to be excluded from the capture range. Enable the masks by 
toggling the corresponding Enable: number On or Off.

Example: if you specify 10 to 88 in step 8 and a mask of 33 to 55, the 
test set captures cells with VPIs in the ranges 10 to 32 and 56 to 88.

Í

      <ATM Cell Capture Setup #1>
 Path/Circuit Notation>Hex
 Cell Capture Mode>Range of VPIs

   <ATM Cell Capture-Range of VPIs>
 Display Cell #>001
 Capture VPI>01 To FF

 Press ACTION to display selected cell#
 Press < RESULT > to scroll

Í

    <ATM Cell Capture-VPI Masking>
 1>Mask From VPI> 00 TO  00
 2>Mask From VPI> 00 TO  00
 3>Mask From VPI> 00 TO  00
 4>Mask From VPI> 00 TO  00
Enable: 1>Off 2>Off 3>Off 4>Off
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Run a Cell Capture Test

ATM
10. Start the cell capture test by pressing START.

The 156MTS captures cells using the criteria you defined. The test 
runs until 500 cells are captured, or until you press STOP. The 
number of cells captured is displayed in the Cells> field on the top 
half of the display.

11. Use the RESULT keys to scroll the top half of the display and view 
the header and payload of each of the captured cells. The 
ATM Cell # field on the top line indicates which cell is being 
displayed.

12. To avoid scrolling through all the cells, enter the number of the cell 
you’d like to view in the Display Cell #> field and then press the 
ACTION key.

 1 ATM Cell # 007   Final:  00:00:00.00 
 Cell Capture Complete        Cells>500
 00010001 xx 03 59 01 07 03 59 01 07 03
 09 01 01 03 59 01 07 03 59 01 07 03 09
 01 07 03 59 01 07 03 59 01 07 03 59 01
 07 03 59 01 07 03 59 01 07 03 59 01 07

   <ATM Cell Capture-Range of VPIs>
 Display Cell #>001
 Capture VPI>01 To FF

 Press ACTION to display selected cell# 
 Press < RESULT > to scroll
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Set up for ATM Testing

ATM testing features are available when the payload is set for ATM.

1. From the Main Menu press FIELD to select a testing mode.

2. Press MENU-down. The testing setup screen for the mode you 
select is displayed (this example shows Terminal testing mode).

3. Use FIELD and VALUE to set the transmitter (Tx Rate:) and 
receiver (Rx Rate:). For Monitor and D&I modes the transmitter 
and receiver are set simultaneously (Tx/Rx Rate:).

4. Next press the right FIELD key to select the Payload: parameter. 
Use VALUE to set the payload to an ATM selection.

• For OC-12, select 12c/ATM or 3c/ATM; for OC-3, select 3c/ATM.

• For STS-1 and OC-1, select STS1/ATM.

• For DS3, DS1, or E1 select DS3, DS3/DS1, DS3/E1, DS1, or E1 
as appropriate for your test.

5. Press MENU-down. The test operation screen is displayed.

Before you configure the ATM parameters, you should decide which 
ATM test mode to use. See Choose an ATM Test Mode, page 18–8.

         TERMINAL TESTING

Tx Rate: STS1/OC1      Rx Rate: STS1/OC1

Payload: STS1/ATM

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press MENU-dn to enter test mode.
Press MENU-up to return to Main Menu.
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ATM
Choose an ATM Test Mode

1. From the test operation screen press CONFIG-right to display the 
Control Screen menu.

2. Select ATM Setup and press CONFIG-right to display the ATM 
Setup menu.

3. Select the ATM test mode that you want to use.

Refer to the table on page 18–9 for help selecting an ATM test mode.

4. Proceed with the ATM parameter setup. See Configure Global ATM 

Parameters, page 18–10.

Global Settings  |  Data Link Control
Alarm Control    |  ATM Setup
APS Control      |  DS3 Prog Pattern
DS3 FEAC Control |
DS3 C-Bit Control|
SONET OH Control |

Í

          ATM Standard Active
Standard           |
VPI/VCI Scan       |
Transfer Delay     |
Inter Arrival Time |
Cell Capture       |
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How to select an 
ATM test mode

1. Find the ATM measurements you want to make in the table below.

2. Note the ATM test mode that meets your needs and check the 
requirements and restrictions associated with it. You will probably 
use Standard mode unless you are making cell delay measurements.

3. Select the corresponding mode on the ATM Setup menu (see 
page 18–8).

Note: There is only one ATM test mode for STS-12c. STS-12c ATM testing features 
5% bandwidth step size, AAL-0 cell type, and continuous distribution. 
Background cells and OAM cells are not available. See Setup for STS-12c 
ATM Testing, page 18–19)

If you want to measure… Bandwidth, Cell Count, HEC errors, BER, Misinsert, PLCP, Alarm,  OAM

…Plus… AAL-1 (cell loss, CRC) Cell Transfer Delay 
(round-trip delay)

Inter-cell Arrival Delay

…Select this Test Mode: Standard Cell Transfer Delay Cell Inter-Arrival Delay

Re
qu

ir
em

en
ts

/R
es

tr
ic

tio
ns

Traffic Shaping Yes (2% or 10% BW 
step only)

No No

BW Step Size 2% (no bkgrnd), 10%, 
Line rates.

2% 2%

Fgnd Cell Type AAL-0, AAL-1 Test Cell Test Cell

Fgnd Distribution Continuous
Burst (no OAM)

Continuous Continuous

Fgnd OAM Yes (Continuous 
distribution)

No No

Rx Chan Cell Type AAL-0, AAL-1, 
AAL-3/4, AAL-5

Test Cell Test Cell

Bkgnd Cells/OAM Yes (10% BW step 
only)

No No
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ATM
Configure Global ATM Parameters

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

• When you press CONFIG-right from the ATM Setup menu, the ATM 
Global Setup screen is displayed.

1. Use FIELD and VALUE to set cell scrambling (Cell Scramble>)  
and to set the cell address format (Circuit/Path Notation>).

2. Set traffic shaping on (Basic) or Off.

3. Next set the foreground channel bandwidth step size. You can select 
2% or 10% increments, or select a nominal line rate.

Note: If you select 2% bandwidth increments or a line rate, transmit background 
channels are disabled and ATM setup screens 5 and 6 are not displayed.

4. For DS3, select a Cell Delineation>. Choose either HEC-based or 
PLCP-based mapping. See DS3 Cell Mapping, page 19–5

5. Press CONFIG-right when done. The Foreground Channel Control 
screen is displayed (see Configure the ATM Foreground Channel 

(no traffic shaping), page 18–11).

    <ATM SETUP #1: Global Setup>
Cell Scramble>Off
Circuit/Path Notation>Hex
Traffic Shaping>Off
BW Step Size>10% with Bkgnd AALs
Cell Delineation>HEC
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Configure the ATM Foreground Channel
(no traffic shaping)

Note: If you set Traffic Shaping> to Basic (see step 2, page 18–10) proceed to 
Configure the ATM Foreground Channel (with basic traffic shaping), 
page 18–12.

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

• From the ATM Global Setup screen, press CONFIG-right to display 
the Foreground Channel Control screen.

1. Use FIELD and VALUE to set the bandwidth (BW) used by the 
foreground channel. The bandwidth can be set in increments of 2% 
or 10%, depending on the BW Step Size> (see step 3, page 18–10).

For more information about 
Line rate bandwidths, 
see Bandwidth Step Size, 
page 19–4 and 19–5.

• If you set BW Step Size to a “line rate” (see step 3, page 18–10), 
BW is replaced by Line Increment. Choose the Nominal rate, 
or adjust the rate up or down in five steps (–5 to +5).

2. Select Type> and use VALUE to set either AAL0 or AAL1 for the 
foreground channel. If you did not select Standard test mode, this 
field is set to Test Cell (see step 3, page 18–8).

3. Next select a interleave transmission mode (Distribution>). If the 
test mode is not Standard, this field is set to Continuous.

4. If you selected Single Burst or Periodic Burst for Distribution, 
use FIELD and VALUE to set the number of cells transmitted each 
burst (Cells Per Burst>) and the length of time between bursts 
(Period>).

• From this screen only, press ACTION to trigger a single burst of 
foreground channel cells.

5. Next configure the OAM injection parameters (Distribution> must 
be set to Continuous). Choose the type, alarm, and segment.

6. Press CONFIG-right when you have finished. The Cell Payload Data 
screen is displayed (see Set ATM Cell Payloads, page 18–13).

  <ATM SETUP #2: Fgnd Channel Control>
BW>100%                Type>AAL0
Distribution>Continuous
Cells Per Burst>100    Period>0.0 Sec
OAM:Enable>Off  Type>F5    >AIS     >End
>>>Press ACTION to send Single Burst<<<
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ATM
Configure the ATM Foreground Channel
(with basic traffic shaping)

Note: If you set Traffic Shaping> to Off (see step 2, page 18–10) refer to Configure 
the ATM Foreground Channel (no traffic shaping), page 18–11.

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

This procedure configures the bandwidth and distribution of the ATM 
foreground channel, and sets the foreground OAM transmit function.

• From the ATM Global Setup screen, press CONFIG-right to display 
the Foreground Channel Control screen.

For more information on the 
leaky bucket algorithm, 
see Leaky Bucket Algorithm, 
page 19–7.

1. Use FIELD and VALUE to set the peak cell rate (PCR), sustained 
cell rate (SCR), and maximum burst size in cells (MBS). These 
parameters are used to calculate the “leaky bucket algorithm” for 
traffic shaping when Service Type is set for VBR (see next step).

2. Set Service Type to either CBR (constant bit rate) or VBR 
(variable bit rate). When Service Type is set to CBR, the PCR value 
is used for the foreground channel bandwidth.

3. Select AAL Type> and set either AAL0 or AAL1 for the foreground 
channel.

4. Next select a interleave transmission mode (Distribution>).

5. If you selected Single or Periodic for Distribution, set the length 
of time between bursts (Period>). The number of cells in a burst is 
defined by MBS (see step 1).

• From this screen only, press ACTION to trigger a single burst of 
foreground channel cells.

6. Next configure the OAM injection parameters (Distribution> must 
be set to Continuous). Choose the type, alarm, and segment.

7. Press CONFIG-right when you have finished. The Cell Payload Data 
screen is displayed (see Set ATM Cell Payloads, page 18–13).

  <ATM SETUP #2: Fgnd Channel Control>
PCR>100%       SCR>010%      MBS>0100
Service Type>CBR         AAL Type>AAL1
Distribution>Continuous Period>0.1 Secs
OAM:Enable>Off  Type>F5    >AIS     >End
>>>Press ACTION to send Single Burst<<<
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Set ATM Cell Payloads

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

This procedure sets the payloads of the foreground channel and idle 
cells, and defines the user-programmable ATM test patterns.

• From the Foreground Channel Control screen, press CONFIG-right 
to display the Cell Payload Control screen.

1. Use VALUE to set the payload pattern for the ATM foreground 
channel.

2. Use FIELD to select Idle Cell Data> and use VALUE to set a 
hexadecimal value for the payload of the transmitted idle cells.

3. Next use FIELD and VALUE to enter a value for the 32-bit 
foreground pattern. The value is entered in hexadecimal.

4. In the same manner, use FIELD and VALUE to enter a value for the 
32-bit background pattern.

Note: The background pattern is only available when traffic shaping is off and the 
bandwidth step size is set to 10% increments.

5. Press CONFIG-right when you are finished. The fourth ATM setup 
screen is displayed (see Set the Foreground, Idle and Receive 

VP/VC, page 18–14).

   <ATM SETUP #3: Cell Payload Data>
Fgnd Data>2^15-1
Idle Cell Data>00
32-Bit Fgnd Pattern>12345678
32-Bit Bkgnd Pattern>9ABCDEF0
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ATM
Set the Foreground, Idle and Receive VP/VC

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

This procedure sets the cell header fields for the foreground channel, 
idle cells, and receive channel. It also sets the receive channel cell type.

• From the Cell Payload Data screen, press CONFIG-right to display 
the fourth ATM screen.

1. Use FIELD and VALUE to set the generic flow control bits (GFC), 
virtual path identifier byte (VPI), virtual circuit identifier bytes 
(VCI), payload type bits (PT), and cell-loss priority bit (CLP) for 
the foreground channel cell headers (Fgnd Hdr:).

2. Next set the GFC, PT, and CLP for the transmitted idle cells 
(Idle Hdr:). The idle VP/VC address is not editable.

3. Set the VP/VC for the receive channel (Rx Chan:). The test set uses 
this address to make “selected VP/VC” measurements (see Selected 

VP/VC Measurement Screens, page 20–4).

4. Use FIELD and VALUE to set the cell type for the received 
channel(Rx Cell Type>). If you did not select Standard test mode 
this field is set to Test Cell (see step 3, page 18–9).

5. Press CONFIG-right when you are finished.

• If you set a bandwidth step size of 10% (see step 3, page 18–10), 
the Background Channel Control screen is displayed. 
See Configure the ATM Background Channels (traffic shaping 

off), page 18–15.

• If you set a bandwidth size of 2%, the display returns to the test 
operation screen and you are ready to begin the test (see Run the 

ATM Test, page 18–21).

Note: You can go back to the other ATM screens by pressing CONFIG-left.

           <ATM SETUP #4>
         GFC VPI   VCI   PT   CLP
Fgnd Hdr: 0   01  0001  000    0
Idle Hdr: 0   --  ----  000    0
Rx Chan:  -   01  0001  ---    -
Rx Cell Type> AAL0
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Configure the ATM Background Channels
(traffic shaping off)

Note: If you set Traffic Shaping> to Basic (see step 2, page 18–10) proceed to 
Configure the ATM Background Channels (with basic traffic shaping), 
page 18–16.

• From the fourth ATM setup screen, press CONFIG-right to display 
the Background Channel Control screen.

Note: This screen is not displayed if BW Step Size> is set to 2%. See Configure 
Global ATM Parameters, page 18–10.

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

1. Use VALUE to set the background cell type (Type>). Next use 
FIELD and VALUE to set the payload (Data>).

2. Use FIELD and VALUE to select and activate or deactivate the four 
background channels (Enable: 1> through 4>).

3. Next set the OAM parameters (Distribution> must be Continuous, 
see step 3, page 18–11). Choose the type, alarm, and segment.

4. Press CONFIG-right. The Background Header Setup screen is 
displayed.

5. Use FIELD and VALUE to configure the cell headers for the four 
background channels. The fields are the same as for the foreground 
(See Set the Foreground, Idle and Receive VP/VC, page 18–14).

6. Press CONFIG-right when you are finished. The Misinserted Cell 
Error Control screen is displayed (see page 18–18).

<ATM SETUP #5: Tx Bkgnd Channel Control>
Type>AAL5
Data>All 0s
Enable: 1>Off 2>Off 3>Off 4>Off
OAM:Enable>Off  Type>F5    >AIS     >End

 <ATM SETUP #6: Tx Bkgnd Header Setup>
        GFC VPI   VCI   PT   CLP
Hdr1:    0   02  0001  000    0
Hdr2:    0   03  0001  000    0
Hdr3:    0   04  0001  000    0
Hdr4:    0   05  0001  000    0
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Configure the ATM Background Channels
(with basic traffic shaping)

Note: If you set Traffic Shaping> to Off (see step 2, page 18–10) refer to Configure 
the ATM Background Channels (traffic shaping off), page 18–15.

• From the fourth ATM setup screen, press CONFIG-right to display 
the Background Channel Control screen.

Note: This screen is not displayed if BW Step Size> is set to 2%. See Configure 
Global ATM Parameters, page 18–10.

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

1. Use FIELD and VALUE to set each of the four background channels 
(1–4) On or Off.

2. Set the Service Type for each background channel to either CBR 
(constant bit rate) or VBR (variable bit rate).

3. Next set the AAL Type for each background channel.

4. Set the OAM parameters (Distribution> must be set to Continuous, 
see step 3, page 18–11). Choose the type, alarm, and segment.

5. Press CONFIG-right. The Background Payload Data screen is 
displayed.

6. Use FIELD and VALUE to configure the payloads of the four 
background channels.

<ATM SETUP #5: Tx Bkgnd Channel Control>
Enable:       1>Off 2>Off 3>Off 4>Off
Service Type: 1>CBR 2>CBR 3>CBR 4>CBR
AAL Type:     1>AAL5      2>AAL5
              3>AAL5      4>AAL5
OAM:Enable>Off Type>F5    >AIS     >End

 <ATM SETUP #6: Tx Bkgnd Payload Data>
Data          32-bit Pattern
1>32-Bit Prog   >9ABCDEF0
2>32-Bit Prog   >9ABCDEF0
3>32-Bit Prog   >9ABCDEF0
4>32-Bit Prog   >9ABCDEF0
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7. Press CONFIG-right. The Background Header Setup screen is 
displayed.

8. Use FIELD and VALUE to configure the cell headers for the four 
background channels. The fields are the same as for the foreground 
(See Set the Foreground, Idle and Receive VP/VC, page 18–14).

9. Press CONFIG-right when you are finished. The Misinserted Cell 
Error Control screen is displayed (see page 18–18).

 <ATM SETUP #7: Tx Bkgnd Header Setup>
        GFC VPI   VCI   PT   CLP
Hdr1:    0   02  0001  000    0
Hdr2:    0   03  0001  000    0
Hdr3:    0   04  0001  000    0
Hdr4:    0   05  0001  000    0
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Configure Misinserted Cell Errors

For STS-12c ATM applications, 
see Setup for STS-12c ATM 
Testing, page 18–19.

This procedure measures the misinserted cell injection capability. 
Misinserted cells can be injected during ATM testing by setting the error 
type (Err: Type>) to Misins Cell.

• From the Background Header Setup screen, press CONFIG-right to 
display the Misinserted Cell Error Control Screen.

1. Use FIELD and VALUE to set the Period. This is the amount of time 
between cell misinsertions when the error injection Rate is set to 
Periodic.

2. Use FIELD to select the Data field and use VALUE to set the 
payload pattern for the misiniserted cells.

3. Next use FIELD and VALUE to configure the value of the 32-bit user 
pattern in hexadecimal (32-bit Prog). The pattern is used when 
Data is set to 32-Bit Prog.

4. When you are finished, press CONFIG-right to return to the test 
operation display.

<ATM SETUP #7: Misinsert Cell Err Cntl>
Period>0.1 Secs
Data>All 1s
32-bit Pat>ABCDEF01
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Setup for STS-12c ATM Testing

For more information on 
STS-12c ATM parameters, 
see STS-12c ATM Parameters, 
page 19–23.

This procedure configures the unit for ATM testing on STS-12c signals.

1. To configure the test set for STS-12c/ATM testing, set the 
transmitter and receiver for OC-12, and set the payload for 
12c/ATM. (See Set up for ATM Testing, page 18–7.)

2. On the test operation screen, use FIELD and VALUE to set the 
transmit timing source (STSN: TxClk>) as desired. This parameter 
can be set to internal, loop timing, or external timing sources.

3. Press CONFIG-right to display the Control Screens menu.

4. Select ATM Setup from the Control Screens menu and then press 
CONFIG-right. The first STS-12c ATM setup screen is displayed.

5. Set cell scrambling on or off, and then set the display notation for 
circuit and path addresses to either decimal or hexadecimal.

6. Press CONFIG-right. The second STS-12c ATM setup screen is 
displayed.

7. Set the bandwidth percentage for the transmit channel (TxBW>) 
and then activate the transmit channel (Enable>On).

8. Next set the payload for the transmit channel cells 
(Active Cell Data>) and the idle cells (Idle Cell Data>).

9. If you selected the user-programmable pattern (32-bit Prog) for the 
transmit channel data, program the pattern in hexadecimal 
(32 Bit Pattern>).

       <STS-12c ATM SETUP #1>
Cell Scramble>On
Path/Circuit Notation>Hex

       <STS-12c ATM SETUP #2>
TxBW>050%          Enable>On
Active Cell Data>2^31-1
Idle Cell Data>00
32 Bit Pattern>12345678
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ATM
10. Press CONFIG-right. The third STS-12c ATM setup screen is 
displayed.

11. Configure the cell header for the transmit channel (Tx Hdr), setting 
each of the header fields as appropriate (GFC, VPI, VCI, PT, and 
CLP).

12. Next configure the GFC, PT, and CLP for the idle cell headers, if 
desired.

13. Configure the VP/VC address for the receive channel (Rx Chan: 

VPI and VCI). This is the address the test set uses to make “selected 
VP/VC” measurements.

14. Press CONFIG-right to return to the test operation display.

• You are now ready to run the test. See Run the ATM Test, 
page 18–21.

Note: You can go back to the other ATM screens by pressing CONFIG-left.

       <STS-12c ATM SETUP #3>
         GFC VPI   VCI   PT   CLP
Tx Hdr:   0   01  0001  000    0
Idle Hdr: 0   --  ----  000    0
Rx Chan:  -   01  0001  ---    -
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Run the ATM Test

After you have configured the ATM foreground and background 
channel parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the 
elapsed time begins to increment.

2. If you want to inject ATM errors use FIELD and VALUE to select an 
ATM error type in the Err: Type> field, and to choose an 
appropriate injection rate (Rate>).

3. Press ERROR INJECT to inject the errors.

4. Use the RESULT keys to scroll through different measurements on 
the upper half of the display.

5. To inject bursts of ATM cells, access the Foreground Channel 
Control screen and use the ACTION key to trigger the bursts. 
See Configure the ATM Foreground Channel (no traffic shaping), 
page 18–11.

6. To end the test, press STOP.

 1 STS1-STS1 (ATM)  Elapsed:00:00:28.00 
ATM Measurement Summary
Valid Cell Delineation:    ON
Selected VP/VC Cell Rcv’d: ON
Total Active BW (Hz), Avg: 22,392,484
Rx VP/VC BW (Hz), Avg:     5,480,387

STS1:   TxClk>Int        Scramble>On
        Tx>STSX1         Rx>STSX1
Err:    Type>ATM Pyld    Rate>Off
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ATM Traffic Selection

ATM
ATM Traffic Selection

For STS-12c ATM testing, 
Option 203 is required. For all 
other ATM testing, Option URZ 
is required.

The type of ATM traffic to be tested is determined by the Payload 
selection on the Terminal or Monitor testing setup screen (Terminal 
mode is shown here):

The Tx Rate, Rx Rate, and Payload fields must be set as described 
below (for Monitor modes the rates are set together):

OC12–OC12 12c/ATM: For testing ATM on STS-12c signals.

STS1/OC1–STS1/OC1 STS1/ATM: For testing ATM on STS-1 
electrical signals or OC-1 optical signals.

All Other Rates: ATM can be performed on the lowest-rate signal 
indicated in the Payload selection. For example in a OC12–OC3 DS3 
test setup, ATM testing is available on the DS3 signal. To use the ATM 
capability, the Data> field must be set to ATM on the test operation 
screen (press MENU-down from the test setup screen).

About Cell Transmission

The primary test channel is the foreground channel. You specify the 
service type (CBR or VBR), the bandwidth used by this channel, and the 
transmission method. The remaining bandwidth can be either idle cells 
or as many as four different background AAL channels. The bandwidth 
that is not assigned to the foreground channel is divided evenly among 
the active background channels. OAM cells can be inserted on the 
foreground or background channels.

         TERMINAL TESTING

Tx Rate: STS1/OC1      Rx Rate: STS1/OC1

Payload: STS1/ATM

----------------------------------------
Select Tx and Rx Rates first
then select payload.

Press MENU-dn to enter test mode.
Press MENU-up to return to Main Menu.
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The ATM Setup Menu

This screen is not available for 
STS-12c.

The ATM Setup menu provides access to the ATM test modes and setup 
screens. When ATM Setup is selected from the Control Screens menu, 
the following menu is displayed:

The first line: This line indicates which ATM mode is active. The 
active mode is the mode that was last selected from this menu. Each 
mode is described below (for information selecting the test mode 
see Choose an ATM Test Mode, page 18–8):

Standard: This mode is for performing BERT or cell-loss 
measurements. Background channels are enabled in this mode 
(see Bandwidth Step Size, page 19–4).

Cell transfer delay is also 
called “round-trip delay.”

Transfer Delay: This mode is for performing cell transfer delay 
measurements. The foreground channel uses only test cells 
(see Foreground Channel Type, page 19–8), OAMs and background 
channels are disabled.

Inter Arrival Time: This mode is for performing inter-cell arrival time 
measurements. The foreground channel uses only test cells 
(see Foreground Channel Type, page 19–8), OAMs and background 
channels are disabled.

• For information on using the VPI/VCI Scan, see Run an 

Automatic VP/VC Scan, page 18–2.

• For information on using Cell Capture, see Run a Cell Capture 

Test, page 18–4.

          ATM Standard Active
Standard           |
VPI/VCI Scan       |
Transfer Delay     |
Inter Arrival Time |
Cell Capture       |
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ATM
Global ATM Parameters (ATM SETUP #1)

The ATM Global Setup screen is accessed by selecting an ATM test 
mode from the ATM Setup menu.

Cell Scrambling Cell Scramble> switches the ATM cell payload scrambler On or Off. 
Cell scrambling is used to guard against the payload information 
mimicking the SONET scrambling sequence, which could result in an 
excess zeros condition.

Address Notation Circuit/Path Notation> selects the display notation for the VP/VC 
address information on the ATM setup screens. Hex sets hexadecimal 
notation; Decimal sets decimal notation.

Traffic Shaping (Not available for STS-12c) Traffic Shaping> switches the traffic 
shaping feature on and off.

Off: Traffic shaping is not used. Foreground channel is CBR.

Basic: Traffic shaping is active. The foreground channel can be set to 
VBR, and the PCR, SCR, and MBS parameters are used to define the 
“leaky bucket” algorithm. See Leaky Bucket Algorithm, page 19–7.

Bandwidth Step 
Size

(Not available for STS-12c) BW Step Size> selects how the bandwidth 
is defined for the foreground channel (see Foreground Channel 

Bandwidth, page 19–6). BW Step Size> can be set as follows:

10% with Bkgnd AALs: The foreground bandwidth is set in 
increments of 10 percent. Background ATM channels are enabled in 
this mode (only available when Test Mode is set to Standard).

2% with no Bkgnd AALs: The foreground bandwidth is set in 
increments of 2 percent, however background ATM channels are 
disabled. This is the only selection when Test Mode is set to 
Cell Transfer Delay or Cell Inter Arrival Time (see next page).

    <ATM SETUP #1: Global Setup>
Cell Scramble>Off
Circuit/Path Notation>Hex
Traffic Shaping>Off
BW Step Size>10% with Bkgnd AALs
Cell Delineation>HEC
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AT
M

The “Line Rate” selections are 
not available when traffic 
shaping is on.

DS0/TS (56k) Line Rate: Sets the foreground bandwidth to a 
nominal rate of about 63 kHz. This corresponds to an ATM data rate of 
about 56 kHz, plus associated overhead.

DS0/TS (64k) Line Rate: Sets the foreground bandwidth to a 
nominal rate of about 72 kHz. This corresponds to an ATM data rate of 
about 64 kHz plus associated overhead.

DS1 Line Rate: Sets the foreground bandwidth to a nominal rate of 
about 1.53 MHz. This corresponds to an ATM data rate of about 
1.54 MHz minus the associated overhead.

E1 TS0/16 Line Rate: Sets the foreground bandwidth to a nominal 
rate of about 1.92 MHz. This corresponds to an ATM data rate of about 
2.04 MHz minus the associated TS0/16 overhead.

The “Line Rate” bandwidths 
can be adjusted using the Line 
Increment field on Screen #2 
(see page 19–6).

E1 TS0 Line Rate: Sets the foreground bandwidth to a nominal rate 
of 1.98 MHz. This corresponds to an ATM data rate of about 2.04 MHz 
minus the associated TS0 overhead.

DS3 HEC Line Rate: Sets the foreground bandwidth to a nominal 
rate of 44.08 MHz. This corresponds to an ATM data rate of about 
44.73 MHz minus the associated overhead.

STS1 Line Rate: Sets the foreground bandwidth to a nominal rate of 
48.20 MHz. This corresponds to an ATM data rate of about 51.84 MHz 
minus the associated overhead.

DS3 Cell Mapping (Available for DS3 only) Cell Delineation> sets how the ATM cells are 
mapped to the DS3 signal:

HEC: Cells are mapped with HEC-based cell delineation.

PLCP: ATM traffic is mapped into 125 µs PLCP frames carried on the 
DS3 signal.
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ATM
Foreground Channel Control Parameters 
(ATM SETUP #2)

The ATM Foreground Channel Control is accessed by pressing 
CONFIG-right after configuring the Global Setup screen.

When Traffic Shaping is set to Off (see Traffic Shaping, page 19–4), 
the display appears as follows:

When Traffic Shaping is set to Basic, the display appears as 
follows:

Foreground 
Channel 
Bandwidth

BW>: sets the bandwidth used by the transmit foreground channel and 
can be set from 000% through 100% in increments of either 10% or 2% 
(5% for STS-12c, see page 19–23). See Bandwidth Step Size, page 19–4. 
This field is available when 10% or 2% is selected for BW Step Size, 
and when traffic shaping is off.

Line Increment: This field adjusts the selected “Line Rate” 
bandwidth. The bandwidth can be adjusted up or down by about 
3 percent in 10 steps (–5 through +5) or set to Nominal (no 
adjustment). This field is only available when BW Step Size is set to a 
Line Rate selection. See Bandwidth Step Size, page 19–4.

Note: Bandwidth that is not assigned to the foreground channel is used by the 
background channels or idle cells. Foreground cells are interleaved with the 
idle or background cells to achieve the specified bandwidth (see ATM 
Foreground Cell Interleaving, page 19–10).

  <ATM SETUP #2: Fgnd Channel Control>
BW>100%                Type>AAL0
Distribution>Continuous
Cells Per Burst>100    Period>0.0 Sec
OAM:Enable>Off  Type>F5    >AIS     >End
>>>Press ACTION to send Single Burst<<<

  <ATM SETUP #2: Fgnd Channel Control>
PCR>100%       SCR>010%      MBS>0100
Service Type>CBR         AAL Type>AAL1
Distribution>Continuous Period>0.1 Secs
OAM:Enable>Off  Type>F5    >AIS     >End
>>>Press ACTION to send Single Burst<<<
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AT
M

VBR Traffic 
Profile

(Traffic shaping on) The PCR, SCR, and MBS fields define the VBR 
traffic profile. These fields are used to calculate the “leaky bucket” 
algorithm when Service Type is set to VBR.

PCR: Peak Cell Rate. The maximum bandwidth that can be used by the 
VBR traffic.

SCR: Sustained Cell Rate. The nominal average bandwidth used by the 
VBR traffic.

MBS: Maximum Burst Size. The maximum number of cells that can be 
transmitted in a single burst of the VBR traffic.

Service Type (Traffic shaping on) Service Type determines whether the traffic is 
constant or variable bit rate.

CBR: Constant Bit Rate. Uses only the PCR value to set the transmit 
bandwidth.

VBR: Variable Bit Rate. uses the PCR, SCR, and MBS fields to calculate 
the “leaky bucket” algorithm (see figure below).

Leaky Bucket Algorithm
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ATM
Foreground 
Channel Type

The Type> or AAL Type> field selects the ATM adaptation layer (AAL) 
protocol used for the foreground channel. Type> can be set to the 
following:

Type> is not applicable for 
STS-12c ATM; the foreground 
is fixed at AAL-0. See STS-12c 
ATM Parameters, page 19–23.

AAL0: A constant bit rate (CBR) cell with a standard header and 
48 bytes of user-definable payload. This type is only available when 
Test Mode> is set to Standard.

AAL1: A CBR cell with standard header, one byte for sequence check 
(SC) and 47 bytes of user-definable payload. This type is only available 
when Test Mode> is set to Standard.

Test Cell: A special CBR cell with a standard header, a 32-bit time 
stamp, and 44 bytes of user-definable payload (see Test Cell Structure, 
page 19–16). This type is used for cell-delay testing. Type> is 
automatically set to Test Cell for Cell Transfer Delay or 
Cell Inter Arrival Time test modes (see The ATM Setup Menu, 
page 19–3).

Foreground 
Distribution

Distribution> sets the cell interleaving mode for the foreground 
channel. This parameter can be set as follows:

Not applicable for STS-12c 
ATM; distribution is 
Continuous. See STS-12c ATM 
Parameters, page 19–23.

Continuous: The foreground channel is transmitted continuously, 
interleaved at the selected bandwidth (BW>). See Foreground Channel 

Bandwidth, page 19–6.

Single Burst: A single burst of cells is transmitted, interleaved at the 
selected bandwidth, when the ACTION key is pressed. The number of 
cells in the burst is defined by Cell Per Burst> (see below). This 
selection is not available when Test Mode> is set for 
Cell Transfer Delay or Cell Inter Arrival Time.

Note: The Single Burst function only works when this screen is displayed.

Periodic Burst: A single burst of cells is transmitted repeatedly at 
user-specified intervals. The number of cells in the burst is defined by 
Cells Per Burst>. The time interval between bursts is defined by 
Period> (see below). See ATM Periodic Burst Transmission Mode, 
page 19–10. This selection is not available when Test Mode> is set for 
Cell Transfer Delay or Cell Inter Arrival Time.

Off: No foreground channel cells are transmitted.
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AT
M

Burst Size Cells Per Burst> defines the number of cells transmitted when a 
foreground channel single or periodic burst is activated. The numbers 
of cells can be set from 000 through 512.

Note: For DS3 ATM, if the bandwidth (BW>) is set for 2% or 4% do not set a burst size 
higher than 200 or 400 cells, respectively.

Burst Period Period> sets the interval between periodic cell burst transmissions. 
For example, if Period> is set to 5.0, a cell burst (as defined by BW> 
and Cells Per Burst>) is activated every 5 seconds. Period> can be 
set from 0.0 though 9.9 seconds in 0.1 second increments. See ATM 

Periodic Burst Transmission Mode, page 19–10.

Note: If you set Period> to 0.0, no periodic bursts are transmitted.
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ATM
ATM Foreground Cell Interleaving

ATM Periodic Burst Transmission Mode

FGND Bkgnd 1 Bkgnd 2 Bkgnd 3 Bkgnd 4 FGND Bkgnd 1 Bkgnd 2 Bkgnd 3 Bkgnd 4 FGND Bkgnd 1

FGND Idle FGND Idle FGND Idle FGND Idle FGND Idle FGND Idle

FGND FGND FGND FGND FGND FGND FGND FGND FGND FGND FGND FGND

FGND FGND

Foreground channel
inter-cell gap set by BW>

Foreground channel bandwidth = 100%

Foreground channel bandwidth = 50%
Background channels all turned OFF

Foreground channel bandwidth = 20%
Background channels all turned ON

Foreground channel interleaved with idle or background cells

FGND 1 FGND 2

Foreground channel
inter-cell gap set by BW>

FGND 3 FGND N FGND 1

Elapsed time between periodic bursts set by Period>

N = Number of cells in each burst, set by Cells Per Burst>

Remaining time in period filled
with idle or background cells
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AT
M

OAM Cell 
Parameters

The OAM: parameters control the generation of OAM cells on the 
foreground channel. Note that OAM parameters are only available when 
Distribution> is set to Continuous and the Test Mode> is set to 
Standard. OAM functions are not available for STS-12c ATM.

OAM Enabling The Enable> field turns foreground OAM generation On or Off. When 
this field is set to On, OAM cells are inserted on the transmit foreground 
channel.

OAM Type The three Type> fields determine the format of the OAM cells inserted 
when Enable> is set to On. The OAM type fields are as follows:

Type>flow >alarm function >payload type

Flow: Sets the OAM flow to F4 (for VPs), F5 (for VCs), or F4&F5 
(both types are generated).

Alarm function: Sets the function of the generated OAM cell to either 
AIS (alarm indication signal), RDI (remote defect indication), or 
AIS&RDI (both).

Payload type: Sets whether the OAM cell applies to the entire path 
(End = end-to-end) or only to the segment (Seg).

OAM Cell 
Transmission

When OAM insertion is active (OAM:Enable>On) the set inserts OAM 
cells on the transmit foreground channel at an average rate of 
approximately ten OAM cells each second. This rate is maintained for 
each active OAM cell type. The different types of cells are inserted in 
the following order:

1. F4 AIS

2. F4 RDI

3. F5 AIS

4. F5 RDI

OAM cell insertion will not be less than one OAM cell each second and 
not more than 1% of the transport capacity.
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ATM
Cell Payload Parameters (ATM SETUP #3)

The setup screen for STS-12c 
ATM is different. See STS-12c 
ATM Parameters, page 19–23.

The ATM Cell Payload Data setup screen is accessed by pressing 
CONFIG-right from the Foreground Channel Control screen.

Foreground Cell 
Payload

Fgnd Data> sets the foreground payload pattern that is sent on the 
transmit ATM stream, and is compared with the receive ATM stream for 
bit error measurements. Fgnd Data> can be set to the following:

2^15-1, 2^20-1, 2^23-1: PRBSs (2^15-1 is a 215–1 PRBS).

1010: A repeating pattern of alternating ones and zeros (1010...).

1100: Repeating pattern of two ones alternating with two zeros (1100...).

Live: Live traffic pass-through.

All 1s: A continuous all-ones pattern (1111...).

All 0s: A continuous all-zeros pattern (0000...).

32-Bit Prog: Repeating pattern set by 32-Bit Fgnd Pattern> (below).

Idle Cell Payload Idle Cell Data> sets the payload for the transmit idle cells. This 
parameter can be set from 00 through FF, hexadecimal. The binary 
equivalent of this value is repeated to fill the cell payload.

User-defined ATM 
Patterns

The 32-Bit Fgnd Pattern> and 32-Bit Bkgnd Pattern> fields define 
the user ATM patterns for the foreground and background streams. 
Each of the eight digits can be set from 0 through F (hex). The binary 
equivalent of the hex value forms the 32-bit binary pattern. The 
appropriate pattern is used when Fgnd Data> or background Data> is 
set to 32-Bit Prog.

Note: When traffic shaping is on, the background cell payloads are defined on the 
Background Payload Data screen. Chapter 19, Background Payload Data 
Parameters (ATM SETUP #6—traffic shaping on).

   <ATM SETUP #3: Cell Payload Data>
Fgnd Data>2^15-1
Idle Cell Data>00
32-Bit Fgnd Pattern>12345678
32-Bit Bkgnd Pattern>9ABCDEF0
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AT
M

Header Setup Parameters and 
Receive Cell Type (ATM SETUP #4)

The setup screen for STS-12c 
ATM is different. See STS-12c 
ATM Parameters, page 19–23.

The ATM Header Setup screen is accessed by pressing CONFIG-right 
after configuring the Cell Payload Data setup screen.

Cell Header Types The following three types of cell headers can be defined on the 156MTS. 
Header fields that are displayed as “----” cannot be edited. See Cell 

Header Parameters, page 19–14, for a description of the header fields.

Fgnd Hdr: Foreground channel header. Configures the cell header 
parameters for the foreground transmit channel.

Idle Hdr: Idle cell header. Configures the cell header parameters for 
the transmitted idle cells. The VPI and VCI are always set to zero.

The idle cells are true idle cells if the CLP is set to 1. The idle cells are 
unassigned cells if the CLP is set to 0.

Rx Chan: Receive channel header. Configures the VP/VC address for 
the receive channel. Received cells with VP/VC addresses matching 
Rx Chan are used to calculate measurements based on 
“Selected VP/VC” (OAM cells are not counted).

           <ATM SETUP #4>
         GFC VPI   VCI   PT   CLP
Fgnd Hdr: 0   01  0001  000    0
Idle Hdr: 0   --  ----  000    0
Rx Chan:  -   01  0001  ---    -
Rx Cell Type> AAL0
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ATM
Cell Header 
Parameters

ATM Cell Header Structure, page 19–16 shows the parts of the header.

GFC: Generic Flow Control. Sets the first four bits of the cell header. 
This parameter can be set from 0 through F (hexadecimal). GFC is not 
editable for Rx Chan.

The VPI and VCI values are 
displayed in hexadecimal (hex) 
or decimal notation according 
to Circuit/Path Notation (see 
page 19–4).

VPI: Virtual Path Identifier. Sets bits 5 through 12 of the cell header. 
The VPI is part of the cell address and can be set from 00 through FF 
(hexadecimal) or 000 through 255 (decimal). VPI is not editable for 
Idle Hdr (idle VPI = 000).

VCI: Virtual Channel Identifier. Sets bits 13 through 28 of the cell 
header. The VCI is part of the cell address and can be set from 0000 
through FFFF (hexadecimal) or 00000 through 65535 (decimal). VCI 
is not editable for Idle Hdr (idle VCI = 0000).

Note that a VCI value of 0003 or 0004, indicates that the cell is an OAM 
cell. If you use a PRBS or all-zeros pattern while transmitting a stream 
of “OAM” cells, you can cause inadvertent OAM alarms.

OAM (Operation and 
Maintenance) cells are used by 
the network for management 
and alarm indication.

PT: Payload Type. Sets bits 29 through 31 of the cell header. The 
payload type field can be set from 000 through 111 (binary). PT is not 
editable for Rx Chan.

Note that a PT value of 1XX, where X is any value, indicates that the 
cell is an OAM cell. If you use a PRBS or all-zeros pattern while 
transmitting a stream of “OAM” cells, you can cause inadvertent OAM 
alarms.

CLP: Cell Loss Priority. Sets bit 32 of the cell header. CLP can be set to 
either 1 or 0 (binary). 1 indicates that the cell can be discarded during 
heavy cell traffic conditions. CLP is not editable for Rx Chan.
19–14



ATM Configuration Reference

Header Setup Parameters and Receive Cell Type (ATM SETUP #4)

19–15

AT
M



ATM Configuration Reference

Header Setup Parameters and Receive Cell Type (ATM SETUP #4)

ATM
ATM Cell Header Structure

Test Cell Structure

Byte 1 2 3 4 5 6 53

Cell Header Information Bytes

53-byte ATM Cell

GFC: Generic Flow Control

VPI: Virtual Path Identifier

VCI: Virtual Channel Identifier

PT: Payload Type

CLP: Cell Loss Priority

HEC: Header Error Control sequence

Byte 1 5 6 7 8 9 53

Cell Header Payload

53-byte ATM Cell

5-Byte Header

4-Byte Time Stamp

44-Byte Payload

Time Stamp
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AT
M

Receive Cell Type Rx Cell Type> sets the ATM adaptation layer protocol for the receive 
channel. This parameter can be set as follows:

Note: The AAL selections are only available in Standard  ATM test mode
(see page 19–3).

This parameter is not 
applicable for STS-12c ATM. 
The Rx Chan is fixed at AAL-0. 
See STS-12c ATM Parameters, 
page 19–23.

AAL0: Received cells are constant bit rate (CBR) cells with a standard 
header and 48 bytes of payload.

AAL1: Received cells are constant bit rate (CBR) cells with a standard 
header, one byte for sequence check (SC), and 47 bytes of payload.

AAL3/4: Received cells use AAL-3/4 segmenting (with cell-based and 
packet-based CRC).

AAL5: Received cells use AAL-5 segmenting (with packet-based CRC).

Test Cell: Received cells are time-stamped CBR cells with a standard 
header, four bytes for the time stamp, and 44 bytes of payload (see Test 

Cell Structure, page 19–16). Rx Cell Type> is automatically set to this 
selection in the Cell Transfer Delay or Cell Inter Arrival Time test 
modes (see page 19–3).

Note: BER measurements can be performed on the receive pattern when 
Rx Cell Type> is set to Test Cell, as long as the received cells match the test 
cell format.

Note: For inter-arrival measurements, the received cells can be any type, as long as 
the VP/VC address matches the Rx Chan.
19–17



ATM Configuration Reference

Background Channel Control Parameters (ATM SETUP #5)

ATM
Background Channel Control Parameters 
(ATM SETUP #5)

Background channels are not 
available for STS-12c.

The Background Channel Control screen is accessed by pressing 
CONFIG-right from the Header Setup screen (ATM SETUP #4).

When Traffic Shaping> is set to Off the screen appears as follows:

When Traffic Shaping> is on the screen appears as follows:

Note: Background channel parameter screens are not available when 
BW Step Size> is set to 2% with no Bkgnd AALs (see Bandwidth Step Size, 
page 19–4).

Background 
Channel 
Activation

Enable: 1> through 4> controls transmission of each of the four 
background channels. A channel set to On is transmitted; a channel set 
to Off is not transmitted. If Type> is set to Idle (traffic shaping off 
only), no background channels are transmitted regardless of their 
Enable setting.

Background 
Service Type

Service Type: 1> through 4> sets the type of service for each of the 
background channels. Each can be set to either CBR (constant bit rate) 
or VBR (variable bit rate). Not available when traffic shaping is off.

<ATM SETUP #5: Tx Bkgnd Channel Control>
Type>AAL5
Data>All 0s
Enable: 1>Off 2>Off 3>Off 4>Off
OAM:Enable>Off  Type>F5    >AIS     >End

<ATM SETUP #5: Tx Bkgnd Channel Control>
Enable:       1>Off 2>Off 3>Off 4>Off
Service Type  1>CBR 2>CBR 3>CBR 4>CBR
AAL Type:     1>AAL5      2>AAL5
              3>AAL5      4>AAL5
OAM:Enable>Off  Type>F5    >AIS     >End
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AT
M

Background Cell 
Type

The Type> or AAL Type> field sets the ATM adaptation layer protocol 
used by the background channels. Type> can be set as follows:

For AAL-3/4 and AAL-5, the set 
transmits a 500-cell packet 
with appropriate internal CRC, 
and so forth.

AAL3/4: Cells use AAL-3/4 segmenting (with cell-based CRC).

AAL5: Cells use AAL-5 segmenting (with packet-based CRC).

Idle: (Traffic shaping off only) Background channels are disabled. 
Only idle cells are transmitted in non-foreground bandwidth, regardless 
of the Enable field settings.

Background Cell 
Payload

When traffic shaping is off, the Data> field is available and sets the 
payload for all the background channel cells as follows:

The background data is set on 
screen#6 when traffic shaping 
is on (see page 19–20).

All 1s: A continuous all-ones pattern (1111...).

All 0s: A continuous all-zeros pattern (0000...).

32-Bit Prog: A repeating pattern defined by the 32-Bit Bkgnd 

Pattern> field (see User-defined ATM Patterns, page 19–12).

OAM Cell 
Parameters

The OAM: parameters control the generation of OAM cells on the 
background channels. Note that background OAM parameters are only 
available when at least one background channel is enabled (On).

OAM Enabling The Enable> field turns background OAM generation On or Off. When 
this field is set to On, OAM cells are inserted on all active background 
channels.

OAM Type The three Type> fields determine the format of the OAM cells inserted 
when Enable> is set to On. The OAM type fields are as follows:

Type>flow >alarm function >payload type

Flow: Sets the OAM flow to F4 (for VPs), F5 (for VCs), or F4&F5 
(both types are generated).

Alarm function: Sets the function of the generated OAM cell to either 
AIS (alarm indication signal), RDI (remote defect indication), or 
AIS&RDI (both).

Payload type: Sets whether the OAM cell applies to the entire path 
(End = end-to-end) or only to the segment (Seg).
19–19



ATM Configuration Reference

Background Payload Data Parameters (ATM SETUP #6—traffic shaping on)

ATM
OAM Cell 
Transmission

When OAM insertion is active (OAM:Enable>On) the set inserts OAM 
cells on the transmit background channels at an average rate of 
approximately five OAM cells each second on every channel. This rate 
is maintained for each active OAM cell type. The different types of cells 
are inserted in the following order:

1. F4 AIS

2. F4 RDI

3. F5 AIS

4. F5 RDI

For each background channel OAM cell insertion will not be less than 
one OAM cell each second and not more than 1% of the transport 
capacity.

Background Payload Data Parameters 
(ATM SETUP #6—traffic shaping on)

When the traffic shaping feature is on, the background channel 
payloads are set on this screen. This screen is not displayed when 
traffic shaping is off.

The Data 1> through 4> fields control the payload pattern for each the 
four background channels individually. Each channel’s payload can be 
set to one of the following:

32-Bit Prog: The user-defined programmable pattern. Enter the 
pattern in hexadecimal on the right side of the screen.

All 1s: A repeating all-ones pattern

All 0s: A repeating all-zeros pattern.

 <ATM SETUP #6: Tx Bkgnd Payload Data>
Data         32-bit Pattern
1>32-Bit Prog   >9ABCDEF0
2>All 1s        >9ABCDEF0
3>All 0s        >9ABCDEF0
4>32-Bit Prog   >9ABCDEF0
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AT
M

Background Header Setup Parameters 
(ATM SETUP #6—traffic shaping off;
ATM SETUP #7—traffic shaping on)

Background channels are not 
available for STS-12c.

The ATM Transmit Background Header setup screen is accessed by 
pressing CONFIG-right after configuring the Background Channel 
Control or Background Payload Data screen.

When traffic shaping is off, this is ATM Setup screen #6; when traffic 
shaping is on, this is screen #7.

Note: Background channel parameter screens are not available when 
BW Step Size> is set to 2% with no Bkgnd AALs (see Bandwidth Step Size, 
page 19–4).

Hdr1 through Hdr4: These fields determine the cell headers for each 
of the transmit background channels. The header is used when the 
corresponding background channel is enabled (see Background 

Channel Activation, page 19–18).

For information on the cell header fields, see Cell Header Parameters, 
page 19–14.

 <ATM SETUP #6: Tx Bkgnd Header Setup>
        GFC VPI   VCI   PT   CLP
Hdr1:    0   02  0001  000    0
Hdr2:    0   03  0001  000    0
Hdr3:    0   04  0001  000    0
Hdr4:    0   05  0001  000    0
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ATM
Misinserted Cell Error Control Parameters 
(ATM SETUP #7—traffic shaping off;
ATM SETUP #8—traffic shaping on)

When traffic shaping is off, 
this is ATM Setup screen #7; 
when traffic shaping is on, this 
is screen #8.

The ATM Misinserted Cell Error Control screen is accessed by pressing 
CONFIG-right after configuring the Background Header Setup screen.

Misinserted Cell 
Period

Period> set s how often a misinserted cell is injected when the error 
inject rate is set to Periodic. This field can be set from 0.0 through 9.9 
seconds.

Misinserted Cell 
Payload

Data> sets the payload pattern of the misinserted cells. This field can 
be set as follows:

All 1s: A repeating all-ones pattern.

All 0s: A repeating all-zeros pattern.

32-Bit Prog: The user-defined programmable pattern. Enter the 
pattern in hexadecimal in the 32-bit Pat> field.

Injecting 
Misinserted Cells

The Misinserted Cell Error Control screen configures the injection of 
misinserted cells on the transmit ATM stream. To inject misinserted 
cells, set Err: Type> to Misins Cell and then set Rate> to Single, 
Periodic, or Off. Misinserted cells are injected when you press the 
ERROR INJECT key.

<ATM SETUP #7: Misinsert Cell Err Cntl>
Period>0.1 Sec
Data>All 1s
32-bit Pat>ABCDEF01

Í

STS1:   TxClk>Int        Scramble>On
        Tx>STSX1         Rx>STSX1
Err:    Type>Misins Cell Rate>Periodic
19–22



ATM Configuration Reference

STS-12c ATM Parameters

AT
M

STS-12c ATM Parameters
OAM functions and 
background channels are not 
supported for STS-12c. Only 
AAL-0 is supported for 
STS-12c.

For ATM on STS-12c signals, three configuration screens are used:

These parameters are the same as for other ATM modes. Use the table 
below to find the sections where the parameters are described. 

       <STS-12c ATM SETUP #1>
Cell Scramble>On
Path/Circuit Notation>Hex

       <STS-12c ATM SETUP #2>
TxBW>050%          Enable>On
Active Cell Data>2^31-1
Idle Cell Data>00
32 Bit Pattern>12345678

       <STS-12c ATM SETUP #3>
         GFC VPI   VCI   PT   CLP
Tx Hdr:   0   01  0001  000    0
Idle Hdr: 0   --  ----  000    0
Rx Chan:  -   01  0001  ---    -

Parameter Description location

Cell Scramble> See Cell Scrambling, page 19–4.

Path/Circuit Notation See Address Notation, page 19–4.

TxBW> See Foreground Channel Bandwidth, page 19–6.

Enable> Turns ATM transmission On or Off.

Active Cell Data> See Foreground Cell Payload, page 19–12.

Idle Cell Data> See Idle Cell Payload, page 19–12.

32 Bit Pattern See User-defined ATM Patterns, page 19–12.

Tx Hdr:, Idle Hdr:,
Rx Chan:

See Cell Header Types, page 19–13, and 
Cell Header Parameters, page 19–14.
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ATM
ATM Error Injection

ATM errors can be injected when the payload is set for ATM. Some 
error types apply specifically to ATM, but other non-ATM error types 
can affect the ATM stream or PLCP frame as well (see ATM-Affecting 

Error Types, page 19–25).

Note: For information on injection rates, see About Error Injection Rates, page 27–8.

HCS Byte: Causes header error control (HEC) field errors by inverting 
the HEC byte of every transmitted cell on every channel. Note that this 
effect causes loss of cell synchronization (LOCS). Rates: Off, 
Continuous (STS-3c); Single, 6 Consec, 7 Consec, 8 Consec, 
Continuous, Off (STS-12c).

HCS Bit: Generates bit errors in the ATM cell header checksum 
field. Rates: Off, Continuous.

ATM Pyld: Generates bit errors in the payload of the ATM cells.
Rates: Single, 1.0E-3, 1.0E-6, Off (non STS-12c modes); Single, 1.0E-2 
through 1.0E-9, Burst, Off (STS-12c).

Loss of Cell: (AAL-1 only) Generates loss of cell condition.
Rates: Off, Single.

SN CRC/Par: (AAL-1 only) Generates sequence number CRC/parity 
error. Rates: Off, Single.

Misins Cell: (AAL-1 only) Generates misinserted cells.
Rates: Off, Single, Periodic.

PLCP B1 Bit: (PLCP only) Generates bit errors in the PLCP frame’s B1 
byte. Rates: Off, Continuous.

PLCP FEBE Bit: (PLCP only) Generates bit errors in the PLCP 
frame’s FEBE field (bits 1–4 of the G1 byte). Rates: Off, Continuous.

PLCP A1/A2 Bit: (PLCP only) Generates bit errors in the PLCP 
frame’s A1 and A2 (framing) bytes. Rates: Off, Continuous.

PLCP POI: (PLCP only) Generates errors in the Path Overhead 
Indicator (P) bytes of the PLCP frame. Rates: Off, Continuous.
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ATM-Affecting 
Error Types

The following table lists error injection types for ATM modes, and 
indicates which types affect the ATM cell stream or PLCP frame.

ATM-affecting Error Types

Error Type
ATM 
Specific

Affects ATM or PLCP

Yes No

HCS Byte 3 n

HCS Bit 3 n

ATM Pyld 3 n

Loss of Cell 3 n

SN CRC/Par 3 n

Misins Cell 3 n

REI-P or REI-L (FEBE) n

Section BER, Line BER, or Path BER n

B1 Byte, B2 Byte, or B3 Byte n

H Pointer n†

A1/A2 Frame n†

DS3 Data, DS3 Dat, Par n

DS3 BPV n

DS3 Frame n†

PLCP B1 Bit 3 n

PLCP FEBE Bit 3 n

PLCP A1/A2 Bit 3 n

PLCP POI 3 n

† May affect ATM (or PLCP) if a Loss of Pointer or Loss of Frame condition results 
from injecting this type of error.
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ATM
ATM Indicators

DS1 Alarm and Status Indicators

Indicator Description

HIST/ALARMS

LOCS Loss of cell synchronization

SCNR Selected cell not received

PLCP LOF Loss of PLCP frame synchronization

PLCP YEL PLCP Yellow alarm

VP-AIS Virtual Path alarm indication signal (F4 OAM)

VP-RDI Virtual Path remote defect indication (F4 OAM)

VC-AIS Virtual Circuit alarm indication signal (F5 OAM)

VC-RDI Virtual Circuit remote defect indication (F5 OAM)

LOPAT Loss of cell payload pattern synchronization

STATUS

CELL SYNC Cell synchronization achieved

CHNL MTCH Selected Rx Chan cell type received

PAT SYNC Cell payload pattern synchronization achieved

PLCP SYNC PLCP frame synchronization achieved

ERRORS ATM errors detected
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ATM Measurement Summary Screen

For each screen, an “s” 
indicates Summary results 
level and a “d” indicates Detail 
level. See To Display More 
Measurement Screens, 
page 1–11.

This screen displays an overview of ATM signal status and 
bandwidth.

PLCP is Physical Layer 
Convergence Protocol: a 
method for mapping ATM cells 
onto a DS3 facility. See PLCP 
Measurement Screens (DS3 
only), page 20–16

Valid Cell Delineation or Valid PLCP Sync: ATM signal status: 
Displays On when a valid ATM signal is being received.

• For HEC-delineated ATM, the item is Valid Cell Delineation.

• For PLCP ATM (DS3 only), the item is Valid PLCP Sync (valid 
PLCP signal synchronization).

Selected VP/VC Cell Rcv’d: Selected ATM channel status: Displays 
On when ATM cells are detected that match the VPI/VCI address set for 
the received channel. See Rx Chan, page 19–13.

Total Active BW (Hz), Avg: Average total active ATM bandwidth: 
The total average bandwidth used by all ATM traffic on the received 
signal, in Hertz.

Rx VP/VC BW (Hz), Avg: Average selected ATM channel bandwidth: 
The average bandwidth (in Hertz) used by the input ATM channel that 
matches the VP/VC setting for the received channel. See Rx Chan, 
page 19–13.

Note: F5 OAM cells (cells with a payload type value of 1xx) with a VP/VC address that 
matches the Rx Chan are not counted for “Selected VP/VC” measurements. 
OAM cells are only counted for “Total Cell Stream” measurements.

s

 1 STS1-STS1 (ATM)  Final:  00:03:09.59
ATM Measurement Summary
Valid Cell Delineation:    ON
Selected VP/VC Cell Rcv’d: ON
Total Active BW (Hz), Avg: 25,794,068
Rx VP/VC BW (Hz), Avg:     7,771,430
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Selected VP/VC Measurement Screens

These two screens display measurements based on the selected receive 
channel (cells with VP/VC address matching the receive channel setting; 
See Rx Chan, page 19–13).

Note: When results relating to the selected VP/VC on the received channel are 
calculated, OAM cells (cells with a PT value of 1xx) with that address are not 
counted. OAM cells are only included in “Total Cell Stream” calculations.

Screen #1 This screen displays measurements relating to the bandwidth of the 
selected channel.

Rx BW (Hz), Avg: Average selected receive channel bandwidth in 
Hertz: The average bandwidth of the selected receive channel since the 
beginning of the test, in Hertz.

Rx BW (%), Avg: Average selected receive channel bandwidth 
percentage: The average percentage of total bandwidth used by the 
selected receive channel since the beginning of the test, as a value from 
0 through 100%.

Rx BW (Hz), Current: Current selected receive channel bandwidth 
in Hertz: The average bandwidth of the selected receive channel for the 
previous 2.25 seconds, in Hertz.

Rx BW (%), Current: Current selected receive channel bandwidth 
percentage: The average percentage of total bandwidth used by the 
selected receive channel in the previous 2.25 seconds, as a value from 
0 through 100%.

s

 1 STS1-STS1 (ATM)  Final:  00:11:13.91
Selected VP/VC Measurements #1
Rx BW (Hz), Avg:           7,771,430
Rx BW (%), Avg:            018
Rx BW (Hz), Current:       13,268,749
Rx BW (%), Current:        030
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Screen #2 This screen displays measurements relating to cell counts on the 
selected channel.

Cell Count: Selected receive channel cell count: The total number of 
cells received since the beginning of the test, in scientific notation.

Cells per Second, Avg: Average selected receive channel cell rate: 
The average number of cells received each second since the beginning 
of the test.

Cells per Second, Current: Current selected receive channel cell 
rate: The average number of cells received each second during the 
previous 2.25 seconds.

d

 1 STS1-STS1 (ATM)  Final:  00:10:11.93
Selected VP/VC Measurements #2
Cell Count:                  1.15E+06
Cells per Second, Avg:        18171
Cells per Second, Current:    31294
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Total Cell Stream Measurement Screens

These three screens display measurements relating to the entire receive 
ATM cell stream.

Screen #1 This screen displays measurements relating to the bandwidth of the 
entire ATM cell stream.

Active BW (Hz), Avg: Average active ATM bandwidth: The average 
bandwidth used by all ATM cells since the beginning of the test, in 
Hertz.

Active BW (%), Avg: Average active ATM bandwidth percentage: The 
average percentage of total bandwidth used by ATM since the beginning 
of the test. Result is a value from 0 through 100%.

Active BW (Hz), Curr: Current active ATM bandwidth: The average 
bandwidth used by all ATM cells during the previous 2.25 seconds, in 
Hertz.

Active BW (%), Curr: Current active ATM bandwidth percentage: 
The average percentage of total bandwidth used by ATM during the 
previous 2.25 seconds. Result is a value from 0 through 100%.

s

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
Total Cell Stream Measurements #1
Active BW (Hz), Avg:       25,794,068
Active BW (%), Avg:        058
Active BW (Hz), Curr:      44,042,480
Active BW (%), Curr:       100
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Screen #2 This screen displays measurements relating to errors in the header 
error control field on the entire ATM cell stream.

NonSTS-12c ATM For ATM on rates other than STS-12c, this screen appears as follows:

During LOCS (loss of cell 
synchronization) conditions, 
individual HEC errors are not 
counted.

HEC Error Count: Header error control field error count: The total 
number of HEC errors detected.

HEC Error/Cell Ratio: Header error control field error ratio: The 
ratio of HEC errors to the total number of cells.

STS-12c ATM For STS-12c ATM, this screen appears as follows:

During LOCS (loss of cell 
synchronization) conditions, 
individual HEC errors are not 
counted.

HCS Error Count (correctable): Correctable header checksum 
error count: The total number of correctable header error control 
(HEC) field errors. A correctable HCS error is defined as a HEC field in 
which a single bit is errored.

HCS Error Count (uncorrectable): Uncorrectable header 
checksum error count: The total number of uncorrectable HEC errors. 
An uncorrectable HCS error is defined as a HEC field in which two or 
more bits are errored.

Total Error Count: The total number of correctable and 
uncorrectable HEC errors.

HCS Errors/Cell Ratio: The ratio of HEC errors to the total number 
of cells received.

s

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
Total Cell Stream Measurements #2
HEC Error Count:              7
HEC Errors/Cell Ratio: 4.13E-07

s

 1 OC12-OC12(12cATM)Final:  00:00:00.00
Total Cell Stream Measurements #2
HCS Error Count (correctable):         6
HCS Error Count (uncorrectable):       4
Total Error Count:                    10
HCS Errors/Cell Ratio:          4.16E-07
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Screen #3 This screen displays measurements relating to cell counts on the entire 
ATM cell stream.

Cell Count: Total ATM stream cell count: The total number of cells 
received since the beginning of the test, in scientific notation.

Cells per Second, Avg: Average total ATM stream cell rate: The 
average number of cells received each second since the beginning of 
the test.

Cells per Second, Current: Current total ATM stream cell rate: The 
average number of cells received each second during the previous 
2.25 seconds.

d

 1 STS1-STS1 (ATM)  Final:  00:01:07.66
Total Cell Stream Measurements #3
Cell Count:                  7.01E+06
Cells per Second, Avg:       103875
Cells per Second, Current:   103874
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ATM Payload Bit Error Measurements Screen

This screen displays BER measurements based on the foreground 
channel.

Note: In a loop test the foreground and receive channels must be set to the same 
AAL type, or else LOP or excessive bit errors will be detected. See Foreground 
Channel Type, page 19–8, and Receive Cell Type, page 19–17.

Err Count: Foreground channel error count: The number of pattern 
bit errors detected on the foreground channel. Sec Ago displays the 
number of seconds elapsed since the last error occurred.

Err Ratio, Avg: Foreground channel average bit error ratio: The 
number of pattern bit errors over the total number of bits received since 
the beginning of the test, in scientific notation.

Err Ratio, Curr: Foreground channel current bit error ratio: The 
number of pattern bit errors received in the previous 2.25 seconds over 
the total number of bits received during the same period (in scientific 
notation).

ES: Foreground errored seconds: The number of seconds that had at 
least one ATM pattern bit error since the beginning of the test.

EFS: Foreground error-free seconds: The number of seconds in which 
no ATM pattern bit errors occurred since the beginning of the test.

%EFS: Percentage of foreground channel error-free seconds: The 
percentage of total seconds, since the beginning of the test, that had no 
foreground channel payload errors.

Pat Sync: Foreground channel pattern synchronization: Displays On 
to indicate that pattern synchronization has been achieved with the 
received ATM channel.

Note: In a loop test, if a received channel (such as a background channel) has the 
same VP/VC address as the foreground channel, that channel will cause ATM 
payload bit errors and may also cause loss of pattern synchronization.

s

 1 STS1-STS1 (ATM)  Final:  00:00:13.50
ATM Payload Bit Error Measurements
Err Count:         7   Sec Ago:       2
Err Ratio, Avg:  4.48E-08 ES:         4
Err Ratio, Curr: 3.70E-08 EFS:        9
Pat Sync: ON              %EFS:   69.23
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ATM AAL-1 Cell Loss Measurements Screen

The screen displays results based on AAL-1 cell loss measurements on 
the receive channel (not applicable for STS-12c ATM).

Note: This screen is only applicable when the receive channel type is set to AAL1. 
See Receive Cell Type, page 19–17.

Count: ATM AAL-1 cell loss count: The number of cells lost based on 
missing sequence numbers on the received AAL-1 cells. Sec Ago 
displays the elapsed time since the previous cell loss.

Err Ratio, Avg: Average cell loss ratio: The number of cells lost over 
the total expected number of receive cells (cells actually received plus 
cells lost), since the beginning of the test.

Err Ratio, Curr: Current cell loss ratio: The average cell loss ratio for 
the previous 2.25 seconds.

ES: Cell loss errored seconds: The number of seconds in which at least 
one cell loss occurred.

EFS: Cell loss error-free seconds. The number of seconds during 
which no cell losses occurred.

%EFS: Cell loss error-free seconds percentage: The percentage of all 
seconds since the beginning of the test during which no cell losses 
occurred.

Note: To perform cell loss measurements in a loop test, both the foreground channel 
and the receive channel must be set to AAL-1.

s

 1 STS1-STS1 (ATM)  Final:  00:01:01.01
ATM AAL1 Cell Loss Measurements
Count:            7   Sec Ago:         5
Err Ratio, Avg:  3.67E-06 ES:          7
Err Ratio, Curr: 0.00E+00 EFS:        54
                          %EFS:    88.52
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ATM AAL-1 SN CRC/Par Error 
Measurements Screen

This screen displays results based on CRC-3 and parity errors in the 
sequence number protection bits of the AAL-1 sequence check byte (not 
applicable for STS-12c ATM).

Note: This screen is only applicable when the receive channel type is set to AAL1. 
See Receive Cell Type, page 19–17.

Count: AAL-1 CRC-3 and parity count: The number of sequence 
number protection CRC and parity errors. Sec Ago displays the elapsed 
time since the previous error.

Err Ratio, Avg: AAL-1 CRC-3 and parity average error ratio: The 
number of CRC and parity errors over the number of selected channel 
cells received, since the beginning of the test.

Err Ratio, Curr: AAL-1 CRC-3 and parity current error ratio: The 
average CRC/parity error ratio for the previous 2.25 seconds.

ES: AAL-1 CRC-3 and parity errored seconds: The number of seconds 
in which at least one CRC or parity error occurred.

EFS: AAL-1 CRC-3 and parity error-free seconds. The number of 
seconds during which no CRC or parity errors occurred.

%EFS: AAL-1 CRC-3 and parity error-free seconds percentage: The 
percentage of all seconds since the beginning of the test during which 
no CRC/parity errors occurred.

s

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
ATM AAL1 SN CRC/Par Error Measurements
Count:           11   Sec Ago:        0
Err Ratio, Avg:  2.00E-05 ES:         6
Err Ratio, Curr: 2.84E-05 EFS:       10
                          %EFS:   62.50
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ATM AAL-1 Misinserted Cell 
Measurements Screen

This screen displays results based on the detection of misinserted cells. 
A misinserted cell is a cell with a valid sequence number received out 
of the proper order.

Note: This screen is only applicable when the receive channel type is set to AAL1. 
See Receive Cell Type, page 19–17. 

Err Count: AAL-1 misinserted cell error count: The number of 
misinserted cells. Sec Ago displays the elapsed time since the previous 
error.

Err Ratio, Avg: AAL-1 misinserted cell average error ratio: The 
number of misinserted cells over the number of selected channel cells 
received, since the beginning of the test.

Err Ratio, Curr: AAL-1 misinserted cell current error ratio: The 
average misinserted cell error ratio for the previous 2.25 seconds.

ES: AAL-1 misinserted cell errored seconds: The number of seconds in 
which at least one misinserted cell occurred.

EFS: AAL-1 misinserted cell error-free seconds. The number of 
seconds during which no misinserted cells occurred.

%EFS: AAL-1 misinserted cell error-free seconds percentage: The 
percentage of all seconds since the beginning of the test during which 
no misinserted cells occurred.

s

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
ATM AAL1 Misinserted Cell Measurements
Err Count:        7   Sec Ago:         2
Err Ratio, Avg:  4.22E-06 ES:          7
Err Ratio, Curr: 1.42E-05 EFS:        46
                          %EFS:    86.79
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ATM Delay Measurements

This screen displays results based on ATM cell delay measurements 
(not applicable for STS-12c ATM).

• When the ATM Test Mode> is set for Cell Transfer Delay the 
measured delay is the time elapsed from when a cell is 
transmitted on the foreground channel output, to when it is 
detected on the receive channel input.

• When the ATM Test Mode> is set for Cell Inter Arrival Time, 
the measured delay is the difference in the arrival time of 
adjacent cells at the receive channel input.

Note: For cell inter-arrival time measurements the received cells can be any type, as 
long as the VP/VC address matches the receive channel (Rx Chan).

Note: This screen is not applicable for ATM Standard test mode. See The ATM Setup 
Menu, page 19–3.

Current-Min: The shortest delay measured in the previous 2.25 
seconds.

Average-Min: The average of all Current-Min values since the 
beginning of the test.

Peak-Min: The shortest delay measured since the beginning of the 
test.

Current-Max: The longest delay measured in the previous 2.25 
seconds.

Average-Max: The average of all Current-Max values since the 
beginning of the test.

Peak-Max: The longest delay measured since the beginning of the test.

Typical: The average of the Average-Min and Average-Max values.

s

 1 STS1-STS1 (ATM)  Final:  00:00:39.59
ATM Delay Measurements (In Seconds)
      Current      Average      Peak
Min.: 1.25E-05     1.24E-05     1.24E-05
Max.: 2.21E-05     7.17E-00     5.63E+01
Typical:  3.58E+00
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ATM OAM Alarm Status

This screen displays the current and historical status of ATM OAM 
alarms (not applicable for STS-12c ATM).

For each alarm, the current status (Alm) and historical status (Hist) is 
listed. If Alm shows On, the alarm condition is present. If Hist shows 
On, an earlier occurrence of the alarm condition was detected.

Each OAM alarm indication is cleared when its corresponding 
condition is not detected for three seconds.

F4 (VP) AIS: F4 flow (virtual path) alarm indication signal: Declared 
when the received OAM cell has a VCI of 3 (segment) or 4 (end-to-end), 
OAM cell type bits set to 0001, and function type bits set to 0000.

F4 (VP) RDI(FERF): F4 flow (virtual path) remote defect indication 
(far-end receive failure): Declared when the received OAM cell has a 
VCI of 3 or 4, OAM cell type bits set to 0001, and function type bits set to 
0001.

F5 (VC) AIS: F5 flow (virtual circuit) alarm indication signal: 
Declared when the received OAM cell has a PT of 100 (segment) or 101 
(end-to-end), OAM cell type bits set to 0001, and function type bits set 
to 0000.

F5 (VC) RDI(FERF): F5 flow (virtual circuit) remote defect 
indication (far-end receive failure): Declared when the received OAM 
cell has a PT of 100 (segment) or 101 (end-to-end), OAM cell type bits 
set to 0001, and function type bits set to 0001.

Note: Transmitting a foreground channel with a PT value of 1xx and a PRBS or 
all-zeros payload can cause unintended OAM alarms. See PT, page 19–14.

s

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
ATM OAM:           Alm  Hist
F4 (VP) AIS:       ON    --
F4 (VP) RDI(FERF): ON    --
F5 (VC) AIS:       --    ON
F5 (VC) RDI(FERF): --    ON
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ATM OAM Alarm Seconds

This screen displays alarm seconds counts of ATM OAM alarms (not 
applicable for STS-12c ATM). The alarms are defined in ATM OAM 

Alarm Status, page 20–14.

F4 (VP) AIS: The number of seconds during which an F4 AIS alarm 
was declared.

F4 (VP) RDI(FERF): The number of seconds during which an 
F4 RDI alarm was declared.

F5 (VC) AIS: The number of seconds during which an F5 AIS alarm 
was declared.

F5 (VC) RDI(FERF): The number of seconds during which an 
F5 RDI alarm was declared.

d

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
ATM OAM Alarm Seconds
F4 (VP) AIS:             40
F4 (VP) RDI(FERF):       36
F5 (VC) AIS:            119
F5 (VC) RDI(FERF):       25
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PLCP Measurement Screens (DS3 only)

PLCP measurements are based on the physical layer convergence 
protocol (PLCP) used to map ATM cells onto DS3 facilities 
(see Physical Layer Convergence Protocol (PLCP), page 21–5). These 
measurements are only applicable if the payload is set to 
ATM/PLCP-Based Cell Delineation.

PLCP 
Measurement 
Summary Screen

This screen displays an overview of basic PLCP signal status.

Count indicates the number of 
errors since the beginning of 
the test; Sec Ago indicates 
the number of seconds elapsed 
since the previous error 
occurred.

B1 BIP: PLCP BIP error count: The number of parity errors indicated 
by the PLCP B1 byte bit-interleaved parity (BIP) check.

Frm & POI: PLCP frame and path overhead error count: The number 
of PLCP framing and path overhead indicator (POI) errors.

FEBE: PLCP far-end block error count: The number of far-end block 
errors as indicated by the PLCP G1 byte.

s

 1 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
PLCP Measurement Summary
              Count      Sec Ago
B1 BIP:       37012         31
Frm & POI:  3317952          9
FEBE:         93975         16
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PLCP B1-BIP 
Measurements 
Screen

This screen displays measurements based on the PLCP bit-interleaved 
parity check (BIP). The BIP uses the B1 byte and is computed over the 
entire PLCP frame, excluding the A1, A2, P, and trailer bits.

Err Count: PLCP BIP error count: The number of B1 BIP errors 
detected since the beginning of the test.

Err Ratio, Avg: PLCP average BIP error ratio: The average ratio of 
BIP errors to the total number of received bits from which the BIP is 
computed, since the beginning of the test.

Err Ratio, Curr: PLCP current BIP error ratio: The ratio of BIP errors 
detected during the previous 2.25 seconds to the total number of 
received bits from which the BIP is computed during that same period.

ES: PLCP BIP errored seconds: The number of seconds in which at 
least one BIP error occurred, since the beginning of the test.

EFS: PLCP BIP error-free seconds. The number of seconds in which 
no BIP errors occurred.

%EFS: PLCP BIP error-free seconds percentage: The percentage of the 
total number of seconds since the beginning of the test in which no BIP 
errors occurred.

d

 1 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
PLCP B1-BIP Measurements
Err Count:   37012
Err Ratio, Avg:  1.14E-05 ES:         5
Err Ratio, Curr: 0.00E+00 EFS:       73
                          %EFS:   93.59
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PLCP Combined 
Frame and POI 
Measurements 
Screen

This screen displays measurements based on the PLCP framing (A1 and 
A2 bytes) and path overhead indicators (P bytes or POI bytes).

Err Count: Frame/POI error count: The number of frame and POI byte 
errors detected since the beginning of the test.

Err Ratio, Avg: Frame/POI average error ratio: The average ratio of 
frame and POI byte errors to the total number of frame and POI bytes 
received, since the beginning of the test.

Err Ratio, Curr: Frame/POI current error ratio: The ratio of frame 
and POI byte errors detected in the previous 2.25 seconds to the total 
number of frame and POI bytes received in that same period.

ES: Frame/POI errored seconds: The number of seconds in which at 
least one frame or POI byte error occurred, since the beginning of the 
test.

EFS: Frame/POI error-free seconds. The number of seconds in which 
no frame/POI errors occurred.

%EFS: Frame/POI error-free seconds percentage: The percentage of 
the total number of seconds since the beginning of the test in which no 
frame or POI byte errors occurred.

d

 1 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
PLCP Combined Frame & POI Measurements
Err Count: 3317952
Err Ratio, Avg:  1.48E-01 ES:         6
Err Ratio, Curr: 0.00E+00 EFS:       72
                          %EFS:   92.31
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PLCP FEBE 
Measurements 
Screen

This screen displays measurements based on the PLCP far-end block 
error field (bits 1–4 of the G1 byte). The FEBE reports the number of 
B1-BIP received by the far end.

Err Count: PLCP FEBE error count: The number of FEBE errors 
detected since the beginning of the test.

Err Ratio, Avg: PLCP FEBE average error ratio: The average ratio of 
FEBE errors to the total number of received bits from which the FEBE 
(B1-BIP) is calculated, since the beginning of the test.

Err Ratio, Curr: PLCP FEBE current error ratio: The average ratio of 
FEBE errors detected in the previous 2.25 seconds to the total number 
of received bits from which the FEBE (B1-BIP) is calculated during that 
same period.

ES: PLCP FEBE errored seconds: The number of seconds in which at 
least one FEBE error occurred, since the beginning of the test.

EFS: PLCP FEBE error-free seconds: The number of seconds in which 
no FEBE errors occurred.

%EFS: PLCP FEBE error-free seconds percentage: The percentage of 
the total number of seconds since the beginning of the test in which no 
FEBE errors occurred.

d

 1 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
PLCP FEBE Measurements
Err Count:   93975
Err Ratio, Avg:  2.91E-05 ES:        13
Err Ratio, Curr: 0.00E+00 EFS:       65
                          %EFS:   83.33
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ATM
ATM Alarm Status
For each alarm, the current status (Alm) and historical status (Hist) is 
listed. If Alm shows On, the alarm condition is present. If Hist shows 
On, an earlier occurrence of the alarm condition was detected.

HEC-based ATM This screen is for HEC-delineated ATM tests.

LOCS: Loss of cell synchronization: Declared when the test set cannot 
synchronize with the ATM cell stream.

SCNR: Selected cell not received: Declared when the test set cannot 
detect any receive cells that match the address information on the 
receive channel (see Rx Chan, page 19–13).

Pyld LOP: Payload loss of pattern: Declared when the unit cannot 
synch to the test pattern in the payload of the foreground test channel.

DS3/PLCP ATM This screen is available for DS3 PLCP-based ATM tests, and displays the 
current and historical status of ATM and PLCP alarms.

PLCP LOF: PLCP loss of frame: Declared when the test set cannot 
synchronize with the DS3 PLCP framing.

PLCP YEL: PLCP Yellow alarm, or remote alarm indication (RAI): This 
is detected in the last four bits of the G1 byte.

SCNR: Selected cell not received: Declared when the test set cannot 
detect any receive cells that match the address information on the 
receive channel (see Rx Chan, page 19–13).

Pyld LOP: Payload loss of pattern: Declared when the unit cannot 
synch to the test pattern in the payload of the foreground test channel.

s

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
ATM:      Alm  Hist
LOCS:     --   ON
SCNR:     --   ON
Pyld LOP: --   ON

s

 1 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
ATM:      Alm  Hist
PLCP LOF: --   ON
PLCP YEL: ON   --
SCNR:     --   ON
Pyld LOP: --   ON
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ATM Alarm Seconds
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ATM Alarm Seconds

HEC-based ATM This screen displays alarm seconds counts of ATM alarms. The alarms 
are defined in ATM Alarm Status, page 20–20.

LOCS: Loss of cell synchronization seconds: The number of seconds in 
which a LOCS alarm was present.

SCNR: Selected cell not received alarm seconds: The number of 
seconds in which an SCNR alarm was present

Pyld LOP: Payload loss of pattern: The number of seconds in which an 
LOP alarm was present.

DS3/PLCP This screen displays alarm seconds counts of ATM and PLCP alarms 
The alarms are defined in ATM Alarm Status, page 20–20.

PLCP LOF: PLCP loss of frame seconds: The number of seconds in 
which a LOF alarm was present.

PLCP YEL: PLCP Yellow alarm or RAI seconds: The number of 
seconds in which a Yellow or RAI alarm was present.

SCNR: Selected cell not received alarm seconds: The number of 
seconds in which an SCNR alarm was present

Pyld LOP: Payload loss of pattern: The number of seconds in which an 
LOP alarm was present.

d

 1 STS1-STS1 (ATM)  Final:  00:00:00.00
ATM Alarm Seconds
LOCS:        17
SCNR:        17
Pyld LOP:    17

d

 1 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
ATM Alarm Seconds
PLCP LOF:    17
PLCP YEL:     0
SCNR:        17
Pyld LOP:    17
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Basic Cell Structure

ATM
Basic Cell Structure

AAL-0 Cell Implementation

Byte 1 2 3 4 5 6 53

Cell Header Information Bytes

53-byte ATM Cell

GFC: Generic Flow Control

VPI: Virtual Path Identifier

VCI: Virtual Channel Identifier

PT: Payload Type

CLP: Cell Loss Priority

HEC: Header Error Control sequence

5-byte Cell Header 6 53

48-byte CBR Payload

53-byte ATM Cell
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AAL-1 Cell Implementation
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AAL-1 Cell Implementation

AAL-3/4 Cell Implementation

5-byte Cell Header 7 53

47-byte CBR Payload

53-byte ATM Cell

CRC: CRC-3 (cyclic redundancy checksum)

Parity Bit

Sequence
Check

SC: Sequence Count

CSI: Convergence Sublayer Indicator

5-byte Cell Header 53

44-byte Payload
of variable length

packets

53-byte ATM Cell

MID: Message Identification

LI: Length Indication

SN: Sequence Number

ST: Segment Type

76 52

CRC: CRC-10 (cyclic redundancy checksum)
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AAL-5 (SEAL) Cell Implementation

ATM
AAL-5 (SEAL) Cell Implementation

ATM Test Cell Structure

5-byte Cell Header 6 53

48-byte Payload
of variable length packets

(w/internal CRC)

53-byte ATM Cell

Byte 1 5 6 7 8 9 53

Cell Header Payload

53-byte ATM Cell

5-Byte Header

4-Byte Time Stamp

44-Byte Payload

Time Stamp
21–4
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Physical Layer Convergence Protocol (PLCP)

The DS3 PLCP is based on a 125 µs frame within the DS3 payload, 
which provides for the transmission of 12 ATM cells for each PLCP 
frame. There is no fixed relationship between the PLCP frame and the 
DS3 frame.

Physical Layer Convergence Protocol—DS3

Framing
bytes

POI 
bytes

POH
bytes 53 bytes

A1 A2 P11 Z6 ATM Cell

A1 A2 P10 Z5 ATM Cell

A1 A2 P9 Z4 ATM Cell

A1 A2 P8 Z3 ATM Cell

A1 A2 P7 Z2 ATM Cell

A1 A2 P6 Z1 ATM Cell

A1 A2 P5 F1 ATM Cell

A1 A2 P4 B1 ATM Cell

A1 A2 P3 G1 ATM Cell

A1 A2 P2 M1 ATM Cell

A1 A2 P1 M2 ATM Cell

A1 A2 P0 C1 ATM Cell Trailer

POI: Path overhead indicator bytes.
POH: Path overhead bytes.

13 or 14
nibbles
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Configuration Storage and Retrieval
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Configuration Storage and Retrieval

Store a Test Set 
Configuration

Follow this procedure to save a test set configuration in memory.

1. Configure the test set the way you want.

The 156MTS stores as many as 
ten test set configurations in 
nonvolatile, internal memory. 
You can configure the test set 
and then save that setup for 
later recall and use.

2. When you have finished setting up the instrument, press MENU-up 
to return to the Main Menu

3. Use FIELD to select Store and Recall Configurations and press 
MENU-down. The Store/Recall Configurations screen is 
displayed:

4. Use VALUE to set Action to Store.

5. Press FIELD to select Test #, and then use VALUE to choose a 
memory location in which to store the configuration.  Also, the 
following explains the use of local and retrieval command featured 
in Release 7.0 or higher Software.

          MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences

Í
Setup System Parameters
Store and Recall configurations

----------------------------------------
Press < FIELD > to highlight item, then
Press MENU-down to select item.

Í

Í

  STORE/RECALL      #      Status
 CONFIGURATIONS
                    1>EMPTY
Action: Store       2 EMPTY
                    3 EMPTY
Test #: 1           4 EMPTY

                    5 EMPTY
------------------  6 EMPTY
Press MENU-dn to  | 7 EMPTY
initiate action.  | 8 EMPTY
Press MENU-up to  | 9 EMPTY
go to Main Menu.  |10 EMPTY
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Note: SCPI mode has “new” Store/Recall feature enhancement.  Release 7.0 and 
higher software provides support for test set Store and Recall functions.  In 
SCPI mode, the test set only has a limited number of operational front panel 
controls.  Release 7.0 and higher software syntax requires the use of the colon 
“:” where earlier releases do not. 

The test set configurations are saved when you execute the SCPI 
command :SYSTEM:STORE:n[:name].  The “n” is a number location 
(between 1 and 10) that specifies the save slot  of the configuration 
data.  Using the “name”  (optional parameter)  specifies the name tag 
under which the test set stores the configuration data.  This replaces the 
default configuration name (the mode title name).   Note that to store 
test set modes, the unit must be operating in the desired mode via local 
(front panel) mode.  Prior to entering SCPI,  it is possible to query the 
status of the test set with :SYSTEM:ERR. The test set will return to the 
a textual string indicating the status of the local “SCPI” mode.

When using earlier released software, to recall test set configuration, 
you had to place a test set in non-menu mode prior to entering SCPI 
mode.  The reason being that the test set cannot exit SCPI mode to 
enter terminal mode unless the test set was placed in terminal mode 
prior to entering SCPI control.  As the Host SW V7.0, the 
:SYSTEM:REMOTE command will be rejected if the test set is in a 
menu.  Enter SCPI control  using a :SYST:REM command.  The table 
lists the local and SCPI retrieval commands:

SCPI Command Context Command Description

:SYSTEM:ERR?
Local Query test set for local SCPI mode 

status.

:SYSTEM:STORE:1[:name] Local Store Configuration to position 1.

:SYSTEM:REM
Local Enter SCPI control, leave test set 

mode unchanged.

:SENS:AU:STORE?
SCPI Query the position number last 

stored.

:SYSTEM: STORE?n
SCPI Query name of configuration 

stored in position “n”.
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6.  Press MENU-down.

• If there is already a configuration stored in the memory location 
you choose, you are prompted to overwrite it (press MENU-up) 
or leave it (press MENU-down). If you do not want to overwrite 
the existing configuration, select a new memory location (see 
step 5).

The configuration is entered in the list on the right side of the display in 
location you selected. The date and time the configuration was stored is 
shown on the line below Test #.

7.  Press MENU-up to return to the Main Menu.

:SYSTEM:CLEAR n
SCPI Erase configuration stored in 

position “n”.

:SYSTEM:RECALL n
SCPI Exit SCPI mode, bring test set to 

stored configuration “n”.

SCPI Command Context Command Description

  STORE/RECALL      #      Status
 CONFIGURATIONS
                    1>OC3-OC3 (ATM)
Action: Store       2 EMPTY
                    3 EMPTY
Test #: 1           4 EMPTY

Í

Í 10/11/95 11:13:00   5 EMPTY
------------------  6 EMPTY
Press ENTER to    | 7 EMPTY
initiate action.  | 8 EMPTY
Press MENU to go  | 9 EMPTY
to Main Menu.     |10 EMPTY
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Retrieve a Test Set 
Configuration

Follow this procedure to retrieve a test set configuration that is stored 
in memory.

1. From the Main Menu use FIELD to select Store and Recall 

Configurations and press MENU-down. The Store/Recall 
Configurations screen is displayed:

2. Use VALUE to set Action to Recall.

3. Press FIELD to select Test #, and then use VALUE to choose the 
memory location from which you want to retrieve the configuration.

4. Press MENU-down.

The configuration is read from memory and implemented in the test 
set. The display switches to the appropriate test operation screen.

5. Begin your test.

If you inadvertently recalled the wrong configuration, or if you want to 
change the configuration and resave it, press MENU-up to return to the 
Store/Recall Configurations screen.

  STORE/RECALL      #      Status
 CONFIGURATIONS
                    1>OC3-OC3 (ATM)
Action: Recall      2 EMPTY
                    3 EMPTY
Test #: 1           4 EMPTY

10/11/95 11:13:00   5 EMPTY
------------------  6 EMPTY
Press ENTER to    | 7 EMPTY
initiate action.  | 8 EMPTY
Press MENU to go  | 9 EMPTY
to Main Menu.     |10 EMPTY
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Results Storage and Retrieval

Store Test Results Follow this procedure to store the current test results into the next 
available memory buffer.

The 156MTS stores as many as 
ten sets of test results in 
nonvolatile internal memory. 
As you test with the 
instrument, you can store all of 
the current results, and then 
review or print them later.

1. Configure the test set and run your test.

2. Either while the test is running or after the test has stopped, press 
STORE. The results are stored, and the memory buffer number on 
the top line of the display is incremented.

The memory buffer number indicates the next buffer that will be 
used for results storage.

3. When you want to store more results, press STORE again.

The complete range of measurements for the selected test mode is 
stored in the memory buffer. The results are retained in memory 
even when the unit is switched off.

Note: Press CLEAR at any time to erase all stored results.

• Each time you store results, the next buffer is automatically 
selected. If you want to select a different memory buffer:

• Make sure the test is stopped.

• Press RECALL repeatedly to increment the memory buffer 
number. The buffer number and test mode name flash rapidly to 
indicate the display is in recall mode. Empty buffers show 
Nothing Stored.

• When the memory buffer you want is shown press EXIT.

• Press STORE to save the current test results.

Í  2 DS3-DS3(ATM/PLCP)Final:  00:00:00.00 
ATM Measurement Summary
Valid Cell Delineation:    --
Selected VP/VC Cell Rcv’d: --
Total Active BW (Hz), Avg: --
Rx VP/VC BW (Hz), Avg:     --
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Recall and Review 
Test Results

Follow this procedure to recall any test results that have been 
previously stored (see Store Test Results, page 22–6).

1. Make sure that a test is not running. Press STOP if necessary to end 
the current test.

2. Press RECALL. The buffer number and test mode name flash rapidly 
to indicate the display is in recall mode. .

3. Press RECALL repeatedly to cycle through the memory buffers 
(1–12) until the buffer you want to view is displayed.

The display changes to show the results stored in each memory 
buffer. If a memory buffer is empty, the display shows 
Nothing Stored.

4. Use the RESULT keys to scroll through the measurement screens 
available for the stored test results, just as you would in normal test 
mode.

Because all test data is stored, you can adjust the results level to see 
more screens, regardless of the results level setting at the time the 
results were stored. See To Display More Measurement Screens, 
page 1–11.

5. If you want to print stored results, select the memory buffer you 
want and press the PRINT key. See Chapter 24, Printing, for more 
information on the print function.

6. Press EXIT to leave recall mode and return to the normal display.

Note: Press CLEAR at any time to erase all stored results.

Í  2 OC3-OC3 (ATM)    Final:  00:00:00.00 
ATM Measurement Summary
Valid Cell Delineation:    --
Selected VP/VC Cell Rcv’d: --
Total Active BW (Hz), Avg: --
Rx VP/VC BW (Hz), Avg:     --
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Configure and 
View Event 
Logging

The Event Logging Setup and View display allows you to view logged 
events and configure which events are logged.

1. To access the Event Logging Setups display select Setup System 

Parameters from the Main Menu and press MENU-down.

2. Select Event Logging Setups from the Setup menu and press 
MENU-down.

3. Use FIELD and VALUE to set the event logging choices in the 
bottom of the display. These settings are used when you run tests.

4. Use RESULT to scroll through logged events in the upper half of the 
display. The date and time is displayed for each logged event.

See Event Logging Setup Parameters, page 22–9 for more 
information on event logging parameters.

5. Press MENU-up to exit the display.

 1 Event Log
09Mar 03:09:59 Power On
09Mar 04:01:41 Start DS1-DS1 (DS1)
09Mar 04:01:41 DS1 LOS Alarm On
09Mar 04:02:53 DS1 LOS Alarm Off
                (empty)

Event Print: No
           DS1/E1      DS3      SONET
Bit      : Don’t Log Don’t Log
Frame    : Don’t Log Don’t Log Don’t Log
CRC/P/BIP: Don’t Log Don’t Log Don’t Log
BPV      : Don’t Log Don’t Log Don’t Log
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Event Logging 
Setup Parameters

Automatic Printing of 
Events

Event Print switches automatic printing of events on and off. When 
this parameter is set to On events are automatically printed as they 
occur, according to the setting of the event type fields (see below).

While the event memory is limited to 50 stored events, automatic event 
printing provides for an unlimited hard-copy log of events.

Logged Events 
Selections

The following table describes the events that can be selected to be 
logged, as shown on the display.

Event Logging Mode Each type of event listed for a specific rate on the display can be set to 
one of the following event logging modes:

Don’t Log: The event type is not logged.

Log All: Every occurrence of the event type is logged.

Example: A selection of 
Sqlch E-3 for the Bit error 
type corresponds to a 
threshold of 1×10–3, or one bit 
error out of 1000 bits.

Sqlch E-3 through Sqlch E-6: Event log squelch. The event is logged, 
but when the error rate exceeds the squelch threshold for ten seconds 
further event are not logged. Squelching is removed when there are five 
seconds in which the error rate is less than the threshold. “Squelch on” 
and “squelch off” messages are entered in the event log.

Sqlch: Event log squelch (low error rate). This is similar to the 
Sqlch E-N rates described above, but the squelch threshold is one error 
per second.

Event Print: No
           DS1/E1      DS3      SONET
Bit      : Don’t Log Don’t Log
Frame    : Don’t Log Don’t Log Don’t Log
CRC/P/BIP: Don’t Log Don’t Log Don’t Log
BPV      : Don’t Log Don’t Log Don’t Log

Error Type DS1/E1 DS3 SONET

Bit Bit errors Not applicable

Frame Framing errors

CRC/P/BIP Cyclic redundancy check and parity check errors

BPV Bipolar violation
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Local Mode - Store/Recall Command Feature

SCPI mode has “new” Store/Recall feature enhancement.  Release 7.0 
and higher software provides support for test set Store and Recall 
functions.  In SCPI mode, the test set only has a limited number of 
operational front panel controls.  Release 7.0 and higher software 
syntax requires the use of the colon “:” where earlier releases do not. 

The test set configurations are saved when you execute the SCPI 
command :SYSTEM:STORE:n[:name].  The “n” is a number location 
(between 1 and 10) that specifies the save slot  of the configuration 
data.  Using the “name”  (optional parameter)  specifies the name tag 
under which the test set stores the configuration data.  This replaces the 
default configuration name (the mode title name).   Note that to store 
test set modes, the unit must be operating in the desired mode via local 
(front panel) mode.  Prior to entering SCPI,  it is possible to query the 
status of the test set with :SYSTEM:ERR. The test set will return to the 
a textual string indicating the status of the local “SCPI” mode.

When using earlier released software, to recall test set configuration, 
you had to place a test set in non-menu mode prior to entering SCPI 
mode.  The reason being that the test set cannot exit SCPI mode to 
enter terminal mode unless the test set was placed in terminal mode 
prior to entering SCPI control.  As the Host SW V7.0, the 
:SYSTEM:REMOTE command will be rejected if the test set is in a 
menu.  Enter SCPI control  using a :SYST:REM command. 

Enter a few selected System Commands  in Local SCPI Mode using the 
store and recall commands.  The command syntax , (listed below) 
require use of the complete (upper-case) mnemonic and not the 
abbreviated version that is used in SCPI mode.   Table lists the 
Store/Recall command set. 

 1 SCPI Remote Mode  Final:  00:00:00.00 
Trouble Scan
  
             No Errors or Alarms
 

Enable Display of Results and Alarms

     SONET>Off               ATM>Off
       DS3>Off
 T-Carrier>Off               VT1.5>Off
 Results Level> Delete    Trouble Scan On
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Local   Mode Stare/Recall Command Table

SCPI Command Context Command Description

:SYSTEM:ERR?
Local Query test set for local SCPI mode 

status.

:SYSTEM:STORE:1[:name] Local Store Configuration to position 1.

:SYSTEM:REM
Local Enter SCPI control, leave test set 

mode unchanged.

:SENS:AU:STORE?
SCPI Query the position number last 

stored.

:SYSTEM: STORE?n
SCPI Query name of configuration 

stored in position “n”.

:SYSTEM:CLEAR n
SCPI Erase configuration stored in 

position “n”.

:SYSTEM:RECALL n
SCPI Exit SCPI mode, bring test set to 

stored configuration “n”.
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Global Settings

The Global Settings choice is always listed on the Control Screens 
menu. Selecting Global Settings and pressing CONFIG-right calls the 
Modify Global Configurations screen:

Configuration 
Lock During Test

Modify Config While Running? enables or disables adjustments to 
the test set’s configuration while a test is running (RUN indictor lit). 
This parameter can be set as follows:

No: The test set’s main mode configuration cannot be changed during a 
test. However, screens accessed through the Control Screens menu can 
be changed.

Yes: The configuration can be changed during a test; changes take 
effect immediately. Note that changing signal parameters during a test 
can cause unexpected results and misleading measurements. However, 
this is a good way to experiment with the setup and observe changes in 
real-time.

Measurement 
Display 
Configuration

Results Level configures the level of detail provided when viewing 
measurements. Results Level can be set to either Summary or Detail.

Each measurement screen is either a “summary” or a “detail” screen. 
Summary screens show higher-level information. Detail screens show 
more in-depth information. When Results Level is set to Summary 
only summary screens can be viewed. When Results Level is set to 
Detail all screens (both summary and detail) can be viewed.

Trouble Scan 
Activation

Trouble Scan switches Trouble Scan ON or OFF. For more 
information on using Trouble Scan, see To Use Trouble Scan, page 1–7.

Note: When you press the TROUBLE SCAN key, the Trouble Scan feature is 
automatically set to On.

    >Modify Global Configurations<
Modify Config While Running?    No
Results Level: Summary  Trouble Scan:On
Inhibit Errors on Alarm?        Yes
Inv PRBS? No
Jitter Hits Thresh. (UI): WB>5.0  HB>0.2
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Error Squelching 
During Alarms

Inhibit Errors on Alarm? sets whether errors are counted during 
alarm conditions. When this parameter is set to Yes, errors are not 
counted during alarm conditions. When this parameter is set to No, 
errors are counted during alarm conditions.

Test Pattern 
Inversion

Inv PRBS? enables and disables inversion of the transmit PRBS 
patterns. When this parameter is set to No, PRBSs selected in the 
Data> field are transmitted normally. When this parameter is set to 
Yes, transmitted PRBSs are inverted (binary 0s switched to 1s, and 1s 
switched to 0).

Jitter Threshold 
Configuration

Jitter Hits Thresh sets the jitter hits threshold used for making jitter 
hits measurements. This item is only displayed if a jitter option is 
installed in your test set. Jitter Hits Thresh comprises two fields, as 
follows:

WB: Wide-band jitter. This parameter sets the jitter hit threshold for all 
jitter (phase variation equal to or greater than the wide-band cut-off 
frequency). WB is set in unit intervals (UI) from 0.1 through 6.9 in 0.1 
increments.

HB: High-band jitter. This parameter sets the jitter hit threshold for 
high-band jitter (phase variation equal to or greater than the high-band 
cut-off frequency). HB is set in unit intervals (UI) from 0.1 through 1.9 
in 0.1 increments.

Timed Test Duration Refer to Page 23-9 for instruction for Timed Test Duration in SCPI   
mode. 
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Auxiliary Test Setup Parameters

The Auxiliary Test Setups parameters apply to all test modes, and are 
accessed by selecting Auxiliary Test Setups from the Setup System 
Parameters menu.

Test Duration 
Mode

Test Dur. Mode sets the test length and repeat mode as follows:

Continuous: Tests begin when START is pressed and run continuously 
until STOP is pressed.

Timer: Tests begin when START is pressed, run once for a specified 
duration and then stop automatically. The test duration is determined 
by the Timer Duration field. (Tests can be stopped before the duration 
ends by pressing STOP.)

Timer/Restart: Tests begin when START is pressed, run for a specified 
duration and then repeat automatically. Each test’s duration is 
determined by the Timer Duration field. (Tests can be stopped before 
they end by pressing STOP.)

Timed Test Length Timer Duration sets the duration used for Timer and Timer/Restart 
duration modes, and can be set in the format hh:mm:ss from 00:00:00 
through 99:59:59, where hh is hours, mm is minutes, and ss is seconds.

Note: If you set Timer Duration to 00:00:00 and select a timer test duration mode, the 
test set will run Continuous duration mode tests.

Auxiliary Test Setups
Test Dur. Mode:   Continuous
Timer Duration:   00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Sub Menu Opt Pwr: Off   Auto Tst: Stop

Pwr Up Optical Tx State:  Last State
STS12 # Scheme:   STS3#, STS1#
VT Counting: VT Group   DS2 Tx-XBit: 0
DS1 Block Size:   2Kbit
DS1 LOP & OOF Hold-off: 0.0 Seconds
Bits Clk Out Derived from: STS-N Rx Clk
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Automatic 
Printing

Auto. Print Mode selects the mode for the automatic printing of test 
results, as follows:

Off: Test results are not automatically printed.

Timed Test End: Test results are automatically printed at the end of 
every timed test.

On Error: Test results are printed during a test when an error is 
detected.

Every 15 Minutes: Test results are automatically printed every 15 
minutes when a test is running.

Every 2 Hours: Test Results are automatically printed every two 
hours when a test is running.

Automatic Result 
Storage

Auto. Store Mode selects the mode for the automatic storage of test 
results into the test set’s 12 memory locations. The instrument 
automatically stores the results in the next higher available memory 
location. When location 12 is reached, the storage begins again at 
location 1. When all 12 memory location have been used, the test set 
writes over the previous data.

The memory location is 
displayed on the first line of 
the display. Test results also 
can be stored manually by 
pressing the STORE key. 
See Results Storage and 
Retrieval, page 22–6.

Auto. Store Mode can be set as follows:

Off: Test results are not automatically stored.

Timed Test End: Test results are automatically stored at the end of 
every timed test.

On Error: Test results are stored during a test when an error is 
detected.

Every 15 Minutes: Test results are automatically stored every 15 
minutes when a test is running.

Every 2 Hours: Test Results are automatically stored every two hours 
when a test is running.

Automatic Test 
Start

Auto Tst sets whether a test is automatically started when you press 
MENU-down from the test setup screen to go to the test operation 
screen. When Auto Tst is set to Start, a test is automatically started. 
When Auto Tst is set to Stop, a test will not begin until you press 
START.
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Laser State on 
Test Setup Screen

Sub Menu Opt Pwr controls whether the optical transmitter is active 
(laser on) when you press MENU up to go to the test setup screen from 
the test operation screen. When this item is set to Off (the default) the 
laser is deactivated; when this item is set to On the laser remains active. 
(The “test setup screen” is where you select the Tx Rate, Rx Rate, and 
Payload; the “test operation screen” is where you view results and 
configure signal parameters.)

Optical Tx 
Power-up State

For information on the optical transmitter (laser) power-up state, 
see Optical Transmitter Power-up State, page 3–2.

STS-12 Numbering 
Scheme

For information on the STS-12c numbering scheme, see STS-12 

Channel Numbering Scheme, page 3–4.

VT1.5 Channel 
Setup Mode

VT Counting Mode sets the method for specifying VT drop and insert 
channels on a SONET signal. This parameter can be set as follows:

The table shows the two VT 
counting modes. Note that VTs 
are always mapped using the 
group scheme.

VT Group: VT channels are specified in groups of seven, each 
comprising four VTs. A channel is specified as VT 1 through 4 in 
VT group 1 through 7.

1 through 28: VT channels are specified by their position in the 
overall STS-1 signal, from 1 through 28.

Transmit DS2 
X-Bit Status

DS2 Tx-XBit sets the status of the X-bits on the transmitted DS2 
signals (each DS3 comprises seven DS2s). The X-bits provide an alarm 
status for the DS2. DS2 Tx-XBit can be set to 0 (alarm on) or 1 (alarm 
off).

VT Group: 1 2 3 4 5 6 7

Position in 
Group

(VTs = 1–28)

1 1 2 3 4 5 6 7

2 8 9 10 11 12 13 14

3 15 16 17 18 19 20 21

4 22 23 24 25 26 27 28
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DS1 Block Size DS1 Block Size sets the DS1 information block size for testing 
applications involving block transfer protocols (such as video 
telephony). This parameter can be set from 2Kbit through 8Kbit 
(kilobits). The block size is used to compute block error measurements 
(see DS1 Block Error Measurements Screen, page 12–6).

BITS Clock 
Output Source

BITS Clk Out Derived from selects the source of the BITS signal 
output at the rear-panel BITS CLK OUT port, and can be set as follows:

BITS: building integrated 
timing source.

STS-N Rx Clk: The BITS timing is derived from the receive SONET 
signal, as selected on the test operation screen. This mode is similar to 
the operation of BITS operation on SONET terminal equipment.

STS-N Tx Clk: The BITS timing is derived from the selected timing 
source (TxClk>) on the test operation screen. This allows the BITS 
timing output to be derived from the BITS input or the test set’s internal 
Stratum 3 clock.
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The Administrative Setups display is accessed by selecting 
Administrative Setups from the Setup System Parameters menu.

Printer & Remote 
Port Parameters

Printer and Remote set the communications parameters for the 
rear-panel PRINTER RS-232 and the REMOTE RS-232 ports. The fields 
can be set in the format: bbbb,d–s–pppp, where:

bbbb: Sets the baud rate. This field can be set to 300, 1200, 2400, 
4800, 9600, or 19200 baud.

d: Sets the number of data bits to either 8 or 7.

s: Sets the number of stop bits to either 1 or 2.

pppp: Sets the parity to None, Odd, or Even.

System Date and 
Time

The Data & Time fields set the unit’s time-of-day clock and calendar in 
the format: mm/dd/yy hh:nn:ss, where mm=month, dd=day, yy=year, 
hh=hours, nn=minutes, and ss=seconds.

IEEE-488 
Interface 
Parameters

The SCPI/IEEE-488 interface is configured by the following two 
parameters:

IEEE-488 Addr: Sets the test set’s IEEE-488 instrument address. This 
field can be set from 00 through 31.

Also see Setup for 
SCPI/IEEE-488 Remote 
Operation, page 25–7

SCPI Via: Selects the rear-panel interface port that is used for the SCPI 
interface connection. This field can be set to either REMOTE- 

IEEE-488 or REMOTE-RS-232.

Administrative Setups

Printer:       9600,8-1-None
Remote:        9600,8-1-None
Date & Time:   01/07/95  03:09:59
IEEE-488 Addr: 29
SCPI Via:      REMOTE-IEEE-488
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Release 7.0 Software and higher supports time limited trst duration 
setting under SCPI mode.  

 Use of this feature is accomplished using the commands listed in the 
following table:

 1 SCPI Remote Mode  Final:  00:00:00.00 
Trouble Scan
  
             No Errors or Alarms
 

Enable Display of Results and Alarms

     SONET>Off               ATM>Off
       DS3>Off
 T-Carrier>Off               VT1.5>Off
 Results Level> Delete    Trouble Scan On

Timed Test Duration Command Table

       SCPI Command                      Command Description

*RST Access SCPI mode and set parameters to 
default settings.

:SENS:AU:TESTDURMODE TIMER Place the test set in SCPI mode. 

:SENS:AU:TIMERDURHOURS 1 Set test duration for 1 hour.

:SENS:AU:TTIMERDURMINS 22 22 minutes duration

:SENS:AU:TTIMERDURSECS 15 15 minutes duration

:INIT Start running the test. Turn on run 
indicators on test set
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Set up for Printing

Follow this procedure to prepare for printing from the test set.

1. Switch off power on both the printer and the 156MTS.

You can also use the printer 
port to connect to a terminal 
for “printing” on the terminal’s 
display.

2. Connect one end of an appropriate RS-232 serial cable or to the 
rear-panel PRINTER RS-232 port on the test set. Connect the other 
end of the cable to the printer. (See Printer Port, page 27–2, for the 
serial port pinout.)

3. Switch on the printer and test set.

4. From the test set’s Main Menu, use FIELD to select Setup System 

Parameters and then press MENU-down. The Setup menu is 
displayed.

5. Use FIELD to select Administrative Setups and press 
MENU-down. The Administrative Setups screen is displayed:

6. Use FIELD to highlight the parameters for the Printer port. Set the 
baud rate, data bits, stop bits, and parity to match your printer.

7. Press MENU-up to exit the Administrative Setups screen.

Administrative Setups

Í Printer:     9600,8-1-None
Remote:      9600,8-1-None
Date & Time: 01/07/95  03:09:59
GPIB Addr:   29
GPIB Via:    IEEE-488
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Configure Automatic Printing

After you connect a printer and configure the printer port, follow this 
procedure to set what information is printed automatically during a 
test.

1. From the Main Menu use FIELD to select Setup System 

Parameters and press MENU-down. The Setup menu is displayed.

1. On the Setup menu, select Auxiliary Test Setups and press 
MENU-down. The Auxiliary Test Setups screen is displayed. 

2. Use FIELD and VALUE to select Auto Print Mode and set it as 
desired. You can select no automatic printing (Off), printing at the 
end of timed tests, or periodic printing (see Automatic Printing, 
page 23–5).

3. Press MENU-up to return to the Setup System parameters menu and 
use FIELD to select Event Logging Setups. Press MENU-down; 
the Event Log screen is displayed.

4. Use VALUE to set Event Print to Yes (events printed) or No.

5. Press MENU-up to exit the Event Log display.

Í

Auxiliary Test Setups
Test Dur. Mode:     Continuous
Timer Duration:     00:01:00 (hh:mm:ss)
Auto. Print Mode:   Off
Auto. Store Mode:   Off
Pwr Up Optical Tx State:  Last State

STS12 # Scheme:     STS3#, STS1#
VT Counting Mode:   VT Group
DS2 Tx-XBit:        0
DS1 Block Size:     2Kbit
DS1 LOP & OOF Hold0off: 0.0 Seconds
Bits Clk Out Derived from: STS-N Rx Clk

Í Event Print: No
           DS1/E1      DS3      SONET
Bit      : Don’t Log Don’t Log
Frame    : Don’t Log Don’t Log Don’t Log
CRC/P/BIP: Don’t Log Don’t Log Don’t Log
BPV      : Don’t Log Don’t Log Don’t Log
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Print on Demand

Whether or not you enable automatic printing (see Configure 

Automatic Printing, page 24–3), you can generate a measurement 
results and configuration report any time a test is running.

• To generate a printed report while a test is running, press PRINT. 
The PRINT indicator lights while the data is being transmitted.
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About Remote Control

The 156MTS can be controlled from a remote control device using 
either of two methods: the Remote Front Panel allows you to simulate 
front-panel key presses from a connected terminal or PC with a 
terminal emulator. Option UHR, SCPI/HP-IB Interface, allows you to 
use SCPI commands (Standard Commands for Programmable 
Instruments) over an HP-IB or RS-232 interface.

This chapter describes how to set up for either type of remote control 
operation, and how to use the Remote Front Panel option to control the 
test set. For information on controlling the 156MTS using the 
SCPI/HP-IB interface, refer to the SCPI Programmer’s Guide (part 
number 09-0600-0005).
25–2



Using Remote Control

Remote Front Panel at a Glance

G
en

er
al
Remote Front Panel at a Glance

Remote Front Panel Keyboard Functions

Key Key Function Shift + Key Function

1 ENTER key MENU key

2 NEXT (right) RESULT key PRIOR (left) RESULT key

3 Right FIELD key Left FIELD key

4 Right VALUE key Left VALUE key

5 START key STOP key

6 DS3 History LEDs RESET key DS1 History LEDs RESET key

7 STS-1 History LEDs RESET key PRINT CONTROL key

8 ERROR INJECT key DISPLAY HOLD key

9 RECALL key EXIT key

0 STORE key CLEAR key

r Redraw remote display

+----------------------------------------+   KEY FUNCTION (shift fcn)
|          MODEL 156 MAIN MENU           |    1 ENTER (MENU)
|Auto      (Automatic Setup)             |    2 Next (Prev) Result Page
|Terminal  (Independent Tx and Rx)       |    3 Next (Prev) Field
|Monitor   (Non-disruptive pass-through) |    4 Next (Prev) Field Value
|D&I       (Payload Drop & Insert)       |    5 Start (Stop) Test
|Sequences (Programmed test sequences)   |    6 Clear DS3 (DS1) History
|Patterns  (Programmable data patterns)  |    7 Clear STS1 History (Print)
|Setup     (System parameters)           |    8 Err Inject (Display Hold)
|Configure (Store/Recall configurations) |    9 Recall Stored (End Recall)
|----------------------------------------|    0 Store (Erase All Stored)
|Press PREV FIELD/NEXT FIELD to select.  |    r Redraw screen
|Press ENTER for next level of selection.|
+----------------------------------------+
----- DS3 ------   ----- DS1 ------  -- VT -  ------------- STS-N -------------
   His Alm   Stat    His Alm   Stat      Alm      His Alm         Stat   Errors
LOS  .   .  Sig *  LOS .   .  Sig *  PAIS  .  LOS   .   .  STS-N Sig *  B1 CV .
FFM  .   .  M13 *  OOF .   .  SF  *  PYEL  .  LOF   .   .  STS-N Frm *  B2 CV .
OOF  .   .  CBit.  LOP .   .  ESF .  LOPNTR.  LOPNTR.   .  Valid Pntr*  B3 CV .
LOP  .   .  Pat .  AIS .   .  Pat .           LOCLK .   .               FEBE  .
AIS  .   .  XBit.  Yel .   .  B8ZS.      Err  PAIS  .   .  -- Others --
            Idle.  COFA.   .         V5CV  .  PYEL  .   .  Run        .
                                     FEBE  .  LAIS  .   .  Printing   .
                                              LFERF .   .  Err Active .

Test Set Display area

Key Functions List
( ) = key plus Shift

LED Indicator area
. = off; * = on
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Setup for Remote Front Panel Operation

The Remote Front Panel option operates by exchanging commands and 
data with a controller (such as a PC running a terminal program) 
through the test set’s rear-panel REMOTE RS-232 port. You can connect 
to the test set either directly or using modems.

Direct Connection The following procedure describes how to connect a PC or terminal 
directly to the test set. Before you begin, make sure you have an RS-232 
serial cable with appropriate connectors or adapters to match the test 
set and your PC.

1. Connect one end of the RS-232 serial cable to the rear-panel 
REMOTE RS-232 port on the test set.

2. Connect the other end of the serial cable to the appropriate port on 
the PC or terminal.

3. Configure the PC and the test set to the appropriate 
communications settings. Refer to the documentation that came 
with your PC for configuration instructions. See Test Set 

Configuration, page 25–5 to configure the 156MTS.

Dial-up 
Connection

A dial-up connection requires a modem at each end; one modem 
connected to the PC and another connected to the test set. The modem 
connected to the test set must be configured for auto-answer.

Before you begin, make sure you have an RS-232 null-modem cable 
with appropriate connectors or adapters to match the test set and your 
modem. See Null-modem connections, page 27–2, for null-modem 
pinout data.

1. Connect one end of the null-modem cable to the rear-panel 
REMOTE RS-232 port on the test set.

2. Connect the other end of the null-modem cable to the appropriate 
port on the modem.

3. Connect the modem to a working telephone jack.

4. Connect the other modem to a telephone line and to the PC. Refer to 
the documentation that came with your modem and PC for 
installation instructions.
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5. Configure the PC, modems, and the test set to the appropriate 
communications settings. Refer to the documentation that came 
with your PC and modems for configuration instructions. See Test 

Set Configuration, page 25–5 to configure the 156MTS.

Test Set 
Configuration

Before using the remote front panel feature of the 156MTS, you must 
configure the rear-panel REMOTE RS-232 port. Follow this procedure 
to set the baud rate and data handling parameters.

1. From the test set’s Main Menu, use FIELD to select Setup SystemP 

parameters and then press MENU-down. The Setup System 
Parameters menu is displayed.

2. Use FIELD to select Administrative Setups and press 
MENU-down. The Administrative Setups screen is displayed:

3. Use FIELD to highlight the parameters for the Remote port. Set the 
baud rate, data bits, stop bits, and parity checking to match your 
printer.

Note: Both the test set and the device to which it is connected (PC or modem) must 
be configured identically.

4. Press MENU-up to exit the Administrative Setups screen.

Administrative Setups

Í
Printer:       9600,8-1-None
Remote:        9600,8-1-None
Date & Time:   01/07/00  03:09:59
IEEE-488 Addr: 29
SCPI Via:      IEEE-488
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Use Remote Front Panel Operation

General 1. Set up and configure the test set and controller; see Setup for 

Remote Front Panel Operation, page 25–4. Make sure the test set is 
switched on.

2. Start remote control from the controller. For example, launch a 
terminal emulator on your PC. The remote front panel displays on 
the controller (see Remote Front Panel at a Glance, page 25–3).

• If the display is blank, press the “r” key on the PC keyboard to force 
a screen redraw.

3. Use the number keys along the top of the keyboard (not the numeric 
keypad) to mimic the keys on the front panel of the test set.

The effects of the remote 
commands are displayed on 
the test set’s front panel.

The number key actions are listed in the Key Function display area. 
Each key has two actions: one when you press only that key, and one 
when you hold Shift and press the key. The Shift action is listed in 
parentheses.

Note: You can still control the test set using the front panel. Commands entered are 
reflected on the remote front panel display.

Test Example 1. With the Main Menu shown on the controller’s display, press the “3” 
key to select the type of test you want to run. (The “3” key 
corresponds to pressing the right FIELD key on the test set).

2. Press “1” to display the test setup screen (the same as pressing 
MENU-down).

3. Press “3” and “#” (Shift–3) to select the Tx Rate, Rx Rate and 
Payload fields. Use “4” and “$” (Shift–4) to set the values for these 
fields.

4. Press “1” again to display the test operation screen; and then press 
“3,” “4,” and Shift as necessary to configure any signal parameters as 
required for your application.

5. Press the “5” key to start the test.

6. Press “2” and “@” (Shift–2) to view other measurement screens in 
the top half of the display (this corresponds to using the RESULT 
keys).

7. Press “%” (Shift–5) to stop the test.
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Setup for SCPI/IEEE-488 Remote Operation

This section briefly describes how to set up the 156MTS for 
SCPI/IEEE-488 control. For more information see the SCPI/IEEE-488 

Interface Programmer’s Manual (Manual Part Number 09-0600-0005).

1. Connect the remote cable to a port on the rear of the 156MTS (SCPI 
control can be implemented using either an IEEE-488 or RS-232 
interface). For pinouts see Printer and Control Ports, page 27–2.

The terms HP-IB, GPIB, and 
IEEE-488 are names for 
essentially the same type of 
interface.

• If you are using an IEEE-488 interface, connect an HP-IB cable to 
the REMOTE IEEE-488 port.

• If you are using an RS-232 interface, connect a serial RS-232 cable 
to the REMOTE RS-232 port.

2. Connect the other end of the cable to a port on the controller 
device.

3. From the Main Menu, use FIELD to select Setup System 

Parameters and press MENU-down.

4. Select Administrative Setups from the Setup System Parameters 
menu and press MENU-down.

5. If you are using SCPI through the RS-232 port, use FIELD and 
VALUE to set Remote (baud rate, data bits, stop bits, and parity).

6. If you are using the SCPI interface through an IEEE-488 interface, 
use FIELD and VALUE to set the address (IEEE-488 Addr).

7. Next set which port is being used for the SCPI interface (SCPI Via).

Administrative Setups

Í

Í
Í

Printer:       9600,8-1-None
Remote:        9600,8-1-None
Date & Time:   01/07/00  03:09:59
IEEE-488 Addr: 29
SCPI Via:      REMOTE-IEEE-488
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Use the SCPI/IEEE-488 Interface

After you have connected the 156MTS and SCPI controller, and 
configured the test set’s interface parameters, you are ready to activate 
SCPI mode.

1. Using the SCPI/IEEE-488 interface on the controller device, send 
the reset string “*RST” to the test set, or use the :SYST:REM 
command.

These commands puts the test set in SCPI/HP-IB mode. *RST sets 
all parameters to their default values; :SYST:REM maintains the 
current parameter settings. Refer to the SCPI/HP-IB Programmer’s 

Manual for more information.

2. When the test set is in SCPI mode, the display changes to show the 
following:

Note: When the test set is in SCPI mode, most front-panel controls are inoperative. 
Setup operations must be done using SCPI commands from the controller.

3. Use the FIELD and VALUE keys to configure which results are 
shown on the test set display while the unit is in SCPI mode.

4. Next use FIELD to select Results Level and then use VALUE to set 
the results level for the level of measurement detail you want.

5. Use the RESULT keys to scroll through measurement screens in the 
upper half of the display. The measurement screens available 
depend on the results enabled in the lower half of the display.

 1 SCPI Remote Mode Final:  00:00:00.00 
Trouble Scan   >>>>>>>
SONET LOS:     HIS    DS3 LOS:       HIS
SONET LOF      HIS    DS3 LOP:       ON
SONET LOPNTR:  ON     DS3 FFM:       ON
PATH CV:  18273645    More...

Enable Display of Results and Alarms

     SONET>Off               ATM>Off
       DS3>Off     PLCP>Off
 T-Carrier>Off               VT1.5>Off
 Results Level>Detail   Trouble Scan>Off
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Using an Answer-only Modem
Option UHS provides an external, answer-only modem for remote 
dial-up applications with your 156MTS.

Programming the 
Modem

The modem retains its programming when power is switched off; 
however if you change the settings you can return to the factory 
configuration by entering the commands as listed below.

Modem Cable When using the modem with a CERJAC test set, you must use the 
special modem cable (included). The cable has DB-25P connectors at 
each end, and provides the following connections:

Also, see test set interface cables on Page 27-6

Command Description

ATS0=1 Set auto-answer on.

AT&C1 Enable carrier detect output (pin 8).

AT&Y0 Use profile 0 on power up.

ATF0 Activate baud rate scan and synchronize.

AT&U1 Use QAM modulation encoding.

ATQ1 Disable responses (no “OK” response to commands).

ATE0 Disable command echo.

AT&W0 Store this configuration as user profile 0 in the modem’s 
non-volatile memory.

20

8

7

6

4

3

2

6

4

7

20

8

2

3

Cable End
A

Cable End
B

Null Modem
Connector
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With Release 7.0 or higher, SCPI mode now supports an ATM VPI/CPI 
(Virtual Path Identifier/Virtual Channel Identifier) scan.  *RST.  Issue 
the appropriate SCPI commands to the set the desired rate and with an 
ATM payload.  Select Standard active and VPI/VCI scan screen.

Perform the VPI/CPI scan using the following sequence of commands 
from the table below:

 1 ATM VPI/VCI Scan Final:  00:00:00.00 
>
1  >--/----   ---%   5  >--/----    ---%  
2  >--/----   ---%   6  >--/----    ---%
3  >--/----   ---%   7  >--/----    ---%
4  >--/----   ---%   8  >--/----    ---%

Enable Display of Results and Alarms

     SONET>Off               ATM>Off
       DS3>Off
 T-Carrier>Off               VT1.5>Off
 Results Level> Delete    Trouble Scan On

ATM VPI/VCI Scan Command Table

SCPI Command Command Description

:SYSTEM:SCAN:MODE CHANNEL  Select VPI/VCI scan channel search mode.

:SYSTEM:SCAN:STATUS Retern channel search scan status.

:SYSTEM:SCAN:START Start the channel search scan, observe front panel.

:ABORT Stop scan when all channels are recognized.

:SOUR:DM:ATMGEN DECILAM Set format of VPI/VCI channel results to decimal.

:SOUR:DM:ATMGEN HEX Set format of VPI/VCI channel results to hexa- 
decimal.

:SYSTEM:SCAN:CHANNEL? n Fetch VPI/VCI scan results for channel n.
25–10



Using Remote Control

ATM VPI/CPI Scan Capability Enhancement

G
en

er
al
:SYSTEM:SCAN:MODE BANDWIDTH Select VPI/VCI scan bandwidth measurement 
mode.

:SYSTEM:SCAN:START Start the bandwidth scan, observe the front panel.

:SYSTEM:SCAN:STATUS Return bandwidth scan status.

:SYSTEM:SCAN:BANDWIDTH? n Fetch VPI/VCI bandwidth results for channel “n”.

:SYSTEM:SCAN:SELECT n Select Channel “n”for further measurement.

:SYSTEM:SCAN:SELECT? Query last channel selected for further 
measurement.

:SYSTEM:SCAN:MODE EXIT Exit VPI/VCI scan mode and return to ordinary 
SCPI mode

ATM VPI/VCI Scan Command Table

SCPI Command Command Description
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About Software Downloading

For information on the latest 
operating software for your 
set, contact your Agilent 
representative or call 
1-800-9-CERJAC.

At CERJAC Telecom Operation, we are continuously working to 
enhance and improve the operation of our products. Some product 
enhancements do not require new hardware in the test set, but reside in 
the instrument’s operating software. You can upgrade the test set’s 
operating software without opening the case or making any internal 
modifications to the test set. Simply download new operating software 
using a PC and a CERJAC distribution diskette.

There are two different types of operating software that can be 
downloaded:

• Host software: This is the general “operating system” of the test 
set.

• Feature specific software: This includes software associate with 
a specific option, such as ATM or STS-12c.

The basic procedure for downloading operating software to the test set 
includes:

• Install the download program and software files on your PC, and 
check  for “readme.txt” files which contain the latest information.

• Connect the test set to your PC.

• Start the test set in Download mode.

• Execute the download procedure on the PC.

In addition, the download procedure can be modified to meet the 
specific needs of your application.

Note: Depending on the age and hardware configuration of your test set, you may 
not be able to take advantage of all the new features incorporated in a 
software release. CERJAC’s Technical Support department can help you 
determine if a hardware upgrade is necessary to support the features you 
desire. Call 1-800-9-CERJAC or contact your HP representative.
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Download Procedure

The following procedure describes how to download Host or 
feature-specific software (such as ATM) to the test set. Be sure to read 
any release notes that came with the software distribution diskette.

Note: Be sure to check the distribution diskette for any “readme.txt” files which may 
contain additional information and instructions about the download procedure.

Caution: The download procedure clears all stored data and test set configurations.

Caution: This procedure creates a directory called “UPGRD” on your C: hard drive. If 
your PC already has an UPGRD directory, the installation will delete its 
contents. Make sure you move any important files to another directory before 
you begin this procedure.

1. Insert the software distribution diskette in your PC’s disk drive.

This procedure assumes you 
are using Windows on your PC 
to perform the download.

2. Install the download program and test set software files on your 
hard drive by doing one of the following:

2a. From Windows: 

• Select Run from the Start or File menu. 

• In the Command Line box type A:\INSTALL and click 
OK. 

2b. From DOS: 

• Type the letter of the distribution disk’s drive (for 
example) “A:\” and press Enter. 

• Type INSTALL and press Enter.

The installation program creates the C:\UPGRD directory or, if the 
directory exists, deletes the contents of the directory. Next the 
installation program copies and decompresses files to the 
C:\UPGRD directory.
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3. View the contents of the C:\UPGRD directory and make a note of 
the operating software files.

• Host software files have the name MTSxxxxx.OUT

• Feature specific software files have names like ATMxxxxx.HEX 
where “ATM” indicates the name of the feature.

3a. To view the directory contents from Windows:

• Double-click on the File Manager icon to launch it.

• Click on the C: drive icon.

• Double-click the UPGRD directory.

3b. To view directory contents from DOS:

• Type DIR C:|UPGRD and press Enter.

4. Start the download program by doing one of the following:

4a.  From Windows:

• In Program Manager, select Run… from the File menu.

• In the Command Line box type

C:\UPGRD\DOWNLOAD filename

Help is available by typing 
DOWNLOAD /? and pressing 
Enter.

where filename is the name of the file you want to download.

• Click OK.

4b. From DOS:

• Type DOWNLOAD filename and then press Enter.

The CERJAC Download screen is displayed.

5. Switch off your CERJAC test set and use a straight-through RS-232 
cable to connect the REMOTE RS-232 port on the test set to a COM 
port on the PC.

6. Press and hold the MENU-up key and then switch on the test set.

7. Continue holding MENU-up until the menu  is displayed.
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8. Next press one of the following keys:

• If you are downloading the Host software, press the START key 
and proceed to step 10.

• If you are downloading feature software, press the appropriate 
key listed on the display. For example, press MENU-down for 
ATM. The screen displays the following message:

9. If you are downloading feature software, press START again. 

10. At the PC, press Enter to start the download.

When the download is complete, the test set displays a message that 
the download was successful.

11. Press the EXIT key to restart the test set.

The download is complete.

Model 156 MTS SONET Maintenance Test Set
Boot PROM Version X.XX Oct 11 1993
Serial#: MTSXXXX

Press START key to start download.
Press MENU-dn key to load ATM firmware.

Use VALUE keys to set Baud rate.
Baud rate: 38.4 Port: Remote
Change serial port settings if necessary

Model 156 MTS SONET Maintenance Test Set
Boot PROM Version X.XX Oct 11 1993
Serial#: MTSXXXX

Í
Current ATM Firmware: X.XX  Nov 13 1991
     Press START key to download,
       or STOP to abort.
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About the DOWNLOAD Program

The DOWNLOAD.EXE executable file is included on the distribution 
diskette when you receive your operating software upgrade. While 
simply typing DOWNLOAD to execute the program is adequate for most 
applications, the DOWNLOAD program accepts several variables that 
modify its operation for special cases.

You can type DOWNLOAD /? to 
get help with this command.

The full format for the download command is as follows:

DOWNLOAD filename.ext /Pn /In /Bnnnn /Annn

The parts of the command are described below.

DOWNLOAD: The root command. Starts the software download 
process. If no parameters are specified the default values are used (see 
below) which is equivalent to typing DOWNLOAD /P1 /I4 /B38.4 /A3F8.

Each software .OUT file is 
keyed to individual test set 
serial numbers. A particular 
copy of a .OUT file may be 
valid for only one or several 
test sets, depending on your 
requirements.

filename.ext: Selects the software file to be downloaded. Operating 
software files end with the extension .OUT; feature-specific files end 
with the extension .HEX. If no file is specified, the program downloads 
the first file in the working directory that has the .OUT extension.

/Pn: Specifies the COM port to be used on the PC, where n is 1 through 
4. For example /P3 selects COM3. If no port is specified, COM1 is used.

/In: Specifies the system interrupt request line (IRQ) for the COM port, 
where n is 1–7. For example /I4 selects IRQ 4. If no IRQ is specified, 
IRQ 4 is used for COM1 and COM3 and IRQ 3 is used for COM2 and 
COM4.

/Bnnnn: Specifies the baud rate for the COM port, where nnnn is 1200, 
4800, 9600, 19.2, or 38.4. For example /B19.2 sets the baud rate to 
19.2 Kbaud. If no baud rate is specified, 38.4 Kbaud is used.

/Annn: Specifies the COM port’s base address in hexadecimal 
notation, where each digit of nnn can be 0 through F. For example   
/A3F8 sets the base address for 3F8h. If no base address is specified the 
base addresses 3F8, 2F8, 3E8, and 2E8 are used for COM1 through 
COM4, respectively.
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Printer and Control Ports

Printer Port PRINTER RS-232: RS-232C (DCE) with request-to-send and 
clear-to-send. DB-25 pin connector.

Remote Port 
(RS-232)

REMOTE RS-232: RS-232C (DTE) with request-to-send and 
clear-to-send. DB-25 socket connector.

Null-modem 
connections

To connect to a modem use a “null-modem” cable or adapter as 
described in the following table (Also, see , page 25–9):

Pin Function Pin Function

2 Rx Data input 7,1  ground

3 Tx Data output 20 Data terminal ready 
(DTR); tied to pin 4

4 Clear to send (CTS) output

5 Request to send (RTS) input Others Not used

Pin Function Pin Function

2 Tx Data output 7,1 Signal Ground

3 Rx Data input 9 +5V

4,20 Request to send (RTS) output Others Not used

5 Clear to send (CTS) input

End “A” Pins to End “B” Pins End “A” Pins to End “B” Pins

2 3 6 20

3 2 20 6

4 8 7 7

8 4
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Remote Port 
(IEEE-488)

REMOTE IEEE-488: HP-IB (GPIB) interface. 24-conductor, type 57 
microribbon socket connector. Conforms to IEEE-488.1 standards.

Error Burst 
Triggering

BURST ERR IN: Burst error injection trigger input: TTL level, 50 ohm, 
BNC. When the receive level is high, error injection is active. The error 
injection Rate> field must be set to Burst. see About Error Injection 

Rates, page 27–7.

Pin Function Pin Function

1 DIO 1

Data input/ouput

13 DIO 5

Data input/ouput
2 DIO 2 14 DIO 6

3 DIO 3 15 DIO 7

4 DIO 4 16 DIO 8

5 EOI End or Identify 17 REN Remote enable

6 DAV Data valid 18 pair w/6

7 NRFD Not ready for data 19 pair w/7

8 NDAC Not data accepted 20 pair w/8

9 IFC Interface clear 21 pair w/21

10 SRQ Service request 22 pair w/10

11 ATN Attention 23 pair w/11

12 Shield Earth ground 24 Signal ground
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Data Link Interfaces

RS-232 Data Link 
Port

DATA LINK RS-232 port: DB-25 socket connector. See SONET 

Datalink Control Parameters, page 3–20.

RS-422 Data Link 
Interface

DATA LINK RS-422: DB-25 socket connector. See SONET Datalink 

Control Parameters, page 3–20.

RS-232 Data Link Interface Pinout

Pin Signal Name Pin Signal Name

1, 7 Ground 10 Receive Sync Out

2 Transmit Data In 15 Transmit Clock Out

3 Receive Data Out 17 Receive Clock Out

5 Transmit CTS Out All others Not used

9 Transmit Sync Out

RS-422 Data Link Interface Pinout

Pin Signal Name Pin Signal Name

2 Transmit Data In (NEG) 14 Transmit Data In (POS)

4 Transmit Clock Out (NEG) 16 Transmit Clock Out (POS)

6 Transmit Sync Out (NEG) 18 Transmit Sync In (POS)

8 Receive Data Out (NEG) 20 Receive Data Out (POS)

10 Receive Clock Out (NEG) 22 Receive Clock Out (POS)

12 Receive Sync Out (NEG) 24 Receive Sync Out (POS)

1, 7 Ground Others Not used
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Handset Interface HANDSET: RJ-11 socket connector. See SONET Datalink Control 

Parameters, page 3–20.

Note: The handset interface is not available on test sets equipped with Option 231. 
See Option 231, page 27–6.Physical and Electrical Characteristics

Physical Size (W×H×D): 14.5×7.5×16.0 inches (36.8 × 19.0 × 40.6 cm).

Weight: 30.0 pounds (13.8 kg).

Electrical AC Line: 100 to 240 Vac; 47 to 63 Hz; 200 VA maximum.

Fuse rating:

Warning! This test set requires different fuses for 115 Vac and 230 Vac operation. Refer 
to the table below.

Warning! Disconnect power before replacing fuse. For continued fire protection, replace 
with same type of fuse.

Option 231 If your 156MTS is equipped with Option 231, the unit complies with the 
directives required to display the “CE” mark for shipments into Europe. 
Refer to the Declaration of Conformity that was shipped with your unit 
for a list of the regulations to which the test set conforms.

Handset Interface Pinout

Pin Signal Name

1 Transmit In (NEG)

2 Receive Out (POS)

3 Receive Out (NEG)

4 Transmit In (POS)

1 2 3 4

Fuse Rating

115 Vac Operation 5 Amp, Slow-Blow, 250 Volt

230 Vac Operation 2.5 Amp, Slow-Blow, 250 Volt
27–5



27–6

G
eneral

Test Set Interface Cabling

The following information describes how to connect your 
156MTS or 31XE test set to a PC for software download or 
remote control, and to a printer for test data output.

The available Remote Interface Cable package (E8523A) allows 
you to connect the test set to a PC. Refer to the figure below.
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Handset Option: The SONET datalink handset connector is not 
available on units equipped with Option 231.

Environmental Operating Temperature: 0 to +45 °C (+32 to +113 °F).

Storage Temperature: –20 to +70 °C (–4 to +158 °F).

Humidity: 5 to 90 %RH, noncondensing.
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About Error Injection Rates

When you inject errors on the transmit signal, the error injection speed 
or number of repetitions is controlled by the alarm Rate> field. The 
available rates vary depending on the selected error Type>.

Single: One occurrence of the error type is transmitted each time the 
ERROR INJECT key is pressed.

1.0E-X: A steady error rate of the selected type begins when the 
ERROR INJECT key is pressed, and stops when the key is pressed 
again. The LED is lit when errors are being injected. This value sets the 
error ratio so that 1 × 10–X (1-out-of-10X) bits of the selected type are 
errored. For example, selecting 1.0E–2 would error 1×10–2 bits, or one 
bit out of every 102 = 100 bits.

X Consec: Injects errors for X consecutive frames or occurrences. 
These values are useful for testing alarm detection thresholds, and may 
be set just above or just below the threshold.

Continuous: Errors are injected into every bit or byte of the selected 
type. Injection is toggled on and off using the ERROR INJECT key.

Burst: Error injection is active when a logic high level is present at the 
rear-panel BURST ERR IN jack. see Error Burst Triggering, page 27–3.

Off: No errors are injected. The ERROR INJECT key is disabled so that 
errors are not inadvertently injected.
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Physical and Electrical Characteristics

Physical Size (W×H×D): 14.5×7.5×16.0 inches (36.8 × 19.0 × 40.6 cm).

Weight: 30.0 pounds (13.8 kg).

Electrical AC Line: 100 to 240 Vac; 47 to 63 Hz; 200 VA maximum.

Fuse rating:

Warning! This test set requires different fuses for 115 Vac and 230 Vac operation. Refer 
to the table below.

Warning! Disconnect power before replacing fuse. For continued fire protection, replace 
with same type of fuse.

Option 231 If your 156MTS is equipped with Option 231, the unit complies with the 
directives required to display the “CE” mark for shipments into Europe. 
Refer to the Declaration of Conformity that was shipped with your unit 
for a list of the regulations to which the test set conforms.

Handset Option: The SONET datalink handset connector is not 
available on units equipped with Option 231.

Environmental Operating Temperature: 0 to +45 °C (+32 to +113 °F).

Storage Temperature: –20 to +70 °C (–4 to +158 °F).

Humidity: 5 to 90 %RH, noncondensing.

Fuse Rating

115 Vac Operation 5 Amp, Slow-Blow, 250 Volt

230 Vac Operation 2.5 Amp, Slow-Blow, 250 Volt
27–9



General Specifications

Physical and Electrical Characteristics

G
eneral
27–10



A

               Appendix  A                                       

156MTS HOST CODE V7.00 Release Notes A–2 

���076�+RVW�6RIWZDUH��9HUVLRQ�����5HOHDVH�1RWHV $¥�

���076�+RVW�6RIWZDUH��9HUVLRQ�����5HOHDVH�1RWHV $¥��

����076�+RVW�6RIWZDUH�9HUVLRQ������5HOHDVH�1RWHV $¥��

����076�+RVW�6RIWZDUH�9HUVLRQ������5HOHDVH�1RWHV $¥��

Host Software Version 6.41 and 
ATM Software Version 3.40 Release Notes A–21
A–11

 

Software Release
Notes



Appendix A

156MTS HOST CODE V7.00 Release Notes
 Features: 1. Added Terminal mode OC3-OC3 (STS1/ATM) 
2. Added Monitor mode OC3-Mon (STS1ATM).
3. Added Drop and Insert mode OC3-D&I (STS1/ATM). 
4. Added Terminal mode OC12-OC12 (STS1/ATM).
5. Expanded Auto Setup to include SDH, OC3-OC3 (STS1/ATM), and 

OC12-OC12 (STS1/ATM) detection.
6.  Store/Recall Feature added to SCPI Mode
7.   ATM VPI/VCI Scan Capability added to SCPI Mode
8.  Timed Test Duration in SCPI Mode

Fixes: 1. Corrected problem with ESF FDL data intepretation.

2. SCPI commands returns invalid data for functions not previously set 
has been corrected by initializing all SCPI queries structures to zero.

3. SCPI command :SYST:REMOTE was corrected.

4. E1 TS mode with drop/insert set to 29 to 31, then switching to a DS1 
mode, the DS0 setup screens drop and insert field settings were 
corrected.

5. Removed the “Aux” pick from field “Others>” in all modes with a 
VT1.5A payload.

6. Fixed problem in the H pointer increment test for mode OC12-OC12 
(STS12); where error inject and local action key appears to be 
locked.

7. DS2 OOF (out of frame) error while recovering from a power 
interruption.

8. Fixed SCPI commands :SOUR:DM:EINJ:STS1 A1A2 | B1 | 
SECT_BER | LINE_BER 

9. Fixed H Pointer operation in STS1-STS1 (ATM).  Added OC3-OC3 
(STS1/ATM) and OC12-OC12 (STS1/ATM).

10. Fixed mode with  VT1.5b payload following factory defaults.

11. Corrected OC12-D&I (DS3/1) and OC3-D&I (DS3/1) modes.

12. Changed J0, J1, and J2 from Hewlett Packard to Agilent 
Technologies.

156MTS HOST CODE V7.00 Release Notes
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13. Fixed SCPI command :SOUR:DM:ALARM DS1_YEL.

14. Fixed  SCPI commands :SOUR:DM:EINJ:DS3 FRAME, BURST 
and, :SOUR:DM:EINJ:DS3 FRAME,OFF.

15. Fixed  STS frame measurements (A1/A2) results screen.

16. Corrected  A1/A2  SEFS detection for OC3 and STS.

17. Added the SCPI command :SENSe:DM:DATA3 BITER_ON 
to display DS3 error bits.  Also,  SCPI command 
:SENSe:DM:DATA3 BITER_OFF inhibits  error display. 

18. Upon entering SCPI mode, all display results get set to off and must 
be reenabled. 
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156MTS Host Software Version 6.8 Release Notes

156MTS Host Software Version 6.8 Release Notes
Product Number 
E4480A

The 156MTS SONET Maintenance Test Set Host Code Version 
6.80 is a new release of the application software for the E4480A 
156MTS SONET Maintenance Test Set.

Release Overview This new version of the 156MTS SONET Maintenance Test Set 
software incorporates several significant improvements.

SCPI Command 
Fixes and 
Additions

For each new query command shown below, the SCPI/HPIB 
User’s Manual documentation has been updated to incorporate a 
question mark (?). The question mark has been added to the 
command to query the test set for its current parameter values.

1. Two SCPI commands have been added to return the DS3 and DS1 
frame type settings. The commands are: 

:SOURce:DM:FRAMe:TYPE1?  Returns DS1 frame setting, and  

:SOURce:DM:FRAMe:TYPE3?  Returns DS3 frame setting.

2. A new SCPI command has been added to return the VT1.5 mode 
setting (either asynchronous or byte-synchronous). The command 
syntax is: 

:SOURce:DM:VT15?

3. Five new SCPI commands have been added to return the input filter 
settings, as follows:

:INput:FILTer:DS1?

:INput:FILTer:DS3?

:INput:FILTer:DS3B?

:INput:FILTer:STS1?

  :INput:FILTer:E1?

4. A following SCPI command has been added to return the setting of 
the DS1/E1 input port termination:

:INput:TYPE?
14
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5. Three new SCPI commands have been added to return the setting of 
the transmit port output:

:OUTPut:FILTer:DS1?

:OUTPut:FILTer:DS3?

:OUTPut:FILTer:STS1?

6. Four new SCPI commands have been added to return the ON or 
OFF setting of the transmit outputs:

:OUTPut:STATe1? Returns state of the DS1 output.

:OUTPut:STATe2? Returns state of the STS1 output.

:OUTPut:STATe3? Returns state of the DS3 output.

:OUTPut:STATe4? Returns state of the optical output.

7. A new SCPI command returns the identity of the channel to be 
dropped from a demultiplexer:

 :ROUTe:DMUX? DS0|DS31|VTGRP|VT15|STS12

8. A SCPI command has been added to return the identity of the 
channel inserted in a multiplexer:

:ROUTe:MUX:INS? DS0|M13|VT15|VTGRP|STS12

9. A new SCPI command returns the setting of the remaining channels 
in the multiplexer:

:ROUTe:MUX:OTH? DS0|M13|VT15|VTGRP|STS12

10. A SCPI command has been added to return the setting of the DS1 
line code:

:SENSe:DM:CODE1?

11. A SCPI command has been added to return the inhibit error on 
alarm setting:

:SENSe:DM:IERR?

12. Another new SCPI command to return the on/off setting of Trouble 
Scan function:

:SENSe:DM:DATA:TRBLscan?

13. Three new SCPI commands were added to return framing type 
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specified by the :SENSe:DM:FRAMe command:

:SENSe:DM:FRAMe:TYPE1?

:SENSe:DM:FRAMe:TYPE3?

:SENSe:DM:FRAMe:TYPE3B?

14. The following new SCPI command returns the DS3B LED sharing 
mode:

:SENSe:DM:DS3B? LEDS

15. A new SCPI command to return the ATM DMUX mapping setting:

:SENSe:DM:ATMDMUX?

16. A new SCPI command has been added to return the selected jitter 
measurement rate:

:SENSe:DM:JITTer? RATE|WB_THRESH|HB_THRESH

17. A new SCPI command has been added to return the DS3 pulse mask 
setting:

:SENSe:DM:MSKSEL?

18. A new SCPI command was added to return the pulse mask polarity 
setting:

:SENSe:DM:MSKPOL?

19. A SCPI command was added to return the pulse mask tolerance 
setting:

:SENSe:DM:MSKTOL?

20. A SCPI command was added to return the setting of the pulse mask 
stop/start switch:

:SENSe:DM:MSK?

21. A new SCPI command was added to return the setting of the ATM 
physical layer mapping:

:SOURce:DM:ATMMUX?

22. A new SCPI command returns the settings of the ATM Layer 
Generator:

:SOURce:DM:ATMGEN? <ATM param>
A–16
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23. A new SCPI command was added to return the setting of the DS1 
input impedance:

:INPUT:IMPedance?

SCPI Manual, Text 
Changes Only

The following H1 byte overhead command exists but were not 
previously documented in this manual. These commands set and 
query SONET overhead H1 byte. The commands are:

:SOURce:DM:OHH1, <value>

where value can be 0 or 1, and 

:SOURce:DM:OHH1?

The following query commands (?) exist but were not previously 
documented in this manual. these commands have been added 
to the SCPI documentation

:SOURce:DM:PROG1 PATTERN,<pattern>?

:SOURce:DM:PROG3 PATTERN,<pattern>?

:SOURce:DM:PROG32 PATTERN,<pattern>?

:ROUTe:MATRix <output>,<input>?

:SOURce:DM:DS3:FEAC:CBIT?

:SOURce:DM:DS3:FEAC:CONT_ALM_STAT?

:SOURce:DM:DS3:FEAC:BURST_SETTING?

:SOURce:DM:DS3:FEAC:LOOPBACK_LINE?

:SOURce:DM:DS3:FEAC:BURST_SIZE?

:SOURce:DM:DS3:FEAC:ALM_STAT?

:SOURce:DM:FT1?

:SOURce:DM:FE1?

:SOURce:DM:NX?

The following SCPI command for setting the input impedance 
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exists but was not documented in this manual.

:INPUT:IMPedance <value>

Terminal mode is indicated when the value is less than or equal 
to 100. Bridge mode is indicated when the value is more than 
100.

Miscellaneous.  
Fixes

1. ATM functionality failed following the restoration of default settings 
using a Setup Menu pick. The problem was caused when the ATM 
board lost synchronization with the host CPU when the test set was 
warm started. This problem was corrected by restoring test set 
default settings on the fly and not warm starting the unit.

2. When the test set was configured for DS1 rate with a DS1 payload in 
monitor mode, it would not display the DS0 VF Measurement 
screen. This short coming has been corrected.

3. When the test set is configured for terminal mode 
STS1/OC1-STS1/OC1 (VT1.5A) and 1 to 28 counting mode with other 
VT’s set to AIS, drop and insert fields set to 7, then 8, and back to 7; 
the DS1 signal became lost. This problem was corrected

4. A SCPI command was fixed to set the terminal mode state for 
DS1-DS1 (DS1) with DS0 data. This command changes the state of 
the ABCD signaling bits. 

5. For terminal mode DS3-DS3 (DS3), the test set loses sync when TX 
clock is set to LOOP. This problem has been corrected.

6. For terminal mode E1-E1 (E1), an unframed data lights the yellow 
alarm. This problem has Been corrected.

Additions Support has been added for the new OC12-4 board. which 
includes board recognition, and loading.

Firmware. Firmware code was added to recognize and provide electrical 
STS1 LOS signal detection. This capability is provided only when 
the OC12-4 board is present. It is not supported by the OC12+ or 
earlier boards. 

Installation Install only software with a higher version number than the 
software already in your test set. The distribution diskette includes 
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the appropriate software for your test set.

For More 
Information 

For more information, call Agilent’s TNTD at 800-923-7522.
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156MTS Host Software Version 6.7 Release 

Product Number 
E4480A

The 156MTS SONET Maintenance Test Set Host Software 
Version 6.70 is a new release of the software for the E4480A 
156MTS SONET Maintenance Test Set.

Release Overview This new version of the 156MTS SONET Maintenance Test Set 
software incorporates several significant improvements.

Software 
Improvements

An Auto Setup problem was fixed in which the unit found an 
STS1/OC1 with an STS-1/ATM payload but reported “This 
mapping is supported for OC3C & DS3 transport only".

1. An inability of the Auto Setup function to detect E1 mapping 
on a single STS in OC3-OC3 (DS3/E1) mode, has been fixed.

2. A key was added to the Auto Setup MENU on the DS1 map 
screen to allow an escape from Auto Setup.

3. Additional code was added to set STS drop & insert fields for 
the OC12-OC12 (DS3), & OC3-OC3 (DS3) modes.

The Auto Setup function has been enhanced for modes OC12, 
OC3, & STS1 and a VT1.5A/B payload. 

The new software adds a new menu layer. After VT structured 
STS1 is chosen, the test set scans and displays 28 DS1 channels. 
In terminal mode, the unit operator can then pick a DS1 channel 
to be tested. The insert fields for the STS1, VT group, & VT 
position have been modified to match the drops and now 
supports VT group and 1 to 28 counting modes.

An enhanced Auto Setup capability was added for modes that 
support DS3, DS1, & E1 payloads. The new software adds a new 
menu layer. Now after choosing DS3 structured STS1, the test 
set displays 28 DS1 or 21 E1 channels, respectively. In terminal 
mode the operator can pick a DS1/E1 channel to test. The insert 
fields were also modified to match the drops.
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A tributary frame scan function was added. This function allows 
the test set to scan each DS1 channel to identify the framing of 
each DS1, or E1 channel.

The Auto Setup feature was also enhanced by the addition of a 
data pattern scan capability along with the framing scan function.

Now the operator can choose a channel in the low-level tributary 
menu, perform a frame scan, or a data scan sequence.

The Auto-Setup function was changed to force the test set to 
search for signals in descending order from the highest optical 
rates (OC3) down to the slower electrical rates (STS1).

Additional Auto Setup features and improvements include: 

A frame that scan can now be performed at each of the DS1, E1, 
and VT Auto Setup menu screens. The scan can be aborted by 
pressing the MENU key once. The operator can then choose to 
rescan, pick a channel, or go back to the main menu.

 Trouble Scan 
Improvements

Trouble Scan performance has been improved; reducing total 
scan time from 4.5 to 1.0 seconds.

An ability to filter errors and alarms issued to the front panel has 
been added through the use of the screen selector fields.

SCPI Command 
Improvements

Nine new SCPI commands have been added to return errors and 
alarms by payload category. For example:

:FETCh:TRBL:DS0?
[DS1?|DS2?|DS3?|DS3B?|E1?|VT?|ATM?|SONET?]

This manual has been updated to indicate that the host software 
supports a SCPI command that enables the DS3 error out signal. 
The SCPI command is as follows:

:ROUTe:SELect   BIT_ERROUT OFF|DS3|STS3C|STS12C 

Additionally, the DS1 error out jack is active, both on the front 
panel and in SCPI command mode. 
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This signal is always active when DS1 bit errors are present. 
There is no corresponding SCPI command to control the DS1 
error out so the above SCPI commands has been added to this  
manual.

The SCPI commands have been reworked to match SCPI 
:SOURCE:DM:CLOCKn command set in the documentation in 
this manual.  The updated SCPI command structure is as 
follows:

:SOURce:DM:CLOCK1 <parameter> (sets DS1 clock source)

:SOURce:DM:CLOCK2 <parameter> (sets STS1 clock 
source)

:SOURce:DM:CLOCK3 <parameter> (sets DS3 clock 
source)

New following SCPI commands have been added:

:SOURce:DM:CLOCK1? (queries DS1 clock source

:SOURce:DM:CLOCK2? (queries STS1 clock source)

The new SCPI commands have been added to query test set for 
its clock source settings. These commands have been added to 
this SCPI Manual.

The following SCPI commands has been added to query DS3 
FFM status:

:FETCh:DMOD:DS3? FFM

The test set has been modified to detect DS1 yellow alarm when 
transmit data pattern is set to AIS.

Miscellaneous 
Fixes 

The SCPI command used to inject errors has been improved. 
Previously, the software required the error inject command to be 
issued twice before the test set responded. This has been 
corrected. The error injection command format is as follows: 
:SOURce:DM:EINJect:<payload> <error><rate> where 
the parameter for rate is CONTINUOUS.
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Product Numbers 
E4480A & E4487A

Host software version 6.60 is a software maintenance release for 
the HP 156MTS and 31XE test sets.

Agilent recommends you install this software in your test set.

Applicability Host version 6.60 supports these test sets:

• E4480A 156MTS SONET/T-Carrier Test Set

• E4487A 31XE SONET Electrical Test Set

Requirement Before installing the new host version 6.60 software, you must 
upgrade the test set’s software with boot-code version 6.2. In the 
past, you had to send your 156MTS or 31XE test set back to HP 
to have new boot-code software installed. Starting with 
boot-code version 6.2, you can install the software yourself. See 
the Boot-code Software Version 6.2 Release Notes for 
installation instructions.

Enhancements Host version 6.60 includes the following enhancements: 

• Path-trace string (J1 and J2 byte) and section-trace string (J0 
byte) display and editing features 

• Performance improvements 

SCPI Commands Host version 6.60 introduces several new SCPI commands. also 
look up command descriptions in this manual.

:SYSTem:OPTionS ? 

:FETCh:DMON:OPTionS ?

:FETCh:DMOD:DS3:CBIT ? <row,cbit>

:FETCh:DMOD:STS3C ? RXFREQ

:FETCh:DMOD:STS12C ? RXFREQ

Host Software Version 6.60 Release Notes
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Use the following new SCPI command to retrieve DS1 ones 
density alarm violations:

:FETCh:DMOD:DS1 ? ONESDEN

Installation You can install the new host software (see –10) after you install 
the boot-code software version 6.2 on your test set.

Install only software with a higher version number than the 
software already in your test set. The distribution diskette includes 
the appropriate software for your test set.

For more information, 
call Telecomms Networks Test Division (TNTD) at 800-923-7522.

Path- and 
Section-Trace 
Strings 

Host version 6.60 lets you display and edit the J1 and J2 
path-trace strings, and the J0 section-trace string. (See Chapters 
3 and 4 of this manual, for information about the screens.) 

• New fields have been added to the J1 & J2 Path Trace Control 
and J0 Section Trace Control screens. 

• The Fill on ACTION (or Fill on INJECT) and Format fields 
define the transmit trace string to transmit when you press the 
ACTION (INJECT) button (see the table below). 

• Results Display in sets the display mode for the path-trace 
byte and section-trace byte values (below). This field has two 
options: 

• ASCII (the default)–displays values in ASCII. 

• Hex & ASCII–displays values in hex and ASCII. 
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Fill on Action

Format

1-Byte 16-Byte 64-Byte

NULL 0x00 in all bytes. 0x00 in all bytes. 0x00 in all bytes. 

HEX 0x01 in all bytes. 0x41 – 0x4F with CRC7, 
copied 4 times. 

0x41 to 0x7F (ASCII A 
to DEL), followed by a 
carriage return (0x0D) 
and line feed (0x0A). 

ASCII 0x41 in all bytes. “nnnnnn” serial number 
with CRC7, copied 4 times. 

“Agilent Technologies 
156MTS Test Set Serial 
No. nnnnnn” followed by 
carriage return (0x0D) 
and line feed (0x0A). 

USER First byte copied to all 64 
bytes. 

Calculate and insert CRC7 
of first 16 bytes; copy first 
16 bytes 4 times. 

No action.
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156 MTS Host Software Version 6.50 Release 

Product Numbers 
E4480A & E4487A

Host software version 6.50 is a software maintenance release for 
the 156MTS and 31XE test sets.

Agilent recommends you install this software in your test set.

Applicability Host version 6.50 supports these test sets:

• E4480A 156MTS SONET/T-Carrier Test Set

• E4487A 31XE SONET Electrical test Set

New Features Host version 6.50 includes the following new features: 

• path-trace string (J1 byte) and section-trace string (J0 byte) 
display and editing features 

• several new SCPI commands for controlling DS3 FEAC bits

• performance improvements

This release also fixes problems with SCPI performance, and 
results store/recall functions. 

Installation If the software described in this release note is not already 
installed in your test set, follow the instructions on –26 to 
download the software. 

Install only software with a higher version number than the 
software already in your test set. The distribution diskette includes 
the appropriate software for your test set.

For more information, call Telecomms Networks Test Division 
(TNTD) at 800-923-7522.

Path- and 
Section-Trace 
Strings 

Host version 6.50 introduces enhancements for displaying and 
editing the J1 path-trace string and the J0 section-trace string. 
(See Chapters 3 and 4 of the user manual for the screens.) 
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J1 Path Trace Control and 
J0 Section Trace Control Screens

Two new fields have been added to these screens. 

Fill on ACTION (or Fill on INJECT for older models) 
automatically fills the transmit trace string when you press the 
ACTION (INJECT) button. The field has three options: 

• NULL fills the string with 00. 

• HEX fills the string with incremental hex values from 42 to 7D 
(ASCII characters B to }), followed by a carriage return (0x0D) 
and line feed (0x0A). For example, byte 1 is set to 42, byte 2 to 
43, and so on, up to byte 64 which is 7D. 

• ASCII fills the string with the text 156MTS Test Set Serial No 
nnnnnn’ (where nnnnnn is the serial number of the test set). The 
string is followed by a carriage return (0x0D) and line feed 
(0x0A). The remaining bytes are set to 00. 

Results Display in sets the display mode for the path-trace 
byte and section-trace byte values (below). This field has two 
options: 

• ASCII (the default) displays values in ASCII. 

• Hex & ASCII displays values in hex and ASCII. 

STS-Path Trace Byte (J1) Values and OC-12 Section Trace Byte 
(J0) Values Screens

These screens display the 64-byte message carried in the 
path-trace (J1) or section-trace (J0) bytes. The message begins 
at the first non-zero byte following a NULL (0x00), carriage 
return (0x0D), or line feed (0x0A) byte. 

The Results Display in field (above) controls how the message 
is displayed: 

• When set to ASCII, only characters in the range 20 through 7E 
hex are shown. 

• When set to Hex & ASCII, the message takes up two screens: 
the first screen shows bytes 1–32, and the second shows bytes 
33–64. 
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DS3 FEAC Control The DS3 FEAC Control screen provides access to DS3 FEAC 
bits. This section describes several screen features previously 
not documented. (See “DS3 FEAC Channel Parameters” in 
Chapter 7 of the user manual for information about this screen.) 

When the Continuous Alarm/Status field is set 
to ON, the test set continuously transmits the FEAC code 
specified in the Alarm/Status field. When the field is set to off, 
the FEAC bit is set to the value 
(0 or 1) specified in the DS3 C-Bit Control screen: Row 1, C3 
program bit. 

The FEAC Burst and Burst of fields are used to transmit a 
FEAC code several times in a row. The code burst is sent when 
the ACTION (INJECT) key is pressed. When the burst sequence 
is complete, the FEAC setting returns to its previous value. 

• FEAC Burst specifies the code to send.

• Burst of specifies how many times to send it. 

When FEAC Burst is set to Loopback Activate or Loopback Deactivate, 
the test set sends loopback codes (loop-up or loop-down) to the 
line specified in Loopback Line, as follows: 

• The loopback code is sent the number of times specified by 
Burst of. 

• The value of Loopback Line is sent the number of times 
specified by Burst of. 

When FEAC Burst is set to Alarm/Status, the FEAC code 
specified by the Alarm/Status field is sent Burst of number of 
times. 

See the following section for information about how to control 
DS3 FEAC codes through the SCPI interface. 

New DS3 FEAC 
SCPI Commands

Host version 6.50 introduces several commands for controlling 
DS3 FEAC codes through the SCPI interface. Currently, the 
commands are available only for FEAC codes received on the 
DS3-A input. 
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For more information about FEAC codes and their functionality, 
ANSI T1.107, section 9.3.3 (1995). 

:FETCh:DMOD:DS3? <parameter> 
retrieves information about the FEAC codes received by the 
test set. The following table lists command parameters.  

For example, :FETCh:DMOD:DS3? FEAC_CODE retrieves 
the last FEAC alarm/status code received. 

:SOURce:DM:DS3:FEAC:CBIT < row, cbit, 0|1 > 
sets the specified C-bit to a 1 or 0 (where row is the M3 
subframe 1–7, and cbit is 1, 2, or 3). For example, 
:SOURce:DM:DS3:FEAC:CBIT 1, 3, 0 assigns the value 
0 to the C3 bit in row 1 (the FEAC bit). See “DS3 C-Bit 
Configuration” in Chapter 7 of the user manual for more 
information about rows and C-bits. 

:SOURce:DM:DS3:FEAC:CONT_ALM_STAT <ON|OFF> 

controls whether FEAC codes are sent continuously (ON), or 
not (off). When off, the FEAC bit is set by the DS3 C-Bit 
Control screen: Row 1, C3 program bit. 

   :SOURce:DM:DS3:FEAC:BURST_SETTING  <parameter> 

Parameter Retrieved Value 

FEAC_CODE Last received FEAC alarm/status code (text and 
six-bit sequence) 

FEAC_CODE_SEC Number of seconds since last FEAC code received

FEAC_SEQ Type of FEAC control-code sequence 
(activate or deactivate) last received 

FEAC_SEQ_SEC Number of seconds since last FEAC control-code 
sequence received 

FEAC_LINE Line affected by most recently received FEAC 
loopback control sequence (for example, DS1 #7) 
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selects the type of FEAC code to transmit several times in a 
row (BURST_SIZE specifies how often). The codes are 
transmitted when the ACTION (INJECT) key is pressed. 

:SOURce:DM:DS3:FEAC:LOOPBACK_LINE < 0...63 > 
selects the DS3 line to send the loop code to. Specify the 
decimal equivalent (0 – 63) of the line identifier code listed in 
the user manual (the left-most bit is the MSB). For example, 
:SOURce:DM:DS3:FEAC:LOOPBACK_LINE 47 sends the 
loop code to DS1 line #15. 

:SOURce:DM:DS3:FEAC:BURST_SIZE < 3...15 > 
specifies the number of times (3–15) to transmit the selected 
FEAC code (BURST_SETTING) when the ACTION 
(INJECT) key is pressed. 

:SOURce:DM:DS3:FEAC:ALM_STAT < 0...63 > 
selects the FEAC code to transmit when CONT_ALM_STAT 
is set to ON, or BURST_SETTING is set to ALM_STAT. Specify 
the decimal equivalent (0 – 63) of the FEAC code bit sequence 
listed in the user manual (the left-most bit is the MSB). For 
example, :SOURce:DM:DS3:FEAC:ALM_STAT 25 sends a 
DS3 Equipment Failure (SA) alarm. 

:SOURce:DM:DS3:FEAC:ACTION 

is equivalent to pressing the ACTION (INJECT) key in the 
DS3 FEAC Control screen. 

Parameter Code Transmitted

NONE No codes transmitted 

ACTIVATE Loop-up code for LOOPBACK_LINE 

DEACTIVATE Loop-down code for LOOPBACK_LINE 

ALM_STAT FEAC code for ALM_STAT (below) 
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Host Software Version 6.41 and
Product Numbers 
E4480A & E4487A

Host software version 6.41 is a minor maintenance upgrade to 
version 6.40.

 Agilent recommends you install this software in your test set.

Installation If release 6.41/3.40 is not already installed in your test set, please 
follow the attached instructions to download the software.

Applicability Host version 6.41 and ATM software version 3.40 supports these 
test sets:

• E4480A 156MTS SONET/T-Carrier Test Set

• E4487A 31XE SONET Electrical test Set

Older test sets may require a hardware upgrade to support some 
features. Please contact the factory.

New ATM 
Features

Host software version 6.41 combined with ATM version 3.40 
adds new ATM test capabilities.

Option URZ is required for ATM.

ATM Data  
Selection

“ATM” is a payload selection for the Data> field in OC-3c, DS3, 
DS1, and E1 signals. This replaces the ATM selections for the 
Payload field on the test setup screen. The DS3, DS1, and E1 
signals can be dropped from higher-rate signals.

When Data> is set to ATM, the ATM Setup selection is enabled 
on the Control Screens menu.

The Data> ATM selection does not apply for STS-12c and STS-1 
ATM testing. These modes are selected by setting Payload to 
ATM on the Test Setup screen.

ATM Software Version 3.40 Release Notes
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ATM Setup Menu An ATM Setup menu has been added to select the ATM test 
mode. Selecting ATM Setup from the Control Screens menu 
calls this menu, which allows the selection of standard, VPI/VCI 
scan, transfer delay, inter-arrival time, or cell capture modes.

Selecting an ATM mode automatically activates the appropriate 
ATM setup screens and corresponding ATM results screens.

Use with older 
ATM hardware

To take full advantage of the new ATM features in the 6.41/3.40 
release, older test sets may require a hardware upgrade 
performed at the factory. Please consult the factory for more 
information.

Other New 
Features

Other features in the 6.41/3.40 release include:

Auto Setup 
Enhancements

• Enhanced E1 detection

• Improved “demo” when test set is looped back on itself

• Animated activity indicator during Auto Setup test

SCPI Commands The following SCPI commands have been added to support the 
ATM Data> selections:

• :SOUR:DM:DATA1 <ATM>

• :SOUR:DM:DATA3 <ATM_HEC | ATM_PLCP>

• :SOUR:DM:DATA4 <ATM>
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AAL: ATM adaptation layer. Two sublayers of the 
BISDN protocol model that handle the segmenting 
of service payloads into ATM cells.

AB/ABCD: Signaling bits for DS0 and TS 
channels.

ac: Alternating current.

AIS: Alarm indication signal. Originally called a 
“Blue” alarm.

ALBO: Automatic line build out.

all-ones: A bit pattern made up entirely of binary 
1s.

AMI: Alternate mark inversion. A line coding 
scheme.

ANSI: American National Standards Institute.

APS: Automatic protection switching.

asynchronous: Not synchronized; not timed to 
an outside clock source.

ATM: Asynchronous transfer mode. A 
multiplexing and switching scheme using 
fixed-length cells comprising a header and payload 
section. There is no fixed relationship between cell 
generation and the transmission medium.

background channel: Additional channels on 
the ATM stream that are not the foreground 

channel.

bandwidth: A network’s or channel’s capacity to 
carry traffic.

BER: Bit error ratio. The number of errored bits 
over the total number of bits. This term is often 

used interchangeably with bit error rate (the 
number of errored bits per second).

BERT: Bit error ratio testing. This term is often 
used interchangeably with bit error rate testing.

BIP-n: Bit-interleaved parity n. An error 
monitoring scheme in which an n-bit code is used 
to provide proper parity over a specific part of a 
signal.

B-ISDN: Broadband ISDN. See also ISDN.

bit: A basic unit of data. A bit can be set to either 
a zero or a one.

BITS: Building integrated timing supply. A 
stratum 1 clock source, typically in a CO.

Blue alarm: See AIS.

BnZS: Bipolar with n-zero substitution. A line 
coding scheme in which n consecutive zeros are 
replaced by a substitution code to maintain a high 
pulse density. Typical codes are B3ZS for DS3 and 
B8ZS for DS1.

BPV: Bipolar violation. The occurrence of a pulse 
that breaks the alternating polarity rule.

BW: See bandwidth.

byte: Eight bits. Usually refers to a particular 
location in a frame.

C-bit: The third, fifth, and seventh overhead bits 
in a DS3 signal’s M-subframes.

C-bit parity format: A DS3 framing format.

CAS: Channel associated signaling.
Glossary–1



Glossary
CBR: Constant bit rate. A type of service in an 
ATM network for steady rate voice or synchronous 
data.

CCITT: Consultative Committee on International 
Telegraph and Telephone.

cell: Basic unit in ATM transmission. A 53-byte 
ATM cell comprises a 5-byte header and 48 bytes of 
information.

cell header: The first five bytes of an ATM cell.

cell loss priority bit: Bit 32 of an ATM cell 
header (bit 8 of byte 4).

clock: The timing of, or timing source for, digital 
telecom equipment.

CLP: See cell loss priority bit.

CMI: Code mark inversion. A line coding scheme.

COFA: Change of frame alignment. A shift in the 
alignment of a signal’s framing bits.

concatenation: The grouping of SONET STS 
payloads to form one large payload.

CP-bit: The third, fifth, and seventh overhead 
bits in the third M-subframe of a C-bit parity 
formatted DS3 signal.

CRC: Cyclic redundancy checksum. A basic 
error-checking technique.

CSES: Consecutively severely errored second.

CV: Code violation.

D4: See SF.

Daly pattern: A repeating 55 octet pattern.

datalink: A transmission path for data.

dB: Decibel. Standard unit for transmission loss, 
gain, and relative power ratios.

dBdsx: Decibels relative to the DSX level.

dBm: Decibels relative to one milliwatt.

dc: Direct current.

DCC: Data communications channel.

DCE: Data circuit-terminating equipment. 
Equipment that provides the interface between a 
DTE device and a transmission circuit. For 
example, a modem.

DRS: Digital reference signal.

DS0: Digital signal level 0; typically 64 or 56 kb/s.

DS1: Digital signal level 1; 1.544 Mbs.

DS2: Digital signal level 2; 6.312 Mbs

DS3: Digital signal level 3; 44.736 Mbs.

DSX: A digital signal cross-connect and patch 
bay.

DTE: Data terminal equipment. Equipment that 
converts user information into data signals for 
transmission. For example, a PC.

E1: A CCITT digital signal of 2.048 Mbs.

EFS: Error-free second.

error rate: The number of errors per second. 
Compare error ratio.

error ratio: The number of errors over the total 
number of bits. This term is often used 
interchangeably with error rate, although they are 
two different measurements.

ES: Errored second. A second in which at least 
one error occurred.

ESF: Extended Superframe framing format 
(DS1).

F-bit: Framing bit.

F4 OAM: An ATM OAM cell with a VCI of 3 or 4 
(decimal), used for VC OAM. See also OAM cell.
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F5 OAM: An ATM OAM cell with a PT of 4 or 5 
(decimal), used for VP OAM. See also OAM cell.

FAS: Frame alignment signal.

FEAC: Far-end alarm and control. The FEAC 
channel uses the third C-bit to carry alarm and 
control information.

FEBE: Far-end block error.

FERF: Far-end receive failure.

FFCV: Frame format coding violation.

FFM: Frame format mismatch.

foreground channel: The primary ATM channel 
used for ATM BER testing, etc.

frame: A group of bits, timeslots, or bytes whose 
unique positions can be identified relative an 
alignment signal or pointer.

FT1: Fractional T1. A subrate signal on a DS1, 
comprising N number of DS0 channels. See also 
N × 64.

GFC: Generic Flow Control. The first four bits of 
byte 1 in an ATM cell header.

GPIB: General purpose interface buss. See 
HP-IB.

HCS: Header check sequence. See HEC.

header: See cell header.

HEC: Header error control. A CRC field in the 
ATM cell header (byte 5).

hexadecimal: A base-16 numbering system in 
which the digits range from 0 through F. A 
hexadecimal value is noted with a subscript “h,” for 
example: “2A0Fh.”

HDB3: High-density bipolar with three-zero 
substitution. A line coding scheme.

HP-IB: Hewlett-Packard interface bus. A control 
bus for instruments.

Hz: Hertz.

idle cell: An ATM cell with a VP/VC address of 
000/0000, PT of 000, and CLP of 1. Compare with 
unassigned cell.

idle signal: A signal transmitted to indicate that 
a channel is not in use.

IEEE-488: Another name for the HP-IB or GPIB.

ISDN: Integrated Services Digital Network.

ISO: International Standards Organization.

jitter: Short-term variation in the phase of a 
digital signal (includes phase variation above 
10 Hz).

kbs: Kilobits.

kHz: Kilohertz.

LBO: See line build-out.

LCD: Liquid crystal display.

LCVA: Line code violation alarm.

LCVR: Line code violation rate.

line: In a SONET network, the part of the path 
between two consecutive line terminating network 
elements.

line build-out: A circuit that simulates the signal 
attenuation of a specified cable length.

line identifier: A FEAC bit sequence that 
indicates which DS3 or DS1 line is to be affected by 
a loopback command.

LOCS: Loss of cell synchronization.

LOF: Loss of frame.
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loopback: A state in which the transmit signal is 
reversed back as the receive signal, typically by a 
far-end network element.

LOS: Loss of signal.

M-bit: M-subframe framing bit. Bit 1 of the fifth, 
sixth, and seventh M-subframes in a DS3 signal.

M13: A DS3 framing format, or the multiplex 
between the DS1 and DS3 levels.

MBLT: Mobile both-line terminal framing format.

Mbs: Megabits per second. One megabit equals 
one million bits.

MBS: Maximum burst size.

M-frame: See multiframe.

MFA: Multiframe alignment. See multiframe.

MHz: Megahertz.

misinserted cell: An ATM AAL-1 cell that has a 
valid sequence number but is received out of order.

monitor level: The signal level at a DSX Monitor 
point.

multiframe: A set of consecutive frames in 
which the position of each is defined in relation to a 
multiframe alignment signal.

N × 64/N × 56: A subrate signal on a DS1 formed 
by using N number of 64 kbs or 56 kbs channels.

NDF: New data flag.

NIU: Network interface unit.

nm: Nanometer. One-billionth (10–9) of a meter.

NNI: Network–network interface. The 
demarcation point between two networks.

O-bit: DS3 overhead communication channel 
bits.

OAM cell: Operation and maintenance cell. An 
ATM cell with a payload type value of 1xx.

OC-1: Optical carrier signal, level 1 (51.840 Mbs).

OC-N: Optical carrier signal, level N (N number 
of OC-1s).

octet: Eight bits. Typically refers to a group of 
bits that spans more that one byte. Compare byte.

OH: See overhead.

OOF: Out of frame.

orderwire: A voice or data circuit used for 
maintenance purposes.

overhead: The bits or bytes in a frame or cell that 
are not the payload. Overhead provides for signal 
control and monitoring.

P-bit: Parity bit. The P-bit channel of a DS3 
comprises the P1 and P2 bits of the M-frame and 
provides parity information for the preceding 
M-frame.

parity: An error checking method that uses extra 
bits to provide even or odd parity for a specific 
group of bits.

path: In a SONET network, the connection 
between the point where the frame for a signal is 
assembled, and the point where it is disassembled.

path overhead: The portion of STS overhead 
contained with the SPE.

payload: The information bits of a frame or cell. 
Those bits that are not part of the overhead.

payload pointer: The pointer that indicates the 
beginning of the SPE.

payload type: Three bits in the fourth byte of an 
ATM cell header indicates the payload type for the 
cell.

PCR: Peak cell rate.
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PDH: Plesiochronous digital hierarchy

PLCP: Physical layer convergence protocol. A 
protocol that defines the mapping of ATM cells 
onto a facility. DS3 PLCP comprises a 125 µs frame 
within the DS3 payload; there is no fixed 
relationship between the PLCP frame and the DS3 
frame.

POH: See path overhead.

POI: Path overhead indicator.

pointer: See payload pointer.

PRBS: Pseudorandom bit sequence. A test 
pattern that simulates live, random traffic.

QRSS: Quasirandom sequence signal.

RAI: Remote alarm indication.

RDI: Remote defect indication.

SC: Sequence check. The first byte after the 
header in an AAL-1 ATM cell.

SCNR: Selected cell not received.

SCPI: Standard commands for programmable 
instruments. A remote instrument control 
language.

SCR: Sustained cell rate.

SDH: Synchronous digital hierarchy.

section: The part of a SONET path between a 
terminal network element and a regenerator, or 
between two regenerators.

SEE: Severely errored event.

SF: Superframe format. DS1 framing format.

SLC-96™: Subscriber loop carrier system 96. An 
AT&T T1 framing format.

SN: Sequence number. A unique value indicating 
the transmission order of ATM cells. Also called 
sequence count.

SONET: Synchronous optical network.

SPE: Synchronous payload envelope. The part of 
the STS frame not including the transport 
overhead.

STS-1: The basic synchronous transport signal. A 
125 µs frame (51.840 Mbs). 

STS-N: Synchronous transport signal N, where N 
indicates the number of STS-1s interleaved to 
generate the signal.

STS-Nc: Concatenated STS signal. An STS-N in 
which the payloads are grouped to carry a 
super rate signal.

sub-multiframe: A division of a multiframe that 
also contains multiple frames. Also called an 
M-subframe.

synchronous: Synchronized. Occurring at the 
same rate or period; sharing common timing with 
an outside timing source.

T1: See DS1.

timeslot: A unique, cyclic time interval; typically 
providing a single channel.

timing: See clock.

traffic profile: In ATM, the characteristics of a 
cell stream as defined by its peak cell rate, 
sustained cell rate, and maximum burst size.

transport overhead: The portion of STS 
overhead including section OH and line OH.

TS: See timeslot.

TS0: Timeslot zero. The first timeslot in an E1 
frame.
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TS16: Timeslot sixteen. The 17th timeslot in an 
E1 signal, used to provide channel associated 
signaling.

TTL: Transistor-to-transistor logic. A standard 
transmission level with a logic low of zero volts and 
a logic high of 5 volts.

UAS: Unavailable seconds.

UI: Unit interval. The duration of one clock cycle, 
or pulse period, for a given rate.

unassigned cell: An ATM cell with VP/VC of 
000/0000 and a CLP of 0. Compare with idle cell.

UNI: User-Network Interface. The demarcation 
point between the customer premise and the 
network.

V: Volts.

Vac: Volts, alternating current.

VC: Virtual channel. A path between two points 
identified by a label rather than a fixed physical 
path.

VCI: Virtual channel identifier. The label assigned 
to a VC.

Vdc: Volts, direct current.

VF: Voice frequency.

VP: Virtual path. A route, identified by a label, for 
a group of VCs transmitted between common 
points.

VPI: Virtual path identifier. The label assigned to 
a VP.

Vpk: Volts peak.

VT: Virtual tributary.

VT1.5: A virtual tributary carrying a DS1 (1.544 
Mbs) signal.

X-bit: The first overhead bit in the first and 
second M-subframes of a DS3 M-frame.

Yellow alarm: (DS1) Also called a remote alarm 
or RAI, this alarm indicates a near-to-far 
transmission failure.
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Agilent Technologies Limited 
Warranty

Agilent warrants to you, the end-user customer, that Agilent 
hardware, accessories, and supplies will be free from defects in 
materials and workmanship after the date of purchase, for the 
period specified above. If Agilent receives notice of such defects 
during the warranty period, Agilent will, at its option, either repair 
or replace products which prove to be defective. Replacement 
products may be either new or equivalent in performance to new.

1. Agilent warrants to you that Agilent software will not fail to 
execute its programming instructions after the date of purchase, 
for the period specified above, due to defects in material and 
workmanship when properly installed and used. If Agilent receives 
notice of such defects during the warranty period, Agilent will 
replace software which does not execute its programming 
instructions due to such defects.

2. Agilent does not warrant that the operation of Agilent products will 
be uninterrupted or error free. If Agilent is unable, within a 
reasonable time, to repair or replace any product to a condition as 
warranted, you will be entitled to a refund of the purchase price 
upon prompt return of the product.

3. Agilent products may contain remanufactured parts equivalent to 
new in performance or may have been subject to incidental use.

4. Warranty does not apply to defects resulting from (a) improper or 
inadequate maintenance or calibration, (b) software, interfacing, 
parts or supplies not supplied by Agilent, (c) unauthorized 
modification or misuse, (d) operation outside of the published 
environmental specifications for the product, or (e) improper site 
preparation or maintenance.

5. Agilent warrants that the Agilent Product described above will be 
able to accurately process date data (including, but not limited to, 
calculating, comparing, and sequencing) from, into, and between 
the twentieth and twenty-first centuries, and the years 1999 and 
2000, including leap year calculations, when used in accordance 
with the Product documentation provided by Agilent (including 
any instructions for installing patches or upgrades), provided that 
all other products (e.g. hardware, software, firmware) used in 

Agilent Product: Duration of Limited Warranty:

156MTS (E4480A) 3 years
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combination with such Agilent Product (s) properly exchange date 
data with it. If the Specifications require that specific Agilent 
Products must perform as a system in accordance with the 
foregoing warranty, then that warranty will apply to those Agilent 
Products as a system, and Customer retains sole responsibility to 
ensure the Year 2000 readiness of its information technology and 
business environment. The duration of this warranty extends 
through January 31, 2001. To the extent permitted by local law, this 
warranty applies only to branded Agilent Products and not to 
products manufactured by others that may be sold or distributed 
by Agilent. The warranty in this paragraph 6) applies only to 
Agilent Products shipped after July 01, 1998. The remedies 
applicable to this paragraph 6) are those provided in paragraphs 1, 
2, and 3.

6. Products purchased from Agilent outside the U.S. will receive the 
standard warranty in the country of purchase. If end user customer 
moves such Products to another country where Agilent has 
Support presence, then end user customer will receive the 
destination country standard warranty.

7. Products purchased in the U.S., based on the U.S. list prices will 
only receive standard warranty in the U.S., except for Products 
with a global warranty. A global warranty means that the Product 
will include the destination country’s standard warranty in any 
country where the Product is moved, provided that Agilent has 
Support presence in that country.

8. TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE 
WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY OR 
CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR 
IMPLIED AND AGILENT SPECIFICALLY DISCLAIMS ANY 
IMPLIED WARRANTIES OR CONDITIONS OF 
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS 
FOR A PARTICULAR PURPOSE. Some countries, states or 
provinces do not allow limitations on the duration of an implied 
warranty, so the above limitation or exclusion might not apply to 
you. This warranty gives you specific legal rights and you might 
also have other rights that vary from country to country, state to 
state, or province to province.

9. TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN 
THIS WARRANTY STATEMENT ARE YOUR SOLE AND 
EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO 
EVENT WILL AGILENT OR ITS SUPPLIERS BE LIABLE FOR 
LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR 
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OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR 
OTHERWISE. Some countries, states or provinces do not allow the 
exclusion or limitation of incidental or consequential damages, so 
the above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, 
EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT 
EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO 
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE 
SALE OF THIS PRODUCT TO YOU.
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Calibration 

Calibration This instrument must be calibrated only by authorized Agilent 
Technologies personnel. Unauthorized service or calibration will void 
the warranty. 

The 156MTS (E4480A) requires calibration every two years. To arrange 
for calibration, please contact Technical Support at 1-800-923-7522 or 
978-266-3300.

Service If your 156MTS does not appear to be operating properly, carefully 
check all configuration parameters and connections. Improper 
selection of timing modes or drop channels, for example, can cause 
unexpected operation.

To reset the 156MTS to its factory-default settings, switch the 
instrument on while pressing and holding the STOP key. Release the 
STOP key when the display shows “Performing Cold Start.” When the 
factory defaults are reset, you can use a patch cord to loop the 
instrument back on itself and perform simple tests to verify its 
operation. If this procedure does not solve your problem, call Agilent  
Service Test Division Technical Support at 1-800-923-7522 or 
978-266-3300. Trained personnel are available to help solve your 
problem or determine if the unit must be returned for repair.Returning a 
Unit for Repair

If your 156MTS must be returned, a Technical Support representative 
will assign a return material authorization (RMA) number. No product 
will be accepted for service without an RMA number.

Ship the instrument to: Repair Department
Agilent Technology Service Test Division
2 Robbins Road
Westford, MA 01886 USA 
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Be sure to mark the RMA number on the outside of the shipping 
container. In addition, be sure to include the following information:

• Model number (E4480A) and name (156MTS)

• Serial number

• Your name and phone number

• A written description of the problem

• Return “ship to” address

• Invoice address

• Payment information (if unit is out of warranty)
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Index
A
A1/A2 bytes

error injection 3-31
error measurements 4-12

AAL type
cell structures 21-2–21-4
foreground channel 19-8
receive channel 19-17

action/local key 1-2

Administrative Setups 
screen 23-8

alarms
ATM measurements 20-20
DS1 measurements 12-16
DS3 measurements 8-13
E1 16-15
error squelching 23-3
SONET 2-8, 3-31
STS-N measurements 4-26
VT measurements 4-36

APS
configure 2-4
measurement screen 4-15
message 3-12
mode 3-13
passthrough 3-22
requested channel 3-13
setup parameters 3-12

ASCII characters hex values 3-19

ATM
address notation 19-4
automatic channel scan 18-2
background channels 18-15, 
18-16, 19-19
BW step size
cell capture 18-4
configure VP/VC 18-14
error injection 19-24
GFC 19-14
global setup 

parameters 18-10, 19-4
idle cell payload 19-12
indicators 20-2
MBS 19-7
payload type 19-14
PCR 19-7
periodic burst mode 19-10
receive cell type 19-17
receive channel 19-13
SCR 19-7
setup menu 19-3
setup parameters 19-1–19-23
test mode 19-3
testing 18-1
traffic shaping 19-4, 19-7
user pattern 19-12
VBR profile 19-7
VCI 19-14
VPI 19-14

ATM cell
burst size 19-9
payloads 18-13
scrambling 19-4
structure 21-2
test cell 19-8, 21-4

ATM foreground channel 18-11, 
18-12, 19-13

distribution 19-8
interleaving 19-10
setup 19-6
ATM measurements 20-1–20-21
AAL-1 CRC/parity 20-11
AAL-1 misinserted cells 20-12
alarms 20-20
cell loss 20-10
HEC errors 20-7
payload bit error 20-9
PLCP 20-16
selected VP/VC 20-4
total cell stream 20-6

ATM on STS-12c 19-23

ATM rx channel 
measurements 20-4

ATM SETUP screens
#1 Global Setup screen 19-4
#2 Foreground Channel Control 

screen 19-6
#3 Cell Payload Data 

screen 19-12
#4 screen (header and rx 

channel) 19-13
#5 Transmit Background 

Channel Control 
screen 19-18

#6 Transmit Background 
Header Setup screen 19-21

STS-12c 19-23

Auto Setup key 1-2

automatic print mode 23-5

automatic test start 23-5

Auxiliary Test Setup 
display 23-4
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Index
B
B1 byte

CV measurements 4-5
error injection 3-30

B2 byte
CV measurements 4-6
error injection 3-30

B3 byte
CV measurements 4-9
error injection 3-30

background channels
AAL type 19-19
activation 19-18
configure 18-15, 18-16
header setup 19-21
payload 19-19

bandwidth—see BW

BITS timing
input 3-3, 3-5
output source 23-7

block errors
DS1 measurements 12-6
E1 measurements 16-7

block size 23-7

BPVs
DS1 measurements 12-10
DS3 measurements 8-10
E1 measurements 16-11
STS-1 measurements 4-13

burst error input 1-3

burst error trigger 27-3, 27-8

BW
foreground channel 19-6
step size 19-4

C
calibration and service 4

C-bit 7-11
Index–2
CDI (DS1 idle) 11-8, 12-12

CE mark 27-5, 27-9

cell capture
running a test 18-4

cell interleaving 19-10
periodic bursts 19-9, 19-10

cell loss measurements 20-10

cell loss priority 19-14

CLP 19-14

Code>
DS1 11-3
E1 15-4

cold start 1-8

Configuration From>
DS0 11-19
DS1 11-17

configuration lock during 
test 23-2

configuration storage
recall 22-5
store 22-2

contrast keys 1-2

correctable HEC errors 20-7

counting mode (VT) 3-28, 23-6
configure 2-11

D
D&I channel—see D&I>

D&I>
DS0 11-11
DS1 11-6
STS-1 3-8
STS-3c 3-10
TS 15-7

Daly pattern 11-5

Data>
ATM background 
channel 19-19
ATM foreground 

channel 19-12
ATM idle cells 19-12
DS0 11-11
DS1 11-4
DS3 7-3
E1 15-3
FE1 15-9
FT1 11-9
STS-1 3-8
STS-12c 3-9
STS-3c 3-9
STS-Nc 3-9
TS 15-7

datalinks
configure 2-7, 10-5
handset port 1-3, 27-5
ports 27-4

date and time 23-8

display 1-4

display hold key 1-2, 1-10

download
DOWNLOAD program 26-6

drop & insert mode 1-14

drop channel—see Drop>

Drop>
DS0 11-11
DS1 11-6
DS1 from dual DS3 7-6
E1 15-5
STS-1 3-7
STS-3c 3-10
TS 15-6
VT 3-27
VT group 3-28



Index
DS0
bit error measurements 12-20
configure 10-8
D&I channel 11-11
drop channel 11-11
error injection 11-8
insert channel 11-10
payload 11-11
setup 

parameters 11-10–11-12
signaling drop port 13-4
signaling scan 10-17, 11-19
testing 10-1
tx signaling 11-12
VF measurements 12-19

DS1
automatic drop scan 10-15
block size 23-7
CDI 11-8
configure 10-4
D&I channel 11-6
drop channel 11-6
DS0 11-10
DS1/E1 alarm and status 

LEDs 1-2
error injection 11-8
ESF datalink message 10-5
framing format 11-3, 13-6
FT1 11-9
idle code 11-8, 12-12
indicators 12-2, 16-2
insert channel 11-6
line code 11-3
loop codes 11-8, 11-14
payload 11-4
rx level 11-4
setup parameters 11-2–11-8
status screen 12-18
termination mode 11-4
testing 10-1
tx level 11-3
tx timing 11-2
user patterns 10-6, 11-13
DS1 measurements 12-1–12-22
alarms 12-16
bit error 12-4
block error 12-6
BPV 12-10
CRC-6 12-7
DS0 12-19, 12-20
ESF FDL 12-13
framing error 12-8
FT1 12-21
idle/CDI 12-12
jitter 4-25, 12-15, 16-14
loop codes 12-13
signal 12-14
slips 12-11

DS1 structure 13-6

DS1 DROP jack 11-6

DS1/E1 connectors 1-2

DS2
frame format 9-5
measurement screen 8-20
transmit X-bit 23-6
DS3
alarm and status LEDs 1-2
C-bits 6-7, 7-11
configure 6-4
drop and insert 7-4
dual DS3 setup 6-5, 7-5
E1 mapping 15-5
error injection 7-17
FEAC 6-7, 7-8
FEBE bits 7-4
frame format 7-2, 9-5
indicators 8-2
payload 7-3
rx level 7-2
setup parameters 7-1–7-17
testing 6-1
tx DS2 X-bit 23-6
tx level 7-2
tx timing 7-4
user pattern 6-9, 7-14
X-bit 7-4

DS3 C-Bit Control screen 7-11

DS3 connectors 1-2

DS3 FEAC Control screen 7-8

DS3 measurements 8-1–8-21
alarms 8-13
bit error 8-4
BPV 8-10
C-bit monitor screen 8-12
CP-bit parity 8-7
DS2 8-20
dual DS3 8-3
FEAC 8-11
FFCV 8-9
frame error 8-8
jitter 4-25, 12-15, 16-14
P-bit parity 8-6
P-bits 8-12
PLCP 20-16
signal 8-15
status screen 8-17
X-bits 8-12
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Index
DS3 overhead bits 9-6

DS3 pulse mask
results 8-18
setup 7-12
test 6-11

DS3 DROP jack 7-4

dual DS3 7-5
DS1 drop 7-6
LED sharing 7-6
measurements 8-3
setup parameters 7-7
test setup 6-5

E
E1

block size 23-7
configure 14-4, 14-9
drop channel 15-5
DS1/E1 alarm and status 

LEDs 1-2
DS3 mapping 15-5
error injection 15-10
FE1 15-9
framing format 15-2, 17-5
indicators 12-2, 16-2
insert channel 15-4
line code 15-4
payload 15-3
rx level 15-4
setup parameters 15-2–15-5
signaling scan 14-11
status screen 16-17
termination mode 15-4
testing 14-1
timeslot mode 15-6
TS setup parameters 15-6
tx level 15-4
tx timing 15-2
Index–4
E1 measurements 16-1–16-19
alarms 16-15
bit error 16-4
block error 16-7
BPV 16-11
CAS frame error 16-9
CRC-4 16-10
jitter 4-25, 12-15, 16-14
signal 16-13
slips 16-12
TS 16-18, 16-19
TS0 frame error 16-8
TS16 frame error 16-9

E1 multiframe structure 17-6

E1 structure 17-5

error inject key 1-2

error injection
about error injection 

rates 27-8
ATM 19-24
ATM-affecting error 

types 19-25
burst input 1-3
burst trigger 27-3, 27-8
DS1/DS0 11-8
DS3 7-17
E1 15-10
SONET 3-30
VT 3-32

error squelching 23-3

ESF datalink message 10-5

ESF loop codes 11-14

event logging setup 
parameters 22-9

Event Logging Setups menu 22-8

F
FDL 12-13

FE1
setup parameters 15-9
FEAC
alarm and status codes 7-8
measurement screen 8-11
setup parameters 7-8
transmission 7-8

FEBE
bits 7-4, 9-5
far-end FFCV count 8-9

FFCV measurements 8-9

foreground channel
AAL type 19-8
bandwidth 19-6
bit error measurements 20-9
cell distribution 19-8
configure 18-11, 18-12
distribution 19-10
header 19-13
payload 19-12

frame slips—see slips 

measurements

framing format—see Frm>

Frm>
DS1 11-3
DS3 7-2
E1 15-2

front panel 1-2

FT1
bit error measurements 12-22
configure 10-7
setup parameters 11-9
testing 10-1

G
G1 byte

FEBE measurements 4-10
REI-P 4-10

GFC 19-14

GPIB—see IEEE-488



Index
H
H1SS (H1 byte) 3-16

handset 1-3

handset interface 27-5, 27-9

HEC errors 20-7

hex values
ASCII characters 3-19
ATM programming 19-4

history reset key 1-2

HP-IB—see IEEE-488

I
idle cells

header 19-13
payload 19-12

idle code (DS1) 11-8, 12-12

IEEE-488
address 23-8
interface port 23-8
operation 25-8
setup 25-7

in-band loop codes 11-14

Ins>
DS0 11-10
DS1 11-6
E1 15-4
STS-1 3-7
STS-3c 3-10
TS 15-6
VT 3-25
VT group 3-28

insert channel—see Ins>

insert STS-1 channel numbering—
see STS-12 numbering 

scheme

Inv PRBS? (invert PRBSs) 23-3
J
J0 byte

display screen 4-21, 4-22
programming 3-18

J1 byte
display screen 4-21, 4-22
programming 3-18, 3-24

jitter
hits measurements 4-25, 8-16, 

12-15, 16-14
hits threshold 23-3
mask measurements 4-25, 

8-16, 12-15, 16-14
measurements 4-25, 12-15, 

16-14

K
K1/K2—see APS

L
laser 3-2

laser state during test setup 23-6

LCD display 1-2, 1-4

LEDs
ATM indicators 20-2
DS1/E1 indicators 12-2, 16-2
DS3 indicators 8-2
dual DS3 mode 7-6
STS-N indicators 4-2
VT indicators 4-29

Line (SONET span) 5-8, 5-10

line code—see Code>

line FEBE—see REI-L

line overhead bytes 3-15

loop codes
DS1 11-8
DS1 results 12-13
user-programmable 11-14
M
main menu 1-4

measurements
pulse mask 8-18

memory keys 1-2

misinserted cell results 20-12

mode—see test mode

Modify Global Configurations 
screen 23-2

monitor mode 1-13

N
navigation keys 1-2

Nx> (base rate) 11-9, 11-11

O
OAM cells 19-14

OC-1
rx source 3-6
setup parameters 3-5
tx timing 3-5

OC-12 rx source 3-3

OC-3 rx source 3-3

optical signal connectors 1-2

optical transmitter 3-2

Option 231 27-5, 27-9

order at mux input 
(STS-12) 23-6

order of transmission 
(STS-12) 23-6

orderwire 1-3
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Other>
DS0 11-10
DS1 11-6
STS-1 3-7
STS-3c 3-10
TS 15-6
VT 3-26
VT group 3-28

Other>E1 15-5

Oths> (E1) 15-5

Oths>—see Other>DS1

out-of-band loop codes 11-14

overhead bytes 3-15

overhead configuration 2-5

P
passthru

DS1 11-5
DS3 7-3

Path (SONET span) 5-8, 5-10

path overhead
bytes 3-16
results screen 4-20

Path Overhead Control 
screen 3-16

patterns
55 octet 11-5
PRBS inversion 23-3
user programmable 7-14, 

10-6, 11-13, 19-12

patterns—see also Data>

payload type 19-14

payload—see Data>

P-bits display 8-12

PLCP
error injection 19-24
measurements 20-16
structure 21-5
Index–6
pointer
automatic sequence 2-9
error injection 3-31
STS-12c measurements 4-15

pointer measurements 4-14

power-up optical transmitter 
state 3-2

PRBS inversion 23-3

print key 1-2

printing 24-1
automatic 23-5, 24-3
automatic event printing 22-9
printer port parameters 23-8
setup 24-2

Prog32>
STS-12c 3-9

PT 19-14

pulse mask
results 8-18
running a test 6-11
setup 7-12

R
rear panel 1-3

receive channel 19-13
cell type 19-17
measurement screens 20-4
VP/VC 19-13

REI-L

remote control 25-1
IEEE-488 interface 

parameters 23-8
remote port parameters 23-8
SCPI/IEEE-488 25-7

remote front panel 25-3
operation 25-6
setup 25-4

repeating tests 23-4
restore default settings 1-8

results level 23-2

results storage
automatic store 23-5
clear 22-7
recall 22-7
store 22-6

RS-232 datalink port 3-20, 7-15, 
11-16

RS-422 datalink port 27-4

rx level—see Rx>

Rx>
DS1 11-4
DS3 7-2
E1 15-4
OC-1 3-6
STS-1 3-6
STS-N 3-3

S
SCPI

operation 25-8
setup 25-7

scrambling
ATM cells 19-4
STS-1 3-5, 3-8

SDH 3-16

Section (SONET span) 5-8, 5-10

section overhead bytes 3-15, 
3-18

Section Overhead Control 
screen 3-18

Section Trace 3-18

Select>
FE1 15-9
FT1 11-9

service 4



Index
Setup Menu
ATM 19-3

Setup menu
administrative setup 

parameters 23-8
auxiliary test setups 23-4

signaling
drop port 13-4
DS0 11-12
TS 15-7

signaling scan
DS0 10-17
E1 14-11

slips measurements
DS1 12-11
E1 16-12

SONET
alarms 3-31
DCC pass-through 3-21
error injection 3-30
J1 Path Trace Control 

screen 3-18
orderwire handset 1-3
overhead bytes 5-10
overhead 

parameters 3-14–3-19
parameters 3-1–3-32
VT parameters 3-25

SONET measurements 4-1–4-28
APS 4-15
line code violations 4-6
path code violations 4-9
path FEBE 4-10
path overhead results 4-20
path trace display 4-21, 4-22
pointer 4-14
REI-L 4-7
REI-P 4-10
section code violations 4-5
transport overhead 

results 4-19
speaker keys 1-2

Start/Stop keys (test pause) 1-2

STS-1
D&I channel 3-8
D&I payload 3-8
drop channel 3-7
insert channel 3-7
rx level 3-6
rx source 3-6
scrambling 3-5, 3-8
setup parameters 3-5, 3-7
tx level 3-6
tx timing 3-5

STS-1 frame 5-8

STS-1 measurements
BPV 4-13
jitter 4-25, 12-15, 16-14

STS-12 numbering scheme 23-6

STS-12c
ATM 19-23
ATM HEC errors 20-7
bit error measurements 4-11
concatenated frame 5-11
pointer measurements 4-15
setup parameters 3-9

STS-3c
bit error measurements 4-11
drop channel 3-10
error injection 3-30
insert channel 3-10
pointer measurements 4-14
REI-L measurements 4-7
setup parameters 3-9

STS-3c frame 5-11
STS-N
alarm and status LEDs 1-2
alarms measurements 4-26
frame measurements 4-12
indicators 4-2
pointer measurements 4-14
receive source 3-3
setup parameters 3-3
status screen 4-28
tx timing 3-3

STS-N connectors 1-2

STS-N frame 5-9
concatenated 5-11

STS-Nc
setup parameters 3-9

Sub Menu Opt Pwr 23-6

System Configuration 
screen 1-12

system parameters
event logging 22-8
system configuration 1-12

T
Term>

DS1 11-4
E1 15-4

terminal test mode 1-13

termination mode—see Term>

test duration mode 23-4

test mode 1-13
ATM 19-3

test mode label 1-4, 1-13

test operation screen 1-4

test pause (Start key) 1-2, 1-10

test sequences
signaling scan 11-19

timed test length 23-4

timeslot—see TS
Index–7



Index
Tone> 15-7

traffic profile 19-7

traffic shaping 19-4

transport overhead
results screens 4-19

Transport Overhead Control 
screen 3-15

Trouble Scan 23-2

Trouble Scan key 1-2

TS
bit error measurements 16-19
configure 14-7
D&I channel 15-7
drop channel 15-6
insert channel 15-6
measurements screen 16-18
payload (data) 15-7
payload (tone) 15-7
setup parameters 15-6–15-10
signaling drop port 13-4
signaling scan 11-19
testing 14-1
timeslot mode 15-6
tx signaling 15-7

TS0 frame error 
measurements 16-8

TS16 frame error 
measurements 16-9

tx level—see Tx>

tx timing—see TxClk>

Tx>
DS1 11-3
DS3 7-2
STS-1 3-6
Index–8
TxClk>
DS1 11-2
DS3 7-4
E1 15-2
OC-1 3-5
STS-1 3-5
STS-N 3-3

Type>
background channel 19-19
foreground channel 19-8
receive channel 19-17

U
uncorrectable HEC errors 20-7

user patterns
ATM 18-13, 19-12
DS1 10-6, 11-13
DS1 loop 11-14
DS3 6-9, 7-14
E1 11-13
STS-12c 3-9

V
V5 byte

FEBE mesurements 
(VT) 4-32

VF measurements 12-19

VP/VC
address notation 19-4
automatic scan 18-2
background channel 19-21
configure 18-14
foreground channel 19-13
receive channel 19-13
setup 19-14

VT
configure 2-11
error injection 3-32
indicators 4-29
setup parameters 3-25

VT alarm and status LEDs 1-2
VT mapping
counting mode 2-11, 3-28, 

23-6
drop channel 3-27
drop VT group 3-28
insert channel 3-25
insert VT group 3-28
Other VTs payload 3-26
VT group mapping 3-29

VT measurements 4-29–4-37
alarms 4-36
code violations 4-31
FEBE 4-32
pointer measurements 4-33

VT overhead bytes 5-13

VT1.5 format and mapping 5-12

X
X-bit 7-4

DS2 23-6

X-bits display 8-12
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